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Chapter 1: Introduction to CAM2® 2021

CAM2® 2021 is a NIST and PTB-certified CAD-based metrology software package specifically designed to 
conduct precise measurements and inspections of complex features simply by inputting 3D measurements. There is 
virtually no limit to the types of measurements you can analyze using CAM2. Through IGES, VDA, CATIA, 
ProEngineer, or Unigraphics translation, your data can be exchanged with any number of CAD systems.

This document contains all general information and specific instructions needed to use CAM2. If you have any 
questions or need further instructions for any procedure, contact your Customer Service Representative by Phone, 
Fax or E-Mail. See “Technical Support” on page 333. You can also reach the Customer Service Applications and 
Training group via Internet e-mail at the following addresses:

• support@faro.com
• applications@faro.com
• training@faro.com

Visit the FARO Customer Service area on the Web at www.faro.com to search our Knowledge Base, which is 
available 24 hours a day, 7 days a week. 

 
How to Use This Manual 2

System Requirements 3

Installing CAM2 4

Licensing CAM2 4

Versions 9

Directory and File Locations 10

Getting Started 10

Screen Layout 15

Ribbon 16

Quick Access Toolbar 23

Notification Center 24

Navigation Window 24

Control Panels 25

Controlling the View 28

FARO CAM2 2021 (v2021.0) Page 1 of 336

mailto:support@faro.com
mailto:applications@faro.com
mailto:training@faro.com
http://www.faro.com/


Features 28

Device-controlled Mouse 29
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Help 29
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How to Use This Manual
Listed below are some visual and typographical conventions used in each of the sections.

Bold text Indicates directory names, menu names, buttons, tabs, key names, dialog box names, dialog 
box items, acronyms, and modes.

monospaced 
text

Indicates alphanumeric characters or values you enter in a field on the screen. For example, 
“Type 0.005 for the tolerance setting.”

It is important that you understand the meaning of the following words before proceeding.

digitize Indicates the recording of XYZ coordinates of a point or location in 3D space. The word digitize is 
the same as the term measure when referring to points.

choose or 
select Indicates that you are initiating an action. For example, “Select File > Insert > CAD Parts.”

left-click, 
right-click, 
click, or 
press

Indicates that you press and release the corresponding mouse button or keyboard key. Also used 
when referring to the hardware device buttons. For example, “After selecting a file from the Open 
File dialog box, click OK to open the file” or “Press ESC at anytime to cancel a command.”

drag Indicates that you press and hold the left mouse button down and move the mouse. Release the 
mouse button to finish. This word is often used when changing the size of a window or toolbar.

Warning
WARNING:  A WARNING notice denotes a hazard. It calls attention to an operating procedure, practice, or 
event that, if not correctly performed or adhered to, could result in personal injury or death. Do not proceed 
beyond a WARNING notice until the indicated conditions are fully understood and met. 

Caution
CAUTION:  A CAUTION notice denotes a hazard. It calls attention to an operating procedure, practice, or 
event that, if not correctly performed or adhered to, could result in damage to the product or loss of important 
data. Do not proceed beyond a CAUTION notice until the indicated conditions are fully understood and met. 

FARO CAM2
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Note
NOTE:  A NOTE notice denotes additional information that aids you in the use or understanding of the 
equipment or subject. Specifically, they are not used when a WARNING or CAUTION is applicable. They are 
not safety related and may be placed either before or after the associated text as required. 

System Requirements
The following are the minimum and the recommended hardware and software requirements for CAM2.

Hardware
• Processor: Dual Core CPU
• RAM: 8 GB
• Hard Drive: 500 GB
• GPU: NVIDIA Quadro® M520
• USB ports: 1 (if using portlock licensing)

Recommended Requirements (For Point Probe Measurements with 
Large CAD; Moderate Point Cloud Scanning)
• Processor: Quad Core CPU
• RAM: 16 GB
• Hard Drive: 512 GB SSD
• GPU: NVIDIA Quadro® M2200
• USB ports: 1 (if using portlock licensing) 

High Performance Requirements (For Intensive Point Cloud Scanning)
• Processor: Quad Core CPU
• RAM: 32 GB
• Hard Drive: 1 TB SSD
• GPU: NVIDIA Quadro® P5000
• USB ports: 1 (if using portlock licensing)

Software
NOTE:  The following computer operating systems are supported:

• Microsoft® Windows® 8.1 (64 bit)
• Microsoft® Internet Explorer 10.0

OR 

• Microsoft® Windows® 10 version 1607 or later (to support .Net Framework 4.7.1)
• Microsoft® Internet Explorer 11.0

NOTE:  We recommend Windows 10 64 bit Professional operating system for point cloud scanning.

FARO CAM2
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Installing CAM2
CAM2 is quick and easy to install. The CAM2 USB includes the software and a standard Windows help file. Also 
included in this USB is a Portable Document Format (*.PDF) file of the CAM2 manual. You must install Adobe 
Acrobat Reader, included on the CAM2 USB, to read and print the manual from your computer.

To Install CAM2: 

1. Place the CAM2 USB into the computer’s USB port. The USB automatically loads and opens the CAM2 
window. 

• If the USB does not automatically open the CAM2 window, click Start > My Computer, double-click 
your computer’s USB drive (usually D:), and then double-click autorun.exe. 

2. Click an installer language. Or, click View Manual to move to the CAM2 manual menu.

• Adobe Acrobat Reader is required to view the CAM2 manual. You can install this program from the 
CAM2 manual menu.

3. If necessary, The CAM2 install program displays a list of auxiliary system programs that are required for 
CAM2. Click Install to continue. Click OK to confirm the install of each program. A system restart may also 
be required during this section of the install.

4. Read the Welcome screen and click Next.

5. Read and accept the Software License agreement. Click Next to continue.

6. Add or remove a component by clicking on the individual component.

7. Click Change to change the destination folder for CAM2, or click Next to create the default folder.

8. Click Install to begin installing the software.

9. Click Finish when the installation is complete. 

NOTE:  You can also install and manage your CAM2 installation using FARO InTouch. For more 
information, see “FARO InTouch” on page 10.

Licensing CAM2
CAM2 requires the installation of a license. Your licensing option is determined at the purchase of CAM2. There 
are two licensing options for CAM2:

1. Licensing with a port lock - the license number is recorded into the port lock. Attach the port lock to a USB port 
on your computer.

2. Licensing with a key code - the key code is printed on the back of the CAM2 package (this box.) Start CAM2 
and enter this code into the dialog box.

• The license key code must be validated using an Internet connection. Once complete, this validation is 
permanently stored on your computer.

FARO CAM2
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• If you do not have an available Internet connection, contact FARO’s customer service team to receive a 
validation file.

• Each key code can only be activated three times. If you install CAM2 on a new computer, contact 
FARO’s customer service team to deactivate your key code from your old computer.

Contact FARO’s customer service team if you need to switch your licensing option, or have another issues with 
licensing CAM2. See “Updating Your License” on page 8.

Licensing Wizard
When you start an unlicensed version of CAM2, the licensing wizard displays. Select from the following options:

• I have a license

Click Product Key and enter your product key

OR 

Click Hard Lock Key and insert your port lock.

• I don’t have a license

Click Trial to run a trial version of the software for 30 days

OR 

Click Purchase for additional information from the FARO website on purchasing the software.

• Additional Options

Click Network License to transfer a network license from a server.

Click Transfer Key to transfer a license from another computer.

If you plan to use CAM2 on more than one computer, especially computers on different networks, a hard lock key 
allows you to easily move the license between computers. Product keys are more convenient for single computer 
installations.

Select Network License if you are managing multiple licenses over a network. See “Network Licensing” below.

Select Transfer Key if you are transferring a product key from another computer. See “Transferring Network 
Licenses” on page 8.

Network Licensing
CAM2 allows management of multiple licenses over a network. This option is available for users who want to 
employ a separate computer to host a network license without having to install CAM2 on that computer.

Network licenses are hosted on a license server computer and shared to client computers over the network. They 
can be locked to a USB dongle (port lock) or to the licensing server computer.

When you start CAM2 on any computer in your network, it will search the network for available licenses. If one is 
found, it will use this license for the time it is executed. When you close CAM2, the license will be released and 
will be available to other CAM2 installations in the network.

FARO CAM2
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Installing the Sentinel HASP Licensing Software on the License 
Server
CAM2 licenses are managed with Sentinel HASP from SafeNet. To setup a computer as a license server, you must 
install the Sentinel licensing software on that computer. Sentinel is automatically installed with CAM2; however, if 
you do not want to install CAM2 on the computer that hosts the network licenses, you must install Sentinel 
manually. Do one of the following to install the Sentinel licensing software on the server computer:

• Click HASP Network License Manager on the USB menu and follow the prompts,

OR 

• Execute haspdinst.exe –install from a command shell. You can obtain this file from the FARO Technical 
Support Center site.

To verify the proper installation of the Sentinel licensing software, open an Internet browser on the license server 
and enter the address http://localhost:1947/ to open the Sentinel Admin Control Center. If the Sentinel Admin 
Control Center appears, installation was successful.

Enabling Remote Access on the Server
Before users can access the network licenses, remote access has to be enabled on the server computer:

1. Open an Internet browser on the license server and enter the address http://localhost:1947/ to open the Sentinel 
Admin Control Center.

2. In the Options window, select Configuration to display the configuration tab set.

3. Click the Access from Remote Clients tab.

4. Select the Allow Access from Remote Clients check box.

5. Click Submit.

Network Licenses Attached to a USB Dongle (Port Lock)
You can obtain a special network port lock from FARO Customer Service. This port lock may be plugged into any 
computer that has the Sentinel HASP drivers installed. This computer will act as the license server and share the 
licenses over the network (after you enable remote access from clients). Activation of these licenses is not 
necessary.

If you want to add network licenses to a port lock, you can purchase network licenses linked to a product key. To 
transfer them to the port lock, attach it to any computer with CAM2 installed and follow the steps to validate the 
product key and activate the licenses. When validating the key and activating the licenses, you will be asked 
whether you want to lock the licenses to the computer or to the attached port lock. Select the second option. Once 
complete, you can remove the port lock from the computer and attach it to the license server again (if you used 
another computer to activate the licenses).

Network Licenses Attached to a Key Code
You can also lock network licenses to the license server computer using a product key. To do so, install and start 
CAM2 on the server, then follow the steps to validate the product key and activate the licenses. 

• Click File > Help > Open License Information Page in CAM2

OR 
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• Open http://localhost:1947 with an Internet browser on the server to verify the proper activation of the CAM2 
license. In the Options window, select Products to display the available CAM2 licenses.

Detaching Network Licenses
If your license server hosts network licenses that are attached to the computer with a key code (not to a port lock), 
you can detach a network license and temporarily bind it to a client computer. The license can then be used locally 
on that computer without being connected to the network. When the detached license expires, it is automatically 
unbound from the client computer and restored to the server.

The license server and the client computer must be configured to allow detaching of network licenses.

To enable license detachment on a server or client computer:

1. Click Network License in the Licensing Wizard and enter a host or IP name

OR 

2. Click File > Help > Manage Licenses in CAM2

OR 

Open http://localhost:1947/ with an Internet browser on the server or client computer.

3. In the Options window, select Configuration to display the configuration tab set.

4. Click the Detachable Licenses tab.

5. Enable Detaching of Licenses. 

NOTE:  On a server, you may also specify the number of reserved non-detachable licenses and the maximum 
detach duration.

6. Click Submit.

To detach a license and bind it to your client computer:

1. Open http://localhost:1947/ with an Internet browser on the client computer.

2. In the Options window, select Products for an overview of all available local and network licenses. Detachable 
network licenses are identified by a red arrow.

3. Click the Detach button to access the Detach License dialog.

4. Select the expiration date to specify the day the license will be restored to the pool.

5. Click Detach & Attach to temporarily bind the license to your client computer. It will return to the network 
license pool when it has expired.

To return a detached license before it expires:

1. Click Network License in the Licensing Wizard

OR 

2. Click File > Help > Manage Licenses in CAM2

OR 
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Open http://localhost:1947/ with an Internet browser on the server or client computer.

3. In the Options window, select Products for an overview of all available local and network licenses. Detached 
network licenses are identified by a green arrow.

4. Click the Cancel License button and confirm your selection on the following dialog to return the license to the 
network license pool.

Transferring Network Licenses
To transfer (rehost) a valid CAM2 license from one computer to another:

1. Click Transfer Key in the Licensing Wizard and select a license

OR 

2. On both computers, start CAM2 and click File > Help > Manage Licenses.

3. On both computers, click More Options and click Transfer Key.

4. On the recipient computer (the computer that will receive the license), select a location to save an information 
file (ID) and click Collect and Save Information.

5. Transfer the ID file to the source computer (the computer which currently contains the license).

6. On the source computer, highlight the license to transfer.

7. Browse to the ID file created in Step 3.

8. Select a location to save a license transfer file (H2H) and click Generate License Transfer File.

9. Transfer the H2H file to the recipient computer.

10. On the recipient computer, click the Apply License File tab.

11. Select the H2H file created in Step 7 and click Apply Update.

License Server Administration
The Sentinel Admin Control Center provides various functions to manage and monitor the usage of network 
licenses and to diagnose problems. For more information, refer to the Sentinel Admin Control Center help.

Updating Your License
Use the Licensing Wizard to check for any pending license updates. When you run this program, CAM2 will 
download any pending updates or orders and automatically update your port lock. 

• If you do not have an available Internet connection, contact FARO’s customer service team to update your 
license. You will need to create a C2V license file for FARO customer service if you are deleting a license, 
modifying a license, or activating the software for the first time on a computer that does not have Internet 
access (also known as an offline activation). Make sure you apply the license you are given before you 
generate a C2V.

To create a C2V file:

1. Click Product Key in the Licensing Wizard.

2. Click I Don’t Have An Internet Connection.

3. Click Web Portal.
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4. Click C2V and select a destination to save the C2V file.

5. On a computer with Internet access, browse to http://license.faro.com/Portal/activation.

6. Enter your product key, then browse to the C2V file created in Step 4.

7. Click Activate to generate and save a V2C file (select the destination).

8. Return to the original computer and click Next.

9. Click V2C to browse to the V2C file created in Step 7.

10. Click Next to apply the V2C file.

Versions
CAM2 is available in two versions: Full and Probing.

Full Version
The Full version of CAM2 contains all available functionality.

Probing Version
The Probing version contains functionality tailored for probe measurement. Functionality for point clouds and 
scanning is limited:

• Open: CAM2 will not open saved measurement files containing point clouds. If you change your license from 
Full to Probing while a measurement file containing point clouds is open, you will be prompted to save the file 
before CAM2 closes it. See “Open” on page 58.

• Import Points: You can import a maximum of 7,000 points, and point clouds are excluded from import. See 
“Points” on page 61.

• Import Point Cloud: This command is not available. See “Point Cloud” on page 61.

• Point Cloud To Mesh: This command is not available. See “Point Cloud To Mesh” on page 65.

• Point Cloud Workspace: This command is not available. See “Point Cloud” on page 38.

• Manage Devices: The FARO 3D Imager and FARO Laser Line Probe are excluded from use. See “Manage 
Devices” on page 130.

• Align Point Cloud: This command is not available. See “Align Point Cloud” on page 269.

• Preferences: Point Cloud preferences are not available. See “Preferences” on page 67.

• Construct Cross-Section Scan: This command is not available. See “Construct Cross-Section Scan” on 
page 254.

• Measuring a Cross-Section Scan: This command is available for use with a hard probe only. See “Measuring 
a Cross-Section Scan” on page 168.
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Directory and File Locations
The initial location of the files and directories is determined by the options selected during the installation of 
CAM2. These locations can always be modified as a new default preference file. See “Preferences” on page 108.

NOTE:  A detailed listing of the directory and file locations is available from FARO Customer Service.

Getting Started
If you have purchased a port lock license, make sure that you have inserted the port lock into the computer’s USB 
port. Although not required, it is recommended that you connect your measuring device to the computer before 
starting CAM2. 

FARO InTouch
FARO InTouch is a software distribution and management application which streamlines the downloading, 
installation, updating, and execution of FARO software such as CAM2 and RPM. With an internet connection and 
the auto-update option enabled, you can automatically install the latest version without manually downloading and 
installing every new released version. You can also launch individual FARO software applications directly from 
InTouch.

NOTE:  FARO InTouch is only compatible with Microsoft® Windows® 10. When installing InTouch for the 
first time, uninstall any previous versions of CAM2, RPM, Device Center and CAD Translator via the 
Windows Control Panel before installation.

!Gallery. Contains FARO software applications (as tiles).

"Sidebar. Displays the sidebar menu. 
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Figure 1-1 FARO InTouch panel

Gallery
The FAROInTouch gallery contains all CAM2 software within a single location. Each tile represents an available 
FARO application.

 

Application Operation
Each tile has an operation button. Click the down arrow to select from available operation options:

Install: Click to install the application. Any dependent applications will also be installed as part of the installation 
process.

Update: A newer version is available. Click to update the application. Any dependent applications will also be 
installed as part of the installation process.

Run: The application is installed and available. Click to start the application.

Uninstall:  Click to uninstall the application.

Repair: An issue has been detected with the installation. Click to repair the installation.

NOTE:  One or more of these options may not be available depending upon the application status.

Application Status
The colored bar in each tile below the application's icon indicates the application's installation status:

Light Blue: The application is not installed.

Green: The application is installed and available for use.

Red: The application is installed but is not available for use.

Sidebar
The sidebar contains the following menu options:

Auto-Updates
When enabled, this option allows seamless updating of installed applications with new versions. 

If Auto-Update is not enabled and Update Notifications is enabled, InTouch application tiles will notify you of 
available updates which you can manually install.

Update Notifications
When enabled, this option allows InTouch to generate Windows notifications when updates are available, installed, 
or if an issue is detected. 

Repair Repository Files
When enabled, Touch will monitor the health of the repository files and automatically repair as needed.

Heal Invalid Files
When enabled, InTouch will monitor the health of the  installed files and automatically heal invalid files.
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Fix Orphan Files
When enabled, InTouch automatically fixes files that have lost association to another file.

Language
Select the language from the drop down list.

NOTE:  This also changes the language of the installed applications.

System Information
Service Status
Server: The connection to the external server that FAROuses to store and distribute applications globally.

Green: InTouch can communicate with the server.

Red: InTouch cannot communicate with the server, typically due to internet connection issues.

Service: The InTouch service running on the local machine.

Green: The service is running normally.

Red: The service is not running or has stopped. When starting InTouch, this status can appear red for several 
minutes while  the service starts up.

Maintenance: An operation to verify InTouch is running as expected, relating to the repair and healing options 
within Settings.

Green: The service is running normally.

Red: Maintenance in progress. When starting InTouch, this status can appear red for several minutes while  the 
service starts up.

Starting CAM2
Click  the CAM2 2021 program icon on the Desktop or from FARO InTouch; or, from the Windows Start menu, 
click All Programs > FARO > CAM2 2021 and finally the CAM2 icon.
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Figure 1-1 CAM2 2021 Program Icon

As the software loads, the software attempts to initialize communication with a primary measuring device. 

• If the measuring device is connected properly, Device Center displays the device’s information. 

• If there is no connection between the device and the computer’s USB or serial port, or if the device is off, 
Device Center is empty. Connect your measuring device to the computer and click + if not recognized, or 
continue using CAM2 without a measuring device.

For more information, see “Device Center” on page 128.

NOTE:  CAM2also supports multiple devices for simultaneous measurement. For more information, see 
“Multiple Devices” on page 129. 
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Figure 1-2 Device Control panel

CAM2 Experience Index
When you start CAM2, the CAM2 Experience Index analyzes your computer’s graphical capabilities, available 
memory, and processor speed to assess your CAM2 user experience.

When the analysis is complete, CAM2 presents you with a Calculated Global Score from 1 to 5 (1 being the 
lowest, 5 being the highest) that gauges your CAM2 experience based on your computer’s attributes.

NOTE:  If your graphics card driver is outdated, the Main window will display a red border and a message 
indicating the need to update your graphics driver.

Click the Recalculate Experience Index link to refresh the CAM2 Experience Index window.

The CAM2 Experience Index appears the first time you start CAM2 and each subsequent time unless you select the 
Never Show Again check box.

NOTE:  You can also access the CAM2 Experience Index from the CAM2 Help screen. See “Help” on 
page 29.

Customer Experience Improvement Program
The CAM2 Customer Experience Improvement Program analyzes and collects anonymous CAM2 error and usage 
data, which is periodically transmitted to FARO when an Internet connection is available.

By agreeing to the EULA (End-User License Agreement), you agree to participate and accept the sharing of 
information; however, you can opt out of the program by selecting FARO Customer Experience Improvement 
Program from the CAM2 Help screen. See “Help” on page 29.

NOTE:  Participation is mandatory for pre-release versions of CAM2.
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For more information about the EULA, see End User Documents on page 335

Experimental Features
As part of the FARO Customer Experience Program, some versions of CAM2 contain Experimental Features. 
These Experimental Features enable you to experiment with new software capabilities in the development stage, 
and share your feedback directly with the development team. 

Enable Experimental Features by clicking Experimental Features on the CAM2 Help screen and opting-in to each 
feature. See “Help” on page 29.

NOTE:  To enable Experimental Features, you must first opt-in to the FARO Customer Experience 
Improvement Program. 

By accepting the Use Experimental Features, you acknowledge that such features are not an integral part of 
CAM2 and that FARO cannot be held liable for the quality or continuity of any capabilities exposed via the 
Experimental Features. We recommend these features be used only in test files, not production files.

Screen Layout
The CAM2 screen contains the following areas.

! Quick Access Toolbar. See “Quick Access Toolbar” on page 23.

" Ribbon. See “Ribbon” on the next page.

#Notification Center. See “Notification Center” on page 24.

$ Navigation Window. See “Navigation Window” on page 24.

% Main Window. This is the main view window for your part.
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& QuickTools Control Panel. See “QuickTools” on page 26.

' Messages, Measurement Data, and Nominals and Tolerances Control Panels. See Messages on page 26, 
Measurement Data on page 192, and Nominals and Tolerances on page 194. 

Figure 1-1 CAM2 Screen Layout

Ribbon
The CAM2 Ribbon is designed to help you quickly access the commands that you need to complete a task. 
Commands are organized into logical groups, which are collected together under tabs. Each tab relates to a type of 
activity, such as measuring a feature or configuring a measurement device. 

Figure 1-1 CAM2 Ribbon

The contents of tabs are customized according to your needs. For example, the Home tab contains reporting 
commands when the Reporting panel is active.

To display a tab on the ribbon, move the pointer over the tab name and click the Left Mouse button.

Keyboard Shortcuts
Some commands on the CAM2 Ribbon also start using a single keyboard key, or Keyboard Shortcut.

You can configure a Keyboard Shortcut for any command on the Ribbon by right-clicking the command and 
selecting Set Keyboard Shortcut. Using the Assign Keyboard Shortcut dialog, you can view the existing 
Keyboard Shortcut for the command (if applicable), assign a new Keyboard Shortcut, or view the list of existing 
Keyboard Shortcuts in the application.

You can also view, edit, and print the list of CAM2 Keyboard Shortcuts by clicking Shortcuts on the File tab. See 
“Shortcuts” on page 66.

For a list of CAM2’s Keyboard Shortcuts, see Keyboard Shortcuts and Shortcut Menus on page 307.

Default Tabs
At the top of your screen are the CAM2 tabs. These contain basic commands that you will regularly use.
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! File Tab

" Home Tab

# View Tab

$ Devices Tab

% Automation Tab

& Measure Tab

' Extract Tab

( Key-In Tab

) Pick From CAD Tab

* Construct Tab

+ Alignments Tab

, GD&T Tab

- RPM Tab

. Imager 3D Tab

Figure 1-1 Default Tabs

File Tab
The File tab allows you to access file commands (Open, Save, etc.), Import, Export, view and configure 
Preferences, and access Help. See “File” on page 57. 
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Figure 1-2 File Tab

Home Tab
The Home tab contains a basic workflow including setup, reference, alignment, measurement, and analysis 
commands. See “Home” on page 95. 

Figure 1-3 Home Tab

NOTE:  The contents of the Home tab change based on what you have selected in the Navigation Window. 
For more information, see “Navigation Window” on page 33.

View Tab
The View tab contains all the commands that affect how you see the contents of your measurement file on the 
screen. See “View” on page 111. 

Figure 1-4 View Tab

Devices Tab
The Devices tab contains all the commands used to configure a measuring device. See “Devices” on page 127. 

Figure 1-5 Devices Tab

Automation Tab
The Automation tab contains the commands used to automate your measurement processes. See “Automation” on 
page 141. 
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Figure 1-6 Automation Tab

Measure Tab
The Measure tab contains common commands for measuring. See “Measure” on page 153. 

Figure 1-7 Measure Tab

Extract Tab
The Extract tab contains common commands for extracting geometric features from point clouds. See “Extract” on 
page 199. 

Figure 1-8 Extract Tab

Key-In Tab
The Key-In tab contains commands to create Nominal features using data on drawings or spreadsheets. See “Key-
In” on page 203. 

Figure 1-9 Key-In Tab

Pick From CAD Tab
The Pick From CAD tab contains commands to create Nominal features from CAD models that you add to the 
measurement file. See “Pick From CAD” on page 217.

Figure 1-10 Pick From CAD Tab
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Construct Tab
The Construct tab contains commands to create Nominal features by construction. See “Construct” on page 225. 

Figure 1-11 Construct Tab above

Alignments Tab
The Alignments tab contains Alignment and Coordinate System commands. See “Alignments” on page 265.

Figure 1-12 Alignments Tab

GD&T Tab
The GD&T tab contains Geometric Dimensioning and Tolerancing (GD&T) commands. See “GD&T” on 
page 287.

Figure 1-13 GD&T Tab

Point Cloud Alignments Tab
The Align Point Cloud tab contains Point Cloud Alignment commands. See “Align Point Cloud” on page 269.

Figure 1-14 Point Cloud Alignments Tab

Cross Section Analysis Tab
The Cross-Section Analysis tab contains all the commands that affect how you see a Cross Section Scan feature of 
your measurement file on the screen. See “Cross-Section Analysis” on page 100. 
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Figure 1-15 Cross Section Analysis Tab

NOTE:  The Cross Section Analysis tab is only available when you select a Cross Section Scan feature (with 
readings) and click Cross-Section Analysis in the Home tab.

Image Creator Tab
The Image Creator tab contains Image Creator commands. See “Image Creator” on page 50.

Figure 1-16 Image Creator Tab

NOTE:  The Image Creator tab is only available when you are using Image Creator. 

Home Tab (CAD)
The Home tab contains the CAD commands. See “CAD” on page 37.

Figure 1-17 Home Tab (CAD)

NOTE:  This Home tab is only available after you click CAD at the bottom of the Navigation Window. See 
“CAD” on page 37. 

Home Tab (Point Cloud)
The Home tab contains the Point Cloud commands. See “Point Cloud” on page 38.

Figure 1-18 Home Tab (Point Cloud)

NOTE:  This Home tab is only available after you click Point Cloud at the bottom of the Navigation Window. 
For more information, see “Point Cloud” on page 38. 

RPM Tab
The RPM tab contains commands to interface CAM2 with CAM2® RPM. 
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Figure 1-19 RPM Tab

NOTE:  The RPM tab is only available after you install CAM2 RPM. 

Imager 3D Tab
The Imager 3D tab contains commands to configure your FARO 3D Imager. See “FARO 3D Imager” on 
page 139.

Figure 1-20 Imager 3D Tab Tab

Minimize the Ribbon
There is no way to remove or replace the ribbon with the toolbars and menus found in previous versions of CAM2. 
However, you can minimize the ribbon to increase available space on your screen.

1. Right-click the ribbon and select Minimize the Ribbon, or click the Minimize Ribbon icon (upper right).

To use the ribbon while it is minimized, click the tab you want to access, and then click the option or command 
you want to use when the ribbon expands. Click away from the ribbon, and the ribbon will minimize.

NOTE:  To restore the ribbon to full visibility, right-click and select Minimize the Ribbon (or click the 
Minimize Ribbon icon) again.

Customize the Ribbon
You can customize the CAM2 Ribbon to arrange the tabs, command groups, and commands as needed to define 
your own workflow. Use this option to show and hide tabs on the ribbon, add or delete command groups for a tab, 
add, rearrange, and remove commands on each tab. See “Ribbon” on page 16.

1. Right-click the ribbon and select Customize Ribbon to display the Ribbon Customization window.

The left side of the Ribbon Customization window contains a list of all available commands in CAM2. Use the 
drop-down to switch between a master list and a grouped list of commands arranged by tabs. The right side of the 
window contains a view of all existing tabs and the command groups for each tab. 

• Clear a check box to hide the corresponding tab or command group from the ribbon.

• Select a tab or command, and click New > New Page to create a new (empty) tab.

• Highlight a tab and select New > New Group to add a new (empty) command group to the tab.

• Highlight a command on the left side of the window and click the right arrow button to add the command to a 
group on the right side.
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• Highlight a command on the right side of the window and click the left arrow button to remove the command 
from a group.

• Click the up and down arrow buttons to reorder a highlighted command within a tab.

Quick Access Toolbar
The Quick Access toolbar, located at the top left of the CAM2 title bar, consists of a group of frequently used 
command icons that you can enable for quick access, including Open, Save, Measure Mode, Coordinate Format, 
and Unit Format.

NOTE:  Click Show Quick Access Toolbar Below the Ribbon to move the toolbar below the Ribbon on 
page 16.

Click the Quick Access Toolbar arrow and click a command to add it to the CAM2 title bar for quick access. 
Commands are added to the bar by the order in which you click them. Click the command name in the Quick 
Access Toolbar menu again to remove the command.

You may select up to five commands for quick access: Open, Save, Measure Mode, Coordinate Format, and Unit 
Format.

Open
Open opens a CAM2 measurement file (*.fcd or *.fcdx) that has been previously created, named, and saved. For 
more information, see “Open” on page 58.

Save
Save saves the current file as a CAM2 measurement file (*.fcd or *.fcdx). For more information, see “Save” on 
page 58.

Measure Mode
The Measure Mode check box controls the behavior of the Measure commands. For more information, see 
“Measure Mode” on page 23.

Coordinate Format
The measurement file’s coordinate system, by default, is Cartesian. To work in another coordinate system 
(Cylindrical or Spherical), click Coordinate Format in the Quick Access Toolbar and select another coordinate 
system. This remains the same for all new files until changed again. 

Figure 1-1 Coordinate Format menu

Cartesian 

Point data is displayed in (x, y, z) format:

• x is the value along the x axis.

• y is the value along the y axis.
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• z is the value along the z axis.

Cylindrical 

Point data is displayed in (ρ, ϕ, z) format:

• ρ is the displacement from the origin in the xy plane.

• ϕ is the rotation angle from the +x axis.

• z is the value along the z axis.

Spherical 

Point data is displayed in (ρ, ϕ, θ) format:

• ρ is the displacement from the origin.

• ϕ is the rotation angle from the +z axis.

• θ is the rotation angle from the +x axis.

Unit Format
The measurement file’s unit of measure, by default, is millimeters. To work in another unit of measure, click Unit 
Format in the Quick Access Toolbar and select another unit of measure. This remains the same for all new files 
until changed again.

Unit of Measure can also be controlled and configured as a Preference. For more information, see “Units Tab” on 
page 74. 

Figure 1-2 Units menu

Notification Center
The Notification Center, located at the top right of the CAM2 title bar, is an automatic notification system which 
notifies you of issues that need attention, when new versions are available, and other important messages. New 
notifications appear flagged; click the flag to read the notifications. When you’re finished, click Dismiss All to 
clear all notifications from the Notification Center.

Navigation Window
The Navigation Window contains all of the CAD parts and features in your measurement file, and also controls the 
mode in which CAM2 behaves. It is subdivided into Features, CAD, Point Cloud, Report, Image Creator, and 
Survey sections.
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Figure 1-1 Navigation Window

Control Panels
Control Panels are windows that contain all or some of the following:

• menu and submenu commands

• feature data

• an edit box to change a parameter of an item

• a check box to show/hide items

• tree lists of items and sub items

On the right and bottom edges of the Main Window are control panels which contain many of the common 
commands. Each control panel appears as a tab when not in use. The QuickTools tab is on the right side, and the 
Messages, Measurement Data, and Feature Information tabs are on the bottom. 

• Click on a tab to display a control panel. Click and drag the tab onto the Main Window and the panel 
automatically collapses and hides.

• Click Auto Hide  in the upper right corner of the panel to keep the panel’s title bar visible. 

• Click Close  in the upper right corner to close a panel.

NOTE:  Use View > View Closed Panels to control the visibility of the control panels. See “Panels” on 
page 122.

Moving and Docking Control Panels
CAM2 control panels may be moved, arranged, and docked to customize your layout.
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Moving a Control Panel
To move a panel, left-click and hold the panel’s title bar or tab name. Drag the panel with the mouse to the desired 
location and release the button to release the panel. 

Reordering Control Panel Tabs
Left-click and hold the panel’s tab name. Drag the tab to the desired location and release the mouse button.

Docking Icons
Docking Icons appear when you left-click and begin to drag a panel. Drag and release the panel onto one of these 
icons to instantly dock the panel at the extreme right, left, top, or bottom of the screen (depending on the 
corresponding icon’s arrow). The icons disappear when the panel has been released.

Hiding a Control Panel
Right-click and choose Hide. Use View Closed Panels to show the panel. See “View Closed 
Panels” on page 112.

 

Messages
The Messages panel contains informational messages relating to the measurement file.

Figure 1-1 Messages panel

QuickTools
The QuickTools panel contains all of the QuickTools commands in your measurement file.
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Figure 1-1 QuickTools panel

Views
The Views panel contains all of the captured views of your measurement file. 

Figure 1-1 Views panel

GD&T
The GD&T panel contains GD&T attributes for a selected feature, and is used in conjunction with the GD&T Tab. 
See “GD&T Tab” on page 20.

Figure 1-1 GD&T panel

Measurement Data
The Measurement Data panel contains the data for each individual reading, or measurement point, of a feature. It 
also contains readings for best fit constructions.

Figure 1-1 Measurement Data panel

Feature Information
The Feature Information panel contains nominal and tolerance information for each feature in your measurement 
file. 
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Figure 1-1 Feature Information panel

Controlling the View
You can manipulate and rotate the contents of the Main Window using your mouse. 

To manipulate the view:

1. Click and hold the Right Mouse button. 

2. Drag the mouse left, right, up, and down to move the view.

3. Release the Right Mouse button to set the view.

To rotate the view:

1. Click and hold the Left Mouse button. This changes the mouse pointer to the rotate icon.

2. Drag the mouse left, right, up, and down to rotate the view.

3. Release the Left Mouse button to set the view.

NOTE:  Keyboard Shortcuts are available to pan, zoom, and rotate the view. For more information, see 
“Keyboard Shortcuts” on page 308. 

Center of Rotation
By default,  the rotation center  in a new measurement file is the World Coordinate System. Once you've added 
features and/or CAD to the file, the rotation center becomes the center of all entities (features and CAD) in the 
measurement file. 

You can also change temporarily change the center by left-clicking a feature or CAD surface and dragging the 
mouse cursor to rotate the view around the center of that feature or surface.

Features
CAM2 Features are the geometric objects that you add to the measurement file. There are four types of CAM2 
Features:

• Measured: a feature that you create using a measurement device. See “Measure” on page 153.

• Constructed: a feature that you create from other features or keyed-in values. SeeConstruct From 
Selected Features on page 263 and Key-In on page 203.

• Dimensioned: a length or angle calculation between two or more existing features. See “Dimensions” on 
page 257.

• Nominal: a feature that is the theoretical, or design, value of a measurement. You create nominals from 
CAD models, or entered values.

FARO CAM2
Chapter 1: Introduction to CAM2® 2021

FARO CAM2 2021 (v2021.0)Page 28 of 336



Selecting Features
You may have to select or deselect features that were created in CAM2. To select a feature on the screen, place the 
pointer over any part of a feature and press the Left Mouse button. Selected features appear in red. To deselect a 
feature, click the selected feature again with the Left Mouse button.

Device-controlled Mouse
When you use a measuring device with CAM2, the position of the probe controls the mouse pointer. The standard 
mouse also controls the pointer. For more information, see “Use Arm as Mouse ” on page 78.

NOTE:  Some measurement devices that operate with CAM2 do not constantly send positional data to CAM2, 
so this command may not work properly. Refer to the user manual included for your device.

CAM2 recognizes which measurement device is active and selects that device for the pointer control. After starting 
a measurement command, CAM2 only accepts control from the current measurement device and blocks any input 
except digitized points.

NOTE:  The pointer changes from the single arrow mouse pointer to the Device icon when CAM2 accepts 
data from the input device.

Dynamic Device Camera
CAM2’s dynamic device camera view displays features as they are measured in the Main window, looking from 
the device probe.

Pre-Alignment: When picking the nominal features, the view will dynamically adjust to guide you. You can also 
manually rotate and zoom the view. After you create an alignment, CAM2 reactivates the dynamic camera.

Features With Nominals: If an alignment exists and features containing nominals are measured, the zoom will 
dynamically adjust based on the probe distance from the feature. This ensures both the probe and nominal feature 
are visible during the guidance and measurement process.

Features Without Nominals or via Automatic Feature Recognition: If no nominal features exist or Automatic 
Feature Recognition is used to measure the feature, the zoom will dynamically adjust to display both probe and the 
captured readings. See “Automatic Feature Recognition” on page 188.

When all measurement steps are complete, CAM2 will automatically adjust the view to display all features.

Help
Click Help or select File > Help to access CAM2’s Help screen. From here, you can access Help files for CAM2, 
FaroArms, FAROLaser Trackers, and the FARO Cobalt. You can also access program logs, the CAM2 Experience 
Index, the Customer Experience Improvement Program, Experimental Features, the document history, and licensing 
information. When necessary, you can contact FARO Customer Service and generate support data (a single 
compressed file which can be emailed to FARO Customer Service).
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Figure 1-1 CAM2 Help Screen

Online Help
CAM2’s Help contains system-based information to enhance your use of the application.

NOTE:  Help for measurement commands is available in the Edit Feature dialog box for each feature. Select 
the feature and then select Edit > Properties. 

When the Online Help appears, select the Contents, Index, or Search tab to open specific help files.

• Contents opens a series of books. Double-click the book you want with the Left Mouse button, or single-click 
the book and click Open. If you see another book, continue clicking that selection until you see a topic name.

• A topic has a Question Mark (?) icon in front of its name. Double-click the topic name to open the topic. 
Within a topic, you may have additional links directing you to other topics for further information. Click the 
appropriate link to go to another topic.

• On the Index tab you can type the first few letters of topic or word. You can also scroll down to your topic 
using the scroll bar. Double-click your selection with the Left Mouse button, or single-click to highlight the 
topic and click Display.

• The search tab allows you to type words and search the whole document for the different topics using the 
word(s) you selected. Type the word(s) in the space provided in the first window and click List Topics.

Electronic Manual
You can open an electronic version of the CAM2 Users Manual with Adobe Acrobat Reader, which is included 
with your CAM2 USB. 

• A Table of Contents is on the left-hand side of your screen under the Bookmarks tab. Clicking a bookmark 
takes you to the selected section.

• You can also search the manual by using Edit > Find (Ctrl+F).

Using Acrobat Reader Help
Adobe Acrobat Reader has its own electronic manual if you need help. Running Acrobat Reader HELP inside the 
Acrobat Reader application opens the Acrobat Reader electronic manual.
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What is New
The following sections describe new functions and commands that have been added to CAM2, as well as the 
enhancements made to existing CAM2 commands.

General
FARO InTouch - A software distribution and management application which streamlines the downloading, 
installation, updating, and execution of FARO software such as CAM2 and RPM. See “FARO InTouch” on 
page 10.

Dynamic Device Camera Improvements - View features as they are measured in the Main window, looking from 
the device probe. For more information, see “Dynamic Device Camera” on page 29.

Viewer Performance Improvements - Translation, rotation, and zoom of features and CAD within the Main 
window have been vastly upgraded.

Identification of Features - The Features list displays feature type icons indicating the operation which created the 
feature. For more information, see “Features” on page 34.

Experimental Features - Experiment with new software capabilities in the development stage, and share your 
feedback directly with the development team. For more information, see “Experimental Features” on page 15.

Help
 Generate Support Data - Collect and create a single compressed file which can be emailed to FARO Customer 
Service. See “Help” on page 29.

File Tab
Auto Update Report - Control the automatic update of reports as changes are made. See “Auto Update Report” on 
page 93.

Translate Hidden Entities  - Specify whether the CAD translation includes wireframe items such as lines and 
curves. See “Translate CAD” on page 58.

Material Compensation Mode  - Use three new methods to compensate for material when measuring: Fixture B 
Side, Part Thickness, and Clamp. See “Material Compensation Mode ” on page 84.         

View Tab
Display Point Cloud Excluded Points - Show and hide point cloud readings excluded by the Point Distance Filter. 
See “Display Point Cloud Excluded Points” on page 1.

Labels - A new labeling engine provides the ability to display feature information annotations in the 3D viewer and 
report images. See “Labels” on page 118.
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Automation Tab
Generate QR Code - Add a QuickTools program step to generate a QR code from an existing report. See 
“Generate QR Code” on page 147.

CAD View Commands - Preview a saved CAD View from a QuickTools program step, whether or not you are 
running a QuickTools program. See “CAD View Commands” on page 150.

Alignments Tab
The Manage Alignments and Alignments interfaces have been streamlined to provide a more intuitive experience. 
See “Alignments” on page 265.

Reports
Company Details - Add custom company details to display on the header of the first page of the default report 
templates. See “Report” on page 92.
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Chapter 2: Navigation Window

On the left side of the screen is the Navigation window. This window is divided into six sections: Features, CAD, 
Point Cloud, Report, Image Creator, and Survey. 

Figure 2-1 Navigation Window

 
Features 34

CAD 37

Point Cloud 38

Report 45

Image Creator 50

Survey 53

FARO CAM2 2021 (v2021.0) Page 33 of 336



Features
The Features section of the Navigation window shows every measured, constructed, and nominal feature in your 
measurement file. A graphic to the left of the feature name indicates the feature type:

• Measured/Constructed/Dimension: The geometric graphic to the left of the feature name. 

• Nominal: The geometric graphic to the left of the feature name and a target graphic to the right of the 
feature name.

NOTE:  This content of this panel changes if you select Report or Survey. For more information, see Report 
on page 45 and Performing a Survey on page 55.

Selecting Features
Selecting a feature in the Navigation window highlights the feature in the Main Window.

• To select a single feature, click the name of the feature with the Left Mouse button. 

• To select multiple features in consecutive order, hold down the Shift key and left-click the first (top) feature, 
then click the last feature you want. 

• To select a group of features not in consecutive order, hold down the Ctrl key and left-click each feature you 
want selected. 

Double-click a feature to edit its Properties. For more information, see “Properties” on page 108.

Right-click on a selected feature, or multiple features, to quickly start some commands from the Shortcut Menus. 
For more information, see “Shortcut Menus” on page 310.

Naming a Feature
Every feature in a measurement file is given a default name. To change a feature name:

1. Select a feature in the Navigation window. 

2. Click the feature name again, or press the F2 key to edit the name. 

3. Type a new name and press the Enter key to continue.

Renaming Multiple Features
You have the option to rename multiple features at once. To change multiple feature names:

1. Select multiple features in the Navigation window. 

2. Right-click the selection and choose Rename.
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3. Type a new name to be applied to all of the features and click OK.

Feature Status Indicator
There are several visual indicators that show you a quick status of the features in your measurement file.

When you measure an existing feature, the feature will appear in red.

To the left of the feature is a geometric icon to indicate the feature type. If this icon and the feature name appear in 
gray, the feature is unsolved. See “Unsolved Features” on page 330.

To the right of some features is a Status Indicator graphic. This shows you a quick status of the features in your 
measurement file. The graphic depends on the status of the feature: 

• Black target - Nominal feature. 

• Green check mark - the feature is in tolerance. 

• Flag - the feature is out of tolerance or unsolved. 

• Gray - the feature has no data, or not enough to solve.

• Red - measurement is above the upper tolerance. 

• Blue - measurement is below the lower tolerance. 

NOTE:  Gray and Green flags are straight, Blue lean to the left and Red lean to the right.

Show and Hide Features
To the extreme right of all features is the Visibility icon (eye icon). Click the Visibility icon to hide a feature. 
Once hidden, the icon and feature name appear gray. Click the Visibility icon again to show the feature.

When hidden, features remain in the feature tree but are not shown in the CAD view.

Feature Association
When you use CAM2 to compare actual (measured and constructed) data to nominal data, both features associate. 
The association name automatically uses the nominal feature name. Changing the nominal feature name updates the 
associated name. To associate a measured and nominal feature: 

• Drag any nominal feature to a measured or constructed feature. 

• Select the measured feature and use the Feature Information panel. See “Nominals and Tolerances” on 
page 194.

• Select a nominal feature and Measure.

In the feature association, a prefix automatically appends each feature name: “Actual” to the measured feature, and 
“Nominal” to the nominal feature.
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• Click the arrow to the left of the feature association’s name to expand and collapse the association and hide 
the features.

NOTE:  The Properties of a feature association are the measured or constructed feature properties. See 
“Properties” on page 108. Deleting an association name only deletes the measured or constructed feature. 
Expand the association and select each contained feature to delete the nominal feature. 

Reordering Features
You can change the order of features as shown in the Navigation window.

1. Select one or more features in the Navigation window to move. 

2. Click the Up arrow at the bottom of the panel to move the feature up in the list; or, click the Down arrow to 
move the feature down in the list.

3. You can press and hold the Shift key and drag the feature up and down the list.

NOTE:  Dragging a feature without pressing and holding the Shift key is for grouping nominal and 
measured/constructed features.

Feature Grouping
When you work with a large number of features, it can be helpful to organize them using groups. To create a 
feature group folder:

• Click the New Folder icon in the Navigation window.

• If desired, edit the default name (Group 1).

• Drag any feature or group onto the folder and release the mouse button.

NOTE:  Smart Naming Tab and Show/Hide also apply to folders. For more information, see Smart Naming 
Tab on page 76 and Show/Hide on page 114.

Folder Properties
You can use folders to report features in multiple coordinate systems within the same report. Right-click a folder 
and select Properties to view the Feature Editor window for the folder. In this window, you can assign a coordinate 
system, coordinate system type, and unit of measurement for the contents of the folder.

Capture View Data
Right-click a folder and select Capture View Data to assign a specific CAD view to the folder. To change the 
captured view, change the view as desired, right-click the folder and select Capture View Data.

In the report, this CAD view adds just above the features in the group. See “Adding Pictures” on page 52.
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CAD
The CAD section of the Navigation window shows every CAD feature in your measurement file, and contains a 
workspace for you to import CAD, edit CAD properties, and fix CAD normals. The commands on the Home tab 
are organized into Reference, Layers, Selection Tools, and Normals groups.

Selecting CAD
Selecting a feature in the CAD section Navigation window highlights the CAD feature in the Main Window.

• To select a single CAD feature, click the name of the feature with the Left Mouse button. 

• To select multiple CAD features in consecutive order, hold down the Shift key and left-click the first (top) 
feature, then click the last feature you want. 

• To select a group of features not in consecutive order, hold down the Ctrl key and left-click each feature you 
want selected. 

Double-click a CAD feature to edit its Properties. For more information, see “Properties” on page 108.

Right-click on a selected CAD feature, or multiple CAD features, to quickly start some commands from the 
Shortcut Menus. For more information, see “Shortcut Menus” on page 310.

Show and Hide CAD
To the extreme right of all CAD features is the Visibility icon (eye icon). Click the Visibility icon to hide a CAD 
feature. Once hidden, the icon and CAD name appear gray. Click the Visibility icon again to show the feature.

When hidden, CAD features remain in the feature tree but are not shown in the Main Window.

Reference
The Reference group contains Import CAD and Part Properties commands. For more information, see Import CAD 
on page 96 and Part Properties on page 96. 

Layers
The Layers group contains the commands for adding, editing, and deleting layers. For more information, see 
“Layers” on page 112. 

Adding Features to a Layer
Existing layers are at the top of the list. You can assign any feature in the Navigation window to a layer: 

• Click features in the Navigation window and drag them onto a layer. 

• Right-click any feature in the Features panel, point to Assign a Layer, and choose a layer from the menu. 
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Selection Tools
The Selection Tools group contains the commands for selecting multiple CAD entities. For more information, see 
“Selection Tools” on page 38. 

Normals
The Normals group contains the Fix Normals command. 

Fix Normals
Fix Normals opens Fix Normals mode. Use Fix Normals mode to change the vector orientation of CAD bodies. 
Select a CAD file in the Navigation window and click Fix Normals.

When you open Fix Normals mode, your CAD surfaces will be colored according to their vector orientation 
relative to the screen: 

• Gray surface normals are pointing towards the screen, and thus represent good surfaces.

• Red surface normals are pointing away from the screen, and represent surfaces that may be inverted relative to 
the CAD model. You can fix the normals of red surfaces.

Click a Red (inverted) surface to flip the surface orientation. Once clicked, the surface color becomes gray, 
indicating corrected orientation. Fixed (flipped) CAD bodies are appended with a corresponding “flipped” icon in 
the Navigation window. 

In some situations, surfaces with high degrees of curvature may point both towards and away from the screen. You 
will need to determine the optimal orientation. 

NOTE:  If you invert one surface of a CAD body, all surfaces of that CAD body will invert. If Fix Normals 
results in a CAD body with both correct and incorrect surface orientations, consider importing a revised CAD 
file with correct surface orientation.

Point Cloud
The Point Cloud section of the Navigation window contains a workspace for you to edit captured point clouds. The 
Point Cloud workspace contains only point clouds (no other features), and the Home tab displays point cloud 
editing commands. The commands on the Home tab are organized into Selection Tools, Edit Tools, Registration, 
Filtering, and Smoothing groups. 

NOTE:  If you are using the Probing Version of CAM2, the Point Cloud workspace is not available. See 
“Probing Version” on page 9.

Selection Tools
The Selection Tools group contains commands to select portions of point cloud data for editing: Rectangular, 
Lasso, Polygon, Brush, Invert, and Clear.
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The selection tools select all points contained within an area, including visible points and those that may be hidden 
from view.

NOTE:  If you have already selected points, press and hold SHIFT while selecting to add new points to the 
existing selection. Press and hold CTRL while selecting to remove points from the existing selection.

NOTE:  To change the Main window view while you select points, press SPACE to switch the mouse mode 
to view manipulation. When you’ve changed the view, press SPACE again to switch back to selection mode.

Rectangular
Rectangular selects points using a rectangular (or square) shape. Hold the left mouse button and drag the mouse to 
begin a rectangular selection around the point cloud data you want to select. Release the mouse button to create the 
selection.

Lasso
Lasso selects points in a freehand shape. Hold the left mouse button and drag the lasso around the point cloud data 
you want to select. Release the mouse button when you return to your starting point.

Polygon
Polygon selects points using outlines based on straight-sided polygonal shapes. Click the left mouse button to add 
an anchor point on the point cloud. As you move the mouse from the point, a thin straight line extends from the 
anchor point to your mouse cursor. Click again to add a second anchor point, then release your mouse button to 
join points with the straight line. Continue to add new lines until you end at your first anchor point, completing 
your polygonal selection.

Brush
Brush selects points in a freehand shape. Hold the left mouse button and drag the mouse to select points. Release 
the mouse button to create the selection.

NOTE:  You can adjust the brush thickness in the upper left corner of the Main Window.

Invert
Invert selects the inverse of your currently selected points. Click Invert to invert the selection.

Clear
Clear deselects your currently selected points. Click Clear to undo the selection.
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Select Bad Points
Select Bad Points selects bad point cloud points. Click Clear to undo the selection.

Front Facing
Front Facing specifies that the selection tools will only include points with normal vectors facing the screen, 
excluding all points facing away from the screen.

Edit Tools
The Edit Tools group contains commands to edit selected portions of point cloud data: Paste New, Cut, Copy, 
Paste, Split, Merge, and Delete.

Paste New
Paste New pastes the contents of your clipboard into a new point cloud. This command is only active if you have 
either copied or cut points from a point cloud. 

Cut
Cut removes the selected points from the point cloud. You can paste the points into an existing or new point cloud.

Copy
Copy copies the selected points to your clipboard. You can paste the points into an existing or new point cloud.

Paste
Paste pastes the contents of your clipboard into an existing point cloud. This command is only active if you select 
a point cloud in the Features panel and you have either copied or cut points from a point cloud.

Split
Split creates a new point cloud from a selection of points. The points are removed from the source point cloud and 
placed into a new point cloud.

Merge
Merge combines two or more groups of points into a single new point cloud.
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Delete
Delete permanently removes the selected points from the point cloud.

Registration
Registration is the joining of two or more spatially disjointed point clouds using common references, effectively 
stitching multiple point clouds into one.

• Click Open to access Registration mode. The Main window will split into two halves to facilitate registration.

• Select representative pairs of points from each point cloud by clicking corresponding scan areas in each half of 
the Main window. Point pairs share a common color and number.

• When you have selected at least three point pairs, you can register the scans.

The Registration commands are located in the Registration tab across the top of the screen, and the commands are 
organized into Registration, Import, Edit Tools, View, and Close groups.

Registration (Group)
The Registration group contains the Set Static, Set Movable, Preview, Register, and Unregister commands.

Set Static
Set Static designates a selected point cloud scan or Registration group as the fixed scan in the registration process. 
The fixed scan is stationary during the registration process and appears in the left or top Main window. A new 
static assignment will replace any previous placement.

NOTE:  You can also drag a point cloud or group from the list onto the left or top Main window to designate 
it as the fixed scan.

Set Movable
Set Movable designates a selected point cloud scan or Registration group as the movable scan in the registration 
process. The movable scan moves during the registration process and appears in the right or bottom Main window. 
A new movable assignment will replace any previous placement.

NOTE:  You can also drag a point cloud or group from the list onto the right or bottom Main window to 
designate it as the movable scan.
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Preview
Preview enables a registration preview mode which updates as you create point pairs. Click Preview again to exit 
preview mode. 

NOTE:  Preview mode is only available after you choose 3 point pairs. 

Register
Register calculates the registration of the left and right (or top and bottom) Main windows based on the points you 
picked. After registration, the scans are placed into a Registration Group folder in the point cloud list. The new 
group can be used for further registration.

Unregister
Unregister negates the registration calculation of a selected scan or group.

Fine Registration
Fine Registration solves all of the registered point clouds simultaneously in order to distribute the error and 
improve the overall fit of the registration group.

NOTE:  This can be a very time-consuming calculation, especially with a large number of point clouds.

Import
The Import group contains the Import Reference Targets command. Import Reference Targets from text files 
(*.txt) or Scanlink binary files.

Edit Tools
The Edit Tools group contains the Clear Points, Merge, and Merge All commands. 

Clear Points
Clear Points removes all point pairs from the scans in the Main windows. 

Merge
Merge combines two or more scans or registration groups into a single merged point cloud which appears in the 
Individual folder.
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Merge All
Merge All combines all scans and registration groups into a single merged point cloud which appears in the 
Individual folder.

View
The View group contains the Vertical, Horizontal, Display, and Lock Viewers commands. 

Vertical
Vertical splits the Main window into left and right panels.

Horizontal
Horizontal splits the Main window into top and bottom panels.

Display
Display filters the Main window contents as follows:

• Both - View scanned point cloud data and targets.

• Point Cloud - View scanned point cloud data only.

• Targets - View scanned targets only.

Lock Viewers
Lock Viewers protect the contents of the Main window panels from user input.

Close
The Close group contains the Close Registration command, which exits Registration mode and returns you to Point 
Cloud Editing mode. 

Filtering
Filtering allows you to reduce the number of points in point clouds while still maintaining the characteristics of the 
scanned object. 

Filtering Types
There are 3 different types of filters:

• Grid filtering: specify a grid spacing, and CAM2 preserves only one point within a cube of the specified size. 
For example, a 1 mm grid spacing allows only one point within a 1 mm distance of any other point.
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• Curvature filtering: in conjunction with grid spacing, curvature filtering preserves point density in areas of 
higher curvature and preserves fewer points in flatter areas. CAM2 automatically calculates the maximum 
angle between two adjacent points in the resulting point cloud.

• Density filtering: reduce the point cloud to a fixed size. Relative point density is maintained; areas with higher 
and lower point density will keep their respective densities.

Apply Filtering
To apply a filter to a point cloud:

1. Select the Point Cloud in the Features panel.

2. Click the Filters drop-down and select a filter.

Clear Filtering
To clear a filter from a point cloud:

1. Select the Point Cloud in the Features panel.

2. Click Clear Filter.

Custom Filtering
You can also create a custom point cloud filter. To create a new filter:

1. Click the Filters drop-down and choose New Filter.

2. In the Point Cloud Filter dialog, enter the name, filter type, and filter parameters.

3. After you create the filter, you can apply it to a point cloud.

Delete Exclusions
To permanently delete filtered points from a point cloud:

1. Select the Point Cloud in the Features panel.

2. Click Delete Exclusions.

Smoothing
Smoothing allows you to refine “noisy” point cloud data to achieve a smoother surface.

Smoothing differs from Filtering, in that Smoothing computes new points from existing points using user-defined 
grid-based data organization.

Smoothing Types
There are 2 different types of smoothing methods:

Center Grid: smoothing results in a point cloud containing one point inside any grid cell with one or more points. 
This creates a very organized grid-like point pattern. 

Grid Average: averages the positions of all points within a given grid cell, and the average point represents the 
grid. This creates a smoother, yet less organized point cloud than Center Grid smoothing.

Apply Smoothing
To apply smoothing to a point cloud:
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1. Select the Point Cloud in the Features panel.

2. Click the Smoothing drop-down and select a smoothing method.

Clear Smoothing
To clear smoothing from a point cloud:

1. Select the Point Cloud in the Features panel.

2. Click Clear Smoothing.

Custom Smoothing
You can also create a custom point cloud smoothing. To create a new smoothing:

1. Click the Smoothing drop-down and choose New Smoothing.

2. In the Point Cloud Smoothing dialog, enter the name, smoothing type, and smoothing parameters.

3. After you create the smoothing, you can apply it to a point cloud.

Delete Exclusions
To permanently delete smoothed points from a point cloud:

1. Select the Point Cloud in the Features panel.

2. Click Delete Exclusions.

Report
CAM2 employs the DevExpress™ reporting engine and layout editor. The robust DevExpress engine has been 
incorporated into CAM2 to provide dynamic, customizable reports in many file formats. 
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Reporting Overview 

Figure 2-1 Sample CAM2 Report

The DevExpress engine creates customizable reports based on an XML schema that are automatically formatted for 
the page. The XML Schema is published with the software: 
\Program Files\FARO\CAM2\Schema\. 

Report data is continually updated as the measurement file data changes.

Report Templates
CAM2 automatically detects new report templates that are placed in the proper directory: 
\My Documents\CAM2\Templates\Reporting.

NOTE:  It is good practice not to replace any of the default CAM2 templates because reinstalling or updating 
the software will replace all of the default templates. 

Editing a Report Template
Select a report format from the Home tab and click Edit Layout. This starts the DevExpress template editor. 

• Select File > Save As and save the template with a new name so that you do not accidentally replace the 
default CAM2 report template.

• The report template is divided into four sections:

• PageHeader: Use this area to add items that will show on the top of every page.

• Report: This is a title section for the first page of the report. The logo image filed is in the upper left 
corner of this section. All other fields are Labels. Add, arrange, remove, or edit the existing labels.

FARO CAM2
Chapter 2: Navigation Window

FARO CAM2 2021 (v2021.0)Page 46 of 336



• DetailReport: This section uses the data from the CAM2 file following the current Active Report List. 
Show or hide individual feature data using the Feature Information panel. For more information, see 
“Nominals and Tolerances” on page 194.

• PageFooter: Use this area to add items that will show on the bottom of every page. Every CAM2 report 
template has the Page Info field in this section.

Logo Customization
You can change the logo image displayed in default report templates. The file name is specified in the application 
preferences, and the image size is 3" x 1" with a resolution of 300 dpi.

You can change the report logo image in the Report section of the Preferences and Settings window. Logo  on 
page 93 

Document Properties
Extra data (metadata) for a report is stored within the document properties. Document properties are configured in 
the Document Header Information window. For more information, see “Document Header Information” on page 
107.

This list is not fixed; plug-ins may register additional document properties which will appear in the editor. 
Document properties are arranged into logical groups (typically by the plug-in that registers them).

NOTE:  A plug-in may also override a default document property if it provides duplicate functionality (e.g. 
Part name in the SPC Graph plug-in).

Reporting Interface
The Report window provides an always-available report display that continually updates to reflect measurement 
file data changes. It resides at the same level as the Main Window, and as such cannot be displayed at the same 
time as the Main Window.

Click Report on the Navigation Window to access the Report Window. 

Figure 2-1 Report view

Using the Features Panel
If you select features in the Navigation Window and then click Report, a new Report list creates and 
automatically adds the features. There is a CAM2 preference to control this behavior. See See “Generate From 
Selection ” on page 93.. 
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Report List
Click Report and the Report list replaces the Feature list in the Navigation Window. You should create a name 
for the Active Report before adding or removing features. 

NOTE:  This content of this panel changes if you click survey or Image Creator.

You can create one or more Active Reports under a specific name within the measurement file. 

To create a list:

• Enter a name in the combo, replacing the New List 1 default text.

• Press Enter.

NOTE:  Active Reports are automatically saved as you change them. Saved Active Reports are stored within 
the measurement file and may not be used across different measurement files.

Recall an existing Active Report by selecting it from the drop-down list box on the Home tab.

Delete an existing Active Report by selecting it from the drop-down list box and clicking X next to the drop-down 
arrow. 

Operations
In the Navigation Window, the features in the Report list are included in the report; other features are not. The 
features are reported in the order they appear in the list. All operations are multi-select capable.

To add a feature to the Report list:

• Click Include Features. 

• Select one or more features in the Include Features window, and click Add. 

Figure 2-1 Include Features

To remove a feature from the Report list:

• Select a feature in the Report list.

• Click Exclude Feature.
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To reorder the features in the Report list:

• Select a feature in the Report list and drag it up or down the list. Or, select a feature and use the up or down 
arrows on the Home tab.

NOTE:  The data contained in the current report automatically updates as features are added, moved, and 
deleted in the Report list.

To add captured View Data to the Report list:

• Click Include Features. 

• Select a captured view in the Include Features window. See “Capture” on page 121.

• Drag & drop the captured view to place in the required list position.

For more information, see “View Data” on page 121.

Standard Home Tab Report Commands
Document Header: View and edit the current measurement file’s document properties. See “Document Header 
Information” on page 107.

Find: Enter text to find in the report.

View and Print Keyboard Shortcuts: View, edit, and print CAM2 Keyboard Shortcuts. See “Shortcuts” on 
page 66.

Include Features: View a list of features in the measurement file, and select one or more to add to the Report List.

Exclude Features: Remove one or more features from the Report List.

Report List: Create, select, and delete a Report List.

Move Up: Move a selected feature up the Report List.

Move Down: Move a selected feature down the Report List.

Layout: Select a report layout.

Edit Layout: Opens the DevExpress report editor containing the selected layout.

Choose Watermark: Add text or a picture to the background of the report page. 

Choose Background: Add a background color to the report page.

Select: Use this tool to select an item on the report.

Hand Tool: Use this tool to move the report around the Report window. 

Zoom Tools: Adjust the printed scale of the report, zoom in, or zoom out of the report in the Report window. 

One Page: Zoom the entire report to fit one page in the window. 

Two Pages: Zoom the entire report to fit two pages in the window. 

Page Width: Zoom the entire report to the width of the window. 

Print: Select the printer, page range, and number of copies for the report. 

FARO CAM2
Chapter 2: Navigation Window

FARO CAM2 2021 (v2021.0) Page 49 of 336



Quick Print: Send the report to the current printer. 

Page Setup: Adjust the printer page. 

Export: Export the report. See “E-mailing/Saving a Report” below.

E-Mail: E-mail the report. See “E-mailing/Saving a Report” below.

Measurement Data: Export the report’s measurement data into a custom format. 

E-mailing/Saving a Report
E-mail or Save the report in the following formats: PDF, HTML, MHT, Rich Text, Excel, CSV, Text, and Graphic 
(BMP, EMF, WMF, GIF, JPEG, PNG, TIFF). Not all formats are available for E-mail and Save.

An e-mail message opens using the default e-mail application with the report file attached. You can edit the 
message/subject prior to sending.

Printing a Report
Click Print to access the Print dialog and send the active report to a printer.

Selecting a Report Template
Report templates are listed in the Home tab. Selecting a report template in the combo box makes it the active 
template and the report is updated immediately to reflect the change.

Image Creator
Image Creator on the Navigation window enables CAM2’s Image Creator, which allows you to add pictures to a 
QuickTools program step to enhance the automated measurement process. 

These pictures appear in the Measurement panel when the program is playing. For each Add Readings, you can 
create a single picture or a picture for each reading in the program step. 

Image Creator Commands
The Image Creator commands are located in the Image Creator tab across the top of the screen. The Image Creator 
tab contains all of the commands to create and edit images for QuickTools program steps. The commands on the 
Image Creator tab are organized into General, Image, Probes, and Zoom groups. See “Image Creator Tab” on 
page 21. 

NOTE:  While using Image Creator, you can also access the Automation Tab to manage QuickTools programs 
and the Default Tabs for other common operations. See Automation Tab on page 18 and Default Tabs on 
page 16.

General
The General group contains the Properties command.

Image
The Image group contains all the commands necessary to add, manage, and base images.
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Add 
Add adds a new base image to Image Creator.

Remove 
Remove deletes a base image from Image Creator.

Replace 
Replace changes the base image associated with a QuickTools program step. Select a new image.

Probes
The Probes group contains all the commands necessary to add, manage, and delete probe markers.

Reading 
Reading adds a reading marker to a base image.

Reading Outside 
Reading Outside adds an outside reading marker to a base image.

Reading Inside 
Reading Inside adds an inside reading marker to a base image.

Retract 
Retract adds a retract point marker to a base image.

Back Button 
Reading adds a back button marker to a base image.

Swipe 
Swipe adds a swipe reading marker to a base image.

Curl 
Curl adds a curl reading marker to a base image.

Zoom
The Zoom group contains all the commands necessary to increase and decrease zoom levels for probes and base 
images. 

Zoom Point 
Zoom Point zooms a selected marker in or out.

Zoom Image 
Zoom Image zooms a selected base image in or out. You can use the slider as well as your mouse’s scroll wheel to 
set the image zoom and 2D offset.
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NOTE:  In addition to zooming a base image in and out, you can also pan them left, right, up, or down to 
create the optimal view to complement the corresponding QuickTools program step. The view you set in 
Image Creator becomes the view associated with the QuickTools program.

Adding Pictures
You can add pictures of a part to each QuickTools program step to show an operator exactly where to take 
measurements. 

When taking pictures, include as many features in a shot as possible without sacrificing space, picture clarity, and 
quality. Capturing a big cluster of features from far away will not provide enough detailed information for the 
operator. One picture can be used as many times as needed. 

The ideal image size is 640x480 pixels; most cameras have an adjustable setting for the size of a picture. However, 
you should first add one image to a QuickTools program step, then play the program and look at the picture in the 
Measurement panel. 

NOTE:  NOTE:Create From Features in the Automation Tab instantly creates a QuickTools program 
containing all features in the active document with automatically-generated images. See “Creating a 
QuickTools Program From Features” on page 143. You can modify the images using Image Creator.

Taking and Importing Images
1. Use a digital camera to take pictures of the part.

NOTE:  For best results, take clear, detailed pictures of the part that plainly illustrate the locations to be 
measured. Take close-up shots of areas where extra detail is needed. Orient the camera in the same way that 
the operator will be looking at the part.

2. Transfer the pictures to your computer. 

3. In CAM2, click the Image Creator tab to display the Image Creator window. 

4. Highlight a program step in the QuickTools panel.

5. Click Add an image to the step. 

6. Click the plus (+) button.

7. Navigate to the directory that contains the image. 

8. Select the image. 

9. Click OK to add the image to the QuickTools program step. The image is now available for use in all program 
steps.

NOTE:  If using CAD, you can also create images by rotating the CAD in the 3D Viewer and clicking Export 
As Image. See “Export As Image” on page 122.

Creating QuickTools Pictures
A Base picture with probe images allows you to create a visual measurement map. Use the probe images as targets 
to represent the sphere of a probe or SMR. The sphere is green, or red to match the Front and Back buttons of the 
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FaroArm, or the Gand Hkeyboard keys for the FARO Laser Tracker. 

In the QuickTools panel, select an existing QuickTools program. You may need to click the Plus sign next to the 
program name to expand the list of program steps. 

To add a picture to a QuickTools program: 

1. Select any existing QuickTools program step. Generally, this is an Add Readings. 

2. Click Add an image to the step. 

3. Highlight an existing image and click OK, or import a new image. See “Taking and Importing Images” on the 
previous page.

4. Click a marker in the Probes group of the Image Creator Tab. See “Image Creator Tab” on page 21. 

5. Click a location on the base image to place the probe marker.

6. Move the mouse pointer above any probe marker to edit: 

• Click and drag the center of the probe image to move it. 

• Click and drag the lower right corner of the probe image to make it bigger or smaller. 

• Click and drag the upper center of the probe image to rotate it. 

• Hit the Delete key to remove it. 

7. Repeat steps 4, 5, and 6 as necessary.

8. Save your measurement file. The pictures save with the measurement file. 

Look at the bottom of the Images panel and see a thumbnail of the picture. This is a graphical list of the pictures 
for the selected QuickTools program step. 

Multiple Pictures
You can import and select more than one image per QuickTools program step. When you add a second image to a 
program step, a “filmstrip” appears at the bottom of the view. You can add markers to each image. The marker 
order determines the order of the markers displayed, and the corresponding image displays with each marker. For 
more information, see “Adding Pictures” on page 52.

Survey
Survey on the Navigation window enables CAM2’s Survey capability. Surveying is an automated, repetitive 
measurement process used to track the position(s) of one or more targets over time. The output is a statistical 
analysis of the change in positions for each target. Optionally, Survey may be used to automatically reposition a 
measurement device once sufficient movement has been detected. 

Active Survey
The Active Survey box contains the name of the currently active survey. To change the active survey, click the 
drop-down and select a different survey.
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Survey Type
• May be done as continuous inspection (user defined number of cycles) or on demand; retains all data for 

statistical analysis.

• A single, “clean” run through a set of points compared to nominal data; automation of the measurement 
process.

• Used for locating a detail relative to nominal data; continuous inspection.

• User-configured preferences that persist for later use. You can name, configure, and save custom surveys using 
Survey Setup.

Survey Setup
Click Setup Survey Options in the Survey Type box. From the Survey Setup dialog, you can configure the 
following:

• Display Label: The label for the survey.

• Feature Dwell Time: The amount of time (in seconds) the Laser Tracker should remain on the target after 
acquiring its position.

• Cycle Time: The amount of time (in seconds, minutes, or hours) to wait between ending one cycle and 
beginning the next.

• Moving Average Size: Determines the number of previous samples used to compute the moving average value 
(to show recent trends instead of the entire history of the measurement).

• Feature DRO: Determines the DRO use for the survey:

• On: (Default) A feature DRO is shown for each point in the survey.

• Off: No feature DROs are shown.

• Single: A single feature DRO is shown during the survey and switches from point to point as the survey 
progresses.

• Replace Readings: Determines the method to retain or replace readings:

• Replace Previous: (Default) Each cycle will completely replace the readings from the previous cycle.

• Append: The point feature will accumulate readings from each cycle of the survey, and the geometry of 
the feature will be an average of those readings.

• Disable Previous: Geometry will be the same as the Replace Previous option, but old readings will be 
retained in an unused state.

• Compare to Nominal: Determines whether the drift value will be compared to the nominal:

• Yes: The drift value will be computed as drift from the nominal.

• No: The drift value will be computed as the drift from the starting position of the feature.

• Auto Search: Determines whether the Laser Tracker will search automatically for a missing target:

• Yes: The Laser Tracker will automatically search for a missed target using the standard search pattern.
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• No: The Laser Tracker will not attempt to locate a target that is not found immediately after aiming at the 
expected target location.

• Exclude Missing Targets: Determines whether the Laser Tracker will skip targets missed during the current 
survey on subsequent surveys:

• Yes: Any target missed during a particular cycle of the survey will be skipped on subsequent cycles.

• No: No missed target will be skipped on subsequent cycles.

• Pause Between Cycles: Determines whether the survey will automatically pause between cycles.

• Yes: The survey will automatically pause between cycles. In order to proceed to the next cycle in the 
survey the user must press play.

• No: The survey will not pause between cycles.

NOTE:  If Pause Between Cycles is enabled, the Cycle Time option is unavailable.

• Stopping Conditions: Determines criteria by which the survey should automatically stop:

• Stop After a Fixed Number of Cycles: Enter number of cycles.

• Stop After Missing Target: Enter target number.

• Stop After Specific Time: Date/Time based (hard stopping date/time).

• Move Device Conditions: Determines conditions with which to Move Device:

• Move After This Many Fixed Cycles: Enter number of cycles.

• Move After Maximum Deviation: Enter maximum deviation of any reference point.

NOTE:  You need at least 3 reference points to set Move Device conditions. For more information, see 
“Moving Device Position With a Survey” on page 56.

When you have set up the survey, click OK to use the settings for the current survey or click Save to save the 
settings to the survey template for future use. 

Performing a Survey
While the survey is running, CAM2 allows you to control the survey options. 

Add Points to the Survey
The points in the top half of the FEATURES panel are included in the survey (In Survey); the points in the bottom 
half are not (Not In Survey). 

To add a point to the survey, click the arrow to the left of the point in the Not In Survey box. The point appears in 
the In Survey box. All operations are multi-select capable, so you can add multiple points at the same time.

The points are reported in the order they appear in the list. You can reorder the points in the In Survey box by 
clicking a point and then clicking the up and down arrows to move it.

Survey Controls
The Survey group contains commands to start, pause, and stop a survey:
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• Play: Runs the survey from its current state until a stopping condition is met or you pause or stop the survey. 
If you play a survey from a paused state, the survey will resume. If you play a survey from a stopped state, the 
survey data will be reset.

• Pause: Suspends the survey in its current state until you resume or stop the survey.

• Stop: Ends the survey.

Moving Device Position With a Survey
You can create a new Device Position with a survey by designating at least three of the survey points as reference 
points.

1. Click the star icon to the right of a point in the In Survey box. The star appears yellow, indicating that the point 
is designated as a reference.

NOTE:  Click the yellow star to remove this designation.

2. Repeat Step 1 for at least two other points in the survey.

3. In the Survey Setup dialog, input the number of cycles you want completed before the move is done in the 
Move Device Conditions box, and click OK. See “Survey Setup” on page 54.

The device move is automated in the survey. You can view the results of the new device position in the Manage 
Devices window. See “Manage Devices” on page 130.

Reporting Survey Results
When you’ve successfully completed your survey, click Summary to view a brief summary of the data you’ve 
compiled. From there, click Print Report to access the Preview dialog. Use the Preview dialog to preview the 
layout and print, export, or e-mail the contents.

For more information, see Standard Home Tab Report Commands on page 49, E-mailing/Saving a Report on 
page 50, and Printing a Report on page 50.
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Chapter 3: File

The File commands (Open, Save, Import, Export, Preferences, Help, etc.) are located in the File tab. Some of these 
commands are also available on the Quick Access Toolbar at the top of your screen. For more information, see 
“Quick Access Toolbar” on page 23.
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Open
Open opens a CAM2 measurement file (*.fcd or *.fcdx) that has been previously created, named, and saved. 

If you already have a measurement file open, CAM2 will prompt you to Save the current file or close it without 
saving.

If a CAD file associated with a measurement file cannot be found when you open the measurement file, CAM2 
will prompt you to re-establish a link to the CAD. If you do not re-establish a link, CAM2 will open the file 
without CAD.

To use files created from other CAD systems, create a new measurement file, translate the CAD to the Parasolid 
CAD format (*.x_b), and add the CAD format file to the new measurement file. See Translate CAD below, and 
CAD on page 61.

NOTE:  If you are using the Probing Version of CAM2, saved measurement files containing point clouds will 
not open. For more information, see “Probing Version” on page 9.

Save
Save saves the current file as a CAM2 measurement file (*.fcd) or package file (*.fcdx). If you did not name the 
measurement file before invoking Save, the Save As dialog box will appear. Type a file name in the Save As 
dialog box and click Save. 

Save As
Save As saves the current measurement file under a new file name. Type a file name in the Save As dialog box and 
click Save. 

New
New creates a new measurement file. You cannot have multiple files open at the same time, so if a file is already 
open when you select this command you will be prompted to save that file. If an unsaved (New Document) 
measurement file is open and you quit the program, you will receive a message to save the measurement file. 

Translate CAD
Translate CAD starts the FARO CAD Translator, a separate application that converts your CAD files to the 
Parasolid® CAD data file format (*.x_b).

Figure 3-1 FARO CAD Translator
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NOTE:  You must translate all CAD files to the Parasolid CAD data file format. To add the CAD parts to your 
current measurement file, use Insert > CAD Parts. See “CAD” on page 61.

CAM2 supports ACIS, AutoCAD 3D, CATIA v4, v5 and v6, Ideas, IGES, Inventor, JT, NX, Parasolid, PRC, PTC 
Creo, Rhino3D, Solid Edge, SolidWorks, STEP, STL and VDA-FS formats. For other CAD formats, use Rhino 
software to import your file and save as a STEP file. If you have problems translating CAD files, contact FARO 
Customer Service for help.

Add Files - Click the Add Files link and select your CAD files. You can select multiple files to translate.

Remove Files - Select a file in the list and click the Remove Selected File(s) link to remove one or more files from 
the list. This Does Not delete the CAD file from your computer.

Target Folder - Select a file in the list and click Target Folder to change the target location for each file. The 
target location is the directory and name for the translated Parasolid CAD file (*.x_b). This location remains the 
same until you change it. 

NOTE:  It is good practice to keep your translated CAD files and measurement files in the same folder. 
Measurement files location is a preference. For more information, see “Documents (FCD)” on page 68.

Start Translation - Select a file in the list and click the Start Translation link to start the translation of the file.

Stop Translation - Select a file in the list and click the Stop Translation link to stop the translation of the file.

Options
Healing  - The FARO CAD translator has an option to use Healing, or error correction, during the translation 
process. This option is a preference. For more information, see “Healing ” on page 89. 

Translate Hidden Entities  - You can specify whether the CAD translation includes entities on hidden CAD file 
layers. For more information, see “Translate Hidden Entities ” on page 89.

Translate Hidden Entities  - You can specify whether the CAD translation includes wireframe items such as lines 
and curves. 

Send Document
SelectFile > Send Document to e-mail the current file using the electronic mail system on your computer. Any 
CAD model file that your measurement file uses is not included in the message attachment. Make sure to send any 
CAD model file in a separate message. 

NOTE:  Your e-mail recipient should save all files in the same folder on their computer.

Generate Barcode
CAM2 allows you to generate a 2D barcode optimized for mobile device displays (such as cell phones). Once you 
generate the barcode, you can scan the barcode and open the associated measurement file or specific QuickTools 
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Programs in CAM2, including part number and operator information in the document header. See “QuickTools 
Programs” on page 142.

If you generate a barcode and subsequently choose File > Save As, you are prompted whether to update the 
barcode with the new file path. If you open a document with a barcode mismatched with its current location, you 
are prompted to update the barcode.

If you generate a barcode and subsequently print a report, the report contains the barcode.

To Generate a Barcode:

1. Click File > Generate Barcode.

2. If prompted to do so, save your measurement file.

3. On the Generate Barcode dialog, specify whether the barcode will open the measurement file or a selected 
QuickTools program.

4. Click Save as Image to generate the barcode image file, or click Print to save a printable version of your barcode 
(*.xps format) that you can then send to your printer.

To open a measurement file or QuickTools program using a barcode:

1. Open CAM2.

2. Click File > New.

3. Scan the barcode you generated or printed with your barcode scanner. 

Recent

Recent Documents
Recent Documents contains a list of recently accessed or saved measurement files (*.fcd or *.fcdx) in descending 
order, newest to oldest. Click the name of a document to quickly access it. If you currently have a measurement file 
open and it is not saved, you will be prompted to save changes to the file before opening the file you just selected. 

Recent CAD Parts
Recent CAD Parts contains a list of recently accessed or saved CAD files in descending order, newest to oldest. 
Click the name of a CAD file to import the CAD into the current measurement file.

Import Export
Import Export contains all the commands to: 

• Load data from a file into a CAM2 file. 

• Save data to a file from a CAM2 file. 
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Import
The Import menu allows you to add external files to the current measurement file.

CAD
Select File > Import > CAD to add Parasolid® CAD format data (*x_t or *.x_b) to your current measurement file. 
Select one or more CAD files in the Add CAD Model dialog, then click Open to translate them into Parasolid 
format and load them into the current measurement file.

Large CAD files or CAD files that may take longer to load than other files should be translated into the Parasolid 
format using Translate CAD. See “Translate CAD” on page 58.

NOTE:  By default, imported CAD is displayed with both shading and wireframe information. To import files 
and change options use the FARO CAD translator. For more information, see “Translate CAD” on page 58.

The CAM2 CAD translator has an option to use Healing, or error correction, during the translation process. This 
option is a preference. For more information, see “Healing ” on page 89. 

Points
Select File > Import > Points to access the Import Point Data wizard and import a text file (*.txt) containing 
point-reducible features into the current measurement file. Use the wizard to select the directory location and the 
name of the file to be imported, select the import configuration (including row offset, units, column order, and 
separators), and select the features to import as actual or nominal.

• Select Import Points as Individual Features to import the text file contents as individual features.

• Check the Evaluate Normal Vector By Projecting To CAD check box to associate normal vectors 
evaluated by CAD projection. When you enable this option, CAM2 imports all points as vector points, 
thereby determining a vector for each imported point. From here, you can also specify:

• Default Vector: The vector that CAM2 will use if the distance from the source point to CAD is too 
large.

• Threshold: The maximum distance a point can lie from CAD for the surface normal to be 
meaningful. Points with a distance to CAD greater than this number use the Default vector.

NOTE:  If you are using the Probing Version of CAM2, you can import a maximum of 7,000 points. For 
more information, see “Probing Version” on page 9.

Point Cloud
Select File > Import > Point Cloud to access the Import Point Cloud wizard and import a point cloud from .asc, 
.ptx, .txt and .xyz formats into the current measurement file. Use the wizard to select the directory location and the 
name of the file to be imported, select the import configuration (including row offset, units, column order, color, 
and separators), and select the features to import.

NOTE:  If you are using the Probing Version of CAM2, this command is not available. For more information, 
see “Probing Version” on page 9.
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Reference Targets
Select File > Import/Export > Import Reference Targets to import reference targets from a text file (*.txt) or 
Scanlink binary file into the current measurement file. See “Import” on page 42.

Deviation Markers
Select File > Import/Export > Deviation Markersto import deviation markers from a text file (*.txt) into the 
current measurement file. For more information, see “Deviation Markers” on page 120. 

Tube
Select File > Import > Tube to import a tube from a text file (*.txt) into the current measurement file. Tube data 
may be imported in XYZ or PTB format.

Select the text file to import, and specify the following:

First Row: the row containing the tube name.

Units: the tube’s unit of measurement.

Tube Information: the tube’s data format (XYZ or PTB).

Column Separator: the character in the text file denoting column separation. The default is ;.

Decimal Separator: the character in the text file denoting decimal separation (. or ,).

XYZ Format 

The text file must contain the tube’s name, diameter, and XYZ bend radius. You must create separate lines for each 
breakpoint. 

Example:

Tube 1 - Actual 

0.494544577826446 

0.00;0.00;0.00;1.50 

6.35;0.00;0.00;1.50 

9.60;7.70;0.00;1.50 

13.55;7.60;-0.90;1.50 

16.30;10.25;-1.55;1.50 

17.45;9.17;3.45;1.50 

19.60;7.05;10.65;1.50 

PTB (Pull, Turn, Bend) Format 

The text file must contain the tube’s name, diameter, and PTB bend radius. You must create separate lines for each 
straight. 

Example:

Tube 1 - Nominal 

0.5000 
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5.338;0.000;66.898;1.500 

6.355;-166.140;68.725;1.500 

2.375;174.138;43.839;1.500 

1.559;98.932;97.929;1.500 

3.466;90.840;5.892;1.500 

5.164;0.000;0.000;0.000 

NOTE:  The final PTB straight should have a bend radius of 0.00.

Alignment
Select File > Import > Alignment to insert an alignment file (*.fal) into the current measurement file.

Tolerance Preferences
Select File > Import > Tolerance Preferencesto import a tolerance preference file (*.xml) into the current 
measurement file. Choose an existing file:

• The tolerance preference file previews in a dialog box. 

• Click Import to update the tolerances. 

NOTE:  Select the Apply to All Features check box to import and change the tolerances for the features in 
your current measurement file. 

QuickTools From Learn Files
Select File > Import > QuickTools > From Learn Files to import a Learn file (QuickTools program made with 
CAM2 Measure X or CAM2 Measure v4.0) into the current measurement file. For more information, see 
“Importing QuickTools From Learn Files” on page 143.

Shortcut
Select File > Import > Shortcut to import a Shortcut into the current measurement file. For more information, see 
“Shortcuts ” on page 151.

Export
The Export menu allows you to export data from the current measurement file.

Point Data To Text File
Select File > Export > Point Data To Text Fileto access the Export Point Data wizard and export a text file (*.txt) 
containing point-reducible features from the current measurement file. Use the wizard to select the features to 
export, select the export configuration (including units, decimal indicator, date, column order, and separators), and 
select the directory location and the name of the file to be exported. They export as text files ready to be imported 
into the program.
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Point Cloud To Text File
Select File > Export > Point Cloud To Text Fileto access the Export Point Cloud wizard and export a text file 
(*.txt) containing point cloud features from the current measurement file. Use the wizard to select the point clouds 
to export, select the export configuration (including units, decimal indicator, date, column order, color, and 
separators), and select the directory location and the name of the file to be exported. They export as text files ready 
to be imported into the program.

Deviation Markers
Select File > Export > Deviation Markers to export deviation markers (*.txt) from the current measurement file. 
For more information, see “Deviation Markers” on page 120.

Measurement Data to Text File
Select File > Export > Measurement Data to Text Fileto export a text file (*.txt) containing feature data from the 
current measurement file. Use the wizard to select the features to export, define an export format, and select the 
directory location and the name of the file to be exported. They export as text files ready to be imported into the 
program.

NOTE:  If you are including this function as part of a QuickTools program, you also have the option of 
assigning an automated save name prefix for when users run the QuickTools program.

Export Formats 
You can define and save a custom data export format. Click the ... button on the second page of the export wizard 
to access the Export Measurement Data Formats window. 

To define a custom format:

1. Enter a name for the format in the Export Format box.

2. Specify export options (Export units, Export decimal indicator, Export date, Export columns, Export document 
header, Single line export).

3. Specify separators (Column and Decimal).

• Information is arranged in two major groupings: Properties and Columns.

• Properties: These are the available feature properties, such as Center, Diameter or Length. To add 
properties to the group, press the + button to choose from a list of properties. To remove properties 
from the group, select a property in the group and press the X button.

• Columns: These are the types of property values that can be exported (Actual, Nominal, Deviation, 
Upper Tolerance and Lower Tolerance). Each value in the group has a corresponding icon in the 
Export Preview below. To add properties to the group, press the + button to choose from a list of 
properties. To remove properties from the group, select a property in the group and press the X 
button.

4. Click the double arrow button between the groupings to prioritize them. When you click the button, CAM2 will 
swap the boxes and update the Export preview accordingly. The priority determines the ordering of the 
information in the resulting export file. The left box contains the Level 1 (higher priority) grouping, and the 
right box contains the Level 2 (lower priority) grouping.

5. Click OK to save the export format and return to the wizard.
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Measurement Data to CAD
Select File > Export > Measurement Data to CADto export a CAD file containing features from the current 
measurement file. Use the wizard to select the features to export, select the file format (Parasolid, IGES, STEP, 
VDA), select the measurement unit, and select a name and save location for the CAD file.

CAD to XGL
Select File > Export > CAD to XGL to export an XGL file from the CAD model file in the current measurement 
file. For more information, see “CAD” on page 61.

Tolerance Preferences
Select File > Export > Tolerance Preferencesto export a tolerance preference file (*.xml) from your current 
measurement file.

A tolerance preference file consists of a set of upper and lower tolerances for each feature type, and the option to 
make each toleranced item visible or invisible.

Tube
Select File > Export > Tube to export tube data (*.txt) from the current measurement file.

Transformation Matrix
Select File > Export > Transformation Matrix to export a transformation matrix from any combination of 
matrices available in CAM2, such as an alignment and a coordinate system, or a device position and an alignment. 
You can also export the matrix itself, if necessary.

• Select the matrix for which you want to determine position and orientation. 

• If the Use Base Matrix box is unchecked, CAM2 exports the raw matrix that you selected. 

• If you check the Use Base Matrix box, you can select the Base Matrix for which you want the transformation 
to be relative. In this case, the exported transformation will be the matrix that transforms the Base Matrix to 
the target Matrix.

• Click OK to save the result to one of the following file formats:

• *.xal file: FARO file format for alignments.

• *.xdp file: FARO file format for device positions.

• *.euler file: FARO file format which contains rotation/translation information as a 4x4 matrix, as ZXZ 
Euler angle decomposition, and XYZ Euler angle decomposition.

Point Cloud To Mesh
Select File > Export > Export Point Cloud to Mesh to export a mesh file (*.stl) created from a point cloud.

NOTE:  For best results, scan your point cloud at optimum resolution and apply Filtering or Smoothing to 
organize the points. See Filtering on page 43 and Smoothing on page 44.

• Add one or more point clouds.

• Select a meshing profile to apply appropriate export parameters:

• Smooth: for larger parts with flat or large curved surfaces with little to no detail, such as automotive 
body panels.
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• Curvature: for medium-sized parts with curved and small radiused surfaces, such as pressed or 
molded parts.

• Detailed: for smaller parts with small or fine detail, such as coins.

• Enter the name of the mesh file and browse to a save location.

• Click Finish to export the mesh file.

NOTE:  If you are using the Probing Version of CAM2, this command is not available. See “Probing 
Version” on page 9.

User Profiles
Select File > User Profiles to access the Profiles window. Use this window to create, apply, import, export, and 
delete custom user profiles.

User profiles contain custom screen layout settings, including the ordering and position of Control Panels. See 
“Control Panels” on page 25.

To create a user profile:

1. Adjust the Screen Layout as necessary. See “Screen Layout” on page 15.

2. Click File > User Profiles. Your screen layout is captured as a user profile which you can then save or export to 
recall later. 

NOTE:  When upgrading CAM2 from a previous version, you will be prompted whether to import existing 
User Profiles.

Help
Select File > Help to access CAM2’s Online Help. For more information, see “Help” on page 29.

Shortcuts
Select File > Shortcuts to view, edit, and print the list of CAM2 Keyboard Shortcuts. For more information, see 
“Keyboard Shortcuts and Shortcut Menus” on page 307.

Print
Click Print for a preview of a formatted, printable reference sheet containing the current CAM2 Keyboard Shortcut 
mappings. 

Reset to Defaults
Click Reset to Defaults to reset all Keyboard Shortcut assignments to their default values.
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Edit
Click Edit to access the Customize Keyboard dialog. Use this dialog to search for specific commands by typing 
text in Show Commands Containing box. For example, typing “CAD” filters the list of commands to those 
containing the word CAD.

NOTE:  You can also configure a Keyboard Shortcut for any command on the Ribbon by right-clicking the 
command and selecting Set Keyboard Shortcut. See “Keyboard Shortcuts” on page 16.

Preferences
Default preferences always load when you start CAM2. These preferences can be applied to the current 
measurement file, or saved as the default and loaded each time CAM2 is started. There are ten preference groups: 
File, Display, Panels, Measurement, Alignment, Construction, CAD, Tolerance, Report, and Imager3D.

When you change default Preferences, they appear with pencil icons to indicate their changed status. The changed 
status persists until you save your changes or exit Preferences without saving.

Figure 3-1 Preferences

Editing Preference Settings
To edit a preference setting, click a preference group to access the parameters, then edit the parameters as desired. 
Click OK to confirm the settings for the current measurement file, or click Save to Default to load the preference 
each time CAM2 is started.

NOTE:  Click Reset to Default to revert to the default settings most recently saved.

File
The File preferences define auto-save configuration and the locations from which document, CAD, alignment, 
device position, points, tube, and measurement data are saved and loaded.

Click File in the left window of the Preferences window to see the File preferences.

To change any file location, click the associated button and browse to a folder.

Auto-Save of FCD Documents
This preference controls whether CAM2 automatically saves the active measurement file (document), and if so, 
how often. By default, the auto-save option is enabled at a 5 minute interval.
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To disable auto-save, clear the checkbox. To change the interval, enter a new number in the box.

Overwrite Nominals on Point Import
This preference controls the behavior of the software when you import points from a text file into a measurement 
file with existing nominals.

Click in the drop-down window and select a value:

• Yes: The software automatically overwrites nominals when you import points.

• No: The software does not overwrite nominals when you import points.

• Ask: (Default) You are asked whether to overwrite nominals when you import points. Unless you check the 
“Never ask me again” check box, the software continues to prompt you each time you import points.

Default File Locations
Documents (FCD)
This preference controls the default file location for document (*.fcd and *.fcdx) files.

Exported CAD
This preference controls the default file location for exported CAD files.

Imported CAD
This preference controls the default file location for imported CAD files.

Alignments
This preference controls the default file location for alignment files.

Device Positions
This preference controls the default file location for device position files.

Points
This preference controls the default file location for points files.

Deviation Markers
This preference controls the default file location for deviation markers.

Tube
This preference controls the default file location for tube files.

Measurements
This preference controls the default file location for measurement data.

Reference Targets
This preference controls the default file location for reference targets.

Barcode Mappings Location
This preference controls the default file location for the barcode mappings file.
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Display
The Display preferences determine the way in which CAM2 displays entities, dimensions, labels, and other visual 
elements.

Click Display in the left window of the Preferences window to see the Display preferences.

CAD View Tab
Background Gradient
Top Color 
This preference specifies the top color of the background gradient. To change the color, click in the drop-down 
window and select a color.

Bottom Color 
This preference specifies the bottom color of the background gradient. To change the color, click in the drop-down 
window and select a color.

Features Colors
Measured Features 
This preference specifies the color of measured features. To change the color, click in the drop-down window and 
select a color.

Keyed-In Features 
This preference specifies the color of keyed-in features. To change the color, click in the drop-down window and 
select a color.

Laser Tracker Features 
This preference specifies the color of features measured using the FARO Laser Tracker. To change the color, click 
in the drop-down window and select a color.

Picked From CAD Features 
This preference specifies the color of features created using Pick From CAD. To change the color, click in the 
drop-down window and select a color.

Constructed Features 
This preference specifies the color of constructed features. To change the color, click in the drop-down window and 
select a color.

Point Cloud Features 
This preference specifies the color of point clouds. To change the color, click in the drop-down window and select 
a color.

Selection
Highlight Features On Mouse Hover 
This preference specifies whether CAD surfaces and features highlight when the pointer is moved over them.

• Yes: (Default) CAD surfaces and features highlight when the pointer is moved over them.

• No: CAD surfaces and features do not highlight when the pointer is moved over them.

FARO CAM2
Chapter 3: File

FARO CAM2 2021 (v2021.0) Page 69 of 336



Face Color 
This preference specifies the CAD face selection color. To change the color, click in the drop-down window and 
select a color.

Edge Color 
This preference specifies the CAD edge selection color. To change the color, click in the drop-down window and 
select a color.

CAD Settings
Render Quality 
This preference specifies the balance between quality and performance of CAD rendering. The default is Best 
Quality; however, users with large CAD files may opt to decrease quality to gain an increase in system 
performance and a reduced rendering time.

To change the rendering quality, click in the drop-down window and select a value:

• Best Quality: The CAD renders in best detail with no performance enhancement.

• Good Quality: The CAD renders in good detail with a slight performance enhancement.

• Balanced: The CAD rendering and performance are evenly matched.

• Good Performance: The CAD renders in less detail with a good performance enhancement.

• Best Performance: The CAD renders in lesser detail with the best performance enhancement.

Size and Scale
Whisker Scale
The scale value for whiskers. Each whisker is drawn using the deviation value. This scale value increases that 
length so that the whisker is visible on the screen.

Whisker Calculation Mode
The mode for calculating whiskers relative to features:

Material (Default): Readings are compared relative to the measured feature.

Nominal: Readings are compared relative to the nominal feature.

Size: Readings are compared relative to the measured feature, with deviation colors relative to the size of the 
feature rather than the material.

Readings Size
This sets the size of all feature readings in the measurement file. Move the slider to select a size.

Point Feature Size
This sets the size of all point features in the measurement file. Move the slider to select a size.

Inspect Surface Disk Size 
The size of the disks drawn to represent inspect surface points. The color is predetermined by the tolerance 
condition.
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Vector Points
Arrow Size 
This sets the size of all vector point arrows in the measurement file. Click in the drop-down window and select a 
size. This includes all point features and feature readings.

Disk Color 
The color of the disks drawn on the CAD part. The default is white.

Disk Scale 
The scale of the disks drawn on the CAD part; representing a number by which the size of the disks will be scaled. 
Min. value: 0.01, Max. value 100. The default is 1.

Measurement
Show Closest Point While Measuring 
This preference determines whether CAM2 draws a line between the probe and the closest CAD point.

• Yes: (Default) A line is drawn between the probe and the closest CAD point.

• No: No line is drawn between the probe and the closest CAD point.

Always Show Probe 
This preference determines whether CAM2 shows the probe graphic on-screen.

NOTE:  When shown, the probe is represented as it appears on the device and is displayed in a 1:1 scale. 
Changes to the probe diameter will be reflected in the software.

• Yes: (Default) CAM2 shows the probe on-screen.

• No: CAM2 does not show the probe on-screen.

Show Laser Probe 
This preference determines whether CAM2 shows the laser probe on-screen. If Always Show Probe is not enabled, 
this option is unavailable.

NOTE:  When shown, the laser probe is represented as it appears on the device and is displayed in a 1:1 scale.

• Yes: (Default) CAM2 shows the laser probe on-screen.

• No: CAM2 does not show the laser probe on-screen.

Probe Appearance 
This preference determines whether CAM2 shows the on-screen probe graphic as a solid (default), 3D arrow, 2D 
arrow, or dot. If Always Show Probe is not enabled, this option is unavailable.

NOTE:  When shown, the probe is represented as it appears on the device and is displayed in a 1:1 scale. 
Changes to the probe diameter will be reflected in the software.
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Measuring Line Color 
This preference specifies the color of the measuring line. To change the color, click in the drop-down window and 
select a color.

Dimension Settings
This preference specifies the default font used for dimension annotations in the CAD view.

Use Font Size Proportional to Feature Size 
(Default) CAM2 uses a font size that scales with the size of the feature dimension.

Use Custom Font Style
 CAM2 uses a user-selected font style and size. Click the button and select a font style and font size.

Use Font Size Preset
CAM2 uses a preset size (Very Small, Small, Medium, Large, or Very Large) for fonts.

General Dimension Color
This preference specifies the color of general dimensions. To change the color, click in the drop-down window and 
select a color.

Cross-Section Scan Dimension Color
This preference specifies the color of cross-section scan dimensions. To change the color, click in the drop-down 
window and select a color.

Point Cloud Settings
This preference specifies the visual representation of points clouds. 

Apply Lighting To Measured Point Clouds
Activate lighting for measured point clouds.

Point Representation
Display point cloud points as circles or squares. The default value is Squares.

Display Point Cloud Excluded Points
Display point cloud points excluded by the Point Distance Filter. See “Point Distance Filter” on page 185.

 

Cross-Section Scan Analysis Mode Settings
This preference specifies the visual representation of cross-section scans in analysis mode. For more information, 
see “Cross-Section Analysis” on page 100.

Tolerances Visual Representation
This preference specifies the visual representation of tolerances in cross-section analysis mode.

• Bands: (Default) Tolerances are shown as bands.

• Lines: Tolerances are shown as lines.

• None: Tolerances are not shown.
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Connectors Visual Representation
This preference specifies the visual representation of connectors in cross-section analysis mode.

• None: (Default) Connectors are not shown.

• Polyline: Connectors are shown as polylines.

• Spline: Connectors are shown as splines.

Color Gradients
Display Color Gradient in CAD View
This preference specifies whether the CAD View displays the color gradient.

• Yes: (Default) The CAD View displays the color gradient.

• No: The CAD View does not display the color gradient.

Display Color Gradient Labels
This preference specifies the way in which the CAD View displays color gradient labels.

• Always: (Default) Color gradient labels are always visible in the CAD View.

• For Selection: The CAD View displays a color gradient label for the currently selected entity.

• Never: Color gradient labels are not shown in the CAD View.

Other
Enable Anti-Aliasing
This preference specifies whether to enable anti-aliasing during rendering. Turn this option off to improve 
rendering performance.

• Yes: Anti-aliasing is enabled.

• No: (Default) Anti-aliasing is not enabled.

Device Position Visibility
This preference specifies the way in which device positions appear in the CAD View.

• All: (Default) All device positions appear in the CAD View.

• Solved: Only solved device positions appear in the CAD View.

• Active: Only the active device position appears in the CAD View.

• None: No device positions appear in the CAD View.

Labels Tab
The Labels preferences determine the content and display characteristics of labels in the measurement file.

Settings
Visibility Based Display 
This preference specifies whether to auto hide or show labels based upon the label visibility in the 3D viewer.

• Yes: (Default) Labels are automatically hidden.
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• No:  Labels remain visible.

Hide Labels During Measurement
This preference specifies whether to hide labels while Measure Mode to improve feature visibility in the 3D 
viewer. See “Measure Mode” on page 23.

• Yes: (Default) Labels are automatically hidden while in Measure Mode.

• No:  Labels remain visible.

Display Behavior 
This preference specifies label visibility options after measurement.

• Last Created (default): A label shows only for the most recent feature created.

• Hide All: No created features show labels.

• Show All: All created features show labels..

Style Definitions 
You can use, edit, and create new custom style definitions for labels. Specify the default style definitions to be used 
for Simple, Detailed, and Surface Point, and Callout labels.

Style Properties 
The properties that can be configured for label styles are as follows: 

• Name: Name of the label style (as it appears in the Style Definitions window). 

• Appearance: Font style and size, background color, grid color.

• Single Line Mode: The label appears as a single line of information.

• Show Icon: The label contains an image of the feature’s geometry type.

• Show First Column: The label contains information in columnar form.

• Show Header Row: The label contains a header row.

• Show Comment: The label contains comments associated with the feature.

Contents 
For Surface Point, Callout, and custom label styles, you can specify additional label content: Actual, Nominal, 
Deviation, Status, Lower Tolerance, and Upper Tolerance.

Units Tab
The Units preferences determine the display of decimal places in the Measurement panel and angle units in the 
measurement file.

NOTE:  See Unit Format to change the measurement file’s units.

Angle Unit 
The Angle Unit preference controls the level of detail in which the measurement file displays angles.

Click in the drop-down window and select a value:
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• Degrees-Minutes-Seconds: (Default) The measurement file displays angles in Degree-Minute-Second format 
(example: 90°5’52.34”).

• Degree: The measurement file displays angles in Degree format (example: 90.10°).

• Radians: The measurement file displays angles in radians (example: 1.2 rad).

Length Unit 
The Length Unit preference controls the default unit of measurement (Millimeters, Centimeters, Meters, or Inches). 
The default is Millimeters. See “Unit Format” on page 24.

Click Customize to configure the decimal places for a unit of measurement. You can configure the decimal places 
for existing units or create a new unit (specifying the name, abbreviation, decimal places, and distance in 
millimeters).

Coordinate Format 
The Coordinate Format preference controls the default coordinate system (Cartesian, Spherical, or Cylindrical). The 
default is Cartesian. See “Coordinate Format” on page 23.

Decimal Places
Unit Vector Decimal Places 
The Unit Vector Decimal Places preference controls the number of decimal places displayed for any vector.

To change this preference, input a new number.

Laser Tracker Adapters
Default Unit Systems 
The Default Unit Systems preference controls the preferred unit format for Laser Tracker probe adapters (Auto, 
Metric, or Imperial). The default is Auto.

• Auto: Automatically sets the units.

• Metric: Sets Metric units.

• Imperial: Sets Imperial units.

Construction Tab
The Construction preferences govern the components visible in construction dialog boxes.

Include CAD Objects
Indicates whether CAD objects will be visible in construction dialog boxes.

• Yes: (Default) CAD objects will be visible in construction dialog boxes.

• No: CAD objects will not be visible in construction dialog boxes. 

Include Coordinate System Components
Indicates whether Coordinate System components will be visible in construction drop-down boxes. 

• Yes: (Default) Coordinate system components will be visible in construction drop-down boxes.

• No: Coordinate system components will not be visible in construction drop-down boxes.
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Enable AutoBestfit Components
Indicates whether CAM2 performs automatic fitting when you select items from the Feature Tree.

• Yes: (Default) CAM2 performs automatic fitting when you select items from the Feature Tree.

• No: CAM2 does not perform automatic fitting when you select items from the Feature Tree. 

Include Ancestry Types
Indicates which feature types will be visible in construction dialog boxes. To change this preference, click in the 
drop-down window and select a value:

• All: (Default) All feature types will be visible in construction dialog boxes.

• Measured: Only measured features will be visible in construction dialog boxes.

• Nominal: Only nominal features will be visible in construction dialog boxes.

Smart Naming Tab
The Smart Naming preference allows you to create and edit templates that govern naming conventions of specific 
features and feature groups.

To change a naming template for a feature, click the field to the right of a feature and edit the naming template.

Panels
The Panels preferences determine the appearance and configuration of the panels in CAM2.

Click Panels in the left window of the Preferences window to see the Panels preferences.

Measurement Window Tab
The Measurement window preferences control the colors, fonts, and font colors of both the Measurement panel 
and the Feature window.

DRO 
The DRO preferences control the background color, font, font color of the Measurement window, decimal places, 
and the option to use a special Laser Tracker-related cylindrical coordinate system.

NOTE:  If you select a very large font for the Measurement window prompt, you may need to move the 
prompt’s scroll bar to read the text.

Feature DRO 
The Feature DRO preferences control the background color, font, font color of the Feature window and colors of 
feature tolerances.

Apply Tolerance Color to Background 
When enabled, CAM2 displays corresponding tolerance color backgrounds for live DRO data deviation.

Laser Tracker-Related Cylindrical Coordinate System 
When enabled, CAM2 employs a special FARO Laser Tracker-optimized cylindrical coordinate system.
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Enable Search Radius 
When enabled, a feature’s DRO window does not display data (*****) if the Probe is farther than the specified 
radial distance from the feature’s position.

QuickTools Tab
Font Settings 
The QuickTools preference controls the font and font color of the QuickTools message window.

Features Tab
Font Settings 
The Features preference controls the font and font color of the features as listed in the Features panel.

Device Tab
The Device preference determines whether CAM2 displays the Device Control panel on startup, and how CAM2 
exports device positions.

Device Center
This preference controls the behavior of the Device Control panel on CAM2 startup.

• Yes: The Device Control panel automatically appears when CAM2 is launched.

• No: (Default) The Device Control panel does not automatically appear when CAM2 is launched.

Device Positions 
This preference controls the export preference for device positions in conjunction with the world coordinate 
system.

• Yes: CAM2 exports device positions relative to the world coordinate system.

• No: (Default) CAM2 does not export device positions relative to the world coordinate system.

Measurement
The Measurement preferences determine the measurement workflow.

Click Measurement in the left window of the Preferences window to see the Measurement preferences.

Figure 3-1 Measurement preferences 

General Tab
Auto Repeat Measurement 
This preference automatically repeats the most recent measurement command in Measure mode.

• Yes: (Default) The most recent measurement command automatically repeats.
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• No: The most recent measurement command does not automatically repeat.

NOTE:  This is only active in Measure mode. See “Measure Mode” on page 23.

Auto-Recognize Features 
This preference controls Automatic Feature Recognition. See “Automatic Feature Recognition” on page 188.

NOTE:  You must disable Arm as Mouse to use this feature. See “Use Arm as Mouse ” below.

• Yes: CAM2 automatically recognizes features (specify maximum allowable form).

• No: (Default) CAM2 does not automatically recognize features.

Show Control Window 
This preference controls whether the Measurement dialog box appears when you add new measured features.

• Yes: The Measurement dialog box appears when you add new measured features.

• No: (Default) The Measurement dialog box does not appear when you add new measured features.

Measurement Sound 
This preference determines whether CAM2 makes a sound when a measurement device takes measurement 
readings and end clicks.

If the form of the feature you are measuring is out of tolerance, you will also hear a special sound to indicate the 
out of tolerance condition.

• Yes: (Default) CAM2 makes sounds when the measurement device takes measurement readings and end 
clicks.

• No: CAM2 does not make sounds when the measurement device takes measurement readings and end 
clicks.

Use Arm as Mouse 
This preference controls the interaction of the FaroArm and the CAM2 software.

When enabled, the position of the probe controls the mouse pointer in CAM2. The standard mouse also controls the 
pointer. CAM2 recognizes which input device is active and selects that device for the pointer control. After starting 
a measurement command, CAM2 only accepts control from the current measurement input device and blocks any 
input except digitized points.

Arm as Mouse temporarily disables during Add Readings. 

NOTE:  When you connect a FaroArm, CAM2 colors dialog box buttons red and green to indicate that the 
corresponding FaroArm buttons activate the dialog box buttons.

• Yes: The FaroArm is used as a mouse.

• No: (Default) The FaroArm is not used as a mouse.

Use Automatic Compensation For Surface Points 
This preference controls whether CAM2 automatically compensates surface point measurements.
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• Yes: (Default) CAM2 automatically compensates surface point measurements.

• No: CAM2 does not automatically compensate surface point measurements.

Default Compensation Method 
This preference specifies the default compensation method for measured features.

Click in the drop-down window and select a value:

• Use Sampled End Click: (Default) The BACK button, or H key, will define probe compensation for each 
feature.

• Auto: Features compensate automatically.

NOTE:  Auto compensation uses the orientation position of the probe in each reading. When using this option, 
collect readings with the probe as perpendicular to the surface as possible.

• Measure Inside: Features automatically compensate out for a hole.

• Measure Outside: Features automatically compensate in for a stud.

• None: No probe compensation.

Default Measure Mode 
This preference controls the automatic adding of readings to each Measurement command. See “Measure and 
Template Mode” on page 99.

Click in the drop-down window and select a value:

• Measure Mode: (Default) After choosing a Measurement command, the feature is added to the file, the 
Measurement Panel appears, and you are prompted to add readings to the feature. See “Measurement 
Panel” on page 188.

• Template Mode: After choosing a Measurement command, the feature is added to the file but you are not 
prompted to add readings to the feature.

Measurement Completion Mode 
This preference specifies the method in which CAM2 completes measurement. Measurement may be completed 
after recording a fixed number of readings or recording an end click.

Click in the drop-down window and select a value:

• End Click: (Default) Measurement completes after an end click.

• Fixed Number of Readings: Measurement completes after a fixed number of readings specified using the 
Auto Complete Tab preference. Auto Complete Tab on page 81

Apply Compensation in Feature Windows 
This preference controls whether CAM2 applies compensation in feature windows.

Click in the drop-down window and select a value:

• Yes: CAM2 automatically applies compensation in feature windows. All deviations will be relative to the 
compensated location.
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• No: CAM2 does not automatically apply compensation in feature windows. All deviations will be relative 
to the probe center.

• Ask: (Default) You are asked if you want CAM2 to apply compensation in feature windows. Unless you 
check the “Never ask me again” check box, the software will continue to prompt you to do so.

Projection Plane
Use Last Plane 
This preference controls the automatic assigning of the last measured plane feature to the Feature Properties of the 
current feature. See “Feature Properties” on page 183. 

• Yes: (Default) The last measured plane becomes the default plane of projection for subsequent feature 
measurements.

• No: Subsequent feature measurements are established with new planes of projection.

Allow Constructed Actual Planes 
This preference allows the use of planes constructed from actual features to be used as projection planes.

• Yes: Planes constructed from actual features are usable as projection planes.

• No: (Default) Planes constructed from actual features are not usable as projection planes.

Default 
This preference defines the default plane for features that require a plane to solve. 

Click in the drop-down window and select a value:

• None: The feature solves using the readings for the feature and the plane.

• Define: (Default) A plane feature is added to the file for the feature. You must add readings to the plane to 
solve the feature.

• Auto: CAM2 automatically chooses the most suitable projection plane. If CAM2 cannot find a suitable 
projection plane, you will be prompted to select a plane (or measure one if you have not already done so).

NOTE:  The Auto option predictively selects the best projection plane, and is thus incompatible with the Use 
Last Plane preference. Use Last Plane will be unavailable if you choose the Auto projection plane option.

Auto Nominal Tab
This preference controls the automatic association of the nearest nominal to a measured feature - providing it falls 
within the tolerance zone.

NOTE:  This function is not active until an Alignment has been created. For more information, see “Manage 
Alignments” on page 266.

Automatically Associate Nominal 
This preference determines whether CAM2 automatically associates nominals to measured features.

• Yes: (Default) Nominals are automatically associated to measured features.

• No: Nominals are not automatically associated to measured features.
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• Orientation: The orientation tolerance for auto nominal. The default is 5°.

• Position: The position tolerance for auto nominal. The default is 0.1.

• Size: The size tolerance for auto nominal. The default is 0.1.

Auto Complete Tab
This preference specifies the number of points per feature type to automatically complete a measurement. When 
this number of readings is reached, CAM2 creates the feature and the measurement process terminates.

When used in conjunction with automatic compensation (Default Compensation Method set to Auto), auto 
complete provides for a streamlined measurement process.

NOTE:  Measurement Completion Mode  must be enabled to use this functionality. For more information, see 
“Measurement Completion Mode ” on page 79.

To change the number of auto complete points for a feature:

• Click the number field to the right of a feature.

• Edit the number of points for the feature.

Point Cloud Tab
NOTE:  If you are using the Probing Version of CAM2, Point Cloud preferences are not available. See 
“Probing Version” on page 9.

Scan Trigger Behavior 
This preference determines how the measurement device’s button behaves when scanning.

• Click to Start/Stop: (Default) The device begins scanning when the button is pressed, and finishes 
scanning when the button is pressed again.

• Press and Hold: The device begins scanning when the button is pressed and held down, and finishes 
scanning when the button is released.

Default Alignment Sample Size 
This preference determines the default number of points to sample from a point cloud used in an iterative 
alignment. The default value is 50.

Use Last Plane 
This preference determines whether the last plane measured becomes the clipping plane for future point cloud 
measurements.

Defer Recalculation 
This preference specifies whether point cloud recalculation is automatic or manual (deferred).

• Yes: CAM2 automatically recalculates point cloud data.

• No: (Default) The user recalculates point cloud data.
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NOTE:  If recalculation is deferred, the Main Window will contain a small icon which you can click to 
perform the recalculation.

Keep Raw Data
This preference specifies whether CAM2 uses out-of-core file storage (external memory) to store data at full 
resolution. When enabled, metrology grade points are kept in memory, making the application more fluid without 
losing data.

• Yes: CAM2 uses out-of-core file storage.

• No: (Default) CAM2 does not use out-of-core file storage.

Warn When Raw Data Storage is Deleted or Disabled
This preference specifies whether to notify you when Raw Data storage is deleted or disabled. When Keep Raw 
Data is disabled, data can no longer be retrieved.

• Yes: (Default) CAM2 prompts you when Raw Data storage is deleted or disabled.

• No: CAM2 does not prompt you when Raw Data storage is deleted or disabled.

Do Not Show a Dialog With Exported Nominal Mesh File Path
This preference specifies whether to display the file path when exporting a Nominal Mesh. The default is Ask.

Extraction 
These preferences control the behavior of feature extraction. For more information, see “Extract” on page 199.

Show No Point Selection Control
Show a prompt when no points are selected.

Show No Results Found Control
Show a prompt when no results are found.

Automatically Relate Scan Data To Nominal Data
Enable the automatic extraction of features using a nominal and a point cloud.

Solver Method
Specify the default solver method of feature extraction from nominal. See “Extraction” on page 186.

Sampling
Specify the method to extract features from nominal.

Filtering 
Show a Dialog When Point Clouds Cannot Be Filtered
Show a prompt when point clouds cannot be filtered.

Scanning 
Point Distance Filter
Determines the distance from CAD at which point clouds are not shown. The default value is 3.000 mm. 
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Comparison to CAD
Controls the frequency by which CAM2 compares scanned points to CAD (Automatic, Always On, or Always 
Off). 

Registration 
This preference enables CAM2 to automatically merge registration groups when you exit Registration mode, or 
after each point cloud measurement. For more information, see “Registration” on page 41.

Merge all registration groups when exiting Registration mode
• Yes: CAM2 automatically merges registration groups when you exit Registration mode.

• No: CAM2 does not automatically merge registration groups when you exit Registration mode.

• Ask: (Default) You are prompted whether you want CAM2 to automatically merge registration groups 
when you exit Registration mode. Unless you check the “Never ask me again” check box, the software 
will continue to prompt you to do so.

Selection 
Select Points Facing The User
Select points with normal vectors facing the screen. See “Front Facing” on page 40.

Surface Edge 
Edge Tolerance
The degree to which CAM2 refines point cloud normals at edges (Finest, Fine, Normal, Coarse, Coarsest, or 
Custom). The default value is Fine. Choose Custom to specify minimum edge length, minimum distance from 
edge, and the angle to edge threshold.

Tubing Tab
Display Breakpoints Under Tube 
This preference controls whether CAM2 lists associated cylinders and breakpoints under each tube in the Features 
list. See “Features” on page 34.

• Yes: (Default) CAM2 lists the cylinders and breakpoints associated with each tube.

• No: CAM2 does not list the cylinders and breakpoints associated with each tube.

Align Tube Automatically 
This preference controls whether CAM2 automatically aligns tubes.

When you select a nominal tube, CAM2 creates a new best-fit alignment to align the measured tube to the nominal 
tube.

If you do not have a nominal tube, CAM2 creates a new coordinate system alignment so that the tube will have:

• The start point at the origin.

• The first segment oriented in the +X direction.

• The first two segments lie on the Z=0 plane.
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Automatic tube alignments appear in the Alignments window and can be edited normally. See “Manage 
Alignments” on page 266.

• Yes: (Default) CAM2 automatically aligns tubes.

• No: CAM2 does not automatically align tubes.

Positive Angles Represent A Clockwise Turn 
This preference controls the way in which CAM2 represents clockwise and counterclockwise tube directions.

• Yes: (Default) Positive angles represent a clockwise turn.

• No: Positive angles represent a counterclockwise turn.

Other Tab
Material Compensation Mode 
This preference specifies the way in which CAM2 compensates for material when you measure, so you can 
measure surface points on the material side of a part and compare the points to the CAD model.

The material thickness for the compensation is extracted from the material properties, specified in Part Properties, 
from which the Surface Point is extracted. See “Part Properties” on page 96.

• None: (Default) CAM2 will not compensate for material.

• Back Side: CAM2 will compensate for the part’s CAD side.

• Fixture B Side: CAM2 will compensate for part’s holding fixture.

• Example: Inspect a fixture directly to the Part CAD single surface model to confirm touch points 
contacting the part on the ‘B’ side. The reported data is  the actual measured point on the fixture, the 
dN relative to the fixture surface, and the ISP disc displayed on the CAD ‘A’ Surface. The error 
represents the material condition of the fixture touch point.

• Part Thickness: CAM2 will compensate for part’s thickness.

• Example: Inspect the part thickness deviation of a part held in a fixture against touch points. A single 
surface CAD model is used, offset to the probed part side. The reported data is  the actual measured 
point on the Part ‘B’ side, where the normal is opposite to the CAD surface. The ISP disc is displayed 
on the CAD ‘A’ Surface, and rendered differently to indicate the flipped normal. The error represents 
the material thickness deviation of the part at the touch point.

• Clamp: CAM2 will compensate for part’s clamping surface.

• Example: Inspect fixture clamp positions using the Part CAD model to confirm touch points 
contacting the part on the ‘A’ side. The reported data is  the actual measured point on the clamp 
surface, where the normal is opposite to the CAD surface. The ISP disc is displayed on the CAD ‘A’ 
Surface and rendered differently to indicate the flipped normal. The error represents the material 
condition of the clamp touch point.

Automatically Take Reading 
This preference controls whether CAM2 automatically takes a reading when measuring vector points. See 
Measuring a Vector Point on page 174 and Measuring a Home In Point on page 170.

• Yes: CAM2 automatically takes a reading when measuring vector points (specify Home In Zone size).

• No: (Default) CAM2 does not automatically take a reading when measuring vector points.
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Zone Diameter 
This preference sets the default home in zone size. This value, in conjunction with the point and vector, defines a 
cylindrical zone around the point within which the user is expected to measure the point. The default value is 5 
mm.

To change this preference, input a new number.

DRO Refresh Rate 
This preference sets the rate at which the DRO refreshes. The default value is 200 ms.

To change this preference, input a new number.

Profile Calculation Method
This preference controls CAM2’s calculation of Surface Profiles. See “Profile of a Surface” on page 297.

• Nominal Deviation: (Default) CAM2 will calculate the profile relative to the nominal surface as per ISO 
1660.

• Absolute Error: CAM2 will float the profile calculation with the measurement data as per ASME y14.5.

Measurement Mode
Auto-Switch to Measure Mode 
This preference controls the behavior of the software when you run Add Readings while in Template mode.

Click in the drop-down window and select a value:

• Yes: The software will automatically switch to Measure mode and you proceed to measure features.

• No: The software will not automatically switch to Measure mode, yet you will be prompted to measure 
features.

• Ask: (Default) You are asked to switch to Measure mode. Unless you check the “Never ask me again” 
check box, the software will continue to prompt you each time you attempt to measure a feature in 
Template mode.

Automatically Measure Features 
This preference controls the behavior of the software when you switch to from Template to Measure mode.

Click in the drop-down window and select a value:

• Yes: The software will automatically add readings to all the measured features in the file.

• No: The software will not automatically add readings to all the measured features in the file.

• Ask: (Default) You are asked if you want to add readings to all the measured features in the file. Unless 
you check the “Never ask me again” check box, the software will continue to prompt you each time you 
switch to from Template to Measure mode.

Include Previously Measured Features 
This preference specifies whether Measure All includes previously measured features.

Click in the drop-down window and select a value:

• Yes: The software will include previously measured features when Measure All is invoked.
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• No: The software will exclude previously measured features when Measure All is invoked.

• Ask: (Default) You are asked if you want to include previously measured features in Measure All. Unless 
you check the “Never ask me again” check box, the software will continue to prompt you each time you 
invoke Measure All.

Laser Tracker
The Laser Tracker preferences govern the way in which the FARO Laser Tracker interfaces with CAM2.

NOTE:  These preference apply to the FARO Laser Tracker only.

RMS Threshold 
This preference specifies the upper limit of the Root Mean Square (RMS) threshold to define acceptable reading 
quality, and how CAM2 behaves when the limit is exceeded. RMS values are visible in the Measurement Panel. 
See “Measurement Panel” on page 188.

Measure Elevation Point 
This preference specifies whether to measure a point to be used as a reference to the level plane.

• Yes: (Default) CAM2 measures a point to be used as a reference to the level plane.

• No: CAM2 will not measure a point to be used as a reference to the level plane.

Automatically Aim at the Next Feature 
This preference specifies whether the FARO Laser Tracker should automatically aim at the next feature if the laser 
beam becomes broken.

• Yes: The FARO Laser Tracker automatically aims at the next feature when the laser beam is broken.

• No: (Default) The FARO Laser Tracker will not automatically aim at the next feature if the laser beam is 
broken.

Set Two Face Measurement for Uncompensated Points 
This preference specifies whether the FARO Laser Tracker automatically takes one reading with the front sight and 
one reading with the back sight for uncompensated points.

• Yes: The FARO Laser Tracker performs Two Face measurement for uncompensated points.

• No: (Default) The FARO Laser Tracker will not perform Two Face measurement for uncompensated 
points.

TrackArm
The TrackArm preferences govern the way in which the TrackArm interfaces with CAM2.

NOTE:  These preferences apply to the FARO TrackArm system only.

Locate TrackArm When Device Detected:
This preference specifies whether CAM2 should automatically locate the TrackArm when detected.

Click in the drop-down window and select a value:

• Yes: CAM2 automatically locates the TrackArm when detected.
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• No: CAM2 does not automatically locate the TrackArm when detected.

• Ask: (Default) You are prompted whether to search for the TrackArm when CAM2 detects it.

Temperature Sensors
The Temperature Sensors box contains a list of available and active temperature sensors (External, FaroArm, and 
Laser Tracker) with which to measure outside temperature. These temperature sensors may be used to scale 
measurements by applying the temperatures in the Device Position and Alignment dialogs. The reading 
temperatures for the active measurement device are displayed in the Measurement Data panel. See “Measurement 
Data” on page 27.

Remote
The Remote preferences configure CAM2’s remote server.

Remove Server
Check this box to enable a remote server for CAM2.

Create WiFi Network
Check this box to create a WiFi network (specify a name and key).

Alignment
The Alignment preferences determine configuration and profile information for point cloud alignments.

Click Alignment in the left window of the Preferences window to see the Alignment preferences.

Point Cloud Alignment
This preference specifies whether CAM2 should automatically attempt an alignment after each point cloud 
measurement. 

• Yes: CAM2 performs an alignment after each point cloud measurement.

• No: CAM2 does not perform an alignment after each point cloud measurement.

• Ask: (Default) CAM2 prompts you whether to perform an alignment after each point cloud measurement.

NOTE:  Automatic alignment requires the point cloud to be at least 75% of the volume of the CAD model. If 
the Point Cloud volume is less, automatic alignment is not available.

Iterative Alignment
Maximum Iterations 
This preference controls the maximum iterations for iterative alignments.

Iterative Alignment Tolerance 
This preference controls the default tolerance for iterative alignments.

FARO CAM2
Chapter 3: File

FARO CAM2 2021 (v2021.0) Page 87 of 336



Construction
The CONSTRUCTION preferences determine the way CAM2 handles constructed features.

Auto Best Fit
Indicates whether CAM2 performs automatic fitting when you select items from the Features panel.

• Yes: CAM2 performs automatic fitting when you select items from the Features panel.

• No: (Default) CAM2 does not perform automatic fitting when you select items from the Features panel. 

CAD
The CAD preferences determine the way CAM2 displays CAD files.

Click CAD in the left window of the Preferences window to see the CAD preferences.

Surface Stitching Option
This preference specifies the method in which CAD surfaces are “stitched” to minimize error between feature lines.

Click in the drop-down window and select a value:

• Match Geometry: CAD surfaces are stitched according to geometric data.

• Match Topology: (Default) CAD surfaces are stitched according to topological structures.

CAD Part
The CAD Part preferences define properties for all loaded CAD parts.

Enabled 
Indicates whether the CAD model is available for measurements and alignments.

• Yes: (Default) The CAD model is available for measurements and alignments.

• No: The CAD model is not available for measurements and alignments.

NOTE:  If this preference is set to No, CAD contents will not considered for picking or measurements.

Visible 
Indicates whether the CAD part will be visible in the CAD view.

• Yes: (Default) The CAD part will be visible in the CAD view. 

• No: The CAD part will not be visible in the CAD view. 

Material Composition 
Indicates the default material composition of the CAD. To change this preference, click in the drop-down window 
and select a value. The default value is Steel.
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Material Direction 
Indicates the default CAD compensation. To change this preference, click in the drop-down window and select a 
value:

• Above CAD Surface: (Default) The material begins at the sampled surface and extends upward in a positive 
direction relative to the surface normal, i.e. the CAD surface represents the “bottom face” of the material.

• Below CAD Surface: The material begins at the CAD surface and extends downward in a negative direction 
relative to the surface normal, i.e. the CAD surface represents the “top face” of the material.

Material Thickness 
Indicates the default thickness of the CAD material. The default value is 3mm.

CAD Import
Translate Hidden Entities 
Indicates whether the entities on hidden CAD file layers will be included in CAD translation.

• Yes: Entities on hidden CAD file layers will be included in CAD translation.

• No: (Default) Entities on hidden CAD file layers will not be included in CAD translation. 

Translate Curves and Lines 
Indicates whether the CAD curves and lines will be included in CAD translation.

• Yes: Curves and lines will be included in CAD translation.

• No: (Default) Curves and lines will not be included in CAD translation. 

Use Direct Translation to Parasolid 
Indicates whether CAM2 automatically translates imported CAD into the Parasolid format.

• Yes: (Default) CAM2 automatically translates imported CAD into the Parasolid format.

• No: CAM2 does not automatically translate imported CAD into the Parasolid format. 

Multi-Core Translation
Check this box to allow use of multiple processor cores to increase translation speed.

NOTE:  If CAD translation fails, verify whether your PC configuration supports multi-process translation 
before enabling this option.

Healing 
This preference enables healing of CAD model errors when importing CAD data. You can specify the balance 
between quality and system performance. Large CAD files may warrant a decrease in healing quality to gain an 
increase in system performance and a reduced healing time.

To configure the healing quality, click in the drop-down window and select a value:

• None: Healing is not enabled.
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• Better Speed: (Default) The CAD heals in lesser detail with the best performance enhancement.

• Better Quality: The CAD heals in best detail with no performance enhancement. However, this can 
sometimes double the import time.

Fix Inverted Faces 
Indicates whether CAM2 automatically fixes inverted CAD faces upon import.

• Ask: (Default) CAM2 prompts you whether to automatically fix inverted CAD faces upon import.

• Yes: CAM2 automatically fixes inverted CAD faces upon import.

• No: CAM2 does not automatically fix inverted CAD faces upon import. 

Create the Nominals Automatically
Indicates whether CAM2 automatically creates nominals when importing CAD.

• Ask: (Default) CAM2 prompts you whether to automatically create nominals when importing CAD.

• Yes: CAM2 automatically creates nominals when importing CAD.

• No: CAM2 does not automatically create nominals when importing CAD. 

Tolerance
The Tolerance preferences determine tolerance behavior and the default tolerances for each feature type. 

Click Tolerance in the left window of the Preferences window to see the Tolerance preferences.

General Tab
Copy GD&T Tolerances 
This preference specifies whether to include GD&T data when copying tolerances from one feature to another (or 
others).

To change this preference, click in the drop-down window and select a value:

• Yes: The software will include GD&T data when copying tolerances.

• No: The software will not include GD&T data when copying tolerances.

• Ask: (Default) You are asked if you want to include GD&T data when copying tolerances. Unless you 
check the “Never ask me again” check box, the software will continue to prompt you each time you copy 
tolerances.

Adaptive Tolerance
This preference determines the ‘default’ deviation tolerance for an aligned Point Cloud in order to improve the 
initial Point Cloud colorization. 

By default, CAM2 calculates the best fit tolerance according to the active alignment. If the check box is cleared, 
the Point Cloud will be colored relative to the default tolerance, which may display the point cloud with large red, 
green, and blue areas.

• Yes: (Default) CAM2 will adjust the deviation tolerance to fit the active alignment.

• No: The deviation tolerance will not adapt to the active alignment.
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Datum Suggestions 
This preference specifies the number of datums that the user will be allowed to choose from when assigning 
datums to a feature. The default value is 3.

NOTE:  CAM2 suggests the next N available Datum letters. For example, if the user has elected 3 datum 
suggestions and has already assigned Datums A and D, the next 3 datums suggested will be B, C and E.

Geometries Tab
Tolerances associate to a geometry type regardless of how that geometry type is created in the measurement file.

To change a default tolerance:

• Click the arrow to the left of a feature type to expand or collapse the tolerance information.

• When collapsed:

• The value displayed represents a symmetrical tolerance for all properties of that feature type. 

• You can type in a value to override all tolerance values of all properties of that feature type. For example, 
if a user enters 0.01mm for a circle, it will define a +- 0.01mm tolerance for all circle properties.

• You can associate a DIN or ISO tolerance classification per feature type. When associating a tolerance 
classification to a feature, it will apply to all applicable properties of that feature.

NOTE:  The collapsed text will change to <custom> if any one value differs, in absolute value, to any other 
for that feature type.

• When expanded:

• All properties of the type of feature are displayed.

• Two boxes contain the lower and upper tolerance for each property. Enter tolerance values as appropriate.

• Check boxes indicate whether properties are available or unavailable for tolerancing. Place a check in the 
checkbox to make it available; clear the checkbox to make it unavailable.

• Click Apply to All to apply the modified tolerances to all features in the measurement file.

NOTE:  Geometry tolerance statistics (Maximum Error, Minimum Error, Form, etc.) are the same for all 
feature types.

GD&T Tab
Tolerances associate to a GD&T type. To change a default GD&T tolerance:

• Click the arrow to the right of a GD&T tolerance to expand or collapse the tolerance information.

• When collapsed:

• The value displayed represents a symmetrical tolerance for all properties of that GD&T type. 

• You can associate a DIN or ISO tolerance classification per feature type. When associating a tolerance 
classification to a feature, it will apply to all applicable properties of that feature.
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NOTE:  The collapsed text will change to <custom> if any one value differs, in absolute value, to any other 
for that feature type.

• When expanded:

• All properties of the type of GD&T tolerance are displayed.

• Two boxes contain the lower and upper tolerance for each property. Enter tolerance values as appropriate.

• Check boxes indicate whether properties are available or unavailable for tolerancing. Place a check in the 
checkbox to make it available; clear the checkbox to make it unavailable.

• Click Apply to All to apply the modified GD&T tolerances to all features in the measurement file.

Abbreviations Tab
Choose from two default abbreviation sets:

• Text based: Textual abbreviations.

• Symbol based: Replaces the text with symbols.

NOTE:  When using Symbols, a tool tip will be displayed when hovering the cursor over a symbol in the 
Feature Information panel. 

You can also create custom abbreviations for feature property names. To create abbreviations, you must create a 
new abbreviation set: 

• Type a new name for your abbreviation set in the Abbreviation Set field and press Enter.

NOTE:  You cannot edit the abbreviations of the Default abbreviation set.

• Expand the Position, Orientation, and/or Dimension feature property types. For each property type:

• When collapsed:

• The value displayed represents an abbreviation for all properties of that feature property type. When 
you create an abbreviation at the top level, it applies to all sublevels of that feature property type. For 
example, if you rename Center to C, Center properties become C.x, C.y, and C.z.

• When expanded:

• All properties of the feature property type are displayed.

• Enter abbreviations as appropriate.

• Click OKto exit Preferences and apply all feature property abbreviation changes to the measurement file.

Report
The Report preference determines default formatting for reports, including logo selection.

Click Report in the left window of the Preferences window to see the Report preferences.
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Header
Logo 
Image Location 
This preference selects the logo file for the report template.

To change this file, click the right column and select a different file.

The selected image appears in the Preview window.

Company Name
Company Details
Your organization’s name, address, and contact information.

The selected logo and entered text will display on the header of the first page of the default report templates.

Options
Auto Report
Auto Update Report
This preference controls the automatic updating of reports as changes are made. 

Yes: (Default) CAM2 will  automatically update reports as changes are made.

No: CAM2 will  not update reports automatically.

Generate From Selection 
This preference controls the automatic generation of a report template with features selected in the CAD view. 
With this preference enabled, the user the user highlights the features that are required in the report while still in 
CAD View. When the user switches to the Report tab, the Report opens with the selected features and data 
formatted for the feature components specified in the Feature Information panel.

To change this preference, click in the drop-down window and select a value.

• Always: CAM2 will create a new report template each time the user switches to the Report tab with one 
or more features selected.

• Ask: CAM2 will prompt the user whether to create a new report template each time the user switches to 
the Report tab with one or more features selected.

• No: CAM2 will not generate a report template.

• Once: (Default) CAM2 will create the report template once. All subsequent changes to the Report tab 
will not result in the generation of a new report.

Default Format 
With Alignment 
This preference selects the report format that is used after an Alignment is created. 

To change this preference, click in the drop-down window and select a value.

Without Alignment 
This preference selects the report format that is used before an Alignment is created. 
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To change this preference, click in the drop-down window and select a value.

Other 
Display Color Gradient in Report Images 
This preference specifies whether to show the color gradient in report images. To change this preference, check or 
clear the check box. 

Imager3D
The Imager3D preference determines default 3D Imager workflow.

Use Rotary Table Wizard To Measure Point Cloud
This preference controls whether CAM2 automatically uses the Rotary Table Wizard to measure point clouds. 

Click in the drop-down window and select a value:

• Yes: CAM2 automatically uses the Rotary Table Wizard to measure point clouds.

• No: CAM2 does not automatically use the Rotary Table Wizard to measure point clouds.

• Ask: (Default) You are asked if you want CAM2 to automatically use the Rotary Table Wizard to 
measure point clouds. Unless you check the “Never ask me again” check box, the software will continue 
to prompt you to do so.

Save Wizard Preset On Scan
This preference controls whether CAM2 automatically saves the Rotary Table Wizard configuration to the selected 
preset. If no preset exists, CAM2 will create a new one.

Click in the drop-down window and select a value:

• Yes: CAM2 automatically saves the Rotary Table Wizard configuration to the selected preset.

• No: CAM2 does not automatically save the Rotary Table Wizard configuration to the selected preset.

• Ask: (Default) You are asked if you want CAM2 to automatically save the Rotary Table Wizard 
configuration to the selected preset. Unless you check the “Never ask me again” check box, the software 
will continue to prompt you to do so.

Attempt Registration After Each Point Cloud Measurement
This preference specifies whether CAM2 automatically merges registration groups after each point cloud 
measurement. See “Registration” on page 41.

• Yes: (Default) CAM2 automatically merges registration groups after each point cloud measurement. 

• No: CAM2 does not automatically merge registration groups after each point cloud measurement.

Exit
Closes CAM2. If an unsaved measurement file is open, you are prompted to save or discard the file. 
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Chapter 4: Home

The Home commands are located in the Home tab across the top of the screen, and contain commonly used 
functionality organized in a sequential workflow, allowing you to complete most tasks from a single location. The 
commands on the Home tab are organized into Setup, Reference, Alignment, Measure, Analysis, and Document 
groups. 

The contents of the Home tab change based on what you have selected in the Navigation Window. See 
“Navigation Window” on page 33.

 
Setup 96

Reference 96

Alignment 98

Measure 99

Analysis 100

Document 106
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Setup
The Setup group contains the Device Center and Move Device commands.

Device Center
Device Center accesses the Device Center panel. For more information, see “Device Center” on page 128.

Move Device
Select Devices > Move Device to access the Move Device Position wizard. For more information, see “Manage 
Devices” on page 130.

Reference
The Reference group contains all the commands necessary to import CAD, pick features, view CAD part 
properties, and mirror nominals.

Import CAD
Import CAD adds Parasolid® CAD format data (*.x_b) to your current measurement file. Select one or more CAD 
files in the Add CAD Model dialog, then click Open to translate them into Parasolid format and load them into the 
current measurement file.

Large CAD files or CAD files that may take longer to load than other files should be translated into the Parasolid 
format using Translate CAD. See “Translate CAD” on page 58.

NOTE:  By default, imported CAD is displayed with both shading and wireframe information. To import files 
and change options use the FARO CAD translator. See “Translate CAD” on page 58.

The CAM2 CAD translator has an option to use Healing , or error correction, during the translation process. This 
option is a preference. For more information, see “Healing ” on page 89. 

Pick Features
Click Pick Features to enable intelligent feature-picking from CAD. Pick Features also extracts the same feature 
from Point Cloud if aligned. For more information, see “Pick Features” on page 218.

Part Properties
PART Properties accesses the Edit CAD Part Properties window. The Edit CAD Part Properties window 
contains all loaded CAD parts and the material properties for each CAD part.

Change the CAD Part properties preferences so that all CAD parts add with the same properties.
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Composition: The thermal properties of the CAD material for use by alignments.

Thickness: The thickness of the CAD material (in measurement file units).

Direction: The normal direction of the CAD surface.

• Above CAD Surface: The material begins at the sampled surface and extends upward in a positive direction 
relative to the surface normal; the CAD surface represents the “bottom face” of the material.

• Below CAD Surface: The material begins at the CAD surface and extends downward in a negative direction 
relative to the surface normal; the CAD surface represents the “top face” of the material.

NOTE:  As you measure the part, you can switch between these surfaces using Material Compensation. See 
“Material Compensation” on page 182.

CAD Color: The front and back surface display colors. Change the colors by checking the Override CAD Color 
box and clicking the Front Surface and Back Surface drop-downs.

Wireframe: The wireframe display color.

Mirror On: The axis on which to mirror the CAD.

NOTE:  Mirroring is a state of the CAD part, and must be either made available or unavailable (not both). To 
view the mirrored and unmirrored CAD part simultaneously, load the part twice and mirror one instance.

Visible: Indicates whether the CAD part is visible in the CAD view.

Enabled: Indicates whether the CAD model is available for use by measurements and alignments.

NOTE:  If the CAD is not enabled, it is not considered for picking or measurements.

Mirror Nominal
Mirror Nominal allows you to apply a mirror transformation to all nominals in the measurement file. The mirror 
transformation occurs along an axis-aligned Mirroring Plane that is supplied as a single coordinate (not a feature) in 
conjunction with a Plane Offset, such as Y = 5.0mm. You have the option to mirror the features in place or as a 
copy.

The number of nominal features after the mirror will be the same as before. CAM2 will automatically move any 
constructed nominals that are based on existing features, and any measurements associated to the existing nominals 
will remain properly linked but will have the readings removed.

NOTE:  The nominals will mirror in place unless the Copy Entity box is selected.

Mirrored Entity Suffix 

When you are copying an entity by mirroring, use the Mirrored Entity Suffix box to enter a suffix to be 
automatically appended to the new nominal feature names. The default suffix is *.
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Copy Entity
The initial nominals are retained and a second set of nominals is created, doubling the number of nominal features. 
CAM2 will duplicate Key-In and Pick from CAD features as Key-In features using the mirror plane. Constructions 
and dimensions that are built from features will be copied. Any measurements associated to the existing nominals 
will have corresponding measurements for the newly created construction. Projection planes or home-in features 
will be replaced with the corresponding mirrored measurement.

NOTE:  Measurements, measured features made nominal, and QuickTools will not mirror. 

Create Nominal Mesh
Create Nominal Mesh allows you to create a nominal mesh from a selected point cloud and export the mesh file 
(*.stl) to the default location. Select a meshing profile to apply appropriate parameters to your component:

• Smooth: for larger parts with flat or large curved surfaces with little to no detail, such as automotive body 
panels.

• Curvature: for medium-sized parts with curved and small radiused surfaces, such as pressed or molded parts. 

• Detailed: for smaller parts with small or fine detail, such as coins.

NOTE:  You can also right-click the point cloud and select Create Nominal Mesh from the context menu. 

Alignment
The Alignment group contains all the commands necessary to align your part, manage alignments, create a 
coordinate system alignment, and align a point cloud. 

Align My Part
Select Align My Partto access the Create Alignments Wizard. For more information, see “Align My Part” on 
page 268.

Manage Alignments
Select Manage Alignments to access the Alignments window. For more information, see “Manage Alignments” 
on page 266.

Coordinate System
Select Coordinate System to create a coordinate system alignment. For more information, see “Coordinate 
System” on page 276.
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Align Point Cloud
Select Align Point Cloudto access point cloud alignment mode. For more information, see “Align Point Cloud” 
on page 269.

Measure
The Measure group contains all the commands necessary to select Measure or Template mode, measure features, 
clear readings, and enable automatic feature recognition. 

Measure and Template Mode
Click this icon to switch between Measure and Template mode.

Measure Mode
The current device’s Measurement panel automatically opens and you can begin to Add Readings  to the feature. 
Select multiple measurement commands and each will be added to the Measurement panel in the order that you 
select the commands.

Template Mode
Template mode disables the automatic adding of readings when you add one or more features to the measurement 
file. The default mode is a preference. See “Default Measure Mode ” on page 79.

Select a Measurement command and that measured feature adds to the measurement file. Add readings to the 
feature manually with Add Readings . See “Add Readings ” on page 197.

When Template mode is active, a red border and “Template Mode” text appear around the CAD tab of the Main 
Window. See “Screen Layout” on page 15.

NOTE:  When you switch to Measure mode after adding features in Template mode, CAM2 will prompt you 
to measure those features.

Features
The Features group contains all the measurement commands for 2D and 3D features. For more information, see 
“Features” on page 154.

Measure All
Measure All measures, or adds readings, to every feature in your file. If you have already measured features, 
CAM2 prompts you whether to remeasure those features. The measurement order follow the position of the 
features in the Features panel. See “Reordering Features” on page 36.

1. Select Measure > Measure All. 
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2. Use your measuring device and add readings to the first feature in the Features panel.

3. Press the Back button, or H key, to finish. 

NOTE:  Pressing the Back button, or H key, may also define the Probe Compensation. For more information, 
see “Probe Compensation” on page 184.

Clear Readings
Clear Readings clears all readings from all entities in the measurement file. For more information, see “Clear 
Readings” on page 109.

Auto-Recognize Features
Auto-Recognize Features enables automatic feature recognition. For more information, see “Automatic Feature 
Recognition” on page 188.

Analysis
The Analysis group contains all the commands necessary to create measurement results from features. 

Length From Features
Select Length From Features to create a dimension between features. For more information, see “Length From 
Features” on page 259.

Construct from Selection Gallery
Select features in the gallery to create dimensions between them. For more information, see “Length From 
Features” on page 259.

Cross-Section Analysis
Use the Cross-Section command in the Analysis group to select, extract, dimension, control, and add deviation 
markers to cross-section scan data. Select a cross-section feature (with readings) and click Cross-Section to access 
Cross-Section Analysis mode.

When in Cross-Section Analysis mode, the Navigation Window organizes your content into three folders:

• CAD Parts: The list of all CAD parts associated with your cross-section, with individual show/hide 
capabilities.

• Dimensions: The list of all extracted dimensions. See “Dimensions” on the facing page.

• Views: The list of all saved views. See “Capture” on page 106.
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The Cross-Section Analysis commands are located in the Cross-Section Analysis tab across the top of the screen, 
and the commands are organized into Selection Tools, Dimensions, Editing, Display, View, Deviation Markers, 
View Data, and Close groups.

Selection Tools
The Selection Tools group contains commands to select portions of cross-sections: Rectangular, Lasso, Polygon, 
and Brush. For more information, see “Selection Tools” on page 38.

Dimensions
Create dimensions from your selection of cross-section data. When you select dimensions in the Navigation 
Window (Dimensions folder), you can view and edit their nominal and tolerance values in the Feature Information 
panel.

Dimensions also appear in Report as a detailed listing with specified nominal and tolerance values.

The Dimensions group contains commands to extract 2D dimensions to analyze the measured cross-section: 
Radius, Angle, and Height.

Radius
Radius extracts a radius dimension. Click anywhere on a circular portion of the cross-section, select Radius, and 
CAM2 automatically extracts a radius from the best points in a circular pattern.

Angle
Angle extracts an angle dimension. Click anywhere on a linear portion of the cross section. CAM2 determines the 
first line using the best points in a linear pattern. Click anywhere on the second linear portion of the cross section, 
select Angle, and CAM2 determines the second line and extracts the angle between the two lines.

Height
Height extracts a height dimension. Click anywhere on a linear portion of the cross section. CAM2 determines the 
first line using the best points in a linear pattern. Click on a second linear portion of the cross section parallel to the 
first linear portion, select Height, and CAM2 extracts the height between the two lines.

Dimension Label Position
You can reposition dimension labels and graphics in the Main window. Place your mouse cursor over a dimension 
to highlight the dimension. When the dimension is highlighted, click and drag the dimension to reposition it. Each 
dimension type has specific movable components:

• Radius: Click and drag the text. The callout line extends to the new text position.
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• Angle: Place the mouse cursor on the curved line joining the two angle lines. Click and drag the curved line or 
the text.

• Height: Place the mouse cursor on the line connecting the two portions of the dimension. Click and drag the 
line in a perpendicular direction.

Edit
Edit enables the selection tool you originally used to select points for the dimension. Click Edit and select new 
points. 

Update
Update confirms the dimension recalculation based on the new point(s) you picked.

Editing
The Editing group contains commands to edit and subsequently update the cross-section data used for dimension 
calculation. 

Define Area of Interest
Define Area of Interest enables a Rectangular selection of a specific cross-section area. Once you make a 
selection, the view zooms to that specific rectangular selection.

NOTE:  CAM2 removes all measurements and CAD outside of the defined Area of Interest. To restore the 
complete cross-section, click Reset.

Nominal
Nominal shows the portion of the cross-section scan that only contains nominal data. To restore the complete 
cross-section, click Reset.

Exclude Points
Exclude Points excludes selected points from the cross-section and from any cross-section calculations. Use the 
Selection Tools to choose the points to exclude. See “Selection Tools” on page 38.
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NOTE:  CAM2 hides the excluded points from view but does not delete them. To restore the excluded points, 
click Reset.

Reset
Reset restores any points removed by the Define Area of Interest, Nominal, or Exclude Points commands. 

Display
The Display group contains commands to configure the visual representation of the cross-section.

Tolerance Style
Tolerance Style switches between visual display modes for cross-section tolerances: 

None 

Tolerance Bands

Tolerance Lines

Connectors Style
Connectors Style switches between visual display modes for cross-section connectors: 

None

Connectors Polyline
 

Connectors Spline.

NOTE:  If you select the Connectors Spline style, cross-sections will Export to CAD as Spline entities. See 
“Export” on page 63.
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Whiskers
Whiskers shows feature whiskers in the Main Window.

NOTE:  You can adjust the whisker scale in the View tab’s 3D View group. See “Whisker Scale” on 
page 114.

Show Readings
Show Readings shows the actual readings in the Main Window.

View
The View group contains commands to manipulate the view of the cross-section: 2D Rotation, Reset, Rotate 90° 
Clockwise, Rotate 90° Counterclockwise, and Center Point.

2D Rotation
2D Rotation switches between a 3D rotation to view the cross-section outside of its cutting plane and a 2D rotation 
to rotate cross-section within the plane.

Reset
Reset resets the view to the default view. You can also press the R keyboard shortcut on the keyboard.

When you have finished configuring the cross-section view, click Capture View Data to save the view. See 
“Capture” on page 106.

Rotate 90° Clockwise
Rotate 90° Clockwise rotates the cross-section view 90 degrees clockwise.

Rotate 90° Counterclockwise
Rotate 90° Counterclockwise rotates the cross-section view 90 degrees counterclockwise.
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Center Point
Center Point defines the center of rotation when in 2D rotation mode.

Deviation Markers
Deviation Markers show deviation of the measured cross-section relative to CAD at any position on the CAD 
model. For more information, see “Pick Deviation” on page 106.

Pick
Click Pick to create deviation markers by picking them on the CAD model. The mouse cursor changes to a box 
with a selection arrow. Each time you click the CAD model, CAM2 creates a deviation marker and lists the 
marker’s number and XYZ coordinates on the left side of the Main Window. Click Pick again to exit picking 
mode.

NOTE:  You can automatically create a label at the high and low point on a cross-section, and also define 
markers at a fixed spacing by setting parameters in the cross-section’s properties. For more information, see 
“Construct: Cross-Section Scan” on page 254.

Manage
Click Manage to manage deviation markers for the cross-section. The Manage Deviation Markers dialog allows 
you to specify distance, number of markers, and zone size.

Highest/Lowest
Click Highest/Lowest to identify the highest and lowest deviations. The highest and lowest marker are each 
appended with a label.

View Data
Cross-sections can cover large areas, yet the most relevant information may be restricted to specific portions. 
Capture and recall saved views of specific areas for quick access and inclusion in your reports.

The View Data group contains commands to capture, delete, and recall captured views of the cross-section: 
Capture, Delete, and Recall.

FARO CAM2
Chapter 4: Home

FARO CAM2 2021 (v2021.0) Page 105 of 336



Capture
Capture saves a copy of the current cross-section view. Saved views appear in the Navigation Window’s Views 
folder (and also Report) in the order in which they were created.

Delete
Delete removes a saved cross-section view. Click a view in the Navigation Window’s Views folder, and click 
Delete.

Recall
Recall restores the last saved view. Click a view in the Navigation Window’s Views folder, and click Recall.

Close
Click Close to exit cross-section analysis mode. 

Pick Deviation
Click Pick Deviation to enter Deviation Marker picking mode. For more information, see “Deviation Markers” on 
page 120.

Show Feature Window
Show Feature Window displays a Feature window (DRO) for a selected feature. For more information, see 
“Show Feature Window” on page 124.

Document
The Document group contains the Capture View and Document Header Information commands.

Capture View
Capture View allows you to save a copy of the current view. For more information, see “Capture” on page 121.
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Document Header Information
Document Header Information allows you to view and edit the current measurement file’s header information in 
the Document Header Information window. You can also save the information as a default information set to 
recall later. The information entered here also appears on CAM2 reports. For more information, see “Report” on 
page 45.

In the Document Header Information window, you can:

• Control the visibility of each item:
1. Clear the Visible checkbox to the left of an item to hide the item from view.

2. Place a check in the Visible checkbox to show the item.

• Change the values for each item:
1. Select the Header item.

2. Click in the Value column and enter a new value.

NOTE:  The values remain for every new file until you change them.

• Add custom Header items:
1. Click Add New in the upper left corner of the Document Properties dialog box.

2. Enter a name for the item.

3. Click in the Value column and enter a new value.

4. Press Enter to accept the changes.

• Remove a custom Header item:
1. Select the Header item.

2. Click Delete to remove the item from the list.

NOTE:  You can only delete custom Header items.

• Reorder the Header items:
1. Select the Header item.

2. Click the Up and Down arrow keys to move the item up and down the list.

• Export a Document Header Information text file:
1. Click Export.

2. Enter a filename, browse to a save location, and click Save.

Tolerance Preferences
Tolerance Preferences quickly accesses the Tolerance section of the Preferences. For more information, see 
“Tolerance” on page 90.
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Copy Tolerances
Copy Tolerances copies all tolerances for a selected feature, and is used in conjunction with Paste Tolerances.

NOTE:  You have the option to include GD&T data when copying tolerances. See “Copy GD&T Tolerances ” 
on page 90.

Paste Tolerances
Select a feature, or multiple similar features, and run this command to paste a set of tolerances copied from another 
feature. Paste Tolerances is used in conjunction with Copy Tolerances.

Repeat
Repeat invokes the last used CAM2 command. You can also press the Enter keyboard shortcut on the keyboard. 

Properties
 Select a Feature.1 and use Properties to see and change parameters of any feature or CAD part. This command is 
a
lso available in the Shortcut Menus. See “Shortcut Menus” on page 310. 

You can change the properties of measured features. For more information, see “Feature Properties” on page 183.

CAUTION:  While you can not alter the actual results of a measured feature, adjusting these parameters can 
alter how the results calculate and display. 

You can change the properties of constructed and nominal features. For more information, click the Help button in 
the Edit dialog box. 

NOTE:  In the dialog boxes, Create is replaced by Modify. After changing any parameter, click Modify to 
save the changes. 

You can change the Part Properties. See “Part Properties” on page 96. 

You can view the flipped vector state of the feature or CAD part by checking the Vector Flipped checkbox.

Preferences
Preferences give you the controls to tailor CAM2 to your needs. User preferences may also be accessed from the 
File tab. See “Preferences” on page 67.

1When in a dialog box, click the drop-down arrow and scroll down to select a feature. You can also click the name of the feature with the Left 
Mouse button in the Features panel. To select a feature from the Main Window, move the pointer over the drop-down list box and click the 
From Screen icon that appears. This selects the drop-down list and you can then click a feature with the Left Mouse button in the Main Win-
dow. If the drop-down list is already selected, then just click the feature with the Left Mouse button in the Main Window.
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Clear Readings
Clear Readings clears all readings from all entities in the measurement file. 

NOTE:  To delete all of the readings from a specific feature, right-click the feature and select Delete 
Readings. See “Shortcut Menus” on page 310.

Flip Vector
Flip Vector flips the vector of a feature. This command flips the plane vector of a plane-reducible feature or line 
vector of a line-reducible feature.

NOTE:  A Flip Vector state remains associated with a feature until all readings are cleared using the Clear All 
Readings. Manually deleting all the readings (using the Readings tab) will not disassociate the “Flip Vector” 
state.

If the vector of a feature is used to define a coordinate system, and the coordinate system is then used for an 
alignment, flipping the feature’s vector will not change the displayed vector of the line since that is controlled by 
the alignment. However, the alignment will change and features may shift.

You can view the “Flip Vector” state of a feature by checking the Vector Flipped checkbox in the Feature Editor 
dialog (accessed with Properties).
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Chapter 5: View

The View commands are located in the View tab across the top of the screen. The View tab contains all the 
commands that affect how you see the contents of your measurement file on the screen. It also allows you to 
control what you see on the screen, and the user interface. The commands on the View tab are organized into 
Window, 3D View, Camera, Labels, Deviation Markers, and View Data groups. 

 
Window 112

3D View 114

Camera 116

Labels 118

Deviation Markers 120

View Data 121

Panels 122

Feature Readings 123
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Window
The Window group contains all the commands necessary to display CAM2 at full screen resolution, view closed 
panels, and work with layers. 

Full Screen
Select View > Full Screen to enlarge the CAD tab to fit the entire screen. You can also press the Shift + Alt + 
Enter keyboard shortcut on the keyboard. 

• Click Close Full Screen or press Esc to exit full screen mode. 

View Closed Panels
View Closed Panels accesses a list of closed (but accessible) panels. Click the name of the panel to access the 
panel. 

Layers
All CAD and CAM2 features add to the default layer. Use Layers as a way to group and organize features. You 
can show and hide layers to help simplify your CAD view. Changes made to layers are saved along with the 
CAM2 measurement file.

NOTE:  You can also access the Layers panel by clicking View Closed Panels on the View tab, and then 
Layers. See “View Closed Panels” above.

Viewing Features on a Layer 
To view all features associated with a layer, click the drop-down arrow to the left of the layer name to expand the 
layer contents. If the layer does not contain features, no arrow will be visible.

To the extreme right of all layers is the Visibility button (eye icon). Click the button to hide a layer. Once hidden, 
the button appears gray. Click the button again to show the layer. 

Creating a New Layer
1. In the Layers dialog box, click New Layer to create a new layer.

2. Enter a name for the layer.

3. To select a layer color for on-screen viewing, choose a color from the Override Color drop-down. You can also 
clear the color which sets the color to White. 

4. Clear the Visible box to hide contents of the layer on-screen. 
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NOTE:  You can also enable or disable visibility of a layer by clicking the Visibility button (eye icon). 

5. Clear the Enabled box to hide lock the layer. 

6. Click OK.

Editing a Layer
1. In the Layers dialog box, highlight the layer and click Edit or double-click on the layer name.

2. Edit a name for the layer, edit the override color from the drop-down, and enable or disable the visibility of the 
layer.

3. Click OK.

Deleting a Layer
In the Layers dialog box, highlight the layer and click Delete. 

NOTE:  Deleting a layer automatically moves any features back to the default layer. 

Adding Features to a Layer
You can assign any feature in the Navigation window to a layer:

• Click features in the Navigation window and drag them onto a layer in the Layers panel to associate them 
with the layer. See “Features” on page 34. 

• Right-click any feature in the Features panel, point to Assign a Layer, and choose a layer from the menu. 

NOTE:  To assign CAD features to a layer, click CAD at the bottom of the Navigation window. See “CAD” 
on page 37. 

Removing Features from a Layer 
You can remove any feature from a layer: 

• Click the arrow to the left of a layer to expand and view a list of the features on the layer. 

• Click Delete (red X) to the right of the feature. 

NOTE:  You can also drag a feature to another layer. 
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3D View
The 3D View group contains all the commands necessary to select a shading mode, work with layers, configure 
point size and whisker scale, select and configure custom tolerance indicators, show the grid, and show or hide 
targets. 

Shading Mode
Shading Mode controls the way in which CAM2 applies shading to the view (Shaded + Wireframe, Shaded, and 
Wireframe). The Shaded +Wireframe view is the default view. You can also press the S keyboard shortcut on the 
keyboard to switch between the three shaded and wireframe views.

Show/Hide
Show/Hide controls the visibility of feature and feature groups in the Main Window. Select one or more features 
in the Features panel, then click Show-Hide to hide the selected feature(s). While the selection is hidden, the 
features remain in the Features panel but are not shown in the Main Window. The eye icon appears gray for the 
selection, indicating “hidden” status. Click Show-Hide again to show the feature(s).

NOTE:  You can also access this command in the Navigation Window. See “Navigation Window” on 
page 33.

Show Only Selected
Click the drop-down below Show/Hide to access Show Only Selected. Click Show Only Selected to make only 
selected features visible and all other features invisible.

NOTE:  Show Only Selected also affects folder visibility, though it will not affect the visibility of the features 
in the folder. CAM2 will only show those features set as visible.

Readings Size
Readings Size controls the size at which CAM2 renders points. Use the slider to adjust the size from small (far 
left) to very large (far right). 

NOTE:  To scale the size of Point Features, see Point Feature Size in the Display group of Preferences. See 
“Point Feature Size” on page 70.

Whisker Scale
Whiskers are a single line that visually represent distance data of a feature. There are two types of whiskers: 

• Whiskers - The whisker shows the deviation of each reading to the feature.

• Nominal Whiskers - The whisker shows the deviation of the measured feature to its nominal.
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NOTE:  Nominal Whiskers will not display unless there is a nominal associated to the measured feature.

You can change the scale of the feature whiskers by clicking the up and down arrows or entering a value.

Select a feature from the Features panel, or the CAD View, and click either Whisker command. The whiskers 
change color according to tolerance condition:

• Green - feature is in tolerance

• Red - measurement is above the upper tolerance

• Blue - measurement is below the lower tolerance

You can also access this command by right-clicking on a feature.

Custom Tolerances
The Custom Tolerances drop down contains a list of available tolerance indicators for your measurement file: 

• Rainbow (Default) - tolerance conditions are identified by seven corresponding colors.

• Go/No-Go - tolerance conditions are identified by green (in tolerance) and red (out of tolerance).

• Tri-State - tolerance conditions are identified by green (in tolerance), red (above upper tolerance), and blue 
(below lower tolerance).

Use Manage Custom Tolerances to create, edit, import, export, and delete customized sets of tolerance indicators. 
See “Manage Custom Tolerances” below.

Manage Custom Tolerances
The Manage Custom Tolerances window contains color bars that correspond to tolerance conditions (by 
percentage in/out), and triangles that you can use to specify tolerance indication color schemes. 

When you select a tolerance in the Custom Tolerances drop down, the measurement file displays tolerance 
indicator colors according to the triangles you’ve configured.

Add a Custom Tolerance Indicator
To add a custom tolerance indicator, click Add and enter a name for the new color scheme.

Below the name is a line of color boxes that are placeholders to define colors. Each placeholder represents a 25% 
increment in the tolerance band and the full span of placeholders covers -300% (3x below Lower Tolerance) to 
+300% (3x above upper tolerance).

• Define a placeholder color by double-clicking the placeholder to create a colored triangle. Right-click a 
triangle to select the placeholder color or delete the triangle. 

• Drag and drop triangles to move them.

NOTE:  Placeholders without triangles will appear as follows:

• When to the left of the left-most triangle, the color will match the left-most triangle.

• When to the right of the right-most triangle, the color will match the right-most triangle.
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• When between two colored triangles, the color will be a gradient of the two triangle colors. The steps of 
the gradient are determined by the number of placeholders between the triangles.

• Click OK to save your custom tolerance color scheme.

Delete a Custom Tolerance Indicator
To delete a custom tolerance indicator, highlight the tolerance indicator and click Delete.

NOTE:  The Rainbow, Go-NoGo, and Tri-State tolerance indicators cannot be deleted.

Export (Save) and Import your custom tolerance indicators using the Export and Import buttons.

Grid
Show-Hide Grid shows or hides the grid in the current view. You can also press the Number Sign (#) keyboard 
shortcut on the keyboard. The grid is only visible in the +X/-X View, +Y/-Y View or +Z/-Z View Preset Views. 

Show/Hide Targets
Show/Hide Targets shows or hides point cloud targets in the current view.

Camera
The Camera group contains all the commands necessary to configure the view. 

Preset Views
The Preset Views drop down contains a set of view rotations to a fixed position. All Views respond to the current 
alignment. 

+X/-X View
+X/-X View sets the positive XZ plane parallel to the screen. Select the command again to set the negative XZ 
plane. You can also press the 4 keyboard shortcut on the keyboard. 

+Y/-Y View
+Y/-Y view sets the YZ plane parallel to the screen. Select the command again to set the negative YZ plane. You 
can also press the 5 keyboard shortcut on the keyboard. 

+Z/-Z View
+Z/-Z view sets the XY plane parallel to the screen. Select the command again to set the negative XY plane. You 
can also press the 6 keyboard shortcut on the keyboard. 
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Isometric SE
Isometric SE sets a southeast isometric view looking at the current alignment parallel to the screen. You can also 
press the 7 keyboard shortcut on the keyboard.

Isometric SW
Isometric SW sets a southwest isometric view looking at the current alignment parallel to the screen. You can also 
press the 8 keyboard shortcut on the keyboard.

Isometric NE
Isometric NE sets a northeast isometric view looking at the current alignment parallel to the screen. You can also 
press the 9 keyboard shortcut on the keyboard.

Isometric NW
Isometric NW sets a northwest isometric view looking at the current alignment parallel to the screen. You can also 
press the 0 keyboard shortcut on the keyboard.

Reset View
Reset View returns the view to the default settings of your current preset view. You can also press the R keyboard 
shortcut on the keyboard. 

Recenter View
Recenter View centers the contents of the Main Window according to the active coordinate system. 

Reset Rotation
Reset Rotation returns the view rotation to the default view. 

Zoom To Area
Zoom To Area zooms to a user-defined window of the CAD view. You can also press the W key on the keyboard.

1. Move the mouse pointer to the area of the screen where you want to begin.

2. Click and hold the Left Mouse button.

3. Drag the mouse to create a window for the view.

4. Release the Left Mouse button to set the view.

You can also use the keyboard and mouse to zoom the view without using this command. To zoom to a window:
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1. Press and hold the Shift key on the keyboard.

2. Click and hold the Left Mouse button. 

3. Drag the mouse to create a window for the view.

4. Release the Left Mouse button to set the view.

5. Release the Shift key to end.

Reset Zoom
Reset Zoom resets the zoom so that all features in the Main Window are visible. 

2D Rotation
2D Rotation switches between 2D rotation and 3D rotation. 

Rotate 90° Clockwise
Rotate 90° Clockwise rotates the view 90 degrees clockwise. 

Rotate 90° Counterclockwise
Rotate 90° Counterclockwise rotates the view 90 degrees counterclockwise. 

Center Point
Center Point defines the center of rotation when in 2D rotation mode. 

Labels
Use the Labels commands to arrange, show, hide, and control the detail level of labels. To apply a label to a 
feature, right-click the feature in the Feature list or the main window, then select a Label and Label Style.

 Label Styles
CAM2 has four default label styles:

Simple

NOTE:  The color and icon indicate the overall status (such as maximum deviation) of all feature details.

FARO CAM2
Chapter 5: View

FARO CAM2 2021 (v2021.0)Page 118 of 336



Detailed

NOTE:  The status color and icons indicate the deviation of the individual feature details.

Surface Point

   Callout

NOTE:  The color and icon indicate the dN detail deviation.

CAM2 can display labels as 2D or 3D using the Front Facing icon.

Arrange
Click Arrange to select one of three different label arrangements. See “Labels” on page 191.

Add or remove on-screen labels by right-clicking a feature and selecting Label.

NOTE:  You can configure the appearance of labels and enable them to auto-arrange via the Display 
preferences in the File > Preferences menu. For more information, see “Display” on page 69.

Show All Labels
Show All Labels makes all on-screen labels visible in the current view. 
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Hide All Labels
Hide All Labels removes all on-screen labels from the current view. 

Scale To Screen
Scale To Screen automatically sizes labels relative to the screen and maintains their screen size as you zooms in or 
out of the 3D viewer.

NOTE:  To remove a callout label from the screen, right-click on the callout and select Delete Callout. 

Labels Front Facing
Labels Front Facingdisplays labels as 2D (front facing on) or 3D (front facing off).

NOTE:  When you deselect Front Facing, labels will revert to their previous orientation. 

Label Readings
Label Readings creates callout labels on point cloud, polyline, polyline group, and cross section features. When 
enabled, click the point cloud, polyline, polyline group, or cross section to create numbered labels showing the 
deviation at the point you clicked. The label numbers correspond to discrete callouts in the report data. 

NOTE:  To remove a callout label from the screen, right-click on the callout and select Delete Callout. 

Deviation Markers
Deviation markers show deviation of the measured part relative to CAD at any position on the CAD model. They 
remain associated with the CAD model after you clear or delete an associated point cloud, and they will continue to 
show deviation when you record new point cloud data.

Use the Deviation Markers commands to create and adjust deviation markers. 

Pick
Click Pick to enter picking mode. Create deviation markers by picking them on the CAD model. The mouse cursor 
changes to a box with a selection arrow. Each time you click the CAD model, CAM2 creates a deviation marker 
and lists the marker’s number and XYZ coordinates on the left side of the Main Window. Click Pick again to exit 
picking mode. 
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Generate
Click Generate to create a series of deviation markers using a custom grid overlay.

Drag the mouse pointer to define a rectangular area on your CAD model. To make adjustments:

• Click and drag the center of the rectangle to move it. 

• Click and drag the lower right corner of the rectangle to make it bigger or smaller. 

• Click and drag the upper center of the rectangle to rotate it. 

• Click and drag the red circles along the axes to adjust the grid spacing. You can also key-in exact values.

When you’re ready to create the deviation markers with your grid, press Enter. To cancel the operation at any 
time, press Esc. 

Key-In
Click Key-In to create deviation markers by typing in the XYZ value and threshold.  Typing values in different 
units and coordinate systems.1

Z
one Size
Zone Size controls the size of all deviation markers. Enter a different number in the box to adjust the size. The 
default value is 1 mm. 

Delete
To delete a deviation marker, mouse over the deviation marker on the left side of the Main window and click the X 
in the upper right corner. 

View Data
The View Data group contains commands to capture, delete, and recall custom views: Capture, Delete, and Recall. 
You can access views in the Views panel and include them in reports using the Report window. For more 
information, see Views on page 27 and Report on page 45. 

Capture
Capture saves a copy of the current view. Saved views appear in the Views panel  (and also Report) in the order in 
which they were created. 

1You can type a value in any unit, and CAM2 2020 converts the value to the default unit value. For example, the default value is 0,0,0 mm but 
your feature is 5,5,10 inches. Type 5in, 5in, 10in and CAM2 2020 automatically converts the value to 127, 127, 254 millimeters. To change the 
coordinate system, click the arrow on the right side of the dialog box and select from the menu. CAM2 2020 automatically converts the values 
to the current coordinate system during the feature construction.

FARO CAM2
Chapter 5: View

FARO CAM2 2021 (v2021.0) Page 121 of 336



Delete
Delete removes a saved view. Click a view in the Views panel and click Delete. 

Recall
Recall restores the last saved view. Click a view in the Views panel and click Recall. 

Export As Image
Export As Image exports the current view to an image file (PNG, JPEG, or BMP format). 

Panels
The Panels command shows a list of the hidden panels. By Default, many of the panels are hidden. 

CAD Part Properties
The CAD Part Properties panel contains all loaded CAD parts, the material properties of each CAD part, and 
controls to modify the global properties of any CAD part. 

Figure 5-1 CAD Part Properties panel

For more information, see “Part Properties” on page 96.

Feature Information
The Feature Information panel contains a list of nominals and tolerancing information for a selected feature 
(replicated in feature labels). 

Figure 5-1 Feature Information panel

For more information, see “Nominals and Tolerances” on page 194.

NOTE:  Only the tolerance value itself may be edited; any additional data used to compute the GD&T 
Tolerance can only be edited in the GD&T panel. For more information, see “GD&T” on page 287.
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Layers
The Layers panel contains the list of layers and features assigned to each individual layer. For more information, 
see “Layers” on page 112.

Measurement
The Measurement panel contains the current location of the measuring device’s probe and updates as the probe 
moves through space. The numerical setup of the Measurement panel is a preference. See “Units Tab” on 
page 74.

Figure 5-1 Measurement panel

For more information, see “Measurement Panel” on page 188.

Messages
The Messages panel contains informational messages relating to the measurement file.

Figure 5-1 Messages panel

Measurement Data
The Measurement Data panel contains a list of measurement readings and properties (including XYZ, Deviation 
from Fit, Device Position, and Probe) for a selected feature. 

Figure 5-1 Measurement Data panel

For more information, see “Measurement Data” on page 192.

Feature Readings
Feature Readings shows/hides points that represent the measured readings. Access this command by right-clicking 
on a feature. 

You can change the size of the feature reading point in Preferences. See “Readings Size” on page 70. 
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Select a feature from the Features panel, or the CAD View, and click Feature Readings. The readings change 
color:

• Green (Pass) - reading is in tolerance.

• Red - reading is above the upper tolerance.

• Blue - reading is below the lower tolerance.

The color shows the deviation of each reading to the feature, and uses the Form tolerance. See “Tolerance 
Preferences” on page 63. 

Show Feature Window
Show Feature Window displays a Feature window (DRO) for a selected feature. Access this command from the 
Home menu, by right-clicking on a feature, or pressing the D key on the keyboard.

Use a Feature window to:

• See the live deviations of a specific feature based on the current location of the probe, including normal (dN) 
and radial (dR) deviations for circles and cylinders.

• In an assembly, guide a part into position using the coordinate values of a specific feature on the part.

NOTE:  Each Feature window remains until individually closed.

Configure the Feature window using the controls at the top of the window:

1. Show Options - In the upper left corner of the window, click the Show Options drop-down and select, or 
deselect, values to show or hide different deviation values.

2. Probe Compensation - In the middle is Probe Compensation. Click this button to see the deviation values 
relative to the compensated probe location; click again to see the deviation values relative to the probe center.

NOTE:  The Apply Compensation in Feature Windows  preference determines whether probe compensation 
should be applied to all future Feature windows. See “Apply Compensation in Feature Windows ” on page 79.

3. Lock to Feature - To the right is Lock to Feature. When enabled, the Feature window stays locked to the 
current feature. When not enabled, the Feature window will float to the closest feature (not including CAD).

4. Treat Entities as CAD - When you have locked the window to the current feature, use Treat Entities as CAD 
to designate CAD entities as features when moving the probe.

The deviation values change color:

• Green - the deviation is in tolerance.
• Blue - the deviation is out of tolerance in the negative direction.
• Red - the deviation is out of tolerance in the positive direction.

NOTE:  The values are uncompensated except for the 3D value for surfaces.

You can show tolerance value colors in the DRO’s background using the Apply Tolerance Color to Background  
preference. For more information, see “Apply Tolerance Color to Background ” on page 76.
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3D Distance and Normal Deviation
3D Distance is the distance from a point to a surface represented by XYZ coordinates. Normal Deviation (dN) is 
the simple 3D distance from a point to a surface along the normal vector.

For theoretically infinite features, such as planes or cylinders, the 3D Distance is equal to the Normal Deviation.

For features with trimmed edges, such as surfaces, the 3D Distance is equal to the Normal Deviation if the 
projected point is in the middle of the surface. If the point being compared is off to the side, falls on the edge, or is 
otherwise outside the bounds of the surface, the 3D Distance will likely be larger than the Normal Deviation.

For vector points with a fixed nominal point, the 3D Distance will likely be larger than the Normal Deviation if the 
actual falls outside the zone.
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Chapter 6: Devices

The Devices commands are located in the Devices tab across the top of the screen. The Devices tab contains all the 
commands used to configure measuring devices, and the commands are organized into Setup, FaroArm, FARO 
Laser Tracker, and 6Probe groups. 

 
Setup 128

FaroArm 136

FARO Laser Tracker 136

6Probe 139

FARO 3D Imager 139
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Setup
The Setup group contains all the commands necessary to configure, manage, and move your measurement device
(s).

Device Center
Device Center accesses the Device Center panel. The Device Center panel contains a list of all active (detected) 
devices with the properties of each associated device. You can also press the P keyboard shortcut on the keyboard.

The Device Center panel automatically manages device connections. If an error or connection issue occurs, the 
Device Center panel will detect the issue and automatically reconnect to your measurement device without 
affecting the performance of CAM2.

Available devices are shown as tiles, and each tile contains the device’s image, model, serial number, and active 
probe (FaroArm) or SMR (FARO Laser Tracker).

See the CAM2® 2021 chapter in the current device’s manual for more details about hardware setup and 
configuration. 

Figure 6-1 Device Center

When you access Device Center, all connected measurement devices will be shown as Available. If your device is 
connected but not shown, you can manually add the device.

Add a Device
From the Device Center panel, click + and select New Device. Device Center will search and list all connected 
devices. Select an eligible device from the Select Device Type dialog, and once connected your device will be 
shown as Available.

NOTE:  If you are attempting to connect a FARO Laser Tracker or 3D Imager and Device Center is unable to 
connect automatically, you can manually enter the IP address or serial number of the device. To connect to an 
Imager Array, first create the Array by connecting and selecting the required 3D Imagers.

Configure a Device
From the Device Center panel, click the device’s tile. The expanded view contains detailed Device information 
(status, model, serial number, firmware version, compensation date), Probe information (type, compensation date, 
temperature, error), and setup options.
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Measurement Mode Setting
This preference defines how the measurement device performs measurement. 

• Single Point Mode: The measurement device takes a single point.

• Distance Based Mode: The measurement device takes points at a specified distance interval (specify the 
distance).

• Time Based Mode: The measurement device takes points at a specified time interval (specify the time in 
milliseconds).

Multiple Devices
You can connect and use multiple measurement devices simultaneously, with a single software license, without 
changing computers and merging data. You can connect any combination of FaroArms, FARO Laser Trackers, 
and/or FARO 3D Imagers and Arrays. 

This procedure to connect and define multiple devices involves measuring a set of features with each device, and 
using the Device Manager to assign the features to the second device and calculate each position. For more 
information, see “Manage Devices” on page 130. 

For the Super6DoF solution, use the TrackArm wizard. See “Locate TrackArm” on page 135.

To configure multiple devices for simultaneous measurement, perform the following steps:

1. Locate three point-reducible features and ensure that each device can reach each feature. 

NOTE:  You can use more than three features. 

2. Connect all cables for each device to your computer, power on your devices, computer, and start CAM2. 

3. Now connect and define your measuring devices in the CAM2 file: 
• Open the Device Center and manually connect any device that has not automatically loaded. For more 

information, see “Device Center” on page 128. 

• Measure the three point-reducible features. Notice the device name, usually the serial number in the 
Measurement Panel and measure with that device. This is the default device. For more information, see 
“Measurement Panel” on page 188.

• Measure the three point-reducible features with the second device. In the Features panel, right-click each 
feature and select Add Readings From... and select the second device. For more information, see “Add 
Readings ” on page 197. 

4. Use the Device Manager panel to calculate each position: 
• On the Device tab, select Move Device to access the Device Manager panel. Notice each device and that 

the first device (default) is first on the list. 

• Select Device Position 1 of the second device and use the Select a Feature drop-down to add the point-
reducible features. 

• Click the Solve button. 

Both devices are now measuring together in the same coordinate system. You can add more devices in the same 
manner.
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Manage Devices
Select Device > Manage Devices from the Devices tab to access the Device Manager panel. Use the Device 
Manager panel to update device properties (including edit a device name, disconnect and remap a device, show the 
Measurement panel), and export, import, or configure a device position.

NOTE:  If you are using the Probing Version of CAM2, the FARO 3D Imager and FARO Laser Line Probe 
are not eligible for use. See “Probing Version” on page 9. 

Figure 6-1 Manage Devices

Device Properties
The Properties portion of the Device Manager panel allows you to edit a device name, disconnect and remap a 
device, show the Measurement panel, and configure a device position. Select a device on the left side of the panel 
and execute the following commands:

Edit a Device Name
To edit the name of a device, click in the Name box and input the name as desired.

NOTE:  The device name entered here persists throughout the measurement file.

Disconnect a Device
To disconnect a device from CAM2, click Disconnect to the right of the Serial Number box. The status of the 
device will update in the Status box as “Disconnected”.

Show/Hide Measurement Panel
To constantly show the Measurement panel, select the Show Measurement panel checkbox. Clear this checkbox 
to only show the window during Add Readings . For more information, see “Add Readings ” on page 197.

Set Active
To set a device as default, click Set Active. The Add Readings, Remeasure, and all Measure commands 
automatically use the default device. 

New Position
To create a new device position for a device, click New Position. This creates a new and active device position for 
the device. 
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Device Position
Select the device’s position to access Device Position in the Device Manager panel.

Device Position stores the location of the device relative to the measurements of your part. If you move or change 
the device, Move Device creates another device position that allows you to continue measuring in the same file. 
You can also continue measuring to the same feature from another device position. See “Add Readings ” on 
page 197.

All readings of measured features are labeled with the current device position. If you create another device position 
and add readings to a measured feature, you can see the readings sorted by device position. See “Measurement 
Data” on page 192.

If you edit or redefine a device position, only the readings in that device position are updated. All of this is 
independent of any Coordinate System, but any updated features that are included in the alignment cause a 
recalculation of the alignment.

NOTE:  The default device position (Device Position) for each device is in every new file and may not be 
deleted. 

Select an existing device position to:

Set an Active Device Position
To designate the device position as active, click Set Active to the right of the Name box. The status of the device 
position will update in the Devices/Positions box as “Active”.

Make a Root Device Position
To designate the device position as the reference for all devices, right-click the device position and select Make 
Root. All device positions will be relative to the root position.

Remove a Device Position
To remove the device position, click Clear to the right of the Name box.

Add and Measure Device Position Features
Define with Features tab
•  Select a Feature.1 

• You can also select 
features from the CAD View, or the Features panel before running the command:

1. Select the features.

2. Create a Device Position.

3. Click Add Features in the Details box. 

• Remove any feature by clicking the X next to the drop-down arrow to the right of the feature name. 

1When in a dialog box, click the drop-down arrow and scroll down to select a feature. You can also click the name of the feature with the Left 
Mouse button in the Features panel. To select a feature from the Main Window, move the pointer over the drop-down list box and click the 
From Screen icon that appears. This selects the drop-down list and you can then click a feature with the Left Mouse button in the Main Win-
dow. If the drop-down list is already selected, then just click the feature with the Left Mouse button in the Main Window.
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• Select the Use Nominal check box to use the feature’s nominal instead of the previously measured value. 

Define with TrackArm tab: 
• Select a Laser Tracker.

• Lock the beam onto the SMR and mount it onto the FaroArm. 

• Press the Front green button to activate the Measurement Mode Setting. See “Measurement Mode Setting” on 
page 129.

NOTE:  CAM2 automatically selects the correct probe and SMR size if you have already defined them in the 
Manage Probes window.

• Press the Front green again to begin scanning. Move the FaroArm in free space. When complete, press the 
Back red button to view the results of the Device Position. 

• Press the Back red again to accept the results, or press the Front green to remeasure.

Operations box: 
• Remeasure All - measure all of the device position features in the list. 

• Remeasure Selected - measure any selected features in the list. 

Click Apply/Solve to define the device position. Select the Fit Scale check box to calculate the fit by scaling the 
features. 

Results box: 
• The Number of Iterations of the device position solution. 

• The maximum Error between the measured and nominal features. 

NOTE:  The 3D, X, Y, and Z errors for each feature to its nominal are listed to the right of the feature name.

• Any calculated Scale of the device position solution. 

Click Close to exit the Device Manager panel.

NOTE:  FARO advocates the use of only precision-made, repeatable tooling to define device positions. The 
FARO tooling kit is comprised of precision spheres and/or “cone” mounts with magnetic bases, which serve as 
highly repeatable artifacts to minimize error in the device relocation process. Measured features such as circles 
greatly increase the risk of error in the device relocation process due to potential errors in measurement and 
manufacturing defects. Errors in the device relocation process will compound, which in turn will compromise 
the accuracy of all subsequent measurements taken on the part. 

Import Reference Points
Select Devices > Import Reference Points from the Devices tab to import a text file (*.txt) containing ERS 
(External Reference System) points into the current measurement file. 

FARO CAM2
Chapter 6: Devices

FARO CAM2 2021 (v2021.0)Page 132 of 336



Move Device
Select Devices > Move Device from the Devices tab to access the Move Device Position wizard. Use the Move 
Device Position wizard to select the device to move, and choose the target selection method (automatic or manual). 
You can also press the M keyboard shortcut on the keyboard. 

Figure 6-1 Move Device

A Device Position is the location of the measurement device relative to the measurements of your part. To continue 
measuring in the same measurement file after moving or changing a device, you must create another device 
position.

NOTE:  Selecting Device > Move Device from the Device menu automatically creates a New Device Position 
for you to configure. This new device position exists until you highlight it and click Remove.

To create a new device position, perform the following steps:
1. Measure a minimum of three point-reducible features with the device in the current device position. All point-

reducible features are valid except for cones, the tips of which are difficult to accurately reproduce in tactile 
metrology.

NOTE:  You can only use point-reducible features in the Move Device Position wizard. See “Measuring a 
Point” on page 155.

2. Move the measurement device to a new location.

3. Select Devices > Move Device. The Move Device Position wizard appears. 

4. Choose the device you want to move, and choose the target selection method (automatic or manual). Click Next. 

Figure 6-2 Target Measurement
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NOTE:  Automatic target selection is available only when there are three point features in the file. It is not 
available with spheres or if there are more than three point features in the file.

Automatic 

1. Click Manage Target Points. The Manage Target Points window contains all Point features in the current 
measurement file. 

• If necessary, use the Search field to enter filtering text to help you locate points. 

• Click a point to add it to the target list. The point highlights and the target icon appears. 

• Click a selected target to deselect it. The target icon disappears. 

• Click OK to confirm the list of target points. CAM2 will associate the list of selected targets with the 
measurement file, and will use the list for future device moves.

2. Move your device and remeasure a single reading for each selected target point.

3. Watch the Measurement panel and the Move Device Position dialog box to see your progress with each 
target point. As you measure the target points, the marker to the left of the point name becomes green.

4. After you measure the target points, CAM2 calculates the device position and the standard deviation and 
maximum error appear in the Move Device Position dialog box. 

5. Click Finish to save the device position, or click Previous to remeasure the target points. 

Manual 

1. All of the point features in the file move into the right side of the Move Device Position dialog box. Use the 
arrow buttons to move any unwanted feature to the left side of the dialog box. Click Next. 

2. Move your device and remeasure a single reading for the target points. 

3. Watch the Measurement panel and the Move Device Position dialog box to see your progress with each 
target point. As you measure the target points, the marker to the left of the point name becomes green.

4. After you measure the target points, CAM2 calculates the device position and the standard deviation and 
maximum error appear in the Move Device Position dialog box.

5. Click Finish to save the device position, or click Previous to remeasure the target points. 

You can review and edit this device position with the Manage Devices command. See “Manage Devices” on 
page 130. 

NOTE:  FARO advocates the use of only precision-made, repeatable tooling to define device positions. The 
FARO tooling kit is comprised of precision spheres and/or “cone” mounts with magnetic bases, which serve as 
highly repeatable artifacts to minimize error in the device relocation process. Measured features such as circles 
greatly increase the risk of error in the device relocation process due to potential errors in measurement and 
manufacturing defects. Errors in the device relocation process will compound, which in turn will compromise 
the accuracy of all subsequent measurements taken on the part. 
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Export and Import Device Position
Once you create the device position using the Device Manager panel, you may export the device position to a 
CAM2 device position file (*.fdp) or CAM2 Measure X device position file (*.xdp) to be recalled later.

NOTE:  The default import/export directory is configured in the Preferences window. For more information, 
see “Preferences” on page 67.

To import a device position from a CAM2 device position file (*.fdp) or CAM2 Measure X device position file 
(*.xdp), click Import to the right of the Status box. Browse to the device position file and click Open.

To export a device position to a CAM2 device position file (*.fdp) or CAM2 Measure X device position file 
(*.xdp), click Export to the right of the Status box. Enter a name for the device position file and click Save.

Once a device position file is exported, it can be imported into any measurement file or recalled into a QuickTools 
program.

Save and Load Device Setup
CAM2 allows measurement with more than one device, each with a unique device position, within a single 
measurement file. Once you create positions for each device, you can save and load these setups for future use.

NOTE:  The default import/export directory is configured in the Preferences window. For more information, 
see “Preferences” on page 108.

Once you create device positions for each device in the measurement file using the Device Manager panel, click 
Save Setup. This saves the relationship between multiple, fixed devices for future use.

Click Load Setup to load saved positions for multiple devices.

NOTE:  If the measurement file does not contain the same devices with which you initially saved the setup, 
Load Setup is unavailable.

Locate TrackArm
Select Devices > Locate TrackArm from the Devices tab to access the Locate TrackArm wizard. Use the Locate 
TrackArm wizard to align a FaroArm or FARO ScanArm (with Tracker kit) to a FARO Laser Tracker, so that 
both systems are measuring within the same coordinate system. 

NOTE:  This command is only available when your FaroArm and FARO Laser Tracker are connected and 
available in the Device Manager. For more information, see “Manage Devices” on page 130.

Calibrate and locate the TrackArm probe to generate the 3D path, which both devices capture simultaneously. 
CAM2 then uses the 3D paths to calculate the spatial alignment of the FaroArm relative to the FARO Laser 
Tracker, and to compute the relocation accuracy of the FaroArm. Each position is calculated using the FARO Laser 
Tracker as the root position.

You can use the TrackArm Wizard multiple times to relocate the FaroArm without compounding positional errors 
which may occur using the standard Move Device method. See “Move Device” on page 133.
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Select Measurement Device
If you have multiple devices connected to CAM2, use the Select Measurement Device drop-down to select a 
specific device. See “Multiple Devices” on page 129.

FaroArm
The FaroArm group contains the  FARO Laser Line Probe Settings command. Click Laser Line Probe to access 
Laser Line Probe settings.

FARO Laser Tracker
The FARO Laser Tracker group contains all the commands necessary to interface with your FARO Laser Tracker 
using CAM2.

Use commands to control the Laser Tracker instead of hardware buttons. Buttons (and their associated keyboard 
shortcuts) on the Measurement Panel are used for recording a reading (G), recording an end click (H), and 
removing the last reading (Backspace). For more information, see “Measurement Panel” on page 188.

Self Compensation
Self Compensation starts the Laser Tracker’s Self Compensation routine. When complete (approximately five 
minutes), the Laser Tracker System is within the pointing accuracy specifications and ready to measure. 

NOTE:  This feature is called Quick Compensation when used with the Laser Tracker Vantage.

After the Self Compensation routine, Angular Accuracy Checks should be used to verify the accuracy. See 
“Angular Accuracy Checks” below.

Angular Accuracy Checks
Angular Accuracy Checks starts the Laser Tracker’s Angular Accuracy Check routine, which verifies 
measurement accuracy during the course of a measurement session with minimal disruption. This check should be 
performed before each measurement session or if the temperature has changed more than 5° Fahrenheit.

Measure Level
Measure Level is a type of hybrid measurement/construction command that uses the built-in level functionality of 
the Laser Tracker to produce a plane level to the ground (relative to the Laser Tracker) and through another 
measured point. You can use this feature as an Active Projection plane. See “Projection Plane” on page 181.

• Select Devices > Measure Level to start the measurement of the level plane. 

• When complete, a point feature automatically adds to the measurement file. Measure this point to locate the 
level plane. 
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It is not possible to add readings to a level feature, nor is it possible to edit a level feature by re-sampling the Laser 
Tracker to obtain a new level vector. However, you can measure another point and relocate the level plane by 
editing it’s properties. See “Feature Properties” on page 183.

Motor On Off
Motor On/Off switches on or off the motors that control the movement of the FARO Laser Tracker’s laser beam.

Follow Me On Off
Follow Me On/Off switches on or off the automatic search using the FARO Laser Tracker’s cameras.

Smart Find
Smart Find prompts the Laser Tracker Vantage to locate an SMR using its on-board camera and aim at it.

NOTE:  Smart Find is available only for the Laser Tracker Vantage.

Aim
Aim aims the Laser Tracker at a selected feature, and allows you to select a feature from the Features panel or the 
CAD window and aim the Laser Tracker at the center of the selected feature. 

The Laser Tracker must be the active device in the Device Center panel to start this command.

With two or more measurement devices connected, AIM functionality is optimized if the devices are related using 
device positions. For more information, see “Device Position” on page 131.

NOTE:  Aim is included in the Measurement Data panel to allow aiming at individual readings of measured 
features. See “Measurement Data” on page 192.

Reset
Reset moves the Laser Tracker to the current Reset Point location. If there is a current Reset Point defined, the 
Laser Tracker executes Aim using the specified reset point as the target. If there is no Reset Point, the Laser 
Tracker executes Home and returns to the home position for the selected SMR family.

Search
Search prompts the Laser Tracker to begin a search pattern in an attempt to locate a SMR. Search parameters are 
specified in the preferences.
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Change Adapter
Change Adapter inserts a prompt within a QuickTools program to change the probe adapter. For more 
information, see “Change Adapter” on page 147.

Manage Reset Points
Manage Reset Points allows you to configure an optional Reset Point. If set, the Reset Point acts as an override 
for the home location. You may revert the Reset Point back to home.

NOTE:  Using the Home position for a reset is not the same as using an overridden Reset Point.

Select Manage Reset Points to show the Manage Reset Points panel.

Set Backsight
Set Backsight switches the FARO Laser Tracker to Backsight mode.

Drive Beam
Drive Beam moves the FARO Laser Tracker’s laser beam.

Bundle Adjustment
Bundle Adjustment adjusts multiple device positions at once by refining redundant measurements into the best 
possible point coordinates. This command becomes available when you have multiple device positions with at least 
4 (non-coplanar) measured points.

CAM2 will bring up a Wizard to assist in setting up the alignment.

1. Select the device positions.

2. Select the targets from the list of all measured targets.

3. Configure the Bundle Adjustment calculation parameters:

• Calculation Mode

• Sequential - Bundle Adjustment is performed every time before calculation of initial guess for next 
transformation matrix. This setting increases accuracy, especially for long chains of Device Positions.

• One Step - Initial guesses for all transformation matrices are calculated, then bundle adjustment is 
performed once for all data. This setting increases computation speed.

• Parameterization Mode

• Euler Angles (3 parameters)
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• Quaternions (4 parameters)

• Error tolerance

• Input Tolerance Error - This parameter enforces that all readings taken on a single point from a single 
Device Position must all be located within a sphere with a diameter less than this value.

• Results Tolerance Error - Once the Bundle Adjustment is solved, all resulting readings for each target 
must be located within a sphere with a diameter less than this value.

• Device Errors

• These values represent the standard reported errors of angular and radial measurements for the Laser 
Tracker. These values should only be modified if known.

4. View connectivity of all positions on the Target Relationship Map.

NOTE:  A line connecting 2 positions represents the existence of common targets between those two 
positions. At this point, CAM2 provides an idea of how good the outcome of the Bundle Adjustment may be. 
If any error situation is identified, explanatory text will appear in the right-hand column.

5. View the results of the Bundle Adjustment in the Results window. Use Print to print the contents of the Results 
window.

6Probe
The 6Probe group contains all the commands necessary to interface with your 6Probe using CAM2. For more 
information about the setup and operation of the FARO 6Probe, see the FARO® Laser TrackerVantage user 
manual. 

Probe Management
Use the Probe Management command to access the 6Probe Management panel. Use the 6Probe Management 
panel to add, setup, compensate, and check a 6Probe. 

Probe Customization
Use the Probe Customization wizard to customize up to 12 different commands by configuring actions in the 
Click, Double Click and Long Press drop downs. Operations assigned to a button are shown in bold.

FARO 3D Imager
The FARO 3D Imager group contains all the commands necessary to interface with your FARO 3D Imager using 
CAM2. 
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Array Calibration
Use the Array Calibration command to calibrate an array of 3D Imagers. For more information, see the 3D 
Imager Array section of any FARO 3D Imager user manual. 

Scan Phases Configuration
Use the Scan Phases Configuration command to create imaging groups of 3D Imagers and control the order that 
the individual 3D Imagers scan in a 3D Imager array. For more information, see the 3D Imager Array section of 
any FARO 3D Imager user manual. 
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Chapter 7: Automation

The Automation commands are located in the Automation tab across the top of the screen. The Automation tab 
contains the commands used to automate your measurement processes, and the commands are organized into 
QuickTools and Shortcuts  groups. 

 
QuickTools 142

Shortcuts 151
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QuickTools
The QuickTools group and QuickTools panel contain all the commands necessary to create and edit QuickTools 
programs. QuickTools programs allow you to save a set of CAM2 commands in a list to run anytime the 
measurement file is open. You can create multiple QuickTools programs in a single file, and play them whenever 
you choose. 

QuickTools Programs
The QuickTools group and panel allow you to record, edit, and delete QuickTools programs in either Coordinate 
Format on page 23 or Template Mode. The following chart illustrates the behavior of CAM2 when recording 
QuickTools programs in Measure Mode and Template Mode.

QuickTools

  Not Recording Recording

Measure 
Mode 

Insert Measured 
Features

• Adds feature to measurement 
file

• Prompts operator to measure 
feature

• Adds feature to measurement 
file

• Adds measurement step to 
QuickTool

• Prompts operator to measure 
feature

Manually Invoke 
“Add Readings”

• Prompts operator to measure 
feature

• Adds measurement step to 
QuickTool

• Prompts operator to measure 
feature

Template 
Mode 

Insert Measured 
Feature

• Adds feature to measurement 
file

• Adds feature to measurement 
file

Manually Invoke 
“Add Readings”

• Prompts operator to measure 
feature

• Adds measurement step to 
QuickTool

Recording QuickTools Programs
Record a QuickTools program in Measure Mode or Template Mode. The QuickTools control command buttons are 
at the bottom of the list, just above the Properties panel. To create a QuickTools program: 

1. Open the QuickTools panel and click New Program. See “QuickTools” on page 26.

OR 

Click New on the Automation Tab.

2. Type a name for your program or use the default name.
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3. Click Record to begin recording the program. 

4. Measure your part to add measurement steps to the program.

NOTE:  You can select multiple features and select Add Readings to create multiple measurement steps in 
the QuickTools program, but the current measurement mode will be applied to each of the features added in 
this manner. The person playing the QuickTools program may override the measurement mode for a feature 
being measured, but the next feature will load the measurement mode with which it was created.

5. Click Stop to stop adding program steps. 

6. Save your measurement file. QuickTools programs are stored within each measurement file.

Dragging Features Into Programs
Instantly add steps to a QuickTools program by dragging features and feature groups from the Features panel to a 
QuickTools program. For more information, see “Navigation Window” on page 33.

NOTE:  Dragging a feature group adds all of the features in that group as individual QuickTool steps.

Creating a QuickTools Program From Features
Click Create From Features to instantly create a new QuickTools program containing all features in the active 
document.

For all features constructed from CAD, CAM2 automatically captures the view orientation and associates the image 
to the feature.

Automated Images 

CAM2 automatically associates an image to each feature measurement step, totaling the number of number of 
readings needed to measure minimum geometry plus one end click image. On each image, CAM2 places a green 
marker using a uniform distribution of readings on the 3D feature governed by the 3D position of the nominal. The 
final image has a red marker placed at the location of the representative point on the feature (e.g., center, plane 
point).

You can modify the images using Image Creator. See “Image Creator” on page 50.

NOTE:  For optimal automated image results, adjust the view when you are constructing features from CAD 
so that the view orientation provides a clear picture of the feature to be measured.

Importing QuickTools From Learn Files
You can import SoftCheck Tools files and Learn files created with CAM2 Measure X or CAM2 Measure 4.0 into 
the current measurement file for use in a QuickTools program:

1. From the File menu, click Import > QuickTools > From Learn files. 

2. Select an existing SoftCheck Tools file or Learn file (*.sct or *.xln) and click Import.

3. All supported steps from the imported file appear in the QuickTools program.
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NOTE:  Unsupported steps are highlighted and captured in an error report after the import process. You can 
save the report for future reference.

Editing QuickTools Programs
You can add, reorder, and delete the steps of a QuickTools program. The QuickTools control command buttons are 
at the bottom of the list, just above the Properties panel. To create a QuickTools program: 

1. Open the QuickTools panel. 

2. Select an existing QuickTools program. You may need to click the Plus sign next to the program name to expand 
the list of program steps. 

3. Edit the steps:

• Move a step by dragging any step up and down the list, or by clicking the up/down arrow buttons.

• Delete a step by choosing the step and clicking Delete.

• Add more steps to the program by clicking Record.

4. Save your measurement file. QuickTools programs are stored within each measurement file.

NOTE:  If you have multiple devices assigned to add measurement steps, use the Filter drop-down window to 
only show steps assigned to a specific device.

Playing QuickTools Programs
Play a QuickTools program to measure the features in your measurement file. The QuickTools control command 
buttons are at the bottom of the QuickTools panel, just above the Properties panel. 

1. Open the QuickTools panel.

2. Select a QuickTools program.

3. In the Properties panel, click the Session Data drop-down and select one of the following:

• Do Not Edit Session Data: CAM2 will not present the operator with the Document Header Information 
window.

• Prompt For Session Data: (Default) CAM2 presents the operator with the Document Header 
Information window.

• Import Session Data: Import a specified text file containing document header information when the 
QuickTools program starts. Each line indicates a property of the header, can contain 2 or 3 strings 
separated by a semicolon, property names and values, and True/False states (when missing, the default 
value is True).

NOTE:  You can create a document header text file using the Export command in the Document Header 
Information window. For more information, see “Document Header Information” on page 107.
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4. Check the Clear Existing Measurement Data box to clear all existing measurement data when the QuickTools 
program is run.

5. Check the Maximize Measurement Window box to display the Measurement Panel at full screen size.

6. Check the Re-Use Open Feature Window box to keep the feature window constant while the operator plays the 
QuickTools program.

7. Click Play.

The program steps will run in the list order. You cad add concurrent measurements from multiple devices if 
multiple devices are connected. If steps are assigned to different devices, the first step for each device will run at 
the same time.

A Measurement panel opens for each Add Readings step and is automatically set from the properties of the 
program step. For more information, see “Command Properties” on page 149.

• The collection mode is automatically set from the properties of the program step. 

• The number of readings for the program step is automatically set from the properties of the step. Watch the 
Measurement panel for each reading and take an end click point after the last reading. 

• The number of readings can also be a range, or a minimum and a maximum, number of points. Take an end 
click point after the minimum number of readings, or keep digitizing until you reach the maximum number of 
readings. 

• Close the Measurement panel to skip any Add Readings program step. 

The Measurement panel can also have a picture if one exists in the QuickTools program step. See “Image 
Creator” on page 50.

Automating QuickTools Programs
You can automatically play a QuickTools program without first opening CAM2. 

Open a command line to start CAM2 with the measurement file (*.fcd) containing the QuickTools program, and 
add /runQT:<ProgramName> to the command. 

For example, if you wanted to run the QuickTools program called “My Program 1" in the Measurement file, you 
would open a command line and enter:

cam2measure.exe c:\MeasurementFile.fcd /runQT:My Program 1 

When the QuickTools program runs, CAM2 shows the Measurement panel at full screen size. 

Locking QuickTools Programs
Lock a QuickTools program to secure the program from being edited, overwritten, or deleted from the 
measurement file.

The Lock icon is visible in the QuickTools panel. When locked, users may not modify the QuickTools program. 

1. Select the QuickTools program to be locked.

2. Click Lock.

3. In the Credentials window, enter a password to lock the program. Enter the password again to confirm. 
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4. Click OK to apply the lock. 

NOTE:  Use this same password to unlock the program. After all modifications are complete, click 
QuickTools to lock the program again. 

CAUTION:  If you forget a password, there’s no way to recover it. Consider keeping a backup copy of the 
measurement file with a QuickTool that isn’t password-protected. 

Unlocking QuickTools Programs
Click Lock and enter the password to unlock the program. Click Lock to restore the lock. To remove the lock, 
click Remove Lock. 

Removing the QuickTools Program Lock 
The Remove Lock icon is visible in the QuickTools panel. It is active when you select a locked QuickTools 
program. This permanently removes the lock from the QuickTools program. 

1. Select the locked QuickTools program.

2. Click Remove Lock.

3. In the Credentials window, enter the password for this program. 

4. Click OK to permanently remove the lock. 

NOTE:  To temporarily unlock the QuickTools program, click Lock.For more information, see “Unlocking 
QuickTools Programs” on page 146. 

Deleting QuickTools Programs
Delete a QuickTools program to completely remove it from the measurement file. The QuickTools control 
command buttons are at the bottom of the QuickTools panel, just above the Properties panel.

1. Select the QuickTools program to be deleted.

2. Click Delete to delete the QuickTools program.

NOTE:  You must enter the password to delete a locked QuickTools program. 

QuickTools Tools
The QuickTools Tools drop-down menu, located on the QuickTools menu bar, contains steps that may be included 
in a QuickTools program. For more information, see “QuickTools Program Commands” on page 148.
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Add Comment
Add Comment inserts a comment into a QuickTools program while you are in Record Mode. A comment is a 
textual message that a user will see when playing the QuickTools program, must acknowledge by clicking OK, and 
can thus be used to help guide the user through the program by providing important information at key points. 
Comments may be placed at any position within the QuickTools program.

Add Report
Add Report creates a report macro at the end of a QuickTools program. When you select this command, the 
Report View Settings dialog lets you select a report list, a report template, export options, and file format. When 
the QuickTools program is played, this command will open the Report tab for the user to create and print a report. 
For more information, see “Report” on page 45.

Generate QR Code
Generate QR Codegenerates a QR code from an existing report to be displayed when running a QuickTools 
program. When the QR code is scanned by a smart phone (for example), the feature names and actual results are 
displayed. You can also save the QR code to a file.

Fine Registration
Perform Fine Registration after several scans have been completed. Scans can be pre-registered with the rotary 
table and/or photogrammetry targets.

NOTE:  This QuickTools program command is only available for the FARO 3D Imager.

Extract Feature
Extract a feature using CAM2’s extraction commands. This can be used in tandem with a Freeze/Unfreeze 
Recalculation command to force extraction. For more information, see “Extract” on page 199.

Change Adapter
Change Adapter inserts a prompt into a QuickTools program, in either Measure mode or Template mode, to 
change the SMR/adapter of the FARO Laser Tracker device, or the current probe of the FaroArm. For more 
information, see “QuickTools Program Commands” on page 148.
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When executing this step of a QuickTools program, the user is guided through the process of changing the adapter. 
When the adapter change is successful, the user can continue running the QuickTools program. 

Set Active Device Position
Set Active Device Position inserts a program step to move the device position. While recording the command, the 
new Device Position will be defined based on existing targets. For more information, see “Move Device” on page 
133.

Solve Device Position
Solve Device Position inserts a program step to solve the device position. When the operator runs the QuickTools 
program, the Device Manager panel prompts the operator to remeasure the targets and solve the device position 
before continuing. For more information, see “Move Device” on page 133.

Freeze Recalculation
Freeze Recalculation inserts a program step to suspend all recalculations while the operator runs the QuickTools 
program. 

NOTE:  If you do not add Unfreeze after a Freeze command, all pending recalculations will occur at 
completion of the QuickTools program.

Unfreeze Recalculation
Unfreeze Recalculation inserts a program step to enable all pending recalculations. 

QuickTools Program Commands
QuickTools programs may contain several types of program steps, or commands.

• Add Report: The operator is automatically presented with the Report Window. For more information, see 
“Add Report” on page 147.

• Aim: Aims the Laser Tracker at the center of a selected feature. For more information, see “Aim” on page 
137.

NOTE:  Click Search to enable Search mode for your Aim step. When enabled, the Laser Tracker 
automatically enters search mode (similar to Survey) if it aims and does not find a target. The QuickTools 
program step will pause until the Laser Tracker finds a target or ends the search. For more information, see 
“Survey” on page 53.
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• Angular Accuracy Checks: CAM2 starts the Laser Tracker’s Angular Accuracy Check routine. For more 
information, see “Angular Accuracy Checks” on page 136.

• Change Adapter: The operator is prompted to change the probe adapter of the measurement device. For more 
information, see “Change Adapter” on page 138.

• Clear Existing Measurement Data: When the operator runs the QuickTools program, CAM2 clears all 
existing measurement data in the measurement file.

• Add Comment: The operator is presented with informational text boxes at key points in the program. For 
more information, see “Add Comment” on page 147.

• Export: CAM2 exports all measurement data to a text or CAD file. Specify export options and file format. 
For more information, see “Export” on page 63.

• Import Points: When the operator runs the QuickTools program, CAM2 imports a predetermined points file, 
or else prompts the operator to select the file to be imported.

• Maximize Measurement Panel: When the operator runs the QuickTools program, the Measurement panel is 
displayed at full screen size.

• Measure: CAM2 prompts the operator via the Measurement panel to add readings to measured features or 
add measurements to constructed features.

• Measure Level: CAM2 prompts the operator to produce a plane level to the ground (relative to the Laser 
Tracker) and through the origin. For more information, see “Measure Level” on page 136.

• Prompt for Session Data: When the operator runs the QuickTools program, CAM2 presents the operator with 
the Document Header Information window. For more information, see “Document Header Information” on 
page 107.

• Re-Use Feature Window: CAM2 reuses an existing feature window (if one is open) for the step instead of 
opening a new one. For more information, see “Show Feature Window” on page 124.

• Save File: CAM2 prompts the operator to select a name and save location for the measurement file.

• Self Compensation: CAM2 starts the Laser Tracker’s Self Compensation routine. For more information, see 
“Self Compensation” on page 136.

• Set/Solve Alignment: CAM2 sets an alignment active. When the operator runs the QuickTools program, 
CAM2 presents the operator with the option to cease running the program when the maximum allowable 
alignment error is exceeded. You can also configure the QuickTools program to stop without giving the 
operator an option.

• Show Feature Window: CAM2 displays a Feature window (DRO) for a selected feature. For more 
information, see “Show Feature Window” on page 124.

• View: The CAD View contents zoom, pan, or change viewpoints.

NOTE:  Construction, Dimension, Coordinate System, and Device Position commands are not added to 
QuickTools programs because these features are just waiting for data to solve. 

Command Properties
Some QuickTools program steps have properties that you can edit in the Properties panel, located just below the 
QuickTools control command buttons. To change the program step properties:
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1. Open the QuickTools panel. 

2. Select an existing QuickTools program. You may need to click the Plus sign next to the program name to expand 
the list of program steps. 

3. Select any step. 

CAD View Commands
Use the CAD View buttons to assign, preview, or delete a specific view of the CAD part for any QuickTools 
program step. 

Select any QuickTools program step. 

Save CAD View for Step: Manipulate the position of the CAD part in the CAD View window as desired, 
and click this button to save this view to the QuickTools program step.

Clear Saved CAD View: Click this button to delete an associated CAD View from the QuickTools program 
step. If no CAD View has been saved to this step, this button is unavailable.

Recenter To Saved CAD View: Click this button to recenter the view to a saved CAD View from the 
QuickTools program step. If no CAD View has been saved to this step, this button is unavailable.

Preview Saved CAD View: Click this button to preview an associated CAD View from the QuickTools 
program step, whether or not you are running a QuickTools program. If no CAD View has been saved to this 
command, this button is unavailable.

Add Readings Properties Basic Tab
Use the Basic tab to change the device and number of readings for the program step. 

1. Select an existing device from the Device drop-down window. 

2. Enter the number of readings for the step.

• Select the Use Range check box and enter the minimum and maximum number of points. 

Add Readings Properties Advanced Tab
Use the Advanced tab to set the collection mode; single point or any of the available scanning modes. For more 
information, see “Scanning” on page 190.

1. Select the collection mode from the Sample Mode drop-down window. 

2. Enter any Interval and Distance values if necessary. 

3. Select the Replace Existing Readings check box to replace any existing readings in the feature.
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NOTE:  Insert Clear Readings at the beginning of your QuickTools program to delete all the readings from 
every feature in your file. For more information, see “Clear Readings” on page 109.

QuickTools in Measure Mode
Using Measure Mode to create a QuickTools program will measure a part and record everything about the 
measurement process. See “Measure Mode” on page 99.

You should have at least one device connected. This mode records every necessary measurement step, and for Add 
Readings (measurement) commands automatically sets the following properties:

• The current device. 

• The collection mode. 

• The number of readings. 

The properties are set after you finish the measurement. See “Measurement Panel” on page 188.

QuickTools in Template Mode 
Using Template Mode to create a QuickTools program enables you to create your program without measuring your 
part or without a device connected. See “Template Mode” on page 99.

This mode records every necessary measurement step, and for Add Readings measurement steps the default 
command properties are set. Change these properties in the Properties panel. See “Command Properties” on 
page 149.

CAM2 Control Station 
The CAM2Control Station is a standalone application that allows you to run QuickTools programs without first 
opening RPM. Control Station is a component of CAM2® RPM. 

Shortcuts 
The Shortcuts group contains all the commands necessary to create and edit shortcuts. Just as QuickTools 
programs allow you to automate basic measurement commands, Shortcuts allow you to define quick composite 
measurement commands, such as the length between two circles or a bolt-hole pattern. Shortcuts are based on a 
measurement command or routine that you’ve defined in the measurement file. 

Shortcut Gallery
The shortcut gallery contains over 20 pre-defined shortcuts, such as Angle Two Lines and Length Two Circles. 
Scroll through the gallery using the right-hand side arrows, and click an icon to run the shortcut. 

Creating a Shortcut
Use a feature that you’ve created to make a shortcut, enabling you to replicate that feature with the shortcut.

1. Click the feature for which you want to create a shortcut in the See “Navigation Window” on page 33..

2. Click New in the Shortcuts group.
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3. Enter a name for the new shortcut in the Shortcut Name box.

4. Click Image to associate an image with the new shortcut. This image will become the icon for the shortcut in the 
measurement file.

5. Click OK to create the new shortcut. The shortcut appears in the Shortcuts group.

Editing a Shortcut
1. Click the shortcut in the Shortcuts group that you want to edit. 

2. Click Edit in the Shortcuts group. 

3. Edit a name of the shortcut in the Shortcut Name box. 

4. Click Image to associate a different image with the shortcut. This image will become the icon for the shortcut in 
the measurement file. 

5. Click OK to save changes to the shortcut. 

Deleting a Shortcut
1. Click the shortcut in the Shortcuts group that you want to delete. 

2. Click Delete in the Shortcuts group to delete the shortcut. 

Importing a Shortcut
1. Click Import in the Shortcuts group. 

2. Browse to the name of the shortcut you want to import (*.xml). 

3. Click Open to save changes to the shortcut. 

Exporting a Shortcut
1. Click the shortcut in the Shortcuts group that you want to export. 

2. Click Export in the Shortcuts group. 

3. Browse to the location you want to save the exported shortcut (*.xml). 

4. Click Save to export the shortcut. 
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Chapter 8: Measure

The Measure commands are located in the Measure tab across the top of the screen.

• Click a command to add a measure feature to the measurement file. Click multiple times to quickly add 
features. 

• Some Measure commands also are assigned to Keyboard Shortcuts on your keyboard. See “Keyboard 
Shortcuts” on page 308. 

NOTE:  When describing functions of the Measure tab, the terms measuring and digitizing are used 
interchangeably.

The commands on the Measure tab are organized into Features, Projection Plane, and Options groups. 

 
Features 154

Projection Plane 181

Options 182

Feature Properties 183

Laser Line Probe Measurement 187

Automatic Feature Recognition 188

Measurement Panel 188

Layers 191

Labels 191

Measurement Data 192

Nominals and Tolerances 194

Add Readings 197
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Features
The Features group contains all the measurement commands for 2D and 3D features. 

Measuring a Plane
You can also press the F3  keyboard shortcut on the keyboard.

Projection Plane needed? See 
“Projection Plane” on page 181. No

Probe Compensation needed? See 
“Probe Compensation” on page 184. Yes

Minimum Readings to Solve 3

See “Scanning” on page 190.

XYZ Results Center point of Plane

Vector The surface normal 
(perpendicular to the plane)

See “Best Fit Plane” on page 328.

Measuring a 2D Line
You can also press the F4 keyboard shortcut on the keyboard.
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Projection Plane needed? See 
“Projection Plane” on page 181. Yes

Probe Compensation needed? See 
“Probe Compensation” on page 184. Yes

Minimum Readings to Solve 2

See “Scanning” on page 190.

XYZ Results End1 of the Line
End2 of the Line

Vector The Line from beginning to end

The first two digitized points determine the vector direction of the line. End 1 is the furthest point in the negative 
direction and End 2 is the furthest point in the positive direction.

See “Best Fit Line” on page 327.

Measuring a Point
You can also press the F2 keyboard shortcut on the keyboard.

Projection Plane needed? See 
“Projection Plane” on page 181. No

Probe Compensation needed? See 
“Probe Compensation” on page 184. No

Minimum Readings to Solve 1

See “Scanning” on page 190.

XYZ Results The Point

Vector none
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See “Best Fit Point” on page 328.

Measuring an Inspect Surface Point
You can also press the F5 keyboard shortcut on the keyboard.

Use this command to measure a single point on surface at any location. To measure in an exact area of a surface, 
use Measuring a Home In Point. See “Measuring a Home In Point” on page 170. To measure multiple points 
(point cloud) on your CAD model in a single feature, use Inspect Surface. See “Inspect Surface” below. 

This command requires a nominal surface from a CAD model. The default surface is the CAD model - any 
available surface. You can select a specific surface in the Features panel, or the CAD View before starting this 
command. 

Minimum Readings to Solve 1

XYZ Results

The Point:
The measured surface point 
compensated along the surface 
normal.

Vector The vector of the surface at the 
measured point.

• If the Automatically Create Nominal check box is selected, a nominal surface point is automatically added to 
your file, and grouped with the Actual Inspect Surface point. It is the closest point on the surface. See 
“Dynamic Nominals” on page 195.

A round disk represents the Inspect Surface Point measurement. The disk color is predetermined by the tolerance 
condition. The size of the disk is a preference. See “Size and Scale” on page 70.

Inspect Surface
Use this command to measure single or multiple points (point cloud) on your CAD model. To measure a single 
point on a surface at any location, use Measuring an Inspect Surface Point. See “Measuring an Inspect Surface 
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Point” above. To measure an exact area of a surface, use Measuring a Home In Point. See “Measuring a Home 
In Point” on page 170. 

Each reading for this feature automatically creates a nominal point on the closest surface of your CAD model. The 
end click determines the compensation vector of the digitized point(s).

NOTE:  Surface points measured away from a selected surface appear as surface edge points.

A round disk represents each reading of the Inspect Surface measurement. The disk color is predetermined by the 
tolerance condition. The size of the disk is a preference. 

See “Size and Scale” on page 70.

Measuring a Point Cloud
Use this command to measure single or multiple points (point cloud) for Export or inspection of a surface. 
Readings are not available with this feature. 

Projection Plane needed? See 
“Projection Plane” on page 181. No

See “Probe Compensation” on 
page 184. No

Minimum Readings to Solve 1

See “Scanning” on page 190.

XYZ Results
The Point:
The digitized point compensated 
along the surface normal.

Vector none

NOTE:  This command is only available if a FARO Laser Line Probe is connected to your FaroArm and it is 
the active device, or the FARO 3D Imager is the active device. 

To measure a surface and compare to a nominal surface, use Measuring an Inspect Surface Point or Inspect 
Surface. See Measuring an Inspect Surface Point on the previous page, and Inspect Surface on the previous page.

Decimation Capture
Should the FARO Laser Line Probe’s data density be too high, you can reduce the density using the Decimate 
option in the Measurement Control Window or the point cloud’s Feature Properties. Enable Decimation and set the 
decimation factor for the point cloud capture process. The number entered in the field will determine the number of 
captured points per line. For example, a value of 10 indicates that CAM2 will record every tenth point, effectively 
reducing the number of captured points by a factor of 10.

Scanning Filter
You can apply a scanning filter to filter visible point cloud data. See “Scanning Filter” on page 186.

Labels
You can add callout labels to individual readings in this feature and show deviation at a specific location. 
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Measuring a Surface Edge
Use this command to extract single or multiple points (point cloud) on surface edges. Readings are not available 
with this feature. 

Projection Plane needed? See 
“Projection Plane” on page 181. No

See “Probe Compensation” on 
page 184. No

Minimum Readings to Solve 1

See “Scanning” on page 190.

XYZ Results
The Point:
The digitized point compensated 
along the surface normal.

Vector none

NOTE:  This command is only available if a FARO Laser Line Probe is connected to your FaroArm and it is 
the active device, or the FARO 3D Imager is the active device. 

To measure a surface and compare to a nominal surface, use Measuring an Inspect Surface Point or Inspect 
Surface. See Measuring an Inspect Surface Point on page 156, and Inspect Surface on page 156.

Keep Raw Data
Check the Keep Raw Data check box to store all Laser Line Probe data and recalculate.

Surface
Select the surface to use for edge comparison to CAD.

Edge Tolerance
Select the level of detail to capture edge data:

• Finest: The Laser Line Probe takes very sharp edge data.

• Coarsest: The Laser Line Probe takes more rounded edge data.

Point Distance Filter
Specify a distance from CAD to exclude point data. Measure will filter all points further from CAD than this value.

Measuring a Circle
You can also press the F10 keyboard shortcut on the keyboard.

Projection Plane needed? See 
“Projection Plane” on page 181. Yes

Probe Compensation needed? See Yes
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“Probe Compensation” on page 184.

Minimum Readings to Solve 3

See “Scanning” on page 190.

XYZ Results Center point of Circle

Vector Same as Plane

See “Best Fit Circle” on page 325.

Measuring a Sphere
You can also press the F12 keyboard shortcut on the keyboard.

Projection Plane needed? See 
“Projection Plane” on page 181. No

Probe Compensation needed? See 
“Probe Compensation” on page 184. Yes

Minimum Readings to Solve 4

See “Scanning” on page 190.

XYZ Results Center point of Sphere

Vector none
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See “Best Fit Sphere” on page 329.

Measuring a Cylinder
You can also press the F11 keyboard shortcut on the keyboard.

Projection Plane needed? See 
“Projection Plane” on page 181. No

Probe Compensation needed? See 
“Probe Compensation” on page 184. Yes

Minimum Readings to Solve 6

See “Scanning” on page 190.

XYZ Results Center of Cylinder at first end.

Vector Center Line of Cylinder from 
bottom to top
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The first two digitized points determine the vector direction of the cylinder. 

See “Best Fit Cylinder” on page 326.

Measuring a Torus
Projection Plane needed? See 
“Projection Plane” on page 181. No

Probe Compensation needed? See 
“Probe Compensation” on page 184. Yes

Minimum Readings to Solve 9

See “Scanning” on page 190.

XYZ Results Center Point

Vector  

1. Digitize three points at one cross-section of the torus.

2. Digitize three points at a second cross-section of the torus.

3. Digitize three points at a third cross-section of the torus.
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NOTE:  You must digitize the first nine points in the correct order.   Digitize any additional points anywhere on 
the torus.

Measuring a Tube
You can measure a round tube with a series of simple feature measurements. There are three ways in which you 
can measure a tube: by Cylinders, by Break Points, and by Line Segments.

Measure Tube by Cylinders
When you measure a tube by cylinders, CAM2 combines the measured planes (END-B and END-A) and cylinders 
(tube segments) to construct the tube, then applies the round tube diameter and bend radius values to create the 
final tube feature. All features automatically add to a group. See “Feature Grouping” on page 36.

NOTE:  This command will not work in Template mode, so CAM2 automatically switches to Measurement 
mode if necessary. See “Measure Mode” on page 23. 

NOTE:  Two tube segments are required to create a tube feature.

1. Enter the information for the tube feature:

• Enter the name for the tube.

• Check the Override Diameter box and enter a value, or CAM2 will average the measured diameters from 
the tube. 

• Choose existing planes for the starting (END-B) and ending (END-A) or < Define > to measure each 
plane. 

NOTE:  Both Starting Plane and Ending Plane have modifiers to fine-tune tube length. High Point uses the 
highest reading of the plane to maximize tube length, Low Point uses the lowest reading of the plane to 
minimize tube length, and None ignores these modifiers.

• Choose an existing nominal tube feature, if you have an existing nominal tube in the file. 

• Enter a Bend Radius. 

• Click Create to create the tube and begin measuring.

2. Measure the plane at END-B. See “Measuring a Plane” on page 154.

3. Measure each straight segment of the tube as a cylinder. Be sure to measure these cylinders in the proper order 
(END-B to END-A). See “Measuring a Cylinder” on page 160.

NOTE:  Do not digitize any points on any curved sections unless CAM2 instructs you to do so. Measure 
curved sections as a Torus. See “Measuring a Torus” on the previous page. 

A cylinder measurement is always expected since there are many cylinders that can form a round tube. When you 
cancel the cylinder measurement, you will see a message that the cylinder measurement was unsuccessful. If you 
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have no more segments to measure, click No to end the cylinder measurement and continue with the plane 
measurement at END-A.

4. Measure the plane at END-A. See “Measuring a Plane” on page 154.

NOTE:  You can scan the planes and cylinders of a round tube. See “Scanning” on page 190.

Measure Tube by Breakpoints
When you measure a tube by breakpoints, CAM2 combines the measured planes (END-B and END-A) and 
breakpoints to construct the tube, then applies the round tube diameter and bend radius values to create the final 
tube feature. All features automatically add to a group. Feature Grouping on page 36 and Breakpoints on the next 
page

1. Enter the information for the tube feature:

• Enter the name for the tube.

• Enter a diameter, or CAM2 will average the measured diameters from the tube. 

• Choose existing planes for the starting (END-B) and ending (END-A) or < Define > to measure each 
plane. 

• Choose an existing nominal tube feature, if you have an existing nominal tube in the file. 

• Enter a Bend Radius. 

• Click Create to create the tube and begin measuring.

2. Measure the plane at END-B. See “Measuring a Plane” on page 154.

3. Measure each breakpoint in the proper order (END-B to END-A).

NOTE:  Do not digitize any points on any curved sections unless CAM2 instructs you to do so. Measure 
curved sections as a Torus. See “Measuring a Torus” on page 161. 

4. Measure the plane at END-A. See “Measuring a Plane” on page 154.

Measure Tube by Line Segments
When you measure a tube by line segments, CAM2 combines the measured planes (END-B and END-A) and line 
segments (tube segments) to construct the tube, then applies the round tube diameter and bend radius values to 
create the final tube feature. All features automatically add to a group. See “Feature Grouping” on page 36.

1. Enter the information for the tube feature:

• Enter the name for the tube.

• Enter a diameter, or CAM2 will average the measured diameters from the tube. 

• Choose existing planes for the starting (END-B) and ending (END-A) or < Define > to measure each 
plane. 

• Choose an existing nominal tube feature, if you have an existing nominal tube in the file. 

• Enter a Bend Radius. 

• Click Create to create the tube and begin measuring.
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2. Measure the plane at END-B. See “Measuring a Plane” on page 154.

3. Measure each line segment in the proper order (END-B to END-A).

NOTE:  Do not digitize any points on any curved sections unless CAM2 instructs you to do so. Measure 
curved sections as a Torus. See “Measuring a Torus” on page 161. 

4. Measure the plane at END-A. See “Measuring a Plane” on page 154.

Construction
A round tube constructs along this polyline from start to end using the diameter value.

For more information, see “Construct Tube: From Features” on page 250.

Breakpoints
After measuring all the tube segments, breakpoints automatically add to the drawing file and are viewable in the 
Measurement Data panel. See “Measurement Data” on page 192. Breakpoints are constructed points and are the 
intersection of tube segments along the tube:

• END-B and the first straight segment.

• First and second segment, second and third, third and fourth, etc.
• A radius constructs at the intersection point using the bend radius value.

• END-A and the last straight segment.

A polyline constructs from through all of the breakpoints from END-B to END-A.

Alignment
If you have selected a nominal tube, a Feature Based alignment automatically adds to the drawing file and solves. 
See “Feature Based” on page 275. 

If you do not have a nominal tube, you should create a coordinate system using the first, last, and another 
breakpoint with the Coordinate System. See “Coordinate System” on page 278. 

The Align Tube Automatically user preference determines whether CAM2 automatically aligns tubes. See “Align 
Tube Automatically ” on page 83. 

Reporting
When you create a report containing your tube, the report will contain:

1. Breakpoints with 3D errors.

2. View of tube bending corrections.

3. Sections with nominal, actual and errors showing breakpoints and PTB information.

4. Text report presentation.

For more information, see “Report” on page 45.
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Measuring a Cone
Projection Plane needed? See 
“Projection Plane” on page 181. No

Probe Compensation needed? See 
“Probe Compensation” on page 184. Yes

Minimum Readings to Solve 6

See “Scanning” on page 190.

XYZ Results Apex of Cone

Vector Center Line of Cone from Apex

See “Best Fit Cone” on page 326.

Measuring a Round Slot
Projection Plane needed? See 
“Projection Plane” on page 181. Yes

Probe Compensation needed? See 
“Probe Compensation” on page 184. Yes

Minimum Readings to Solve 6

See “Scanning” on page 190.

XYZ Results Center point of Slot
Length and Diameter

Vector Same as Plane
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NOTE:  You can digitize points on the straight sides of the round slot.

In the Feature Information panel, there are two length values for the round slot:
• Length (end to end) 
• Center to Center Length 

By default, the Length (end to end) check box is selected and the Center to Center Length check box is clear. 
See “Nominals and Tolerances” on page 194. 

The first two digitized points determine the vector direction of the line. See “Best Fit Round Slot” on page 329.

Measuring a Rectangular Slot
Projection Plane needed? See 
“Projection Plane” on page 181. Yes

Probe Compensation needed? See 
“Probe Compensation” on page 184. Yes

Minimum Readings to Solve 6

See “Scanning” on page 190.

XYZ Results Center point of Slot
Length and Width

Vector Same as Plane
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The first two digitized points determine the vector direction of the line. See “Best Fit Rectangular Slot” on 
page 329.

Measuring an Ellipse
Projection Plane needed? See 
“Projection Plane” on page 181. Yes

Probe Compensation needed? See 
“Probe Compensation” on page 184. Yes

Minimum Readings to Solve 5

See “Scanning” on page 190.

XYZ Results Center point of Ellipse

Vector Same as Plane
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See “Best Fit Ellipse” on page 327.

Measuring a Cross-Section Scan
Use this command to measure a cross section of a surface.

NOTE:  If you are using the Probing Version of CAM2, this command is available for use with a hard probe 
only. See “Probing Version” on page 9.

Probe Compensation needed? See 
“Probe Compensation” on page 184. No

Minimum Readings to Solve 2

See “Scanning” on page 190.

XYZ Results (Must be a feature with 
an associated nominal surface)

The Point:
The digitized point compensated 
along the surface normal.

Vector The vector of the surface at the 
measured point.

NOTE:  To measure one or more polylines or cross sections with a contact probe, use Measuring a Polyline 
and Measuring a Polyline. See Measuring a Polyline on page 176 and Measuring a Polyline Group on 
page 178.

• Name: Type in a name for the Cross-Section Scan.

• Automatically Create Nominal: Automatically create a nominal cross section from a CAD surface. 
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• Base Plane: Specify a base plane for the cross section scan. 

• Base Distance: Enter a distance value. While recording measurements, CAM2 ignores any point that is too far 
from the first. 

• Point Distance Filter: Specify a distance from CAD to exclude point data. CAM2 will filter all points further 
from CAD than this value.

• Keep Raw Data: Keep the raw measurement data with the cross section. Enable this option to allow for 
recalculation.

• Use Hard Probe: Use a hard probe to measure the cross section. This is only available if a Laser Line Probe is 
connected to your FaroArm and it is the active device. 

NOTE:  When you align to CAD, the hard probe takes readings when the touch point crosses the plane 
(instead of the probe center). This ensures accurate cross-section scanning on slanted surfaces. 

Deviation Markers
Deviation markers show deviation of the measured part relative to CAD at any position on the CAD model. For 
more information, see “Deviation Markers” on page 120.

Click the Deviation Markers tab to activate picking mode. With each click on the cross section, CAM2 creates a 
deviation marker and lists the marker’s number and XYZ coordinates on the left side of the Main Window. Click 
the measure tab to exit picking mode.

• Show Highest and Lowest Deviation Callouts: Show a label at the highest and lowest deviation points. As 
you remeasure the cross section, these labels automatically appear in the minimum and maximum deviation 
locations.

• Create By: Create deviation markers at a fixed separation distance, or specify the total number of markers to 
be created. When data becomes available, CAM2 will automatically create deviation markers and display 
labels.

• Zone Size: Specify the size of all deviation markers. The default value is 1 mm.

• Click Create to add the feature to your measurement file.

Measuring a 3D Line
Projection Plane needed? See 
“Projection Plane” on page 181. No

Probe Compensation needed? See 
“Probe Compensation” on page 184. No

Minimum Readings to Solve 2

See “Scanning” on page 190.

XYZ Results End1 of the Line
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End2 of the Line

Vector The Line from beginning to end

The first two digitized points determine the vector direction of the line. End 1 is the furthest point in the negative 
direction and End 2 is the furthest point in the positive direction. 

See “Best Fit Line” on page 327.

Measuring a Planar Point
Projection Plane needed? See 
“Projection Plane” on page 181. Yes

Probe Compensation needed? See 
“Probe Compensation” on page 184.

No, the point is automatically 
projected to the selected plane.

Minimum Readings to Solve 1

See “Scanning” on page 190.

XYZ Results The Point

Vector none

See “Best Fit Point” on page 328.

Measuring a Home In Point
Use this command to measure a surface at a specific nominal location. To measure a surface at any location, use 
Measuring an Inspect Surface Point. See “Measuring an Inspect Surface Point” on page 156. 

NOTE:  You must create a nominal point or nominal vector point before starting this command.

You always see the Measure Home In Point properties dialog box regardless of the Show Control Window  
preference setting. See “Show Control Window ” on page 78. 

NOTE:  You may find it helpful to enable Wireframe View to aid in identifying the Home In point. For more 
information, see “Shading Mode” on page 114.

• Name: Type in a name for the Home In Point.

• Approach Type: The location of the compensation point determines probe compensation direction. 
Compensation will be along the approach vector but the “away versus towards” is determined by the 
compensation point.
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• Key-In - Type the IJK values in the Approach Vector box.  Typing values in different units and 
coordinate systems1

•
 Select Surface -  Select a Feature.2 To Sample (measure) the surface of the part before measuring the 

p
oint, select <Define>. 

• Flip Approach Vector - Flip the vector of the nominal surface.

• Target Point:  Select a Point.3  This point is the specific location, or “target point” on the surface.

• Surface:  Select a Surface.4 
T
his is unavailable if Key-In is selected.

• Home In Zone Diameter: The Home In Zone Diameter is the diameter of a cylindrical zone created from the 
nominal point and the surface normal.

• When the probe is in this zone, you can measure the surface. A point is not recorded if the probe is outside 
the zone.

• Rotation Angle: You may find that you have to rotate the view on the screen before you can Home In on a 
point. To rotate the view, enter a Rotation Angle.

• Approach Vector: Type the IJK values in the Approach Vector box.  Typing values in different units and 
coordinate systems5 This is unavailable if Select Surface is selected. 

•
 Click Create to add the feature to your measurement file.

1You can type a value in any unit, and CAM2 2020 converts the value to the default unit value. For example, the default value is 0,0,0 mm but 
your feature is 5,5,10 inches. Type 5in, 5in, 10in and CAM2 2020 automatically converts the value to 127, 127, 254 millimeters. To change the 
coordinate system, click the arrow on the right side of the dialog box and select from the menu. CAM2 2020 automatically converts the values 
to the current coordinate system during the feature construction.
2When in a dialog box, click the drop-down arrow and scroll down to select a feature. You can also click the name of the feature with the Left 
Mouse button in the Features panel. To select a feature from the Main Window, move the pointer over the drop-down list box and click the 
From Screen icon that appears. This selects the drop-down list and you can then click a feature with the Left Mouse button in the Main Win-
dow. If the drop-down list is already selected, then just click the feature with the Left Mouse button in the Main Window. 
3When in a dialog box, click the drop-down arrow and scroll down to select a point, or point reducible, feature. You can also click the name of 
the point with the Left Mouse button in the Points panel. To select a point from the Main Window, move the pointer over the drop-down list 
box and click the From Screen icon that appears. This selects the drop-down list and you can then click a point with the Left Mouse button in 
the Main Window. If the drop-down list is already selected, then just click the point with the Left Mouse button in the Main Window. 
4When in a dialog box, click the drop-down arrow and scroll down to select a surface. You can also click the name of the surface with the Left 
Mouse button in the Surfaces panel. To select a surface from the Main Window, move the pointer over the drop-down list box and click the 
From Screen icon that appears. This selects the drop-down list and you can then click a surface with the Left Mouse button in the Main Win-
dow. If the drop-down list is already selected, then just click the surface with the Left Mouse button in the Main Window.
5You can type a value in any unit, and CAM2 2020 converts the value to the default unit value. For example, the default value is 0,0,0 mm but 
your feature is 5,5,10 inches. Type 5in, 5in, 10in and CAM2 2020 automatically converts the value to 127, 127, 254 millimeters. To change the 
coordinate system, click the arrow on the right side of the dialog box and select from the menu. CAM2 2020 automatically converts the values 
to the current coordinate system during the feature construction.
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Measuring Points
Click Create in the Home In Point dialog box to add the feature to your measurement file.

Figure 8-1 Measuring a Home-In Point

1. You now see the nominal point, the Home In Zone and the current position of your probe.

NOTE:  CAD files may be oriented opposite of the Home-In Point.

2. Place the probe on the surface of the part and move it into the Home In Zone. Watch the screen and listen for the 
Home In Sound.

NOTE:  The 3D distance from the probe to the point, and the depth to the point appear in the Measurement 
panel during the measurement of each Home In point.

3. Measure the surface:

• Press the Front button, or Gkey, to measure the surface point. You can digitize 1 to 3 points - the closest 
reading to the nominal point is used for the measured point. 

• Pull away from the surface and press the Back button, or Hkey, to define probe compensation. 

NOTE:  It is possible to be within the Home In zone and not be touching the surface, ensure that the device is 
touching your part.
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Measuring a High/Low Point
Use this command to measure a set of points and calculate the point with the highest deviation in relation to the 
reference feature. The High Point uses the highest positive deviation, and the Low Point uses the highest negative 
deviation.

NOTE:  This command calculates 3D distance (the absolute distance between two points), not 3D 
displacement.

You always see the Measurement Point properties dialog box regardless of the Show Control Window  preference 
setting. See “Show Control Window ” on page 78.

• Select High Point or Low Point.

• Select the Reference feature type. 

•  Select1 a Reference feature. 

• Select the 
Probe Compensation. See “Probe Compensation” on page 184. 

Minimum Readings to Solve 1

See “Scanning” on page 190.

XYZ Results

The Point:
The three-dimensional (3D) distance 
between the point with the highest 
deviation and the reference feature.

Vector none

Figure 8-1 Measuring a High Point Figure 8-2 Measuring a Low Point

NOTE:  If you select Plane-Reducible for the Feature Type, <Define> is a selection in the Reference 
feature drop-down. Select <Define> to measure a plane as the Reference feature before measuring the point. 
See “Measuring a Plane” on page 154.

1When in a dialog box, click the drop-down arrow and scroll down to select a feature. You can also click the name of the feature with the Left 
Mouse button in the Features panel. To select a feature from the Main Window, move the pointer over the drop-down list box and click the 
From Screen icon that appears. This selects the drop-down list and you can then click a feature with the Left Mouse button in the Main Win-
dow. If the drop-down list is already selected, then just click the feature with the Left Mouse button in the Main Window.
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Measuring a Surface Point
Projection Plane needed? See 
“Projection Plane” on page 181. No

Probe Compensation needed? See 
“Probe Compensation” on page 184. Yes

Minimum Readings to Solve 3

See “Scanning” on page 190.

XYZ Results The center point of the mini 
plane

Vector The surface normal 
(perpendicular to the mini plane)

Measure three or more points in a small area on the surface. The points best fit into a mini plane. 

Only use this command to measure points when you do not have a CAD model. To measure surfaces, use Inspect 
Surface Point, Home In Point, or Vector Point. These commands use or create exact nominal points on CAD 
surfaces. See Measuring an Inspect Surface Point on page 156, Measuring a Home In Point on page 170 and 
Measuring a Vector Point below.

Measuring a Vector Point
Use this command to measure a surface at a specific nominal location by selecting an existing nominal Vector 
Point. See Vector Point on page 205 and Vector Point on page 218. To measure a point on a surface, anywhere on 
the surface, use Measuring an Inspect Surface Point. See “Measuring an Inspect Surface Point” on page 156. 

You can use Vector Points in an Iterative Alignment. See “Iterative” on page 271.

You always see the Measure Vector Point properties dialog box regardless of the Show Control Window  
preference setting. See “Show Control Window ” on page 78.

• Name: Type in a name for the Vector Point.

• Nominal Point:  Select a Point.1 Select an existing nominal Vector Point.

• Home In Zone Size: The Home 
In Zone Size is the diameter of a cylindrical zone created from the nominal Vector Point.

• Ignore Range: Switch off the range control, when appropriate. CAM2 will take a reading once the probe is 
within the zone, regardless of range.

• Click Create to add the feature to your measurement file.

1When in a dialog box, click the drop-down arrow and scroll down to select a point, or point reducible, feature. You can also click the name of 
the point with the Left Mouse button in the Points panel. To select a point from the Main Window, move the pointer over the drop-down list 
box and click the From Screen icon that appears. This selects the drop-down list and you can then click a point with the Left Mouse button in 
the Main Window. If the drop-down list is already selected, then just click the point with the Left Mouse button in the Main Window.
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Measuring Points
Adding Readings to Vector Points differs slightly depending on the Alignment.

• If an Alignment does not exist or exists but is not solved; the Vector Point highlights.

• Touch the surface with the device in the approximate location.

• Press the Front button, or G key, to measure the surface point. You can digitize 1 to 3 points - the closest 
reading to the nominal point is used for the measured point. 

• Pull away from the surface and press the Back button, or H key to define probe compensation. 

• If an Alignment exists and is solved CAM2 guides you to the nominal point. See “Measuring Points” on 
page 172.

A round disk represents the Vector Point measurement. The disk color and size is a preference. See “Size and 
Scale” on page 70.

If the vector point is obstructed by a CAD surface, CAM2 will automatically apply transparency to reveal the 
Vector Point and surface. Once within range of the surface, the view will fix perpendicular to the surface to aid 
probe guidance to the required location.

NOTE:  If the Automatically Take Reading  preference is enabled, CAM2 will automatically measure a 
Vector Point when the probe is inside the home in zone. See “Automatically Take Reading ” on page 84.

Measuring a Compensate Axis Point
Use this command to measure a point with a special axis compensation calculation. 

Projection Plane needed? See 
“Projection Plane” on page 181. No

See “Probe Compensation” on 
page 184. Yes

Minimum Readings to Solve 1

See “Scanning” on page 190.

XYZ Results The Point

Vector none
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The compensation of the point will always be made along the main coordinate system axis (X, Y or Z) most 
parallel to the compensation direction; therefore, points are only compensated in the X, Y, or Z directions with this 
command. The choice of the axis and direction (+/-) will depend on the largest component of the retract vector.

See Measuring a Surface Point to compensate for probe radius in other directions. See “Measuring a Surface 
Point” on page 174.

See “Best Fit Point” on page 328.

CAUTION:  This command should only be used by expert users; it can be a source of large errors in the 
measurement process.

Measuring a Surface Edge Point
Projection Plane needed? See 
“Projection Plane” on page 181. No

See “Probe Compensation” on 
page 184. Yes

Minimum Readings to Solve 1

See “Scanning” on page 190.

XYZ Results
The Point:
The digitized point compensated 
to the surface edge.

Vector none

• If the Automatically Create Nominal check box is selected, a nominal surface point is automatically added to 
your file, and grouped with the Actual Surface Edge point. It is the closest point on the surface edge. See 
“Dynamic Nominals” on page 195.

Measuring a Polyline
Probe Compensation needed? See Yes
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“Probe Compensation” on page 184.

Minimum Readings to Solve 2

See “Scanning” on page 190.

XYZ Results (Must be a feature with 
an associated nominal surface)

The Point:
The digitized point compensated 
along the surface normal.

Vector The vector of the surface at the 
measured point.

Use this command to measure a single 2D or 3D polyline. To measure multiple polylines, or cross-sections, use 
Measuring a Polyline. See “Measuring a Polyline Group” on the next page. 

• Name: Type in a name for the Polyline.

• 2D Plane: Select the 2D Plane check box and select an existing plane.  Select a Plane.1 All measurement 
r
eadings will project to the plane before the polyline is calculated.

• Select Surfaces: Select the Surfaces check box and select the CAD Assembly or individual surfaces from the 
list.  Select from the List.2 The surfaces will become the nominal surface for the polyline. Each point of the 
p
olyline is automatically associated to the closest nominal surface. 

• Minimum Scan Distance: Enter a distance value. CAM2 removes any point that is too close to the next. 

• Auto Nominal Maximum Distance: Enter a distance value. A surface is not associated to any point of the 
polyline if the point is outside this distance. 

• Maximum Scan Distance: Enter a distance value. While recording measurements, CAM2 ignores any point 
that is too far from the first. 

• Select the Probe Compensation. See “Probe Compensation” on page 184. 

• Select the Type.

• Measure on CAD Side: Select the Measure on CAD Side check box to measure the polyline on the part’s 
CAD side.

• Click Create to add the feature to your measurement file.

1When in a dialog box, click the drop-down arrow and scroll down to select a plane, or plane reducible, feature. You can also click the name of 
the plane with the Left Mouse button in the Features panel. To select a plane from the Main Window, move the pointer over the drop-down list 
box and click the From Screen icon that appears. This selects the drop-down list and you can then click a plane with the Left Mouse button in 
the Main Window. If the drop-down list is already selected, then just click the plane with the Left Mouse button in the Main Window.
2When in a dialog box, click in the Selected Choices window. Select a single feature by clicking the name of the feature with the Left Mouse 
button. Select multiple, consecutive features from the Feature panel by holding down the Shift key, clicking the first (top) feature in the 
sequence with the Left Mouse button, then clicking the last feature in the sequence with the Left Mouse button. Select multiple features in non-
consecutive order by holding down the Ctrl key and clicking each feature with the Left Mouse button. You can also click a feature with the Left 
Mouse button in the Main Window, or the name of the feature with the Left Mouse button in the Features panel.
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Measuring a Polyline Group
Probe Compensation needed? See 
“Probe Compensation” on page 184. Yes

Minimum Readings to Solve each 
Polyline 2

See “Scanning” on page 190.

XYZ Results (Must be a feature with 
an associated nominal surface)

The Point:
The digitized point compensated 
along the surface normal.

Vector The vector of the surface at the 
measured point.

Use this command to measure multiple polylines or cross-sections. Cross-sections appear as translucent planes 
during measurement. To measure a single 2D or 3D polyline, use Measuring a Polyline. See “Measuring a 
Polyline” on page 176. 

• Name: Type in a name for the Polyline Group.

• Project to Surface: Select the Project to Surface check box and select the CAD Assembly or individual 
surfaces from the list.  Select from the List.1 The surfaces will become the nominal surface for the polyline 
g
roup. Each polyline point is automatically compensated to the closest nominal surface. By default, the 
projection surface will be the entire CAD Assembly.

• Automatically Create Nominal: Select the Automatically Create Nominal check box to create a nominal 
polyline in addition to the polyline group. The nominal polyline will be projected to the CAD if a CAD surface 
is selected.

• Measure on CAD Side: Select the Measure on CAD Side check box to measure the polyline group on the 
part’s CAD side.

• Select the Probe Compensation Method. See “Probe Compensation” on page 184. 

• Polyline Lock: Select the Polyline Lock check box to select a polyline lock type:

• Parallel 
• Base Plane:  Select a Plane.2 This defines the direction of all parallel planes and the base position for 

a
ll planes.

1When in a dialog box, click in the Selected Choices window. Select a single feature by clicking the name of the feature with the Left Mouse 
button. Select multiple, consecutive features from the Feature panel by holding down the Shift key, clicking the first (top) feature in the 
sequence with the Left Mouse button, then clicking the last feature in the sequence with the Left Mouse button. Select multiple features in non-
consecutive order by holding down the Ctrl key and clicking each feature with the Left Mouse button. You can also click a feature with the Left 
Mouse button in the Main Window, or the name of the feature with the Left Mouse button in the Features panel.
2When in a dialog box, click the drop-down arrow and scroll down to select a plane, or plane reducible, feature. You can also click the name of 
the plane with the Left Mouse button in the Features panel. To select a plane from the Main Window, move the pointer over the drop-down list 
box and click the From Screen icon that appears. This selects the drop-down list and you can then click a plane with the Left Mouse button in 
the Main Window. If the drop-down list is already selected, then just click the plane with the Left Mouse button in the Main Window.
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• Base Distance: Enter a value to define an offset relative to the base plane where the first lock plane 
will start. Using a positive value will determine an offset in the positive direction relative to the plane 
normal and a negative value will do the opposite.

• Distance Between Planes: Enter the distance between the planes to be defined.
• Number of Planes: Enter the number of cross-sectional planes for the polyline group.
• Planes on Negative Side of Base Plane: Select the Planes on Negative side of Base Plane check box 

to define planes in the positive sense and flip them to negative plane direction.

• Radial 
• Rotation Line:  Select a Line.1 This defines the radial cross-sectional plane.
• Zero Angle Direction: Select a 

line-reducible feature. The plane defined by this vector and the rotation line will define the base plane.
• Rotation Angle (Degrees): Enter the angle between the planes.
• Number of Planes: Enter the number of cross-sectional planes for the polyline group. 
• Planes on Negative Side of Base Plane: Select the Planes on Negative side of Base Plane check box 

to define planes in the positive sense and flip them to negative plane direction.

• Cylinder 
• Axis Line:  Select a Line.2 This defines the axis for all defined cylinders.
• Cylinder Sections 

Distance: Enter the radial distance between each of the cylinders.
• Number of Cylinders: Enter the number of cylinders to be created. 

• Minimum Scan Distance: Enter a distance value. CAM2 removes any point that is too close to the next. 

• Maximum Scan Distance: Enter a distance value. While recording measurements, CAM2 ignores any point 
that is to far from the first. 

• Auto Nominal Maximum Distance: Enter a distance value. A surface is not associated to any point of the 
polyline group if the point is outside this distance. 

• Click Create to add the feature to your measurement file.

Polyline Group Examples
Parallel Locked Planes 

1When in a dialog box, click the drop-down arrow and scroll down to select a line, or line reducible, feature. You can also click the name of the 
line with the Left Mouse button in the Lines panel. To select a line from the Main Window, move the pointer over the drop-down list box and 
click the From Screen icon that appears. This selects the drop-down list and you can then click a line with the Left Mouse button in the Main 
Window. If the drop-down list is already selected, then just click the line with the Left Mouse button in the Main Window. Note: Two points 
can also be used to define a line. You can construct a line using two points using Construct Line: By Best Fit.  
2When in a dialog box, click the drop-down arrow and scroll down to select a line, or line reducible, feature. You can also click the name of the 
line with the Left Mouse button in the Lines panel. To select a line from the Main Window, move the pointer over the drop-down list box and 
click the From Screen icon that appears. This selects the drop-down list and you can then click a line with the Left Mouse button in the Main 
Window. If the drop-down list is already selected, then just click the line with the Left Mouse button in the Main Window. Note: Two points 
can also be used to define a line. You can construct a line using two points using Construct Line: By Best Fit. 
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Figure 8-1 Parallel Locked Plane Polylines

Radial Locked Planes 

 
Figure 8-2 Radial Locked Plane Polylines

Measuring a Single Point Circle
Use this command to measure a single point in a hole that is smaller than the probe diameter. The circle diameter 
then calculates by using the distance to the projection plane and the probe diameter from the measured center of the 
probe.

Should the projection plane not cut the sphere of the probe, the resulting diameter will equal the primary probe 
offset times two. If you use an arm probe or SMR without an adapter, the circle will equal the diameter of the 
probe or SMR sphere. If you use a pin nest, the circle will equal the diameter of the pin.

Projection Plane needed? See 
“Projection Plane” on the facing page. Yes

Probe Compensation needed? See 
“Probe Compensation” on page 184. No

Minimum Readings to Solve 1

See “Scanning” on page 190.
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XYZ Results The Point

Vector Same as plane

NOTE:  The probe should be well-seated in the hole when digitizing the point. Ensure that your probe is 
sufficiently larger than the hole to be measured. You can also edit (via Preferences) the auto nominal 
orientation, position, and size coefficients that control the size difference between measured and nominal 
circles. For more information, see “Automatically Associate Nominal ” on page 80.

Measuring a Paraboloid
Projection Plane needed? See 
“Projection Plane” below. No

Probe Compensation needed? See 
“Probe Compensation” on page 184. Yes

Minimum Readings to Solve 8

See “Scanning” on page 190.

XYZ Results Apex of Paraboloid

Vector Center Line of Paraboloid from 
Apex

See “Best Fit Paraboloid” on page 327.

Projection Plane
All two-dimensional (2D) features are entities in which the digitized readings are projected to a plane. All 
measurement readings are projected onto this plane before best fit calculations are started. 

Click the Projection Plane drop-down menu and select an option: 
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•  Select a Plane.1 

NOTE:  Constructed 
actual planes may be available. The Allow Constructed Actual Planes preference controls this option. For 
more information, see “Allow Constructed Actual Planes ” on page 80.

• Choosing <Define> adds an additional feature to the measurement file. You will digitize a plane before you 
digitize the points of the feature. Notice the messages in the Prompt area in the Measurement Panel for the 
active device. See “Measurement Panel” on page 188.

• Choosing <Auto> projects the points of the feature to an automatically selected plane. Notice the messages in 
the Prompt area in the Measurement Panel for the active device. See “Measurement Panel” on page 188.

• Choosing NONE uses the same points of the feature to create a plane.

See Default  on page 80, and Use Last Plane  on page 80. 

2D FEATURES: circles, ellipses, slots, 2D lines, planar points, high/low points, and 2D polylines.

Figure 8-1 Digitized readings projected to a plane

To offset a projection plane, first measure a plane and then construct a parallel plane. See “Construct Plane: By 
Offset” on page 229.

Options
The Options group enables quick access to measurement options such as Material Compensation, Show Feature 
Properties, and Use Arm As Mouse. 

Material Compensation
Material Compensation enables you to select material compensation options:

• None: (Default) No compensation.

1When in a dialog box, click the drop-down arrow and scroll down to select a plane, or plane reducible, feature. You can also click the name of 
the plane with the Left Mouse button in the Features panel. To select a plane from the Main Window, move the pointer over the drop-down list 
box and click the From Screen icon that appears. This selects the drop-down list and you can then click a plane with the Left Mouse button in 
the Main Window. If the drop-down list is already selected, then just click the plane with the Left Mouse button in the Main Window.
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• Back Side: Measure a side of a part with a common material thickness (plastics, sheet metal, etc.) that you 
cannot touch with your measurement device.

• Fixture - B Side: Inspect a fixture to confirm touch points contacting the part on the 'B' side. The actual 
measured point lies on the fixture, with dN relative to the fixture surface and the reading is shown on the CAD 
'A' surface. The error represents the material condition of the fixture touch point.

• Part Thickness: Inspect the part thickness deviation of a part held in a fixture, against touch points. Use a 
single surface CAD model offset to the probed part side. The actual measured point lies on the 'B' side, where 
the normal is opposite to the CAD surface. The reading is shown on the CAD 'A' surface, and indicates the 
flipped normal. The error represents the material thickness deviation of the part at the touch point. Specify the 
thickness and direction of your material by editing the Part Properties of your CAD file. See “Part Properties” 
on page 96.

• Clamp: Inspect fixture clamp positions, using the part’s CAD model to confirm touch points contacting the 
part on the 'A' side. The actual measured point lies on the clamp surface, where the normal is opposite to the 
CAD surface. The reading is shown on the CAD 'A' Surface, and indicates the flipped normal. The error 
represents the material condition of the clamp touch point.

Show Feature Properties
This preference controls whether the Feature Properties panel appears when you add new measured features. See 
“Show Control Window ” on page 78.

Use Arm As Mouse
This preference controls the interaction of the FaroArm and the CAM2 software. When enabled, the position of the 
probe controls the mouse pointer. See “Use Arm as Mouse ” on page 78.

Feature Properties
Most measured features have three properties: Plane, Material Compensation, and Probe Compensation. Plane 
projection features also have Depth Scanning properties. Properties for other features are described later in this 
chapter. 

You can edit the properties of an existing measured feature: 

• Select a feature from the Features panel or the CAD View. 

• Click Home > Properties. You can also right-click the feature in the Features panel and select Properties 
from the shortcut menu. In the Feature Properties panel you can: 

• Edit the name. 

• Select or clear the Material Compensation check box.

• Select a projection plane (2D features only). 

• Change the probe compensation. 

By default, the Feature Properties panel does not appear during each measure command. See “Show Control 
Window ” on page 78. 
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NOTE:  Some features always require you to set properties before creating the feature and ignore this 
preference.

Comments
The Features panel contains a Comments field into which you can type a textual comment. Features with 
comments are identified by a comment icon in the Features panel. You can view the comment quickly by moving 
the pointer over the icon.

NOTE:  You can include your comment in the feature’s label by selecting the Show Comments In Label 
check box.

Plane
Click the Plane drop-down menu and select a projection plane.  Select a Plane1 

Solver Method
This option allows you to best-fit a feature so that all readings are outside (maximum) or inside the feature 
(minimum), and applies to the following feature types: Circle, Sphere, Plane, 2D Line, Round Slot, Rectangular 
Slot, Cylinder and Cone.

Measure on CAD Side
Select this check box if you are measuring a side of a part with a common material thickness (plastics, sheet metal, 
etc.) that you cannot touch with your measurement device. 

Set the composition and global thickness of your material by editing the Part Properties of your CAD file. See 
“Part Properties” on page 96.

Display As Arc
This option allows you to display a circle as an arc using only the actual readings taken.

• When cleared (default), the circle will draw as normal.

• When selected, the circle will only cover the span of the readings.

Probe Compensation
The coordinates of all readings digitized with a spherical probe are located at the center of the probe. CAM2 
calculates for the difference between the center and circumference of the probe when you press the Back button, or 
H key. There are five methods to define the probe compensation:

• Auto: automatically compensates using the orientation position of the probe in each reading. When using 
this option, collect readings with the probe as perpendicular to the surface as possible.

• Sampled End Click: press the Back button, or H key to define probe compensation for each feature.

1When in a dialog box, click the drop-down arrow and scroll down to select a plane, or plane reducible, feature. You can also click the name of 
the plane with the Left Mouse button in the FEATURES panel. To select a plane from the MAIN WINDOW, move the pointer over the drop-
down list box and click the From Screen icon that appears. This selects the drop-down list and you can then click a plane with the Left Mouse 
button in the MAIN WINDOW. If the drop-down list is already selected, then just click the plane with the Left Mouse button in the MAIN 
WINDOW.
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• Measured Inside: automatically compensates out for a hole.

• Measured Outside: automatically compensates in for a stud.

• None: no probe compensation.

Press the Back button, or H key, to end any measurement command. The probe compensation is calculated after 
any best fitting of the measured feature. The current probe compensation method is a preference. See “Default 
Compensation Method ” on page 79.

NOTE:  Some measured features do not require probe compensation. Pressing the Back button, or H key, 
stops Add Readings . See “Add Readings ” on page 197.

Plane-Lock Scanning
Plane-lock Scanning enables you to specify a depth value for a plane projection feature. As you measure the 
feature, CAM2 will automatically record a measurement whenever the probe traverses a plane offset a given depth 
value below the projection plane. Plane-lock Scanning is especially helpful when measuring thin sheet metal planar 
features. 

Plane-lock Scanning options are as follows:

• Enable Plane-lock Scanning: Enables Plane-lock Scanning. If selected, you will measure on the offset 
plane. If cleared, you will measure on the projection plane.

• Plane Offset: (used in conjunction with Enable Plane-lock Scanning) The depth value for the offset plane.

• Enable Sound: Provides sound guidance with distance to depth plane. This option is not available if 
Enable Plane-lock Scanning is cleared.

• Measure on Offset Plane: Records a measurement when the center of probe crosses the offset plane. This 
option is not available if Enable Plane-lock Scanning is cleared.

NOTE:  The Plane-lock Scanning offset option is only applicable to plane projection features (Circle, 2D 
Line, Round Slot, Rectangular Slot, Ellipse, and Planar Point).

Point Distance Filter
When you have aligned point cloud data with a CAD model, the point distance filter excludes point cloud data a 
specified distance from CAD. Depending on the filter setting, you may see an increase or decrease of visible points 
in relation to the CAD model. An alignment change may also affect point visibility. 

NOTE:  Applying this filter only hides points. To permanently delete filtered points, click Delete Exclusions 
in the Feature Properties panel. 

Even Distribution
When working with a cross-section, Even Distribution samples points at a custom space interval. Check the Even 
Distribution check box, and enter the Point Spacing to sample points on the Cross Section. The default spacing is 
1mm. Average deviations will display on the given area of the cross-section.

Comparison to CAD
Comparison to CAD allows you to compare a point cloud to CAD without an alignment.
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• Automatic: (Default) CAM2 will compare a point cloud to CAD when you align them.

• Always On: CAM2 will always compare a point cloud to CAD even if an alignment is not present.

• Always Off: CAM2 will not compare a point cloud to CAD even if an alignment is present.

Scanning Filter
A scanning filter enables you to filter visible point cloud data by decimation or grid filter.

NOTE:  Applying a scanning filter only hides points. To permanently delete filtered points, click Delete 
Exclusions in the Feature Properties panel.

• Decimate: Use decimation to reduce the density of the point cloud. The decimation factor determines the 
number of points per line. For example, a value of 10 indicates that Measure will show every tenth point, 
effectively reducing the number of visible points by a factor of 10.

• Grid: Occasionally, you may scan portions of a part on which data has already been captured. Similar to 
Decimation, grid filtration avoids more than one point in a grid pattern. Enable Grid Filtering and enter the 
grid size. This will also control the resulting point density.

When using a Grid filter, point cloud data will be colored according to point quality based on the angle of 
incidence. Points outside of the acceptable angle will display red to indicate lower quality. You can replace the 
lower quality points by changing the angle of incidence (in the Measurement > Registration  preferences) and then 
rescanning to improve point cloud accuracy. See “Registration ” on page 83.

3D Imager
Registration  governs CAM2’s behavior when encountering bad points. See “Registration ” on page 83.

Plane Definition
Plane Definition provides additional planar control governing feature extraction from point clouds.

Plane: Select the feature’s projection plane.

Use Offset Projection Plane: Specifies the way in which CAM2 chooses points to calculate the feature’s 
projection plane. The option is only available when you select NONE for the projection plane. Specify the following 
parameters:

• Offset: The minimum distance from the outline of the measured feature at which CAM2 includes 
points for projection plane calculation. All points closer than the minimum distance from the outline 
of the feature will be excluded.

• Threshold: The width of the band in which to extract points for fitting the projection plane.

NOTE:  In the case of a circle, the zone will represent a disc around the fitted feature that will specify points 
to calculate the projection plane.

Extraction
Extraction provides additional point selection control governing feature extraction from point clouds.

Extraction options are as follows:
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• Standard Projection: CAM2 ignores all points on the plane and takes all remaining points to be on the 
feature (circle or 2D line) to extract. CAM2 projects the remaining points to the projection plane and 
calculates the feature.

NOTE:  The projection plane can be pre-selected or extracted from the selection. See “Selecting a Projection 
Plane for Extracting 2D Features” on page 201.

Depth Scan: Specifies the way in which Specify the following parameters takes the points that will be 
projected to the plane for fitting the feature. Select this option to exclude data close to the edge of the 
holes. Specify the following parameters:

• Offset: The minimum distance from the Projection Plane at which CAM2 includes points for the 
feature calculation. All points closer than the minimum distance from the projection plane will be 
excluded.

• Thickness: The width of the band in which to extract points for fitting the feature.

• Thin Material: CAM2 ignores points outside the plane and calculates the largest circle that can fit inside 
the gap from the hole. Select this option when scanning thin sheet material that prevents you taking 
interior data.

• Solver Method: Best-fit a feature so that all readings are outside (maximum) or inside the feature 
(minimum).

Laser Line Probe Measurement
CAM2 allows direct feature measurement with a Laser Line Probe, extracting features from the Laser Line Probe 
data. 

1. Calibrate your Laser Line Probe using the Device Center. For more information, see “Device Center” on page 
128. 

2. Set CAM2 to either Measure mode or Template mode. For more information, see “Measure Mode” on page 
23.

3. From the menu, select the feature to measure. Depending on your mode:

• the feature adds to the Features list. 

OR 

• the feature adds to the Features list and you are immediately prompted to measure. 

4. Digitize your part while staying within the measurement range of the Laser Line Probe. Watch the indicator in 
the Range Finder dialog box as you move the Laser Line Probe. After you press the Back button, calculated 
readings add to the feature from the Laser Line Probe data. 

Scanning Tolerance
As you scan your aligned part, CAM2 shows the deviations from tolerance:

• Green - the measurement is in tolerance.
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• Red - the measurement is above the upper tolerance.

• Blue - the measurement is below the lower tolerance.

Scanable Features
You can scan the following features with a Laser Line Probe: planes, circles, edge lines, spheres, cylinders, tubes, 
and point clouds. Selecting any other feature types will automatically switch to the ball probe.

Automatic Feature Recognition
CAM2 can provide an extremely simplified measurement workflow by automatically recognizing features as you 
measure. When you enable automatic feature recognition, you can begin recording measurements without first 
invoking a measurement command.

NOTE:  Automatic feature recognition is enabled and configured in Preferences. You must disable Arm as 
Mouse to use this feature. For more information, see Auto-Recognize Features  on page 78 and Use Arm as 
Mouse  on page 78.

1. Record a measurement using your measurement device. The Measurement Panel appears. See “Measurement 
Panel” below.

2. Continue to record measurements, and the Measurement panel shows the results and appropriate feature name 
as CAM2 computes the geometry that best fits the recorded measurements. 

NOTE:  You can override CAM2’s automatic computation by clicking the Geometry Override drop-down in 
the Measurement panel to manually select a geometry type. Available geometry types depend on the threshold 
set in Preferences.

3. When you finish recording measurements, record an end click to terminate the measurement of the feature. 

Measurement Panel
The Measurement panel opens automatically with each measurement command. Each measurement device, 
connected to CAM2, has a unique Measurement panel. Look in the title area of the panel to see the serial number, 
or name, of the device. 

Figure 8-1 Measurement Panel

NOTE:  Refer to the CAM2 2021 chapter in your hardware device’s user manual for more information about 
specific controls in the Measurement panel. 
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Setup
! The Measurement panel displays the Rectangular XYZ and Form values by default, which update as you 
record measurements. In the upper left corner of the window, click the Show Options drop-down and select, or 
deselect, values to show or hide different values. Some of these values use tolerances, For example:

• The Form value has an Out of Tolerance indicator to the right of the value. After you add one more than 
the minimum number of readings, the value calculates and shows In, Above or Below tolerance using the 
features current form tolerance value. For more information, see “Tolerances” on page 196.

" Show/hide the Geometric Data - geometric data and statistics associated with the current measurement. 

# Show/hide the device’s Digital ReadOut (DRO) - the current location of the measuring device’s probe and 
updates as the probe moves through space. The numerical setup of the DRO is a preference. See “Units Tab” on 
page 74.

$ Show/hide the Measurement Image - the image for the current measurement. For more information, see “Image 
Creator” on page 50. 

% Show/hide the Measurement Prompt - the text area that contains informational messages relating to the current 
measurement. 

Measuring
& Record Measurement. This is the same as pressing the Front button on the FaroArm, or the G key, on your 
computer keyboard. 

' Record End Click. This is the same as pressing the Back button on the FaroArm, or the H key, on your 
computer keyboard. 

( Remove Last Point. You can also press the Backspace key on your computer keyboard. 

NOTE:  Press and hold the Back button on the FaroArm to remove multiple readings in reverse order.

Sizing
) Full Screen. Maximize the Measurement panel to fill the entire computer screen. Click this button again to 
return to the original size.

Geometry Override
* Use the Geometry Override drop-down window to override CAM2’s Automatic Feature Recognition by 
manually selecting a geometry type. See “Automatic Feature Recognition” on the previous page.

NOTE:  Automatic recognition is enabled and configured in Preferences. See “Auto-Recognize Features ” on 
page 78. 
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Cancel
+Closing the Measurement panel cancels the measurement.

Laser Tracker Family and Probe
,Use the Target drop-down window to select an SMR size (FARO Laser Tracker only).

- Use the Adapter drop-down window to select a probe size (FARO Laser Tracker only).

Scanning
. Use the Mode drop-down window to switch the reading collection mode during the measurement process. 
Options for the modes are located in the Device Control panel. See the CAM2 chapter in the user manual of your 
current measuring device for more information. 

• Single Point: press the Front button, or the G key, to collect a single reading. 

• Time Interval: press the Front button, or the G key, to start the time interval. Collect a single reading 
over time. 

• Distance Interval: press the Front button, or the G key, to start the distance interval. Collect a single 
reading when the probe moves a distance.

NOTE:  If the current probe is a Laser Line Probe on the FaroArm, it is best to use the Time Interval setting 
with a very small time interval. Setting the time interval to 5ms collects point data at the FaroArm’s maximum 
speed.

Feature Changes During Measurement
During the adding of readings, or measurement, of a feature it is possible to change the following using the drop-
down list boxes in the Measurement panel:

• The projection plane of any 2D feature;
• The projection surface for an Inspect Surface or Inspect Surface Point feature; and
• Probe settings 

before the feature solves. This is useful if you are measuring many of the same type of feature that slight 
differences or special needs.

Live Measurement Results
The Measurement panel provides real-time feedback of the geometry currently being measured. RMS values of 
the last reading display in the window (Laser Tracker only). For more information, see “RMS Threshold ” on page 
86. Geometric values appear in the window as soon as the minimum number of points required to solve the feature 
have been recorded. The values displayed in the window automatically update each time a new reading is recorded.
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NOTE:  For large numbers of readings at a high rate (such as scanning), the user must pause for a sufficient 
period of time to allow the geometry to solve without affecting the rate of point collection.

Automatic Probe Compensation
Solved geometry must be automatically probe-compensated to accurately represent the measured geometry; as 
such, automatic probe compensation is the default for all measured features. In this mode, the back button click 
will only be used to end the measurement of a feature, not to indicate the compensation direction.

Sampled End Click compensation may be used when the automatic or forced inside/outside compensation 
techniques do not suffice. In this scenario, geometric values shown while measuring may not match the resulting 
geometry solved after the end click is taken. The current probe compensation method is a preference. See “Default 
Compensation Method ” on page 79.

NOTE:  Measurement of geometry that always requires a single sample will automatically complete after the 
first sample is taken.

Layers
Use layers as a way to group and organize features. You can show and hide layers to help simplify your CAD 
view. Changes made to layers are saved along with the CAM2 measurement file. For more information, see 
“Layers” on page 112. 

Labels
After adding the minimum number of readings to solve the feature, and an end click point, the feature draws on the 
CAD view and an on-screen label adds to the measurement file. 
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Figure 8-1 Feature Labels

This label shows the current data for the feature and the border changes color to show any Out of Tolerance 
condition: 

• Green - the feature is in tolerance

• Red - measurement is above the upper tolerance

• Blue - measurement is below the lower tolerance

Select a feature, or multiple features, and each label shows relevant values for the feature. If the feature contains 
actual values, the label shows actual values. If the feature contains nominal values, the label shows nominal values. 
If the feature contains both actual and nominal values, the label shows actual values, nominal values, and deviation. 

NOTE:  XYZ positional data does not show without a solved alignment.

When a feature is not selected, the label only shows the feature name. Move the pointer over the label to 
temporarily show all of the values. Add or Remove values from the labels using the Feature Information panel. 
See “Nominals and Tolerances” on page 194.

To move a label, drag the label around the CAD view or press L to automatically arrange the label in the view. 

To show or hide a label, right-click the current feature in the Features panel or the CAD view, and select Label 
from the shortcut menu. Right-click again and select Detailed Label to change the label to the detailed format. 

There are many preferences to control the visibility, content and behavior of the feature labels. See “Display” on 
page 69.

Measurement Data
Measurement data consists of the individual digitized points of the feature.
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NOTE:  Selecting a “By Best Fit” constructed feature shows each individual feature and its data to the 
constructed feature. 

Figure 8-1 Measurement Data panel

Select a feature, or multiple features, from the Measurement Data panel and use the Measurement Data panel to: 

1. Analyze the readings of a feature.

• The default sort order of the rows is by the ID column. This is also the order of the readings as they were 
added to the feature. Click a column to sort the readings by that column, and click again to reverse the 
sort. 

2. Remove a reading from the feature and re-calculate the feature using the remaining readings.

• Clear the check box in the On column to remove a reading. Click Apply to re-calculate the feature using 
the selected features.

3. Change the probe of existing readings.

•  Select from the List1 the readings. 

• Click Edit Probe 
Settings.

• In the Edit Probe Settings dialog box, change the probe settings and click OK. You can also enter values 
manually for any offsets.

4. Permanently delete a reading.

• Select a reading, right-click and select Delete from the shortcut menu.

NOTE:  The Clear Readings deletes all readings from every feature in your file. See “Clear Readings” on 
page 109.

5. Generate a report of the readings of a feature, or multiple features.

• Click Report to quickly generate a report. For more information, see “Standard Home Tab Report 
Commands” on page 49.

6. Aim the FARO Laser Tracker to the location of an individual reading.

1When in a dialog box, click in the Selected Choices window. Select a single feature by clicking the name of the feature with the Left Mouse 
button. Select multiple, consecutive features from the Feature panel by holding down the Shift key, clicking the first (top) feature in the 
sequence with the Left Mouse button, then clicking the last feature in the sequence with the Left Mouse button. Select multiple features in non-
consecutive order by holding down the Ctrl key and clicking each feature with the Left Mouse button. You can also click a feature with the Left 
Mouse button in the Main Window, or the name of the feature with the Left Mouse button in the Features panel.  
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• Select a reading, right-click and select Aim to point the Laser Tracker at the location of the reading.

Panel Settings
Change the order of the columns by dragging the top of a column to the left or right. Resize a column by dragging 
the top edge of a column to the left or right. Hide a column by dragging the top of a column down to the bottom of 
the Measurement Data panel.

Right-click on the top of any column to get a shortcut menu:

1. Select Sort Ascending to Sort Descending to change the sort order of the readings.

2. Select Column Chooser to see a list of hidden columns. To unhide a column, drag the column from the list 
back to the Measurement Data panel.

3. Select Best Fit to automatically size the column.

4. Select Best Fit (all columns) to automatically size all the columns in the Measurement Data panel.

Nominals and Tolerances
Add and edit nominal and tolerance information to a feature in the Feature Information panel. Use this panel to: 

• Add single or multiple nominal features to a feature. 

• Type in nominal values and create a nominal feature. 

• Change the default Upper and Lower tolerance values for each actual result and see the Deviation values from 
nominal. 

• Select or clear individual values for a feature. This controls visibility of the values on the on-screen label and 
the report.

• Associate a DIN or ISO tolerance classification to a feature. Selecting a tolerance class in either the lower or 
upper tolerance column will set the tolerance values for both upper and lower tolerances. When associating a 
tolerance classification to a feature, it will apply to all applicable properties of that feature.

Figure 8-1 Feature Information panel

NOTE:  You can select multiple features and edit each in the panel. See “Selecting Features” on page 34.

Panel Settings
Each value has a check box; clear this check box to remove it from the on-screen label and the report. Use Show 
Only Selected at the bottom of the Feature Information panel to only show features with checked boxes.

Single Nominal
1. Select a feature from the Features panel or the CAD view.
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2. In the top row of the Feature information panel, click the Nominal Feature column cell, then click the drop-
down arrow.

3.  Select a Feature.1

NOTE:  Clicking X 
in the Nominals Feature column removes the nominal feature from the current feature. 

Multiple Nominals
1. Select a feature from the Features panel or the CAD view.

2. In each row of the Feature Information panel, click the Nominals Feature column cell, then click the drop-
down arrow. Use the scroll bar on the right side of the panel to move down the list and see other values. 

3.  Select a Feature.2

NOTE:  Clicking X 
in the Nominal Feature column removes the nominal feature from the current feature. 

Typing Nominal Values
1. Select a feature from the Features panel or the CAD view.

2. In each row of the Feature Information panel, click in the Nominal column. Type a numeric nominal value and 
press the Enter key. Use the scroll bar on the right side of the panel to move down the list and see other values. 

Adding a nominal feature to a measured, or constructed, feature creates a group in the Navigation Window. See 
“Navigation Window” on page 33. 

Dynamic Nominals
In a few instances, the nominal feature is more complex than the measured feature. In some measured features, 
CAM2 automatically associates a complex nominal to a simple measured feature. When this happens the simple 
measured feature is projected (shortest distance) to the complex nominal. The Actual to Nominal data is the simple 
measured feature and the projected simple nominal feature. 

For example, an Inspect Surface Point has a measured point and an associated nominal surface. The projected 
nominal point is the closest point anywhere on the surface. See “Measuring an Inspect Surface Point” on 
page 156.

Automatic Nominals
Once an Alignment is complete, any new measured feature is compared to all nominals and CAD parts in the 
measurement file. For more information, see “Alignments” on page 265.

1When in a dialog box, click the drop-down arrow and scroll down to select a feature. You can also click the name of the feature with the Left 
Mouse button in the Features panel. To select a feature from the Main Window, move the pointer over the drop-down list box and click the 
From Screen icon that appears. This selects the drop-down list and you can then click a feature with the Left Mouse button in the Main Win-
dow. If the drop-down list is already selected, then just click the feature with the Left Mouse button in the Main Window.
2When in a dialog box, click the drop-down arrow and scroll down to select a feature. You can also click the name of the feature with the Left 
Mouse button in the Features panel. To select a feature from the Main Window, move the pointer over the drop-down list box and click the 
From Screen icon that appears. This selects the drop-down list and you can then click a feature with the Left Mouse button in the Main Win-
dow. If the drop-down list is already selected, then just click the feature with the Left Mouse button in the Main Window.
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If a similar nominal feature is found it is automatically associated. If there is a feature in a CAD part, that feature 
automatically adds as a nominal and associated to the measured feature. Automatic Nominals is a preference with 
default search vales. For more information, see “Automatically Associate Nominal ” on page 80.

Tolerances
NOTE:  In addition to traditional rectangular tolerances, CAM2 also supports many GD&T tolerances. For 
more information, see “GD&T” on page 287.

You can change tolerance values for an individual or selected group of features. You can also change the default 
tolerance values for the entire file in the Tolerance Preferences. See “Tolerance Preferences” on page 63. 

1. Select a feature in the Features panel or from the CAD window. 

2. In the Feature Information panel, select or clear the check box in the first column for each value to tolerance.

3. Change an individual tolerance value by clicking in the Lower or Upper cell and typing a numeric value.

The OOT (Out of Tolerance) and Tolerance columns show the measured to nominal deviations. Each feature 
parameter cell changes color to show any Out of Tolerance condition:

• Green (Pass) - measurement is within the upper and lower tolerance

• Red - measurement is above the upper tolerance

• Blue - measurement is below the lower tolerance

The Tolerance column graphically shows the amount of tolerance that is consumed by the deviation (Pass), or the 
amount above or below tolerance. If the deviation is more than four times the tolerance a plus or minus sign is 
added to the bar.

NOTE:  You will not see some feature values in the on-screen label and the report if an Alignment has not 
been completed. See “Manage Alignments” on page 266.

Changing Multiple Values
You can change the lower and upper tolerance value for multiple values of a feature:

1. Select a feature in the Features panel or from the CAD window. 

2. In the Feature Information panel, hold down the Shift key and left-click the first (top) parameter, then click the 
last parameter you want. For example, the lower tolerance X Y and Z locations. 

3. Type a numeric value into any tolerance field and press Enter. 

You can change the lower and upper tolerance for all values of a feature:

1. Select a feature in the Features panel or from the CAD window. 

2. In the Feature Information panel, left-click the empty cell at the top of the lower or upper tolerance column. 

3. Type a numeric value into any tolerance field and press Enter.
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Add Readings 
Add Readings adds readings to an existing measured feature. You can also press the Insert keyboard shortcut on 
the keyboard.

1. Select a feature in the Features panel or the CAD window.

2. Right-click the feature in the Features panel and select Add Readings from the shortcut menu. If the probe is 
visible on-screen, it will flash green when you add readings.

3. Use your measuring device and add more readings to the feature using the Front button, or Gkey. 

4. Press the Back button, or Hkey, to finish. If the probe is visible on-screen, it will flash red when you press the 
Back button, or Hkey.

NOTE:  You can also use the buttons in the Measurement Panel. For more information, see “Measurement 
Panel” on page 188.

NOTE:  Pressing the Back button, or Hkey, may also define the Probe Compensation. For more information, 
see “Probe Compensation” on page 184.

If you select multiple features the measurement order follow the position of the features in the Features panel. See 
“Reordering Features” on page 36.

Using Multiple Devices
If you have multiple devices connected to CAM2, use the shortcut menu to select a specific device. 

1. Select a feature in the Features panel or the CAD window.

2. Right-click the feature and select the Add Readings From flyout.

3. Select a measurement device and add readings to the feature.
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Chapter 9: Extract

The Extract commands are located in the Extract tab across the top of the screen. The Extract commands allow 
you to extract geometric features from a point cloud by selecting points in the View window. Feature extraction 
may not be as accurate as hard probing; however, if the material is soft or flexible, extraction will be more accurate 
and repeatable than hard probing.

The commands on the Extract tab are organized into Manual Probing, Selection Tools, Features, and Options 
groups. 

Layers
Use layers as a way to group and organize features. You can show and hide layers to help simplify your CAD 
view. Changes made to layers are saved along with the CAM2 measurement file. For more information, see 
“Layers” on page 112. 

 
Manual Probing 200

Selection Tools 200

Features 201

Options 202
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Manual Probing
The Manual Probing group contains commands to manually pick points from a point cloud in order to extract a 
feature: Probing Mode, Remove Last, and Clear Probings.

Probing Mode
Click Probing Mode to enable manual point picking for feature extraction from a point cloud. As you pick points, 
the list of extractable features calculated from the points appears on the left side of the Main window. To create a 
feature from the list, click the feature.

Remove Last
Removes the last point you picked.

Clear Probings
Clears all picked points.

Selection Tools
The Selection Tools group contains commands to select portions of point cloud data for geometry calculation: 
Rectangular, Lasso, Polygon, and Brush. For more information, see “Selection Tools” on page 38.

Editing Point Selections
Adding Points
To add to the current point selection, press and hold the SHIFT key while selecting more points. When you’re 
finished, the resulting selection will include points from the existing selection and the new selection. 

NOTE:  While you add points this way, the selection cursor is appended with a small '+' sign.

Subtracting Points
To subtract points from the current selection, press and hold the CTRL key while selecting the points to subtract. 
When complete, the resulting selection will exclude the points you most recently selected from the existing 
selection.

NOTE:  While you subtract points this way, the selection cursor is appended with a small '-' sign.

From Properties
As you view the feature’s properties using the Feature Properties window, the feature’s points are highlighted in 
the Main window. From here, you can reselect points in the Main window using the Adding Points and 
Subtracting Points methods. When you have updated the point selection, click Modify to save changes to the 
feature. See “Feature Properties” on page 183.
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Clear
Clear resets the active point selection.

Features
The Features group contains all the geometric features that can be extracted from the point cloud: plane, 2D line, 
circle, sphere, cylinder, cone, torus, vector point, round slot, and rectangular slot. Any 3D Feature creates a 
geometric feature that best fits your selected points. Extract All extracts all nominal features from CAD, all 
measured features from existing nominals, and all measured features from selected points.

Extraction from Point Clouds
To extract a feature from a point cloud:

• Use the Selection Tools to select a region of points that fully contains the feature to extract.

• In the Features group, select the feature type to be extracted.

• CAM2 extracts the feature.

Extraction from Nominal
When a point cloud is aligned to a CAD model, CAM2 can automatically extract geometric features from the point 
cloud when you pick a nominal CAD feature. 

To extract a measured feature from a nominal:

• Load a CAD model and align to it.

• Measure a point cloud over CAD features.

• Pick a feature from the CAD model.

• CAM2 creates the nominal feature and extracts the measured feature from the Point Cloud.

NOTE:  The Extraction  - Automatically Relate Scan Data to Nominal Data user preference must be enabled 
to use this feature. See “Extraction ” on page 82. 

Selecting a Projection Plane for Extracting 2D Features
You can specify the projection plane from which to extract a line or circle (2D features) using the Select 
Projection Plane drop-down list on the Measure tab. See “Measure” on page 153.

• Auto: (Default) CAM2 will determine the best existing projection plane for this new feature. If no such plane 
exists, CAM2 will extract the plane from the point cloud data.

• None: CAM2 will extract a projection plane from the data, and then extract the 2D feature using this 
projection plane.

• <Any other plane>: CAM2 will use the selected projection plane as the projection plane for the feature you 
are extracting.
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NOTE:  As with any measured 2D feature, you can also edit the Properties of the extracted feature and modify 
the feature’s projection plane. For more information, see “Properties” on page 108.

Options
The Options group contains options to define a Sampling Method. 

Sampling Method
Click Sampling to select a sampling method: standard projection or thin material. 

FARO CAM2
Chapter 9: Extract

FARO CAM2 2021 (v2021.0)Page 202 of 336



Chapter 10: Key-In

The Key-In commands are located in the Key-In tab across the top of the screen, and are organized into Features 
and Dimensions groups. 

Use these commands to create Nominal features using data on drawings or spreadsheets. 

Layers
Use layers as a way to group and organize features. You can show and hide layers to help simplify your CAD 
view. Changes made to layers are saved along with the CAM2 measurement file. For more information, see 
“Layers” on page 112. 

 
Features 204

Dimensions 215
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Features
The Features group contains all the construction commands for 2D and 3D features. 

Plane
Requires: three sets of XYZ values, or one XYZ value and a normal vector value.

• Name: Type in a name for the constructed plane.

• Plane: Select a radio button:

• Points: Type in the XYZ values.  Typing values in different units and coordinate systems1

OR 

• Point: Type in the XYZ value.  Typing values in different units and coordinate systems2

• Normal: Type in the XYZ values.  Typing values in different units and coordinate 
systems3

• 
Click Create to create the plane.

NOTE:  The vector of the constructed plane is determined by the Right-Hand Rule. For more information, see 
“Right-Hand Rule” on page 330.

Line
Requires: two points.

• Name: Type in a name for the constructed line.

• Point on Line: Select a radio button:

• Point2 on Line: Type in the XYZ values.  Typing values in different units and coordinate systems4

1You can type a value in any unit, and CAM2 converts the value to the default unit value. For example, the default value is 0,0,0 mm but your 
feature is 5,5,10 inches. Type 5in, 5in, 10in and CAM2 automatically converts the value to 127, 127, 254 millimeters. To change the coordinate 
system, click the arrow on the right side of the dialog box and select from the menu. CAM2 automatically converts the values to the current 
coordinate system during the feature construction. 
2You can type a value in any unit, and CAM2 converts the value to the default unit value. For example, the default value is 0,0,0 mm but your 
feature is 5,5,10 inches. Type 5in, 5in, 10in and CAM2 automatically converts the value to 127, 127, 254 millimeters. To change the coordinate 
system, click the arrow on the right side of the dialog box and select from the menu. CAM2 automatically converts the values to the current 
coordinate system during the feature construction. 
3You can type a value in any unit, and CAM2 converts the value to the default unit value. For example, the default value is 0,0,0 mm but your 
feature is 5,5,10 inches. Type 5in, 5in, 10in and CAM2 automatically converts the value to 127, 127, 254 millimeters. To change the coordinate 
system, click the arrow on the right side of the dialog box and select from the menu. CAM2 automatically converts the values to the current 
coordinate system during the feature construction. 
4You can type a value in any unit, and CAM2 converts the value to the default unit value. For example, the default value is 0,0,0 mm but your 
feature is 5,5,10 inches. Type 5in, 5in, 10in and CAM2 automatically converts the value to 127, 127, 254 millimeters. To change the coordinate 
system, click the arrow on the right side of the dialog box and select from the menu. CAM2 automatically converts the values to the current 
coordinate system during the feature construction. 
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OR 

• Line Vector: Type in the IJK values.  Typing values in different units and coordinate systems1

• Length: Type in the length value.  Typing values in different units2

• Click Create to create the line.

Point
Requires: an X, Y, and Z value.

• Name: Type in a name for the constructed point.

• Points: Type in the XYZ values.  Typing values in different units and coordinate systems3

• Click Create to create the point.

Vector Point
Requires: an X, Y, and Z value and a normal vector.

• Name: Type in a name for the vector point.

• Point: Type in the XYZ values.  Typing values in different units and coordinate systems4

• Vector: Determine from CAD or Type in:

• From CAD: Select the Determine Vector from CAD check box to calculate the point’s vector from a 
CAD model.

• Vector: Type in the IJK values.  Typing values in different units and coordinate systems5

Selection
• Zone Type: Choose from 3 zone types:

• Cylindrical creates a circular zone.

1You can type a value in any unit, and CAM2 converts the value to the default unit value. For example, the default value is 0,0,0 mm but your 
feature is 5,5,10 inches. Type 5in, 5in, 10in and CAM2 automatically converts the value to 127, 127, 254 millimeters. To change the coordinate 
system, click the arrow on the right side of the dialog box and select from the menu. CAM2 automatically converts the values to the current 
coordinate system during the feature construction. 
2You can type a value in any unit, and CAM2 converts the value to the default unit value. For example, the default value is 0mm but the dia-
meter is 10inches. Type 10in and CAM2 automatically converts the value to 254 millimeters.
3You can type a value in any unit, and CAM2 converts the value to the default unit value. For example, the default value is 0,0,0 mm but your 
feature is 5,5,10 inches. Type 5in, 5in, 10in and CAM2 automatically converts the value to 127, 127, 254 millimeters. To change the coordinate 
system, click the arrow on the right side of the dialog box and select from the menu. CAM2 automatically converts the values to the current 
coordinate system during the feature construction. 
4You can type a value in any unit, and CAM2 converts the value to the default unit value. For example, the default value is 0,0,0 mm but your 
feature is 5,5,10 inches. Type 5in, 5in, 10in and CAM2 automatically converts the value to 127, 127, 254 millimeters. To change the coordinate 
system, click the arrow on the right side of the dialog box and select from the menu. CAM2 automatically converts the values to the current 
coordinate system during the feature construction. 
5You can type a value in any unit, and CAM2 converts the value to the default unit value. For example, the default value is 0,0,0 mm but your 
feature is 5,5,10 inches. Type 5in, 5in, 10in and CAM2 automatically converts the value to 127, 127, 254 millimeters. To change the coordinate 
system, click the arrow on the right side of the dialog box and select from the menu. CAM2 automatically converts the values to the current 
coordinate system during the feature construction. 
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• Diameter: enter the zone size.

• Rectangular creates a rectangular zone.

• Length: enter the zone length (longest).

• Width: enter the zone width (shortest).

• Angle: enter the orientation angle

• Round Slot creates a rounded slot zone.

• Length: enter the zone length (longest)

• Radius: enter the zone width (shortest)

• Angle: enter the orientation angle

• Threshold: is the distance from the CAD surface (+/-). Readings outside this value will be ignored for the 
vector point calculation.

• Ignore Range: is used only with tactile measurement.

Extraction
Project to nominal vector: This option will project the calculated extracted point to the nominal vector in order to 
report deviation in the surface normal direction (dN). (default)

NOTE:  If you manually extract an actual vector point (as opposed to automatic extraction using a nominal), 
this option is deselected by default and reported deviation is X,Y,Z and dN when associated to a nominal 
Vector Point.

Solver Method:

• Standard: calculates the mean point in vectorial direction.

• Maximum: calculates the highest point in vectorial direction.

• Minimum: calculates the lowest point in vectorial direction.

• Click Create to create the vector point. 

Circle
Requires: an XYZ coordinate, a vector, and a diameter.

• Name: Type in a name for the constructed circle.

• Circle: Type in the XYZ values.  Typing values in different units and coordinate systems1

1You can type a value in any unit, and CAM2 converts the value to the default unit value. For example, the default value is 0,0,0 mm but your 
feature is 5,5,10 inches. Type 5in, 5in, 10in and CAM2 automatically converts the value to 127, 127, 254 millimeters. To change the coordinate 
system, click the arrow on the right side of the dialog box and select from the menu. CAM2 automatically converts the values to the current 
coordinate system during the feature construction. 
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• Normal: Type in the IJK values.  Typing values in different units and coordinate systems1

• Diameter: Type in the diameter value.  Typing values in different units2

• Click Create to create the circle.

The constructed circle is located at the entered values in the current coordinate system.

Sphere
Requires: a diameter and X, Y, and Z values.

• Name: Type in a name for the constructed sphere.

• Center: Type in the XYZ values.  Typing values in different units and coordinate systems3

• Diameter: Type in the diameter value.  Typing values in different units4

• Click Create to create the sphere.

Cylinder
Requires: a diameter, and two center points, or a vector and a length.

• Name: Type in a name for the constructed cylinder.

• Point on Axis: Select a radio button:

• Point 2 on Axis: Type in the XYZ values.  Typing values in different units and coordinate systems5

OR 

• Axis Vector: Type in the IJK values.  Typing values in different units and coordinate systems6

1You can type a value in any unit, and CAM2 converts the value to the default unit value. For example, the default value is 0,0,0 mm but your 
feature is 5,5,10 inches. Type 5in, 5in, 10in and CAM2 automatically converts the value to 127, 127, 254 millimeters. 
To change the coordinate system, click the arrow on the right side of the dialog box and select 
from the menu. CAM2 automatically converts the values to the current coordinate system during 
the feature construction. 
2You can type a value in any unit, and CAM2 converts the value to the default unit value. For example, the default value is 0mm but the dia-
meter is 10inches. Type 10in and CAM2 automatically converts the value to 254 millimeters.
3You can type a value in any unit, and CAM2 converts the value to the default unit value. For example, the default value is 0,0,0 mm but your 
feature is 5,5,10 inches. Type 5in, 5in, 10in and CAM2 automatically converts the value to 127, 127, 254 millimeters. To change the coordinate 
system, click the arrow on the right side of the dialog box and select from the menu. CAM2 automatically converts the values to the current 
coordinate system during the feature construction. 
4You can type a value in any unit, and CAM2 converts the value to the default unit value. For example, the default value is 0mm but the dia-
meter is 10inches. Type 10in and CAM2 automatically converts the value to 254 millimeters.
5You can type a value in any unit, and CAM2 converts the value to the default unit value. For example, the default value is 0,0,0 mm but your 
feature is 5,5,10 inches. Type 5in, 5in, 10in and CAM2 automatically converts the value to 127, 127, 254 millimeters. To change the coordinate 
system, click the arrow on the right side of the dialog box and select from the menu. CAM2 automatically converts the values to the current 
coordinate system during the feature construction. 
6You can type a value in any unit, and CAM2 converts the value to the default unit value. For example, the default value 
is 0,0,0 mm but your feature is 5,5,10 inches. Type 5in, 5in, 10in and CAM2 automatically con-
verts the value to 127, 127, 254 millimeters. To change the coordinate system, click the arrow on 
the right side of the dialog box and select from the menu. CAM2 automatically converts the values to the current coordinate system during the 
feature construction. 
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• Length: Type in the length value.  Typing values in different units1

• Diameter: Type in the diameter value.  Typing values in different units2

• Click Create to create the cylinder.

Torus
Requires: a center point, direction number of the torus axis, major diameter, minor diameter, start vector, and 
sweep angle.

• Name: Type in a name for the constructed torus.

• Center Point: Type in the XYZ values.  Typing values in different units and coordinate systems3

• Point on Axis: Select a radio button:

• Point on Axis: Type in the XYZ values.  Typing values in different units and coordinate systems4

OR 

• Axis (Normal): Type in the IJK values.  Typing values in different units and coordinate systems5

• Major Diameter: Type in the outermost or largest diameter of the torus.

• Minor Diameter: Type in the innermost or smallest diameter of the torus.

• Start Vector: Type in the IJK values.  Typing values in different units and coordinate systems6

• Sweep Angle: Type in the size of the segment to construct. Full sweep angle (360°) constructs 
the whole torus.

• Click Create to create the torus.

1You can type a value in any unit, and CAM2 converts the value to the default unit value. For example, the default value is 0mm but the dia-
meter is 10inches. Type 10in and CAM2 automatically converts the value to 254 millimeters.
2You can type a value in any unit, and CAM2 converts the value to the default unit value. For example, the default value is 0mm but the dia-
meter is 10inches. Type 10in and CAM2 automatically converts the value to 254 millimeters.
3You can type a value in any unit, and CAM2 converts the value to the default unit value. For example, the default value is 0,0,0 mm but your 
feature is 5,5,10 inches. Type 5in, 5in, 10in and CAM2 automatically converts the value to 127, 127, 254 millimeters. To change the coordinate 
system, click the arrow on the right side of the dialog box and select from the menu. CAM2 automatically converts the values to the current 
coordinate system during the feature construction. 
4You can type a value in any unit, and CAM2 converts the value to the default unit value. For example, the default value is 0,0,0 mm but your 
feature is 5,5,10 inches. Type 5in, 5in, 10in and CAM2 automatically converts the value to 127, 127, 254 millimeters. To change the coordinate 
system, click the arrow on the right side of the dialog box and select from the menu. CAM2 automatically converts the values to the current 
coordinate system during the feature construction. 
5You can type a value in any unit, and CAM2 converts the value to the default unit value. For example, the default value is 0,0,0 mm but your 
feature is 5,5,10 inches. Type 5in, 5in, 10in and CAM2 automatically converts the value to 127, 127, 254 millimeters. To change the coordinate 
system, click the arrow on the right side of the dialog box and select from the menu. CAM2 automatically converts the values to the current 
coordinate system during the feature construction. 
6You can type a value in any unit, and CAM2 converts the value to the default unit value. For example, the default value is 0,0,0 mm but your 
feature is 5,5,10 inches. Type 5in, 5in, 10in and CAM2 automatically converts the value to 127, 127, 254 millimeters. To change the coordinate 
system, click the arrow on the right side of the dialog box and select from the menu. CAM2 automatically converts the values to the current 
coordinate system during the feature construction. 
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Tube
Requires: a diameter, PTB or XYZ, and bend radius.

NOTE:  PTB is sometimes labeled as yBC.

• Tube Diameter: Type in the diameter of the tube.

• Default Bend Radius: Type in the default value for the tube’s bend radius. This value will automatically 
populate the Bend Radius field as you input PTB or XYZ data.

• Key-in Tube Data As: Select a radio button:

• PTB: Type in the Pull, Turn, Bend, and Bend Radius values.  Typing values in different units and 
coordinate systems1

OR 

• XYZ: Type in the Breakpoints and Bend Radius values.  Typing values in different units and coordinate 
systems2

• 
Click Create to create the tube.

Cone
Requires: see the options below.

• Name: Type in a name for the constructed cone.

There are five different methods for this construction. Select from the Construct Cone by drop-down:

• Apex: Type in the XYZ values.  Typing values in different units and coordinate systems3

• Axis Direction: Type in the IJK values.  Typing values in different units and coordinate 
systems4

1You can type a value in any unit, and CAM2 converts the value to the default unit value. For example, the default value is 0,0,0 mm but your 
feature is 5,5,10 inches. Type 5in, 5in, 10in and CAM2 automatically converts the value to 127, 127, 254 millimeters. To change the coordinate 
system, click the arrow on the right side of the dialog box and select from the menu. CAM2 automatically converts the values to the current 
coordinate system during the feature construction. 
2You can type a value in any unit, and CAM2 converts the value to the default unit value. For example, the default value is 0,0,0 mm but your 
feature is 5,5,10 inches. Type 5in, 5in, 10in and CAM2 automatically converts the value to 127, 127, 254 millimeters. To change the coordinate 
system, click the arrow on the right side of the dialog box and select from the menu. CAM2 automatically converts the values to the current 
coordinate system during the feature construction. 
3You can type a value in any unit, and CAM2 converts the value to the default unit value. For example, the default value is 0,0,0 mm but your 
feature is 5,5,10 inches. Type 5in, 5in, 10in and CAM2 automatically converts the value to 127, 127, 254 millimeters. To change the coordinate 
system, click the arrow on the right side of the dialog box and select from the menu. CAM2 automatically converts the values to the current 
coordinate system during the feature construction. 
4You can type a value in any unit, and CAM2 converts the value to the default unit value. For example, the default value is 0,0,0 mm but your 
feature is 5,5,10 inches. Type 5in, 5in, 10in and CAM2 automatically converts the value to 127, 127, 254 millimeters. To change the coordinate 
system, click the arrow on the right side of the dialog box and select from the menu. CAM2 automatically converts the values to the current 
coordinate system during the feature construction. 

FARO CAM2
Chapter 10: Key-In

FARO CAM2 2021 (v2021.0) Page 209 of 336



• Distance to Apex: Type in a distance value.

• Angle: Type in the angle value.  Typing values in different units1

• Half Angle: Clear this check box if you are entering the full angle 
of the cone.

• Click Create to create the cone.

The constructed cone is located at the entered values in the selected coordinate system.

Apex, Axis Position and Angle 
• Apex: Type in the XYZ values.  Typing values in different units and coordinate systems2

• Axis Position: Type in the XYZ values.  Typing values in different units and coordinate 
systems3

•
 Angle: Type in the angle value.  Typing values in different units4

• Half Angle: Clear this check box if you are entering the full 
angle of the cone.

• Click Create to create the cone.

The constructed cone is located at the entered values in the selected coordinate system.

Axis, Point on Axis, Diameter at Point and Angle 
• Axis Direction: Type in the IJK values.  Typing values in different units and coordinate systems5

• Point on Axis: Type in the XYZ values.  Typing values in different units and coordinate systems6

1You can type a value in any unit, and CAM2 converts the value to the default unit value. For example, the default value is 0mm but the dia-
meter is 10inches. Type 10in and CAM2 automatically converts the value to 254 millimeters.
2You can type a value in any unit, and CAM2 converts the value to the default unit value. For example, the default value is 0,0,0 mm but your 
feature is 5,5,10 inches. Type 5in, 5in, 10in and CAM2 automatically converts the value to 
127, 127, 254 millimeters. To change the coordinate system, click the arrow on the right side of the dialog box and select from the menu. 
CAM2 automatically converts the values to the current coordinate system during the feature construction. 
3You can type a value in any unit, and CAM2 converts the value to the default unit value. For example, the default value is 0,0,0 mm but your 
feature is 5,5,10 inches. Type 5in, 5in, 10in and CAM2 automatically converts the value to 127, 127, 254 millimeters. To change the coordinate 
system, click the arrow on the right side of the dialog box and select from the menu. CAM2 automatically converts the values to the current 
coordinate system during the feature construction. 
4You can type a value in any unit, and CAM2 converts the value to the default unit value. For example, the default value is 0mm but the dia-
meter is 10inches. Type 10in and CAM2 automatically converts the value to 254 millimeters.
5You can type a value in any unit, and CAM2 converts the value to the default unit value. For example, the default value is 0,0,0 mm but your 
feature is 5,5,10 inches. Type 5in, 5in, 10in and CAM2 automatically converts the value to 127, 127, 254 millimeters. To change the coordinate 
system, click the arrow on the right side of the dialog box and select from the menu. CAM2 automatically converts the values to the current 
coordinate system during the feature construction. 
6You can type a value in any unit, and CAM2 converts the value to the default unit value. For example, the default value is 
0,0,0 mm but your feature is 5,5,10 inches. Type 5in, 5in, 10in and CAM2 automatically converts the value to 127, 127, 254 millimeters. To 
change the coordinate system, click the arrow on the right side of the dialog box and select from the menu. CAM2 automatically converts the 
values to 
the current coordinate system during the feature construction. 
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• Diameter at Point: Type in a diameter value.  Typing values in different units1

• Angle: Type in the angle value.  Typing values in different units2

• Half Angle: Clear this check box if you are entering the full angle 
of the cone.

• Click Create to create the cone.

The constructed cone is located at the entered values in the selected coordinate system.

Axis, Point on Axis, Distance to Apex and Diameter at Point 
• Axis Direction: Type in the IJK values.  Typing values in different units and coordinate systems3

• Point on Axis: Type in the XYZ values.  Typing values in different units and coordinate systems4

• Distance to Apex: Type in a distance value.  Typing values in different units5

• Diameter at Point: Type in a diameter value.  Typing values in different 
units6

•
 Click Create to create the cone.

The constructed cone is located at the entered values in the selected coordinate system.

Axis, Axis Position, Distance from Point to Apex and Angle
• Axis Direction: Type in the IJK values.  Typing values in different units and coordinate systems7

1You can type a value in any unit, and CAM2 converts the value to the default unit value. For example, the default value is 0mm but the dia-
meter is 10inches. Type 10in and CAM2 automatically converts the value to 254 millimeters.
2You can type a value in any unit, and CAM2 converts the value to the default unit value. For example, the default value is 0mm but the dia-
meter is 10inches. Type 10in and CAM2 automatically converts the value to 254 millimeters.
3You can type a value in any unit, and CAM2 converts the value to the default unit value. For example, the default value is 0,0,0 mm but your 
feature is 5,5,10 inches. Type 5in, 5in, 10in and CAM2 automatically converts the value to 127, 127, 254 millimeters. To change the coordinate 
system, click the arrow on the right side of the dialog box and select from the menu. CAM2 automatically converts the values to the current 
coordinate system during the feature construction. 
4You can type a value in any unit, and CAM2 converts the value to the default unit value. For example, the default value is 0,0,0 mm but your 
feature is 5,5,10 inches. Type 5in, 5in, 10in and CAM2 automatically converts the value to 127, 127, 254 millimeters. To change the coordinate 
system, click the arrow on the right side of the dialog box and select from the menu. CAM2 automatically converts the values to the current 
coordinate system during the feature construction. 
5You can type a value in any unit, and CAM2 converts the value to the default unit value. For example, the default value is 0mm but the dia-
meter is 10inches. Type 10in and CAM2 automatically converts the value to 254 millimeters.
6You can type a value in any unit, and CAM2 converts the value to the default unit value. For example, the default value is 0mm but the dia-
meter is 10inches. Type 10in and CAM2 automatically converts the value to 254 millimeters.
7You can type a value in any unit, and CAM2 2020 converts the value to the default unit value. For example, the default value is 0,0,0 
mm but your feature is 5,5,10 inches. Type 5in, 5in, 10in and CAM2 2020 automatically converts the value to 127, 127, 254 millimeters. To 
change the coordinate system, click the arrow on the right side of the dialog box and select from the menu. CAM2 2020 automatically 
converts the values to the current coordinate system during the feature construction. 
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• Axis Position: Type in the XYZ values.  Typing values in different units and coordinate systems1

• Distance from Point to Apex: Type in a distance value.  Typing values in different units2

• Angle: Type in the angle value.  Typing values in different units3

• Half Angle: Clear this check box if you are entering the full angle 
of the cone.

• Click Create to create the cone.

The constructed cone is located at the entered values in the selected coordinate system.

Round Slot
Requires: a center point, the vector of the major and minor axes, and the length and the diameter of the round slot.

• Name: Type in a name for the constructed rectangular slot.

• Center: Type in the XYZ values.  Typing values in different units and coordinate systems4

• Normal: Type in the IJK values.  Typing values in different units and coordinate systems5

• Axis: Type in the IJK values.  Typing values in different units and coordinate systems6

• Length: Type in the length value.  Typing values in different units7

• Diameter: Type in the length value.  Typing values in different 
units8

•
Select or clear the Length is End to End check box.

1You can type a value in any unit, and CAM2 converts the value to the default unit value. For example, the default value is 0,0,0 mm but your 
feature is 5,5,10 inches. Type 5in, 5in, 10in and CAM2 automatically converts the value to 127, 127, 254 millimeters. To change the coordinate 
system, click the arrow on the right side of the dialog box and select from the menu. CAM2 automatically converts the values to the current 
coordinate system during the feature construction. 
2You can type a value in any unit, and CAM2 converts the value to the default unit value. For example, the default value is 0mm but the dia-
meter is 10inches. Type 10in and CAM2 automatically converts the value to 254 millimeters.
3You can type a value in any unit, and CAM2 converts the value to the default unit value. For example, the default value is 0mm but the dia-
meter is 10inches. Type 10in and CAM2 automatically converts the value to 254 millimeters.
4You can type a value in any unit, and CAM2 converts the value to the default unit value. For example, the default value is 0,0,0 mm but your 
feature is 5,5,10 inches. Type 5in, 5in, 10in and CAM2 automatically converts the value to 127, 127, 254 millimeters. To change the coordinate 
system, click the arrow on the right side of the dialog box and select from the menu. CAM2 automatically converts the values to the current 
coordinate system during the feature construction. 
5You can type a value in any unit, and CAM2 converts the value to the default unit value. For example, the default value is 0,0,0 mm but your 
feature is 5,5,10 inches. Type 5in, 5in, 10in and CAM2 automatically converts the value to 127, 127, 254 millimeters. To change the coordinate 
system, click the arrow on the right side of the dialog box and select from the menu. CAM2 automatically converts the values to the current 
coordinate system during the feature construction. 
6You can type a value in any unit, and CAM2 converts the value to the default unit value. For example, the default value is 0,0,0 mm but your 
feature is 5,5,10 inches. Type 5in, 5in, 10in and CAM2 automatically converts the value to 127, 127, 254 millimeters. To change the coordinate 
system, click the arrow on the right side of the dialog box and select from the menu. CAM2 automatically converts the values to the current 
coordinate system during the feature construction. 
7You can type a value in any unit, and CAM2 converts the value to the default unit value. For example, the default value is 0mm but the dia-
meter is 10inches. Type 10in and CAM2 automatically converts the value to 254 millimeters.
8You can type a value in any unit, and CAM2 converts the value to the default unit value. For example, the default value is 0mm but the dia-
meter is 10inches. Type 10in and CAM2 automatically converts the value to 254 millimeters.
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• Click Create to create the round slot. 

 

Figure 10-1 Round Slot on the previous page

•  

Rectangular Slot
Requires: a center point, the vector of the major and minor axes, and the length and the width of the rectangular 
slot.

• Name: Type in a name for the constructed rectangular slot.

• Center: Type in the XYZ values.  Typing values in different units and coordinate systems1

• Normal: Type in the IJK values.  Typing values in different units and coordinate systems2

• Axis: Type in the IJK values.  Typing values in different units and coordinate systems3

• Length: Type in the length value.  Typing values in different units4

• Width: Type in the length value. Typing values in different units5

• Click Create to create the rectangular slot.

1You can type a value in any unit, and CAM2 converts the value to the default unit value. For example, the default value is 0,0,0 mm but your 
feature is 5,5,10 inches. Type 5in, 5in, 10in and CAM2 automatically converts the value to 127, 127, 254 millimeters. To change the coordinate 
system, click the arrow on the right side of the dialog box and select from the menu. CAM2 automatically converts the values to the current 
coordinate system during the feature construction. 
2You can type a value in any unit, and CAM2 converts the value to the default unit value. For example, the default value is 0,0,0 mm but your 
feature is 5,5,10 inches. Type 5in, 5in, 10in and CAM2 automatically converts the value to 127, 127, 254 millimeters. To change the coordinate 
system, click the arrow on the right side of the dialog box and select from the menu. CAM2 automatically converts the values to the current 
coordinate system during the feature construction. 
3You can type a value in any unit, and CAM2 converts the value to the default unit value. For example, the default value is 0,0,0 mm but your 
feature is 5,5,10 inches. Type 5in, 5in, 10in and CAM2 automatically converts the value to 127, 127, 254 millimeters. To change the coordinate 
system, click the arrow on the right side of the dialog box and select from the menu. CAM2 automatically converts the values to the current 
coordinate system during the feature construction. 
4You can type a value in any unit, and CAM2 converts the value to the default unit value. For example, the default value is 0mm but the dia-
meter is 10inches. Type 10in and CAM2 automatically converts the value to 254 millimeters.
5You can type a value in any unit, and CAM2 converts the value to the default unit value. For example, the default value is 0mm but the dia-
meter is 10inches. Type 10in and CAM2 automatically converts the value to 254 millimeters.
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Ellipse
Requires: a center point, the vector of the major and minor axes, and the length of the major and minor axes.

• Name: Type in a name for the constructed ellipse.

• Center: Type in the XYZ values.  Typing values in different units and coordinate systems1

• Normal: Type in the IJK values.  Typing values in different units and coordinate systems2

• Axis: Type in the IJK values.  Typing values in different units and coordinate systems3

• Major: Type in the major length value.  Typing values in different units4

• Minor: Type in the minor length value.  Typing values in different units5

• Click Create to create the ellipse. 

Paraboloid
Requires: an apex, the focal point of the major and minor axes, and the length and the diameter of the paraboloid.

• Name: Type in a name for the constructed paraboloid.

• Apex: Type in the XYZ values.  Typing values in different units and coordinate systems6

• Focal Point: Type in the XYZ values.  Typing values in different units and coordinate 
systems7

1You can type a value in any unit, and CAM2 converts the value to the default unit value. For example, the default value is 0,0,0 mm but your 
feature is 5,5,10 inches. Type 5in, 5in, 10in and CAM2 automatically converts the value to 127, 127, 254 millimeters. To change the coordinate 
system, click the arrow on the right side of the dialog box and select from the menu. CAM2 automatically converts the values to the current 
coordinate system during the feature construction. 
2You can type a value in any unit, and CAM2 converts the value to the default unit value. For example, the default value is 0,0,0 mm but your 
feature is 5,5,10 inches. Type 5in, 5in, 10in and CAM2 automatically converts the value to 127, 127, 254 millimeters. To change the coordinate 
system, click the arrow on the right side of the dialog box and select from the menu. CAM2 automatically converts the values to the current 
coordinate system during the feature construction. 
3You can type a value in any unit, and CAM2 converts the value to the default unit value. For example, the default value 
is 0,0,0 mm but your feature is 5,5,10 inches. Type 5in, 5in, 10in and CAM2 automatically converts the value to 127, 
127, 254 millimeters. To change the coordinate system, click the arrow on the right side of the dialog box and select 
from the menu. CAM2 automatically converts the values to the current coordinate system during the feature construction. 
4You can type a value in any unit, and CAM2 converts the value to the default unit value. For example, the default 
value is 0mm but the diameter is 10inches. Type 10in and CAM2 automatically converts the value to 254 millimeters.
5You can type a value in any unit, and CAM2 converts the value to the default unit value. For 
example, the default value is 0mm but the diameter is 10inches. Type 10in and CAM2 automatically converts the value to 254 millimeters.
6You can type a value in any unit, and CAM2 converts the value to the default unit value. For 
example, the default value is 0,0,0 mm but your feature is 5,5,10 inches. Type 5in, 5in, 10in and CAM2 automatically converts the value to 127, 
127, 254 millimeters. To change the coordinate system, click the arrow on the right side of the dialog box and select from the menu. CAM2 
automatically converts the values to the current coordinate system during the feature construction. 
7You can type a value in any unit, and CAM2 converts the value to the default unit value. For example, the default value is 0,0,0 mm but your 
feature is 5,5,10 inches. Type 5in, 5in, 10in and CAM2 automatically converts the value to 127, 127, 254 millimeters. To change the coordinate 
system, click the arrow on the right side of the dialog box and select from the menu. CAM2 automatically converts the values to the current 
coordinate system during the feature construction. 
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• Length: Type in the length value.  Typing values in different units1

• Diameter: Type in the length value.  Typing values in different 
units2

•
 Click Create to create the paraboloid.

Dimensions
The Dimensions group contains Dimension Angle By Key In and Dimension Length By Key In. The number of 
digits in the dimension data is a preference. See “Units Tab” on page 74.

Dimension Angle By Key-In
Requires: a numeric value.

• Name: Type in a name for the angle dimension.

• Angle: Type in the value.

• Click Create to create the dimension.

Dimension Length By Key-In
Requires: a numeric value. 

• Name: Type in a name for the length dimension.

• Length: Type in the value.  Typing values in different units3

• Click Create to create the dimension.

 

1You can type a value in any unit, and CAM2 converts the value to the default unit value. For example, the default value is 0mm but the dia-
meter is 10inches. Type 10in and CAM2 automatically converts the value to 254 millimeters.
2You can type a value in any unit, and CAM2 converts the value to the default unit value. For example, the default value is 0mm but the dia-
meter is 10inches. Type 10in and CAM2 automatically converts the value to 254 millimeters.
3You can type a value in any unit, and CAM2 converts the value to the default unit value. For example, the default value is 0mm but the dia-
meter is 10inches. Type 10in and CAM2 automatically converts the value to 254 millimeters.
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Chapter 11: Pick From CAD

The Pick from CAD commands are located in the Pick From CAD tab across the top of the screen.

Use these commands to create Nominal features from CAD models that you add to the measurement file. For more 
information, see “CAD” on page 61.

Layers
Use layers as a way to group and organize features. You can show and hide layers to help simplify your CAD 
view. Changes made to layers are saved along with the CAM2 measurement file. For more information, see 
“Layers” on page 112. 
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Pick Features
Click Pick Features to enable intelligent feature-picking mode. When enabled, you can create a nominal feature 
with a single click anywhere on your CAD model without first having to specify the feature type. In the case of 
similar features, CAM2 will provide you with options to select the nominal feature you’d like to create; for 
example, you can create a nominal circle, ellipse, or round slot when you click a hole on your CAD model.

NOTE:  Intelligent feature-picking mode does not support Point, Vector Point, Inspect Surface Point, or 
Paraboloid feature types.

To exit the Automatic mode: 

• Click the Automatic button in the lower right corner of the Main window 

• Click Automatic again 

• Click a different CAD picking command.

Point
Create a constructed point from a CAD model.

• Name: Type in a name for the constructed point.

• Add Statistics: Check this box to add geometric statistics (tolerancing information) to the constructed point.

• Points: Select a nominal point to create the feature.  Select Nominal Points1

Vector Point
Create a vector point from a CAD model.

• Name: Type in a name for the vector point.

Selection
• Zone Type: Choose from 3 zone types:

• Cylindrical creates a circular zone.

• Diameter: enter the zone size.

• Rectangular creates a rectangular zone.

• Length: enter the zone length (longest).

1When choosing points from a CAD model, click any part of the surface, individual points, surface trim lines, polylines, or splines. When pick-
ing a line, you use the point at which the mouse pointer intersects the line. 
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• Width: enter the zone width (shortest).

• Angle: enter the orientation angle

• Round Slot creates a rounded slot zone.

• Length: enter the zone length (longest)

• Radius: enter the zone width (shortest)

• Angle: enter the orientation angle

• Threshold: is the distance from the CAD surface (+/-). Readings outside this value will be ignored for the 
vector point calculation.

• Ignore Range: is used only with tactile measurement.

Extraction
Project to nominal vector: This option will project the calculated extracted point to the nominal vector in order to 
report deviation in the surface normal direction (dN). (default)

NOTE:  If you manually extract an actual vector point (as opposed to automatic extraction using a nominal), 
this option is deselected by default and reported deviation is X,Y,Z and dN when associated to a nominal 
Vector Point.

Solver Method:

• Standard: calculates the mean point in vectorial direction.

• Maximum: calculates the highest point in vectorial direction.

• Minimum: calculates the lowest point in vectorial direction.

• Click on any CAD surface to create the vector point. 

Inspect Surface Point
Create an inspect surface point from a CAD model. Select the feature, or select a nominal point on a surface, 
surface trim line, polyline, or spline to create the feature. 

NOTE:  This command automatically creates an actual Inspect Surface Point feature. 

• Name: Type in a name for the vector point.

• Click on any CAD surface to create the vector point.
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Paraboloid
Create a constructed paraboloid from a CAD model. Select the feature, or select a nominal point on a surface trim 
line, polyline, or spline to create the feature. 

• Name: Type in a name for the constructed paraboloid.

• Add Statistics: Check this box to add geometric statistics (tolerancing information) to the constructed ellipse.

• Points: Select a nominal point to create the feature. See “Select Nominal Points” on page 1.

NOTE:  The vector of the paraboloid is determined by the CAD view at the time you construct the paraboloid. 
If necessary,  use Flip Vector to change the vector of the constructed paraboloid. See “Flip Vector” on 
page 109.

Plane
Create a constructed plane from a CAD model. Select the feature, or select a nominal point on a surface, surface 
trim line, polyline, or spline to create the feature.

• Name: Type in a name for the constructed plane.

• Add Statistics: Check this box to add geometric statistics (tolerancing information) to the constructed plane.

• Points: Select a nominal point to create the feature. See “Select Nominal Points” on page 1.

NOTE:  The vector of the plane is determined by the CAD view at the time you construct the plane. If 
necessary,  use Flip Vector to change the vector of the constructed plane. See “Flip Vector” on page 109.

Line 
Create a constructed line from a CAD model. Select the feature, or select a nominal point on a surface trim line, 
polyline, or spline to create the feature.

• Name: Type in a name for the constructed line.

• Add Statistics: Check this box to add geometric statistics (tolerancing information) to the constructed line.

• Points: Select a nominal point to create the feature. See “Select Nominal Points” on page 1.

NOTE:  The vector of the line is determined by the CAD view at the time you construct the line. If necessary, 
use Flip Vector to change the vector of the constructed line. See “Flip Vector” on page 109.
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Circle 
Create a constructed circle from a CAD model. Select the feature, or select a nominal point on a surface trim line, 
polyline, or spline to create the feature. 

• Name: Type in a name for the constructed circle.

• Add Statistics: Check this box to add geometric statistics (tolerancing information) to the constructed circle.

• Points: Select a nominal point to create the feature.  Select Nominal Points1

NOTE:  The vector of the circle is determined by the CAD view at the time you 
construct the circle. If necessary, use Flip Vector to change the vector of the constructed circle. See “Flip 
Vector” on page 109.

Sphere 
Create a constructed sphere from a CAD model. Select the feature, or select a nominal point on a surface trim line, 
polyline, or spline to create the feature.

• Name: Type in a name for the constructed sphere.

• Add Statistics: Check this box to add geometric statistics (tolerancing information) to the constructed sphere.

• Points: Select a nominal point to create the feature.  Select Nominal Points2

Cylinder 
Create a constructed cylinder from a CAD model. Select the feature, or select a nominal point on a surface trim 
line, polyline, or spline to create the feature. 

• Name: Type in a name for the constructed cylinder.

• Add Statistics: Check this box to add geometric statistics (tolerancing information) to the constructed 
cylinder.

• Points: Select a nominal point to create the feature.See “Select Nominal Points” on page 1.

NOTE:  The vector of the cylinder is determined by the CAD view at the time you construct the cylinder. If 
necessary,  use Flip Vector to change the vector of the constructed cylinder. See “Flip Vector” on page 109.

1When choosing points from a CAD model, click any part of the surface, individual points, surface trim lines, polylines, or splines. When pick-
ing a line, you use the point at which the mouse pointer intersects the line. 
2When choosing points from a CAD model, click any part of the surface, individual points, surface trim lines, polylines, or splines. When pick-
ing a line, you use the point at which the mouse pointer intersects the line. 
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Torus
Create a constructed torus from a CAD model. Select the feature, or select a nominal point on a surface trim line, 
polyline, or spline to create the feature.

• Name: Type in a name for the constructed torus.

• Add Statistics: Check this box to add geometric statistics (tolerancing information) to the constructed torus.

• Points: Select a nominal point to create the feature.  Select Nominal Points1

Cone 
Create a constructed cone from a CAD model. Select the feature, or select a nominal point on a surface trim line, 
polyline, or spline to create the feature. 

• Name: Type in a name for the constructed cone.

• Add Statistics: Check this box to add geometric statistics (tolerancing information) to the constructed cone.

• Points: Select a nominal point to create the feature.  Select Nominal Points2

• Click Create to create the cone.

NOTE:  The vector of the cone is determined by the CAD view at the time you construct the cone. If 
necessary, use Flip Vector to change the vector of the constructed cone. See “Flip Vector” on page 109.

Round Slot 
Create a constructed round slot from a CAD model. Select the feature, or select a nominal point on a surface trim 
line, polyline, or spline to create the feature.

• Name: Type in a name for the constructed round slot.

• Add Statistics: Check this box to add geometric statistics (tolerancing information) to the constructed round 
slot.

• Points: Select a nominal point to create the feature.  Select Nominal Points3

1When choosing points from a CAD model, click any part of the surface, individual points, surface trim lines, polylines, or splines. When pick-
ing a line, you use the point at which the mouse pointer intersects the line. 
2When choosing points from a CAD model, click any part of the surface, individual points, surface trim lines, polylines, or splines. When pick-
ing a line, you use the point at which the mouse pointer intersects the line. 
3When choosing points from a CAD model, click any part of the surface, individual points, surface trim lines, polylines, or splines. When pick-
ing a line, you use the point at which the mouse pointer intersects the line. 
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NOTE:  The vector of the slot is determined by the CAD view at the time you construct the slot. If necessary, 
use Flip Vector to change the vector of the constructed slot. See “Flip Vector” on page 109.

Rectangular Slot 
Create a constructed rectangular slot from a CAD model. Select the feature, or select a nominal point on a surface 
trim line, polyline, or spline to create the feature.

• Name: Type in a name for the constructed rectangular slot.

• Add Statistics: Check this box to add geometric statistics (tolerancing information) to the constructed 
rectangular slot.

• Points: Select a nominal point to create the feature.  Select Nominal Points1

NOTE:  The vector of the slot is determined by the CAD view at the time you 
construct the slot. If necessary, use Flip Vector to change the vector of the constructed slot. See “Flip Vector” 
on page 109.

Ellipse 
Create a constructed ellipse from a CAD model. Select the feature, or select a nominal point on a surface trim line, 
polyline, or spline to create the feature. 

• Name: Type in a name for the constructed ellipse.

• Add Statistics: Check this box to add geometric statistics (tolerancing information) to the constructed ellipse.

• Points: Select a nominal point to create the feature.  Select Nominal Points2

NOTE:  The vector of the ellipse is determined by the CAD view at the time you 
construct the ellipse. If necessary,   use Flip Vector to change the vector of the constructed ellipse. See “Flip 
Vector” on page 109.

1When choosing points from a CAD model, click any part of the surface, individual points, surface trim lines, polylines, or splines. When pick-
ing a line, you use the point at which the mouse pointer intersects the line. 
2When choosing points from a CAD model, click any part of the surface, individual points, surface trim lines, polylines, or splines. When pick-
ing a line, you use the point at which the mouse pointer intersects the line. 
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Chapter 12: Construct

The Construct commands are located in the Construct tab across the top of the screen. The Construct tab contains 
eleven feature commands, including seven that “flyout” to additional Construction commands. The commands on 
the Construct tab are organized into Features, Dimensions, Patterns, and Construct From Selected Features groups. 

Layers
Use layers as a way to group and organize features. You can show and hide layers to help simplify your CAD 
view. Changes made to layers are saved along with the CAM2 measurement file. For more information, see 
“Layers” on page 112.

 
About Constructions 226

Features 226

Dimensions 257

Patterns 262

Construct From Selected Features 263

FARO CAM2 2021 (v2021.0) Page 225 of 336



About Constructions
You can use Constructed features in other constructions, dimensions, coordinate systems, or measurements.

Automatic Constructions
CAM2 automatically creates a construction when you create a construction feature using nominal features and then 
create and measure measured features associated to the individual nominal features. See Pick From CAD on 
page 217 and Key-In on page 203. 

For Example:
• Add nominals to your measurement file, four circles in a bolt pattern.
• Construct a circle by best fit using those four circles. This is a nominal constructed circle.
• Add Measurements to the four nominal circles. 
• Add Readings to each of the four measured circles.
• A Constructed feature, by best fit, using the four measured circles automatically adds to the measurement file 

and associates to the nominal constructed circle.

Expand Geometry
CAM2 also extracts non-center points from lines, cylinders, round slots, and rectangular slots for use in 
constructions. Right-click a feature and select Expand Geometry to instantly add the following points to your 
measurement file:

• Line: Start, End, Midpoint.
• Cylinder: Base, Top, Midpoint.
• Round Slot: Center 1, Center 2.
• Rectangular Slot: First Corner, Second Corner, Third Corner, Fourth Corner.

Using Actual and Nominal Features
If you select a combination of Actual (measured and constructed) and Nominal features in any Construct 
command, a drop-down arrow adds to Create in the dialog box. Select Create as Nominal or Create as Actual 
from the drop-down list. 

CAUTION:  Although at times it may be necessary to mix nominal, measured, and constructed features when 
creating constructions, do it rarely and with caution because mixing types of features to create a construction 
might cause inaccuracies in your measurement data.

Features
The Features group contains all the commands necessary to construct 2D and 3D features. 

Construct Plane
A plane is constructed from point-reducible features, entered values, the intersection of features, or a CAD model. 

FARO CAM2
Chapter 12: Construct

FARO CAM2 2021 (v2021.0)Page 226 of 336



Construct Plane: By 3 Points and 3 Offsets
Requires: three points and three offset distances.

• Name: Type in a name for the constructed plane.

• Points:  Select a Point.1 

• Offsets: Enter positive 
or negative offset distances.  Typing values in different units and coordinate systems.2 

• Click Create to create the plane.

The plane is constructed so the perpendicular distance from the plane to the selected points, using the offset values. 
The direction of the offset is determined by the selected points, and follows the Right-Hand Rule. See “Right-Hand 
Rule” on page 330.

NOTE:  A plane can be constructed above or below the three points, which is why the order that the points are 
selected determines which plane is created.

Figure 12-1 Construct Plane: By 3 Points and 3 Offsets

Construct Plane: By Best Fit
Requires: three point-reducible features.

• Name: Type in a name for the constructed plane.

1When in a dialog box, click the drop-down arrow and scroll down to select a point, or point reducible, feature. You can also click the name of 
the point with the Left Mouse button in the Points panel. To select a point from the Main Window, move the pointer over the drop-down list 
box and click the From Screen icon that appears. This selects the drop-down list and you can then click a point with the Left Mouse button in 
the Main Window. If the drop-down list is already selected, then just click the point with the Left Mouse button in the Main Window.
2You can type a value in any unit, and CAM2 2020 converts the value to the default unit value. For example, the default value is 0,0,0 mm but 
your feature is 5,5,10 inches. Type 5in, 5in, 10in and CAM2 2020 automatically converts the value to 127, 127, 254 millimeters. To change the 
coordinate system, click the arrow on the right side of the dialog box and select from the menu. CAM2 2020 automatically converts the values 
to the current coordinate system during the feature construction.
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• Points:  Select from the List.1 

• After you add the 
minimum number of features a preview feature draws in the Main Window and the dialog box displays 
preview feature data.

• Click Create to create the line.

The selected features are constructed into a Best Fit Plane. See “Best Fit Plane” on page 328. Use the 
Measurement Data panel to see the point data of the feature. For more information, see “Measurement Data” on 
page 192. 

Construct Plane: By Bisection
Requires: two planes.

• Name: Type in a name for the constructed plane.

• Planes:  Select a Plane.2 

• Click Create to create 
the line.

• If the two planes are not parallel, another plane is constructed equidistantly from both planes.

• If the two planes are parallel, another plane is constructed midway between the two planes, with the same 
vector as the first plane.

Figure 12-1 Construct Plane: By Bisection

1When in a dialog box, click in the Selected Choices window. Select a single feature by clicking the name of the feature with the Left Mouse 
button. Select multiple, consecutive features from the Feature panel by holding down the Shift key, clicking the first (top) feature in the 
sequence with the Left Mouse button, then clicking the last feature in the sequence with the Left Mouse button. Select multiple features in non-
consecutive order by holding down the Ctrl key and clicking each feature with the Left Mouse button. You can also click a feature with the Left 
Mouse button in the Main Window, or the name of the feature with the Left Mouse button in the Features panel. 
2When in a dialog box, click the drop-down arrow and scroll down to select a plane, or plane reducible, feature. You can also click the name of 
the plane with the Left Mouse button in the Features panel. To select a plane from the Main Window, move the pointer over the drop-down list 
box and click the From Screen icon that appears. This selects the drop-down list and you can then click a plane with the Left Mouse button in 
the Main Window. If the drop-down list is already selected, then just click the plane with the Left Mouse button in the Main Window.
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NOTE:  There are two possible solutions that are determined by the vector of the selected planes. For more 
information, see “Flip Vector” on page 109.

Construct Plane: By Offset
Requires: a plane and an offset value, a point and an offset distance, or a vector and an offset value.

• Name: Type in a name for the constructed plane.

• Plane:  Select a Plane.1 

• Offset: Select a radio 
button:

• Absolute Offset: Enter a positive or negative offset distance.  Typing values in different units.2 

OR 

• Point:  Select a Point.3 

• Offset: Enter a positive 
or negative offset distance.  Typing values in different units.4 

OR 

• Along Normal:  Select a Plane.5 

• Offset: Enter a positive or 
negative offset distance.  Typing values in different units.6 

• Click Create to create the line.

To construct a parallel plane, select the plane as a vector and type in an offset value.

1When in a dialog box, click the drop-down arrow and scroll down to select a plane, or plane reducible, feature. You can also click the name of 
the plane with the Left Mouse button in the Features panel. To select a plane from the Main Window, move the pointer over the drop-down list 
box and click the From Screen icon that appears. This selects the drop-down list and you can then click a plane with the Left Mouse button in 
the Main Window. If the drop-down list is already selected, then just click the plane with the Left Mouse button in the Main Window.
2You can type a value in any unit, and CAM2 2020 converts the value to the default unit value. For example, the default value is 0mm but the 
diameter is 10inches. Type 10in and CAM2 2020 automatically converts the value to 254 millimeters. 
3When in a dialog box, click the drop-down arrow and scroll down to select a point, or point reducible, feature. You can also click the name of 
the point with the Left Mouse button in the Points panel. To select a point from the Main Window, move the pointer over the drop-down list 
box and click the From Screen icon that appears. This selects the drop-down list and you can then click a point with the Left Mouse button in 
the Main Window. If the drop-down list is already selected, then just click the point with the Left Mouse button in the Main Window. 
4You can type a value in any unit, and CAM2 2020 converts the value to the default unit value. For example, the default value is 0mm but the 
diameter is 10inches. Type 10in and CAM2 2020 automatically converts the value to 254 millimeters. 
5When in a dialog box, click the drop-down arrow and scroll down to select a plane, or plane reducible, feature. You can also click the name of 
the plane with the Left Mouse button in the Features panel. To select a plane from the Main Window, move the pointer over the drop-down list 
box and click the From Screen icon that appears. This selects the drop-down list and you can then click a plane with the Left Mouse button in 
the Main Window. If the drop-down list is already selected, then just click the plane with the Left Mouse button in the Main Window.
6You can type a value in any unit, and CAM2 2020 converts the value to the default unit value. For example, the default value is 0mm but the 
diameter is 10inches. Type 10in and CAM2 2020 automatically converts the value to 254 millimeters. 
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Figure 12-1 Construct Plane: By Offset

Construct Plane: Perpendicular
Requires: a line (two points) and a point.

• Name: Type in a name for the constructed plane.

• Line: Select a radio button:

• Line:  Select a Line.1 

OR 

• Points:  Select a Point.2 

• Point:  Select a Point.3 

The plane is constructed 
perpendicular to the line and through the point. The normal vector of the constructed plane is the same as the 
vector of the selected line.

1When in a dialog box, click the drop-down arrow and scroll down to select a line, or line reducible, feature. You can also click the name of the 
line with the Left Mouse button in the Lines panel. To select a line from the Main Window, move the pointer over the drop-down list box and 
click the From Screen icon that appears. This selects the drop-down list and you can then click a line with the Left Mouse button in the Main 
Window. If the drop-down list is already selected, then just click the line with the Left Mouse button in the Main Window. Note: Two points 
can also be used to define a line. You can construct a line using two points using Construct Line: By Best Fit.  
2When in a dialog box, click the drop-down arrow and scroll down to select a point, or point reducible, feature. You can also click the name of 
the point with the Left Mouse button in the Points panel. To select a point from the Main Window, move the pointer over the drop-down list 
box and click the From Screen icon that appears. This selects the drop-down list and you can then click a point with the Left Mouse button in 
the Main Window. If the drop-down list is already selected, then just click the point with the Left Mouse button in the Main Window.
3When in a dialog box, click the drop-down arrow and scroll down to select a point, or point reducible, feature. You can also click the name of 
the point with the Left Mouse button in the Points panel. To select a point from the Main Window, move the pointer over the drop-down list 
box and click the From Screen icon that appears. This selects the drop-down list and you can then click a point with the Left Mouse button in 
the Main Window. If the drop-down list is already selected, then just click the point with the Left Mouse button in the Main Window.

FARO CAM2
Chapter 12: Construct

FARO CAM2 2021 (v2021.0)Page 230 of 336



Figure 12-1 Construct Plane: Perpendicular

Construct Line
A line is constructed from point-reducible features, entered values, the intersection of features, or a CAD model.

Construct Line: By Best Fit
Requires: point-reducible or line-reducible features for a 3D line, and point-reducible or line-reducible features and 
a plane for a 2D line.

• Name: Type in a name for the constructed line.

• Points/Lines:  Select from the List.1 

• Plane:  Select a Plane.2 Or clear the 
U
se Plane check box. 

• After you add the minimum number of features a preview feature draws in the Main Window and the 
dialog box displays preview feature data.

• Click Create to create the line.

If the Use Plane check box is selected, the features are projected to the plane before constructed into a Best Fit 
Line. See “Best Fit Line” on page 327. Otherwise, the features are fit to a plane.  Use the Measurement Data 
panel to see the point data of the feature. For more information, see “Measurement Data” on page 192. 

1When in a dialog box, click in the Selected Choices window. Select a single feature by clicking the name of the feature with the Left Mouse 
button. Select multiple, consecutive features from the Feature panel by holding down the Shift key, clicking the first (top) feature in the 
sequence with the Left Mouse button, then clicking the last feature in the sequence with the Left Mouse button. Select multiple features in non-
consecutive order by holding down the Ctrl key and clicking each feature with the Left Mouse button. You can also click a feature with the Left 
Mouse button in the Main Window, or the name of the feature with the Left Mouse button in the Features panel. 
2When in a dialog box, click the drop-down arrow and scroll down to select a plane, or plane reducible, feature. You can also click the name of 
the plane with the Left Mouse button in the Features panel. To select a plane from the Main Window, move the pointer over the drop-down list 
box and click the From Screen icon that appears. This selects the drop-down list and you can then click a plane with the Left Mouse button in 
the Main Window. If the drop-down list is already selected, then just click the plane with the Left Mouse button in the Main Window. 
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Construct Line: By Axis Best Fit
Use this command to determine best-fit centerlines for shafts or gears containing different-sized cylinders.

Requires: line-reducible features for a 3D line, and line-reducible features and a plane for a 2D line.

• Name: Type in a name for the constructed line.

• Lines:  Select from the List.1 

• Plane:  Select a Plane.2 Or 
c
lear the Use Plane check box. 

• After you add the minimum number of features a preview feature draws in the Main Window and the 
dialog box displays preview feature data.

• Click Create to create the line.

If the Use Plane check box is selected, the features are projected to the plane before constructed into a Best Fit 
Line. See “Best Fit Line” on page 327. Otherwise, the features are fit to a plane.  Use the Measurement Data 
panel to see the point data of the feature. For more information, see “Measurement Data” on page 192.

Construct Line: By Bisection
Requires: a line and another line.

• Name: Type in a name for the constructed line.

• Lines:  Select a Line.3 

• Click Create to create 
the line. 

• If the two lines are not parallel, another line is constructed equidistantly from both lines.

• If the two lines are parallel, another line is constructed midway between the two lines, with the same 
vector as the first line.

1When in a dialog box, click in the Selected Choices window. Select a single feature by clicking the name of the feature with the Left Mouse 
button. Select multiple, consecutive features from the Feature panel by holding down the Shift key, clicking the first (top) feature in the 
sequence with the Left Mouse button, then clicking the last feature in the sequence with the Left Mouse button. Select multiple features in non-
consecutive order by holding down the Ctrl key and clicking each feature with the Left Mouse button. You can also click a feature with the Left 
Mouse button in the Main Window, or the name of the feature with the Left Mouse button in the Features panel. 
2When in a dialog box, click the drop-down arrow and scroll down to select a plane, or plane reducible, feature. You can also click the name of 
the plane with the Left Mouse button in the Features panel. To select a plane from the Main Window, move the pointer over the drop-down list 
box and click the From Screen icon that appears. This selects the drop-down list and you can then click a plane with the Left Mouse button in 
the Main Window. If the drop-down list is already selected, then just click the plane with the Left Mouse button in the Main Window.
3When in a dialog box, click the drop-down arrow and scroll down to select a line, or line reducible, feature. You can also click the name of the 
line with the Left Mouse button in the Lines panel. To select a line from the Main Window, move the pointer over the drop-down list box and 
click the From Screen icon that appears. This selects the drop-down list and you can then click a line with the Left Mouse button in the Main 
Window. If the drop-down list is already selected, then just click the line with the Left Mouse button in the Main Window. Note: Two points 
can also be used to define a line. You can construct a line using two points using Construct Line: By Best Fit. 
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Figure 12-1 Construct Line: By Bisection

NOTE:  There are two possible solutions that are determined by the vector of the selected lines. For more 
information, see “Flip Vector” on page 109.

Construct Line: By Intersection of 2 Planes
Requires: two planes.

• Name: Type in a name for the constructed line.

• Planes:  Select a Plane.1 

• Click Create to create 
the line.

The line is constructed from the intersection of the two selected planes. The length of the line is determined by the 
extent of the first plane selected for the construction

Figure 12-1 Construct Line: By Intersection of 2 Planes

1When in a dialog box, click the drop-down arrow and scroll down to select a plane, or plane reducible, feature. You can also click the name of 
the plane with the Left Mouse button in the Features panel. To select a plane from the Main Window, move the pointer over the drop-down list 
box and click the From Screen icon that appears. This selects the drop-down list and you can then click a plane with the Left Mouse button in 
the Main Window. If the drop-down list is already selected, then just click the plane with the Left Mouse button in the Main Window.
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Construct Line: By Offset
Requires: a plane, two points, and/or two offsets.

• Name: Type in a name for the constructed line.

• Plane:  Select a Plane.1 

• Offset: Select a radio 
button:

• Line:  Select a Line.2 

• Offsets: Enter a 
positive or negative offset distance.  Typing values in different units.3 

OR 

• Points:  Select a Point.4 

• Offsets: Enter positive 
or negative offset distances.  Typing values in different units.5 

• Click Create to create the line.

The line is constructed by the order of the selected points and follows the . This command is often used to 
construct a coordinate axis from two points at a known distance from that axis. 

NOTE:  There are two possible solutions that are determined by the order you select the points.

1When in a dialog box, click the drop-down arrow and scroll down to select a plane, or plane reducible, feature. You can also click the name of 
the plane with the Left Mouse button in the Features panel. To select a plane from the Main Window, move the pointer over the drop-down list 
box and click the From Screen icon that appears. This selects the drop-down list and you can then click a plane with the Left Mouse button in 
the Main Window. If the drop-down list is already selected, then just click the plane with the Left Mouse button in the Main Window.
2When in a dialog box, click the drop-down arrow and scroll down to select a line, or line reducible, feature. You can also click the name of the 
line with the Left Mouse button in the Lines panel. To select a line from the Main Window, move the pointer over the drop-down list box and 
click the From Screen icon that appears. This selects the drop-down list and you can then click a line with the Left Mouse button in the Main 
Window. If the drop-down list is already selected, then just click the line with the Left Mouse button in the Main Window. Note: Two points 
can also be used to define a line. You can construct a line using two points using Construct Line: By Best Fit. 
3You can type a value in any unit, and CAM2 2020 converts the value to the default unit value. For example, the default value is 0mm but the 
diameter is 10inches. Type 10in and CAM2 2020 automatically converts the value to 254 millimeters.  
4When in a dialog box, click the drop-down arrow and scroll down to select a point, or point reducible, feature. You can also click the name of 
the point with the Left Mouse button in the Points panel. To select a point from the Main Window, move the pointer over the drop-down list 
box and click the From Screen icon that appears. This selects the drop-down list and you can then click a point with the Left Mouse button in 
the Main Window. If the drop-down list is already selected, then just click the point with the Left Mouse button in the Main Window.
5You can type a value in any unit, and CAM2 2020 converts the value to the default unit value. For example, the default value is 0mm but the 
diameter is 10inches. Type 10in and CAM2 2020 automatically converts the value to 254 millimeters.  
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Figure 12-1 Construct Line: By Offset

Construct Line: By Projection
Requires: a plane and a line (two points).

• Name: Type in a name for the constructed line.

• Line: Select a radio button:

• Line:  Select a Line.1 

OR 

• Points:  Select a Point.2 

• Plane:  Select a Plane.3 

• Click Create to create 
the line.

The line is constructed from the projection of the selected line to the selected plane.

1When in a dialog box, click the drop-down arrow and scroll down to select a line, or line reducible, feature. You can also click the name of the 
line with the Left Mouse button in the Lines panel. To select a line from the Main Window, move the pointer over the drop-down list box and 
click the From Screen icon that appears. This selects the drop-down list and you can then click a line with the Left Mouse button in the Main 
Window. If the drop-down list is already selected, then just click the line with the Left Mouse button in the Main Window. Note: Two points 
can also be used to define a line. You can construct a line using two points using Construct Line: By Best Fit. 
2When in a dialog box, click the drop-down arrow and scroll down to select a point, or point reducible, feature. You can also click the name of 
the point with the Left Mouse button in the Points panel. To select a point from the Main Window, move the pointer over the drop-down list 
box and click the From Screen icon that appears. This selects the drop-down list and you can then click a point with the Left Mouse button in 
the Main Window. If the drop-down list is already selected, then just click the point with the Left Mouse button in the Main Window.
3When in a dialog box, click the drop-down arrow and scroll down to select a plane, or plane reducible, feature. You can also click the name of 
the plane with the Left Mouse button in the Features panel. To select a plane from the Main Window, move the pointer over the drop-down list 
box and click the From Screen icon that appears. This selects the drop-down list and you can then click a plane with the Left Mouse button in 
the Main Window. If the drop-down list is already selected, then just click the plane with the Left Mouse button in the Main Window.
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Figure 12-1 Construct Line: By Projection

Construct Line: Parallel
Requires: a line (or two points) and another point and/or an offset, or a distance in an existing plane.

• Name: Type in a name for the constructed line.

• Source Line: Select a radio button:

• Line:  Select a Line.1 

OR 

• Points:  Select a Point.2 

• New Line: Select a radio 
button:

• Point:  Select a Point.3

OR 

• Offset: Type in the XYZ values.  Typing values in different units and coordinate systems.4 

1When in a dialog box, click the drop-down arrow and scroll down to select a line, or line reducible, feature. You can also click the name of the 
line with the Left Mouse button in the Lines panel. To select a line from the Main Window, move the pointer over the drop-down list box and 
click the From Screen icon that appears. This selects the drop-down list and you can then click a line with the Left Mouse button in the Main 
Window. If the drop-down list is already selected, then just click the line with the Left Mouse button in the Main Window. Note: Two points 
can also be used to define a line. You can construct a line using two points using Construct Line: By Best Fit. 
2When in a dialog box, click the drop-down arrow and scroll down to select a point, or point reducible, feature. You can also click the name of 
the point with the Left Mouse button in the Points panel. To select a point from the Main Window, move the pointer over the drop-down list 
box and click the From Screen icon that appears. This selects the drop-down list and you can then click a point with the Left Mouse button in 
the Main Window. If the drop-down list is already selected, then just click the point with the Left Mouse button in the Main Window.
3When in a dialog box, click the drop-down arrow and scroll down to select a point, or point reducible, feature. You can also click the name of 
the point with the Left Mouse button in the Points panel. To select a point from the Main Window, move the pointer over the drop-down list 
box and click the From Screen icon that appears. This selects the drop-down list and you can then click a point with the Left Mouse button in 
the Main Window. If the drop-down list is already selected, then just click the point with the Left Mouse button in the Main Window.
4You can type a value in any unit, and CAM2 2020 converts the value to the default unit value. For example, the default value is 0,0,0 mm but 
your feature is 5,5,10 inches. Type 5in, 5in, 10in and CAM2 2020 automatically converts the value to 127, 127, 254 millimeters. To change the 
coordinate system, click the arrow on the right side of the dialog box and select from the menu. CAM2 2020 automatically converts the values 
to the current coordinate system during the feature construction.
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OR 

• Plane:  Select a Plane.1 

• Offset: Type in the 
XYZ values.  Typing values in different units and coordinate systems.2 

• Click Create to create the line.

The line is constructed parallel to the selected line and through the point, or parallel to the selected line in the 
selected plane.

Figure 12-1 Construct Line: Parallel

Construct Line: Perpendicular
Requires: a plane and a point.

• Name: Type in a name for the constructed line.

• Plane:  Select a Plane.3 

• Point:  Select a Point.4 

• Click Create to create 
the line.

1When in a dialog box, click the drop-down arrow and scroll down to select a plane, or plane reducible, feature. You can also click the name of 
the plane with the Left Mouse button in the Features panel. To select a plane from the Main Window, move the pointer over the drop-down list 
box and click the From Screen icon that appears. This selects the drop-down list and you can then click a plane with the Left Mouse button in 
the Main Window. If the drop-down list is already selected, then just click the plane with the Left Mouse button in the Main Window.
2You can type a value in any unit, and CAM2 2020 converts the value to the default unit value. For example, the default value is 0,0,0 mm but 
your feature is 5,5,10 inches. Type 5in, 5in, 10in and CAM2 2020 automatically converts the value to 127, 127, 254 millimeters. To change the 
coordinate system, click the arrow on the right side of the dialog box and select from the menu. CAM2 2020 automatically converts the values 
to the current coordinate system during the feature construction.
3When in a dialog box, click the drop-down arrow and scroll down to select a plane, or plane reducible, feature. You can also click the name of 
the plane with the Left Mouse button in the Features panel. To select a plane from the Main Window, move the pointer over the drop-down list 
box and click the From Screen icon that appears. This selects the drop-down list and you can then click a plane with the Left Mouse button in 
the Main Window. If the drop-down list is already selected, then just click the plane with the Left Mouse button in the Main Window.
4When in a dialog box, click the drop-down arrow and scroll down to select a point, or point reducible, feature. You can also click the name of 
the point with the Left Mouse button in the Points panel. To select a point from the Main Window, move the pointer over the drop-down list 
box and click the From Screen icon that appears. This selects the drop-down list and you can then click a point with the Left Mouse button in 
the Main Window. If the drop-down list is already selected, then just click the point with the Left Mouse button in the Main Window.
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The line is constructed perpendicular to the selected plane and through the point, or perpendicular to the selected 
line and through the point.

Figure 12-1 Construct Line: Perpendicular

Construct Point
A point is constructed from point-reducible features, entered values, the intersection of features, or a CAD model. 

Construct Point: By Best Fit
Requires: point-reducible features.

• Name: Type in a name for the constructed point.

• Points:  Select from the List.1 

• After you add the 
minimum number of features a preview feature draws in the Main Window and the dialog box displays 
preview feature data.

• Click Create to create the point.

The selected features are constructed into a Best Fit Point. See “Best Fit Point” on page 328. Use the 
Measurement Data panel to see the point data of the feature. For more information, see “Measurement Data” on 
page 192.  

Construct Point: By Midpoint
Requires: two features.

• Name: Type in a name for the constructed point.

• Features:  Select a Feature.2 

1When in a dialog box, click in the Selected Choices window. Select a single feature by clicking the name of the feature with the Left Mouse 
button. Select multiple, consecutive features from the Feature panel by holding down the Shift key, clicking the first (top) feature in the 
sequence with the Left Mouse button, then clicking the last feature in the sequence with the Left Mouse button. Select multiple features in non-
consecutive order by holding down the Ctrl key and clicking each feature with the Left Mouse button. You can also click a feature with the Left 
Mouse button in the Main Window, or the name of the feature with the Left Mouse button in the Features panel. 
2When in a dialog box, click the drop-down arrow and scroll down to select a feature. You can also click the name of the feature with the Left 
Mouse button in the Features panel. To select a feature from the Main Window, move the pointer over the drop-down list box and click the 
From Screen icon that appears. This selects the drop-down list and you can then click a feature with the Left Mouse button in the Main Win-
dow. If the drop-down list is already selected, then just click the feature with the Left Mouse button in the Main Window.
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• Click Create to create the point.

• The point is constructed between the two selected points, or the Midpoint.

Figure 12-1 Construct Point: By Midpoint

Construct Point: By Intersection
Requires: two features or three planes.

• Name: Type in a name for the constructed point.

• Point: Select a radio button:

• Features:  Select a Feature.1 

OR 

• Planes:  Select a Plane.2 

• Click Create to create the 
point. 

Two Feature Examples
The point is constructed at the intersection of two lines.

1When in a dialog box, click the drop-down arrow and scroll down to select a feature. You can also click the name of the feature with the Left 
Mouse button in the Features panel. To select a feature from the Main Window, move the pointer over the drop-down list box and click the 
From Screen icon that appears. This selects the drop-down list and you can then click a feature with the Left Mouse button in the Main Win-
dow. If the drop-down list is already selected, then just click the feature with the Left Mouse button in the Main Window.
2When in a dialog box, click the drop-down arrow and scroll down to select a plane, or plane reducible, feature. You can also click the name of 
the plane with the Left Mouse button in the Features panel. To select a plane from the Main Window, move the pointer over the drop-down list 
box and click the From Screen icon that appears. This selects the drop-down list and you can then click a plane with the Left Mouse button in 
the Main Window. If the drop-down list is already selected, then just click the plane with the Left Mouse button in the Main Window.
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Figure 12-1 Construct Point: Two Lines

NOTE:  If the two lines do not intersect, a point is created at the midpoint of the segment and is defined by 
the shortest distance between the lines.

The point is constructed at the intersection of the two circles.

Figure 12-2 Construct Point: Two Circles

NOTE:  There are two possible solutions for this point based on the order in which the circles are selected. 
The constructed point is determined by the Right-Hand Rule. See “Right-Hand Rule” on page 330.

The point is constructed at the intersection of the line and a plane.

Figure 12-3 Construct Point: Line and Plane

• Line and Circle: the line is projected to the plane of the circle and the point is constructed where the line exits 
the circle.

• Line and Cylinder: where the line exits the cylinder.

• Line and Sphere: where the line exits the sphere.

NOTE:  Since the point is constructed at the exit point (second intersection) the vector direction of the line is 
important. For more information, see “Flip Vector” on page 109.
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Three Planes Example
The point is constructed at the intersection of three planes.

Figure 12-4 Construct Point: Three Planes

Construct Point: By Offset
Requires: a point and a 3D offset distances.

• Name: Type in a name for the constructed point.

• Point:  Select a Point.1 

• Offset: Select a radio 
button:

• Absolute Offset: Enter a positive or negative offset distance.  Typing values in different units.2 

OR 

• Along Line:  Select a Line.3 

• Distance: Enter positive or 
negative offset distances.  Typing values in different units.4 

OR 

1When in a dialog box, click the drop-down arrow and scroll down to select a point, or point reducible, feature. You can also click the name of 
the point with the Left Mouse button in the Points panel. To select a point from the Main Window, move the pointer over the drop-down list 
box and click the From Screen icon that appears. This selects the drop-down list and you can then click a point with the Left Mouse button in 
the Main Window. If the drop-down list is already selected, then just click the point with the Left Mouse button in the Main Window.
2You can type a value in any unit, and CAM2 2020 converts the value to the default unit value. For example, the default value is 0mm but the 
diameter is 10inches. Type 10in and CAM2 2020 automatically converts the value to 254 millimeters. 
3When in a dialog box, click the drop-down arrow and scroll down to select a line, or line reducible, feature. You can also click the name of the 
line with the Left Mouse button in the Lines panel. To select a line from the Main Window, move the pointer over the drop-down list box and 
click the From Screen icon that appears. This selects the drop-down list and you can then click a line with the Left Mouse button in the Main 
Window. If the drop-down list is already selected, then just click the line with the Left Mouse button in the Main Window. Note: Two points 
can also be used to define a line. You can construct a line using two points using Construct Line: By Best Fit. 
4You can type a value in any unit, and CAM2 2020 converts the value to the default unit value. For example, the default value is 0mm but the 
diameter is 10inches. Type 10in and CAM2 2020 automatically converts the value to 254 millimeters. 
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• Along Normal:  Select a Plane.1 

• Offset: Enter positive or negative 
offset distances.  Typing values in different units.2 

• Click Create to create the point.

The point is constructed offset from the selected point.

Figure 12-1 Construct Point: By Offset

Construct Point: By Projection
Requires: a point and a feature.

• Name: Type in a name for the constructed point.

• Point:  Select a Point.3 

• Feature:  Select a 
Feature.4 

•
 Click Create to create the point.

1When in a dialog box, click the drop-down arrow and scroll down to select a plane, or plane reducible, feature. You can also click the name of 
the plane with the Left Mouse button in the Features panel. To select a plane from the Main Window, move the pointer over the drop-down list 
box and click the From Screen icon that appears. This selects the drop-down list and you can then click a plane with the Left Mouse button in 
the Main Window. If the drop-down list is already selected, then just click the plane with the Left Mouse button in the Main Window.
2You can type a value in any unit, and CAM2 2020 converts the value to the default unit value. For example, the default value is 0mm but the 
diameter is 10inches. Type 10in and CAM2 2020 automatically converts the value to 254 millimeters. 
3When in a dialog box, click the drop-down arrow and scroll down to select a point, or point reducible, feature. You can also click the name of 
the point with the Left Mouse button in the Points panel. To select a point from the Main Window, move the pointer over the drop-down list 
box and click the From Screen icon that appears. This selects the drop-down list and you can then click a point with the Left Mouse button in 
the Main Window. If the drop-down list is already selected, then just click the point with the Left Mouse button in the Main Window.
4When in a dialog box, click the drop-down arrow and scroll down to select a feature. You can also click the name of the feature with the Left 
Mouse button in the Features panel. To select a feature from the Main Window, move the pointer over the drop-down list box and click the 
From Screen icon that appears. This selects the drop-down list and you can then click a feature with the Left Mouse button in the Main Win-
dow. If the drop-down list is already selected, then just click the feature with the Left Mouse button in the Main Window.
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Point Projection Examples
The point is constructed from the projection of the selected point to the selected line.

Figure 12-1 Construct Point: Point Project to a Line

The point is constructed from the projection of the selected point to the selected plane, or surface. If you select the 
X, Y, or Z axis you may also select any coordinate system to guide the projection.

Figure 12-2 Construct Point: Point Project to a Plane/Surface

Construct Circle
A circle is constructed from point-reducible features, the intersection of features, entered values, or a CAD model.

Circle Vectors
Some Construct > Circle commands have an option to select the vector direction of the constructed circle. This 
vector direction is for the finished constructed circle - not the direction of the construction.

Construct Circle: By Best Fit 
Requires: a plane and a minimum of three point-reducible features.

• Name: Type in a name for the constructed circle.

• Points:  Select from the List.1 

1When in a dialog box, click in the Selected Choices window. Select a single feature by clicking the name of the feature with the Left Mouse 
button. Select multiple, consecutive features from the Feature panel by holding down the Shift key, clicking the first (top) feature in the 
sequence with the Left Mouse button, then clicking the last feature in the sequence with the Left Mouse button. Select multiple features in non-
consecutive order by holding down the Ctrl key and clicking each feature with the Left Mouse button. You can also click a feature with the Left 
Mouse button in the Main Window, or the name of the feature with the Left Mouse button in the Features panel.  
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• Plane:  Select a Plane.1 Or clear the Use Plane check box.

• After you add the 
minimum number of features a preview feature draws in the Main Window and the dialog box displays 
preview feature data.

• Click Create to create the dimension.

If the Use Plane check box is selected, the features are projected to the plane before constructed into a Best Fit 
Circle. See “Best Fit Circle” on page 325.. Otherwise, the features are fit to a plane. Use the Measurement Data 
panel to see the point data of the feature.For more information, see “Measurement Data” on page 192. 

Construct Circle: By Intersection of a Plane and a Feature
Requires: a plane and a sphere, a plane and a cone, or a plane and a cylinder.

NOTE:  This constructs a best fit circle at the intersection of the plane and the feature. It does not create an 
ellipse. See “Construct Ellipse: By Intersection” on page 253.

• Name: Type in a name for the constructed circle.

• Plane:  Select a Plane.2 

• Sphere, Cone, 
Cylinder:  Select a Feature.3 

• Lock Plane of Circle: The 
intersection points can project to one of two planes. Select a radio button:

• In Plane of Feature 1

• Perpendicular to Feature 2

• Click Create to create the dimension.

1When in a dialog box, click the drop-down arrow and scroll down to select a plane, or plane reducible, feature. You can also click the name of 
the plane with the Left Mouse button in the Features panel. To select a plane from the Main Window, move the pointer over the drop-down list 
box and click the From Screen icon that appears. This selects the drop-down list and you can then click a plane with the Left Mouse button in 
the Main Window. If the drop-down list is already selected, then just click the plane with the Left Mouse button in the Main Window.
2When in a dialog box, click the drop-down arrow and scroll down to select a plane, or plane reducible, feature. You can also click the name of 
the plane with the Left Mouse button in the Features panel. To select a plane from the Main Window, move the pointer over the drop-down list 
box and click the From Screen icon that appears. This selects the drop-down list and you can then click a plane with the Left Mouse button in 
the Main Window. If the drop-down list is already selected, then just click the plane with the Left Mouse button in the Main Window.
3When in a dialog box, click the drop-down arrow and scroll down to select a feature. You can also click the name of the feature with the Left 
Mouse button in the Features panel. To select a feature from the Main Window, move the pointer over the drop-down list box and click the 
From Screen icon that appears. This selects the drop-down list and you can then click a feature with the Left Mouse button in the Main Win-
dow. If the drop-down list is already selected, then just click the feature with the Left Mouse button in the Main Window.
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Figure 12-1 Construct Circle: Plane Intersect

Construct Circle: By Offset
Requires: a circle and a 3D offset.

• Name: Type in a name for the constructed circle.

• Circle:  Select a Feature.1 

• Offset: Select a radio 
button:

• Absolute Offset: Type in positive or negative X, Y, and Z offset distances.  Typing values in different 
units and coordinate systems.2 

•
 Offset Along a Line:  Select a Line.3 Type in an offset distance.  Typing values in different units and 

c
oordinate systems.4 

1When in a dialog box, click the drop-down arrow and scroll down to select a feature. You can also click the name of the feature with the Left 
Mouse button in the Features panel. To select a feature from the Main Window, move the pointer over the drop-down list box and click the 
From Screen icon that appears. This selects the drop-down list and you can then click a feature with the Left Mouse button in the Main Win-
dow. If the drop-down list is already selected, then just click the feature with the Left Mouse button in the Main Window.
2You can type a value in any unit, and CAM2 2020 converts the value to the default unit value. For example, the default value is 0,0,0 mm but 
your feature is 5,5,10 inches. Type 5in, 5in, 10in and CAM2 2020 automatically converts the value to 127, 127, 254 millimeters. To change the 
coordinate system, click the arrow on the right side of the dialog box and select from the menu. CAM2 2020 automatically converts the values 
to the current coordinate system during the feature construction.
3When in a dialog box, click the drop-down arrow and scroll down to select a line, or line reducible, feature. You can also click the name of the 
line with the Left Mouse button in the Lines panel. To select a line from the Main Window, move the pointer over the drop-down list box and 
click the From Screen icon that appears. This selects the drop-down list and you can then click a line with the Left Mouse button in the Main 
Window. If the drop-down list is already selected, then just click the line with the Left Mouse button in the Main Window. Note: Two points 
can also be used to define a line. You can construct a line using two points using Construct Line: By Best Fit. 
4You can type a value in any unit, and CAM2 2020 converts the value to the default unit value. For example, the default value is 0,0,0 mm but 
your feature is 5,5,10 inches. Type 5in, 5in, 10in and CAM2 2020 automatically converts the value to 127, 127, 254 millimeters. To change the 
coordinate system, click the arrow on the right side of the dialog box and select from the menu. CAM2 2020 automatically converts the values 
to the current coordinate system during the feature construction.
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• Offset Along a Normal:  Select a Plane.1 Type in an offset distance.  Typing values in different units and 
c
oordinate systems.2 

• Flip 
Vector: Reverse the vector of the constructed circle by selecting this check box. See “Circle Vectors” on 
page 243.

• New Diameter: Change the diameter of the constructed circle by selecting this check box and typing in the 
diameter value.  Typing values in different units and coordinate systems.3 

Construct Circle: By Coaxial Intersection
Requires: two intersecting coaxial cones, or the intersection of a coaxial cone and cylinder.

NOTE:  Features must be located and orientated relative to each other so that their surfaces of revolution 
intersect.

• Features:  Select a Feature.4 

• Angle Tolerance: Type in 
the angle to determine co-linearity (maximum 5°).

• Click Create to create the circle.

Construct Circle: From Cone
Requires: a cone, and a distance, diameter, or feature.

• Name: Type in a name for the constructed circle.

• Cone:  Select a Feature.5 

1When in a dialog box, click the drop-down arrow and scroll down to select a plane, or plane reducible, feature. You can also click the name of 
the plane with the Left Mouse button in the Features panel. To select a plane from the Main Window, move the pointer over the drop-down list 
box and click the From Screen icon that appears. This selects the drop-down list and you can then click a plane with the Left Mouse button in 
the Main Window. If the drop-down list is already selected, then just click the plane with the Left Mouse button in the Main Window.
2You can type a value in any unit, and CAM2 2020 converts the value to the default unit value. For example, the default value is 0,0,0 mm but 
your feature is 5,5,10 inches. Type 5in, 5in, 10in and CAM2 2020 automatically converts the value to 127, 127, 254 millimeters. To change the 
coordinate system, click the arrow on the right side of the dialog box and select from the menu. CAM2 2020 automatically converts the values 
to the current coordinate system during the feature construction.
3You can type a value in any unit, and CAM2 2020 converts the value to the default unit value. For example, the default value is 0,0,0 mm but 
your feature is 5,5,10 inches. Type 5in, 5in, 10in and CAM2 2020 automatically converts the value to 127, 127, 254 millimeters. To change the 
coordinate system, click the arrow on the right side of the dialog box and select from the menu. CAM2 2020 automatically converts the values 
to the current coordinate system during the feature construction.
4When in a dialog box, click the drop-down arrow and scroll down to select a feature. You can also click the name of the feature with the Left 
Mouse button in the Features panel. To select a feature from the Main Window, move the pointer over the drop-down list box and click the 
From Screen icon that appears. This selects the drop-down list and you can then click a feature with the Left Mouse button in the Main Win-
dow. If the drop-down list is already selected, then just click the feature with the Left Mouse button in the Main Window.
5When in a dialog box, click the drop-down arrow and scroll down to select a feature. You can also click the name of the feature with the Left 
Mouse button in the Features panel. To select a feature from the Main Window, move the pointer over the drop-down list box and click the 
From Screen icon that appears. This selects the drop-down list and you can then click a feature with the Left Mouse button in the Main Win-
dow. If the drop-down list is already selected, then just click the feature with the Left Mouse button in the Main Window.
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• Distance: Type in a positive or negative distance. The distance you enter is measured from the apex of the 
cone. The diameter of the circle is determined by the diameter of the cone at the constructed center point of the 
circle.  Typing values in different units.1 

• Diameter: Type in a diameter. The 
circle is constructed at the position within the cone.  Typing values in different units.2 

• Feature:  Select a Feature.3 The selected features diameter is used, and the circle is 
c
onstructed at the position within the cone. 

• Click Create to create the cone.

Construct Sphere
A sphere is constructed from point-reducible features, entered values, or a CAD model. 

Construct Sphere: By Best Fit
Requires: five point-reducible features.

• Name: Type in a name for the constructed sphere.

• Points:  Select from the List.4 

• After you add the 
minimum number of features a preview feature draws in the Main Window and the dialog box displays 
preview feature data.

• Click Create to create the sphere.

The selected features are constructed into a Best Fit Sphere.See “Best Fit Sphere” on page 329. Use the 
Measurement Data panel to see the point data of the feature.For more information, see “Measurement Data” on 
page 192.

Construct Sphere: By Offset
Requires: a sphere, two points, and/or two offsets.

1You can type a value in any unit, and CAM2 2020 converts the value to the default unit value. For example, the default value is 0mm but the 
diameter is 10inches. Type 10in and CAM2 2020 automatically converts the value to 254 millimeters.  
2You can type a value in any unit, and CAM2 2020 converts the value to the default unit value. For example, the default value is 0mm but the 
diameter is 10inches. Type 10in and CAM2 2020 automatically converts the value to 254 millimeters.  
3When in a dialog box, click the drop-down arrow and scroll down to select a feature. You can also click the name of the feature with the Left 
Mouse button in the Features panel. To select a feature from the Main Window, move the pointer over the drop-down list box and click the 
From Screen icon that appears. This selects the drop-down list and you can then click a feature with the Left Mouse button in the Main Win-
dow. If the drop-down list is already selected, then just click the feature with the Left Mouse button in the Main Window.
4When in a dialog box, click in the Selected Choices window. Select a single feature by clicking the name of the feature with the Left Mouse 
button. Select multiple, consecutive features from the Feature panel by holding down the Shift key, clicking the first (top) feature in the 
sequence with the Left Mouse button, then clicking the last feature in the sequence with the Left Mouse button. Select multiple features in non-
consecutive order by holding down the Ctrl key and clicking each feature with the Left Mouse button. You can also click a feature with the Left 
Mouse button in the Main Window, or the name of the feature with the Left Mouse button in the Features panel. 
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• Name: Type in a name for the constructed sphere.

• Feature:  Select a Feature.1 

• Offset: Select a radio button:

• Absolute Offset: Enter a positive or negative offset distance.  Typing values in different units.2 

OR 

• Along Line:  Select a Line.3 

• Distance: Enter positive or 
negative offset distances.  Typing values in different units.4 

OR 

• Along Normal:  Select a Plane.5 

• Offset: Enter positive or negative 
offset distances.  Typing values in different units.6 

• New Diameter: Change the diameter of the 
constructed circle by selecting this check box and typing in the diameter value. 

• Click Create to create the sphere. Typing values in different units.7 

Construct Cylinder
A cylinder is constructed from point-reducible features, entered values, or a CAD model. 

Construct Cylinder: By Best Fit
Requires: a minimum of three point-reducible features. 

1When in a dialog box, click the drop-down arrow and scroll down to select a feature. You can also click the name of the feature with the Left 
Mouse button in the Features panel. To select a feature from the Main Window, move the pointer over the drop-down list box and click the 
From Screen icon that appears. This selects the drop-down list and you can then click a feature with the Left Mouse button in the Main Win-
dow. If the drop-down list is already selected, then just click the feature with the Left Mouse button in the Main Window. 
2You can type a value in any unit, and CAM2 2020 converts the value to the default unit value. For example, the default value is 0mm but the 
diameter is 10inches. Type 10in and CAM2 2020 automatically converts the value to 254 millimeters. 
3When in a dialog box, click the drop-down arrow and scroll down to select a line, or line reducible, feature. You can also click the name of the 
line with the Left Mouse button in the Lines panel. To select a line from the Main Window, move the pointer over the drop-down list box and 
click the From Screen icon that appears. This selects the drop-down list and you can then click a line with the Left Mouse button in the Main 
Window. If the drop-down list is already selected, then just click the line with the Left Mouse button in the Main Window. Note: Two points 
can also be used to define a line. You can construct a line using two points using Construct Line: By Best Fit. 
4You can type a value in any unit, and CAM2 2020 converts the value to the default unit value. For example, the default value is 0mm but the 
diameter is 10inches. Type 10in and CAM2 2020 automatically converts the value to 254 millimeters. 
5When in a dialog box, click the drop-down arrow and scroll down to select a plane, or plane reducible, feature. You can also click the name of 
the plane with the Left Mouse button in the Features panel. To select a plane from the Main Window, move the pointer over the drop-down list 
box and click the From Screen icon that appears. This selects the drop-down list and you can then click a plane with the Left Mouse button in 
the Main Window. If the drop-down list is already selected, then just click the plane with the Left Mouse button in the Main Window.
6You can type a value in any unit, and CAM2 2020 converts the value to the default unit value. For example, the default value is 0mm but the 
diameter is 10inches. Type 10in and CAM2 2020 automatically converts the value to 254 millimeters. 
7You can type a value in any unit, and CAM2 2020 converts the value to the default unit value. For example, the default value is 0mm but the 
diameter is 10inches. Type 10in and CAM2 2020 automatically converts the value to 254 millimeters. 
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• Name: Type in a name for the constructed cylinder. 

• Points:  Select from the List.1 

• After you add the 
minimum number of features a preview feature draws in the Main Window and the dialog box displays 
preview feature data. 

• Click Create to create the cylinder. 

The selected features are constructed into a Best Fit Cylinder. See “Best Fit Cylinder” on page 326. Use the 
Measurement Data panel to see the point data of the feature.For more information, see “Measurement Data” on 
page 192.

Construct Cylinder: From Circles
Requires: a minimum of two circles.

• Name: Type in a name for the constructed cylinder.

• Select Entities To Fit Through:  Select from the List.2 

• After you add the minimum number of circles, a 
preview feature draws in the Main Window and the dialog box displays preview feature data.

• Click Create to create the cylinder.

• CAM2 computes the cylinder axis fitting a line through all circle centers.

• The diameter of the cylinder will compute as an average of the diameters of all circles used in the 
construction, OR will be overridden by a keyed-in diameter value.

The selected circles are constructed into a Best Fit Cylinder. See “Best Fit Cylinder” on page 326. Use the 
Measurement Data panel to see the point data of the feature.For more information, see “Measurement Data” on 
page 192.

NOTE:  For best results, use circles that are approximately co-linear with normal vectors in the same 
approximate direction as the axis of the resulting cylinder.

Construct Torus
A torus is constructed from existing features. 

1When in a dialog box, click in the Selected Choices window. Select a single feature by clicking the name of the feature with the Left Mouse 
button. Select multiple, consecutive features from the Feature panel by holding down the Shift key, clicking the first (top) feature in the 
sequence with the Left Mouse button, then clicking the last feature in the sequence with the Left Mouse button. Select multiple features in non-
consecutive order by holding down the Ctrl key and clicking each feature with the Left Mouse button. You can also click a feature with the Left 
Mouse button in the Main Window, or the name of the feature with the Left Mouse button in the Features panel. 
2When in a dialog box, click in the Selected Choices window. Select a single feature by clicking the name of the feature with the Left Mouse 
button. Select multiple, consecutive features from the Feature panel by holding down the Shift key, clicking the first (top) feature in the 
sequence with the Left Mouse button, then clicking the last feature in the sequence with the Left Mouse button. Select multiple features in non-
consecutive order by holding down the Ctrl key and clicking each feature with the Left Mouse button. You can also click a feature with the Left 
Mouse button in the Main Window, or the name of the feature with the Left Mouse button in the Features panel. 
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Construct Torus: By Best Fit
Requires: a minimum of nine point-reducible features.

• Name: Type in a name for the constructed torus.

• Points:  Select from the List.1 

• After you add the 
minimum number of features a preview feature draws in the Main Window and the dialog box displays 
preview feature data.

• Click Create to create the torus.

The selected features are constructed into a Best Fit Torus. See “Best Fit Torus” on page 330. Use the 
Measurement Data panel to see the point data of the feature. For more information, see “Measurement Data” on 
page 192.

Construct Tube
A tube is constructed from existing measured or nominal features. 

Construct Tube: From Features
Requires: two planes, two or more cylinders, a tube diameter and a tube bend radius.

• Name: Type in a name for the constructed tube.

• Override Diameter: Check the box and enter a value, or automatically use the average diameter from the 
features.

• Start Plane:  Select a Plane.2 This is END-B. 

• End Plane:  Select a Plane.3 
T
his is END-A. 

1When in a dialog box, click in the Selected Choices window. Select a single feature by clicking the name of the feature with the Left Mouse 
button. Select multiple, consecutive features from the Feature panel by holding down the Shift key, clicking the first (top) feature in the 
sequence with the Left Mouse button, then clicking the last feature in the sequence with the Left Mouse button. Select multiple features in non-
consecutive order by holding down the Ctrl key and clicking each feature with the Left Mouse button. You can also click a feature with the Left 
Mouse button in the Main Window, or the name of the feature with the Left Mouse button in the Features panel. 
2When in a dialog box, click the drop-down arrow and scroll down to select a plane, or plane reducible, feature. You can also click the name of 
the plane with the Left Mouse button in the Features panel. To select a plane from the Main Window, move the pointer over the drop-down list 
box and click the From Screen icon that appears. This selects the drop-down list and you can then click a plane with the Left Mouse button in 
the Main Window. If the drop-down list is already selected, then just click the plane with the Left Mouse button in the Main Window.
3When in a dialog box, click the drop-down arrow and scroll down to select a plane, or plane reducible, feature. You can also click the name of 
the plane with the Left Mouse button in the Features panel. To select a plane from the Main Window, move the pointer over the drop-down list 
box and click the From Screen icon that appears. This selects the drop-down list and you can then click a plane with the Left Mouse button in 
the Main Window. If the drop-down list is already selected, then just click the plane with the Left Mouse button in the Main Window.
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NOTE:  Both Start Plane and End Plane have modifiers to fine-tune tube length. High Point uses the highest 
reading of the plane to maximize tube length, Low Point uses the lowest reading of the plane to minimize tube 
length, and None ignores these modifiers.

• Default Bend Radius: Enter the Bend Radius of the tube. 

• Tube Joints:  Select a Feature.1 Select each feature and then click Enter to add more features. Select the 
c
ylinders in order from start to end. 

• Click Create to create the tube. 

Breakpoints
Breakpoints are constructed points and are the intersection of features along the tube:

• END-B and the first straight segment.

• First and second segment, second and third, third and fourth, etc.
• A radius constructs at the intersection point using the bend radius value.

• END-A and the last straight segment.

A polyline constructs from through all of the breakpoints from END-B to END-A.

Construction
A round tube constructs along this polyline from start to end using the diameter value.

Construct Cone
A cone is constructed from point-reducible features, entered values, or a CAD model. 

Construct Cone: By Best Fit
Requires: a minimum of six point-reducible features.

• Name: Type in a name for the constructed cone.

• Points:  Select from the List.2 

1When in a dialog box, click the drop-down arrow and scroll down to select a feature. You can also click the name of the feature with the Left 
Mouse button in the Features panel. To select a feature from the Main Window, move the pointer over the drop-down list box and click the 
From Screen icon that appears. This selects the drop-down list and you can then click a feature with the Left Mouse button in the Main Win-
dow. If the drop-down list is already selected, then just click the feature with the Left Mouse button in the Main Window.
2When in a dialog box, click in the Selected Choices window. Select a single feature by clicking the name of the feature with the Left Mouse 
button. Select multiple, consecutive features from the Feature panel by holding down the Shift key, clicking the first (top) feature in the 
sequence with the Left Mouse button, then clicking the last feature in the sequence with the Left Mouse button. Select multiple features in non-
consecutive order by holding down the Ctrl key and clicking each feature with the Left Mouse button. You can also click a feature with the Left 
Mouse button in the Main Window, or the name of the feature with the Left Mouse button in the Features panel.  
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• After you add the minimum number of features a preview feature draws in the Main Window and the 
dialog box displays preview feature data.

• Click Create to create the dimension.

The selected features are constructed into a Best Fit Cone.  See “Best Fit Cone” on page 326. Use the 
Measurement Data panel to see the point data of the feature. For more information, see “Measurement Data” on 
page 192.

Construct Slot
Rectangular and round slots are constructed from existing features or a CAD model. 

Construct Rectangular Slot: By Best Fit
Requires: six point-reducible features.

• Name: Type in a name for the constructed rectangular slot.

• Points:  Select from the List.1 

• After you add the 
minimum number of features a preview feature draws in the Main Window and the dialog box displays 
preview feature data. 

• Click Create to create the rectangular slot. 

The selected features are constructed into a Best Fit Rectangular Slot.See “Best Fit Rectangular Slot” on page 329. 
Use the Measurement Data panel to see the point data of the feature.For more information, see “Measurement 
Data” on page 192.

Construct Round Slot: By Best Fit
Requires: six point-reducible features.

• Name: Type in a name for the constructed round slot.

• Points:  Select from the List.2 

1When in a dialog box, click in the Selected Choices window. Select a single feature by clicking the name of the feature with the Left Mouse 
button. Select multiple, consecutive features from the Feature panel by holding down the Shift key, clicking the first (top) feature in the 
sequence with the Left Mouse button, then clicking the last feature in the sequence with the Left Mouse button. Select multiple features in non-
consecutive order by holding down the Ctrl key and clicking each feature with the Left Mouse button. You can also click a feature with the Left 
Mouse button in the Main Window, or the name of the feature with the Left Mouse button in the Features panel.  
2When in a dialog box, click in the Selected Choices window. Select a single feature by clicking the name of the feature with the Left Mouse 
button. Select multiple, consecutive features from the Feature panel by holding down the Shift key, clicking the first (top) feature in the 
sequence with the Left Mouse button, then clicking the last feature in the sequence with the Left Mouse button. Select multiple features in non-
consecutive order by holding down the Ctrl key and clicking each feature with the Left Mouse button. You can also click a feature with the Left 
Mouse button in the Main Window, or the name of the feature with the Left Mouse button in the Features panel. 
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• After you add the minimum number of features a preview feature draws in the Main Window and the 
dialog box displays preview feature data.

• Click Create to create the round slot.

The selected features are constructed into a Best Fit Round Slot.See “Best Fit Round Slot” on page 329. Use the 
Measurement Data panel to see the point data of the feature.For more information, see “Measurement Data” on 
page 192.

Construct Ellipse
An ellipse is created from point-reducible features, entered values, or a CAD model.

Construct Ellipse: By Best Fit
Requires: a minimum of three point-reducible features.

• Name: Type in a name for the constructed ellipse.

• Points:  Select from the List.1 

• After you add the 
minimum number of features a preview feature draws in the Main Window and the dialog box displays 
preview feature data. 

• Click Create to create the ellipse. 

The selected features are constructed into a Best Fit Ellipse. See “Best Fit Ellipse” on page 327. Use the 
Measurement Data panel to see the point data of the feature.For more information, see “Measurement Data” on 
page 192. 

Construct Ellipse: By Intersection
Requires: a cylinder and a plane.

• Name: Type in a name for the constructed ellipse.

• Cylinder:  Select a Feature.2 

1When in a dialog box, click in the Selected Choices window. Select a single feature by clicking the name of the feature with the Left Mouse 
button. Select multiple, consecutive features from the Feature panel by holding down the Shift key, clicking the first (top) feature in the 
sequence with the Left Mouse button, then clicking the last feature in the sequence with the Left Mouse button. Select multiple features in non-
consecutive order by holding down the Ctrl key and clicking each feature with the Left Mouse button. You can also click a feature with the Left 
Mouse button in the Main Window, or the name of the feature with the Left Mouse button in the Features panel.  
2When in a dialog box, click the drop-down arrow and scroll down to select a feature. You can also click the name of the feature with the Left 
Mouse button in the Features panel. To select a feature from the Main Window, move the pointer over the drop-down list box and click the 
From Screen icon that appears. This selects the drop-down list and you can then click a feature with the Left Mouse button in the Main Win-
dow. If the drop-down list is already selected, then just click the feature with the Left Mouse button in the Main Window. 
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• Plane:  Select a Plane.1 

• Click Create to create 
the ellipse.

Figure 12-1 Construct Ellipse: By Intersect

Construct Cross-Section Scan
A cross section scan is created from an existing point cloud feature.

NOTE:  If you are using the Probing Version of CAM2, this command is not available. See “Probing 
Version” on page 9.

Construct: Cross-Section Scan
Requires: a point cloud and a cross-section plane.

• Name: Type in a name for the constructed cross-section scan.

• Comments: Type in additional information for the constructed cross-section scan.

• Show Comments In Label: Append comments to the constructed cross-section scan's label.

Construction
• Point Cloud To Draw Cross-Section:  Select from the List.2 

1When in a dialog box, click the drop-down arrow and scroll down to select a plane, or plane reducible, feature. You can also click the name of 
the plane with the Left Mouse but-
ton in the Features panel. To select a plane from the Main Window, move the pointer over the drop-down list box and click the From Screen 
icon that appears. This selects the drop-down list and you can then click a plane with the Left Mouse button in the Main Window. If the drop-
down list is already selected, then just click the plane with the Left Mouse button in the Main Window.
2When in a dialog box, click in the Selected Choices window. Select a single feature by clicking the name of the feature with the Left Mouse 
button. Select multiple, consecutive features from the Feature panel by holding down the Shift key, clicking the first (top) feature in the 
sequence with the Left Mouse button, then clicking the last feature in the sequence with the Left Mouse button. Select multiple features in non-
consecutive order by holding down the Ctrl key and clicking each feature with the Left Mouse button. You can also click a feature with the Left 
Mouse button in the Main Window, or the name of the feature with the Left Mouse button in the Features panel.  
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Cutting Plane
• Plane:  Select a Plane.1 

• Offset: Specify the 
plane’s base distance. 

• Cross-Section from Screen: Check this box, then create a line for the cross-section's base plane. From the 
Main Window, pick two points, or click and drag to create a line defining the base plane. 

Create Multiple
• Space Between Cross-Sections: Specify a distance between individual cross-sections when you construct 

multiple cross sections simultaneously.

• Number of Cross-Sections or End Feature: Specify the number of cross-sections to be created, or define an 
end feature that will control the total number of cross-sections.

Representative Points
• Point Distance Filter: Specify a distance from CAD to exclude point data. CAM2 will filter all points further 

from CAD than this value.

• Even Distribution: Specify a spacing threshold to distribute points evenly.

Advanced
• Automatically Create Nominal: Automatically create an associated nominal when you create the cross-

section scan.

• Tolerance Bandwidth: Specify a tolerance band around the plane to determine an acceptance threshold for 
candidate points.

• Click Create to create the cross-section scan. If the points are connected, the result is a single polyline.

Deviation Markers
Deviation markers show deviation of the measured part relative to CAD at any position on the CAD model. They 
remain associated with the CAD model after you clear or delete an associated point cloud, and they will continue to 
show deviation when you record new point cloud data. For more information, see “Deviation Markers” on page 
120.

Construct Polyline From Points
A polyline is created from existing surface points. This allows you to measure and report individual points, and 
also to create a surface profile report from multiple points in a polyline. 

Construct: Polyline From Points
Requires: a minimum of two surface points.

• Name: Type in a name for the constructed polyline.
1When in a dialog box, click the drop-down arrow and scroll down to select a plane, or plane reducible, feature. You can also click the name of 
the plane with the Left Mouse button in the Features panel. To select a plane from the Main Window, move the pointer over the drop-down list 
box and click the From Screen icon 
that appears. This selects the drop-
down list and you can then click a plane with the Left Mouse button in the Main Window. If the drop-down list is already selected, then just 
click the plane with the Left Mouse button in the Main Window.
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• Select Entities To Fit Through:  Select from the List.1 

• Click Create to create the polyline.

Split Point Cloud
Use the Split Point Cloud command to create individual point cloud features from a larger point cloud feature. 

By CAD Surfaces
Requires: a point cloud and a nominal CAD part. The point cloud must be aligned to the CAD part. For more 
information, see “Alignments” on page 265.

NOTE:  All CAD surfaces must be assigned to the default layer. This command is not available if any new 
layers exist. For more information, see “Layers” on page 112. 

• Individual point cloud features are automatically created from the point cloud and the boundary of each 
nominal CAD surface. 

By Layers
Requires: a point cloud and a nominal CAD part. The point cloud must be alignment to the CAD part. For more 
information, see “Alignments” on page 265.

NOTE:  The CAD surfaces must be assigned to new Layers. Surfaces on the default layer are ignored. For 
more information, see “Layers” on page 112. 

• Individual point cloud features are automatically created from the point cloud and the boundary of all nominal 
CAD surface on each layer. 

Expand Geometry
Use the Expand Geometry command to create individual point features using the geometry of any: 

• Line - Constructs the ! start, " mid, and # end points.   

• Cylinder - Constructs the ! base, " mid, and # top points.   

1When in a dialog box, click in the Selected Choices window. Select a single feature by clicking the name of the feature with the Left Mouse 
button. Select multiple, consecutive features from the Feature panel by holding down the Shift key, clicking the first (top) feature in the 
sequence with the Left Mouse button, then clicking the last feature in the sequence with the Left Mouse button. Select multiple features in non-
consecutive order by holding down the Ctrl key and clicking each feature with the Left Mouse button. You can also click a feature with the Left 
Mouse button in the Main Window, or the name of the feature with the Left Mouse button in the Features panel.  
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• Round Slot - Constructs two center points.   

• Rectangular Slot - Constructs all four corner points.   

Dimensions
The Construct tab across the top of the screen contains Angle From Features and Length From Features. 
Dimensions appear on the screen with the dimension data. The number of digits in the dimension data is a 
preference. For more information, see “Units Tab” on page 74.

Automatic Dimension
CAM2 automatically creates a dimension when you create a dimension feature using nominal features and then 
create and measure measured features associated to the individual nominal features. See Pick From CAD on 
page 217 and Key-In on page 203. 

For Example:
• Add nominals to your measurement file, two circles.
• Add a length dimension between those two circles. This is a nominal dimension.
• Add Measurements to the two nominal circles. 
• Add Readings to each of the two measured circles.
• A Dimension feature, length: from features, using the two measured circles automatically adds to the 

measurement file and associates to the nominal dimension.

Angle
Angle commands calculate the angular difference between two features. 

Angle From Features
Requires: two features or three points.

• Name: Type in a name for the angle dimension. Select the Two Features or Three Points radio button.
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• Features:  Select a Feature.1 

OR 

• Points:  Select a Point.2 

• Click Create to create 
the dimension.

Two Features Example
The angle dimension is the angle between the two lines.

NOTE:  If the lines do not intersect, the calculated angle is the projection of the first line to the second line.

Figure 12-1 Angle: Line/Line

The angle dimension is the angle between the line and the plane.

Figure 12-2 Angle: Line/Plane

1When in a dialog box, click the drop-down arrow and scroll down to select a feature. You can also click the name of the feature with the Left 
Mouse button in the Features panel. To select a feature from the Main Window, move the pointer over the drop-down list box and click the 
From Screen icon that appears. This selects the drop-down list and you can then click a feature with the Left Mouse button in the Main Win-
dow. If the drop-down list is already selected, then just click the feature with the Left Mouse button in the Main Window.
2When in a dialog box, click the drop-down arrow and scroll down to select a point, or point reducible, feature. You can also click the name of 
the point with the Left Mouse button in the Points panel. To select a point from the Main Window, move the pointer over the drop-down list 
box and click the From Screen icon that appears. This selects the drop-down list and you can then click a point with the Left Mouse button in 
the Main Window. If the drop-down list is already selected, then just click the point with the Left Mouse button in the Main Window. 
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The angle dimension is the angle between the two planes.

Figure 12-3 Angle: Plane/Plane

Three Points Example
The angle dimension is constructed from the first point to the second, using the third point as the apex.

Figure 12-4 Angle: Three Points

Length
Length commands calculate the length between two features and report changes in X, Y, and Z axis and the 3D 
distance. 

Length From Features
Requires: two features.

• Name: Type in a name for the length dimension.

• Length:  Select a Feature.1  Select plane, line or point for each feature. 

1When in a dialog box, click the drop-down arrow and scroll down to select a feature. You can also click the name of the feature with the Left 
Mouse button in the Features panel. To select a feature from the Main Window, move the pointer over the drop-down list box and click the 
From Screen icon that appears. This selects the drop-down list and you can then click a feature with the Left Mouse button in the Main Win-
dow. If the drop-down list is already selected, then just click the feature with the Left Mouse button in the Main Window.
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• Click Create to create the dimension. 

Line-Line 

The length dimension is the shortest distance from the first to the second line.

Figure 12-1 Length: Line/Line

Coplanar Lines 

If the lines are coplanar, the length is measured from the center point of one line to the center point of the other 
line.

NOTE:  If the lines do not intersect, the length dimension is the shortest vertical distance between the two 
lines. If the lines are greater than 3 degrees deviation from parallel, the length cannot solve. See Figure 12-1

Parallel Lines 

The resulting dimension is the distance between the parallel lines. Measured lines will never be exactly parallel, so 
the two lines are analyzed to see if they are not parallel before the final calculation is displayed. This calculation 
will give you a non-zero result.

Skew Lines 

Skew lines do not lie on the same plane. In such cases, the result will be the shortest distance between the lines as 
if they were infinite. If the lines intersect, the length dimension will be 0.

Co-Planar Non-Parallel Lines 

All lines that are co-planar and non-parallel will intersect, so normally this would create a 0 length; however, the 
resulting dimension is the distance from the mid-point of the first line to the second line as if it were infinite.   

NOTE:  The result of co-planar non-parallel lines may not provide repeatable results.

Plane-Plane 

The length dimension is the perpendicular length from the center point of the first plane to the second plane.
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Figure 12-2 Length: Plane/Plane

NOTE:  If the planes do not intersect, the length dimension is the shortest vertical distance between the two 
planes. If the planes are greater than 3 degrees deviation from parallel, the length cannot solve. Figure 12-2

Point-Line 

The length dimension is the shortest distance between the point and the line.

Figure 12-3 Length: Point/Line

Point-Point 

The length dimension is the shortest distance between the two points.

Figure 12-4 Length: Point/Point

Point-Plane 

The length dimension is the shortest distance between the point and the plane.
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Figure 12-5 Length: Point/Plane

Point-Surface 

The length dimension is the shortest distance between the point and the surface.

Figure 12-6 Length: Point/Surface

NOTE:  A surface has boundaries, so the shortest distance is the distance from the point to the surface or 
surface edge.

Patterns
The Patterns group includes the commands to create a pattern of features and report their position. To tolerance 
the position of a pattern: 

1. In the Patterns group, click Create. 

2. On the Features panel, select Pattern 1. 

3. Click Include. 
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4. In the Include Features dialog box,  Select from the List.1 

5. Click Position and enter the position tolerances. 

NOTE:  A feature can only be in one pattern. 

Measure will check the pattern position and display errors for the pattern and for each component feature.

To remove a pattern:

1. On the Features panel, select the pattern.

2. In the Patterns group, click Delete.

To remove features from a pattern:

1. On the Features panel, select the feature in the pattern group.

2. In the Patterns group, click Exclude.

Construct From Selected Features
The Construct From Selected Features group contains construction commands based on the features you select. 

This group is empty until you select one or more features within the measurement file. When you make a selection, 
CAM2 populates the gallery with construction commands appropriate to the type of feature(s) that you select. For 
example, if you select a single circle, CAM2 populates the Construct From Selected Features gallery with 
Construct Point. If you select two circles, CAM2 populates the gallery with Construct Line, Construct Point, 
Angle From Features, and Length From Features.

Click any command in the Construct From Selected Features gallery to add the construction to the measurement 
file. 

1When in a dialog box, click in the Selected Choices window. Select a single feature by clicking the name of the feature with the Left Mouse 
button. Select multiple, consecutive features from the Feature panel by holding down the Shift key, clicking the first (top) feature in the 
sequence with the Left Mouse button, then clicking the last feature in the sequence with the Left Mouse button. Select multiple features in non-
consecutive order by holding down the Ctrl key and clicking each feature with the Left Mouse button. You can also click a feature with the Left 
Mouse button in the Main Window, or the name of the feature with the Left Mouse button in the Features panel. 
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Chapter 13: Alignments

The Alignment and Coordinate System commands are available in the Alignments tab across the top of the screen. 
The commands on the Alignments tab are organized into Alignments and Coordinate Systems groups. 

 
Alignments 266

Coordinate Systems 278
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Alignments
The Alignments group on the Alignments tab contains the following Alignment commands:

• Manage Alignments
• Align My Part
• Align Point Cloud
• Iterative
• Feature Based
• Datum

Alignments in which nominal data (CAD) is matched to measured data (Part) are often called “Coordinate System” 
alignments. This can be a best fit of features or an exact fit of constructed coordinate systems. See “Alignment 
Using Coordinate Systems” on page 278.

Alignments use all the active readings of measured features, regardless of the device position. Editing the readings 
of an alignment feature (feature used in an alignment command) causes a recalculation of the alignment. See 
“Measurement Data” on page 192. 

After completing an Alignment you should run Camera.  This will help you see the part as you are measuring. See 
“Camera” on page 116.

NOTE:  CAM2 only supports  coordinate systems. 

If you are using multiple alignments in your measurement file, quickly switch between each coordinate system by 
choosing it from the Alignment drop-down window. This drop-down window is a toolbar, and its default location 
is just under the pull-down menus at the top of the CAM2 window. 

Manage Alignments
Select Manage to access the Alignments window. The Alignments window consists of three components: The 
Alignment Methods box, the Alignments list, and the drop-down menu. You can also press the A keyboard 
shortcut on the keyboard. 
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‘

Figure 13-1 Alignments window

Alignment Requirements
Alignments require Measured/Constructed features with associated nominals, or two Constructed Coordinate 
Systems (Measured and Nominal). These alignments move the Measured/Constructed features to their nominals 
according to the position of each feature.

• The Alignment Methods box contains four tiles for each creation method: Coordinate System, Datum, 
Iterative, and Feature Based.

• The Alignmentslist contains a list of created alignments. The green check icon indicates the active alignment. 
Highlight an alignment to view the alignment’s properties in the Details box.

• The Details box contains properties pertaining to the alignment highlighted in the Existing Alignments box, 
including Name, Measured Coordinate System, Nominal Coordinate System, and Material.

New
Click the New drop-down and select an alignment creation method: Coordinate System, Datum, Iterative, Feature 
BasedImport.

Set Active
From the Alignments window, highlight an alignment in the Alignmentslist and click Set Active to make that 
alignment current.

NOTE:  The active alignment is identified by a green check icon.

NOTE:  To “clear” the alignment, select NONE from the Alignmentslist. 
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Recalculation
When you edit one or more features comprising an alignment, CAM2 automatically recalculates the alignment 
based on the updated information. 

NOTE:  Recalculation may be time-consuming depending on the complexity of the alignment. You may find 
it beneficial to remove the alignment, edit the component features, and then re-create the alignment.

Delete
Click Delete to delete any selected Alignment. 

Export
Click Export to  export the selected alignment to .fal, .xal, .euler, or .txt formats.

Align My Part
Select Align My Part to access the Create Alignments Wizard. Use the wizard to define an alignment by picking 
nominal features or surfaces, and then measuring those features or surfaces to create the alignment.

The Create Alignments Wizard prompts you to create a Surface Point alignment or a Feature Based alignment.

Surface Point Alignment
To create a Surface Point alignment using the Create Alignments Wizard:

1. Highlight Surface Point Alignment, and click Next.

2. Pick points (Inspect Surface Points) on the CAD model. See “Measuring an Inspect Surface Point” on page 156.

3. When you have picked enough points to constrain all degrees of freedom, the Measure The Alignment Points 
button appears. Click this button to begin measurement. The view will update to show the nominal feature to be 
measured.

4. Measure the features in the order they were created. As you measure the features, CAM2 begins to compute an 
alignment. After you measure the third feature, the alignment computation provides a rough idea of the final 
outcome.

5. After you measure all of the features, the Alignment Results dialog displays each measurement along with the 
standard deviation, number of iterations, and maximum error. From here, you can remeasure all features, 
remeasure out of tolerance features, or click Finish to create the alignment using the existing measurements. 
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Feature Based Alignment
A Feature Based Alignment constrains each feature to degrees of freedom, and once the 6 degrees of freedom are 
constrained, the alignment can be created. Fully constrained alignments can be created regardless of the number of 
features selected.

To create a Three Feature Alignment using the Create Alignments Wizard:

1. Edit the name (if required).

2. Select Primary Feature from the dropdown list and the degrees of freedom locked by the feature will be 
indictated in green.

3. Select Secondary Feature from the dropdown list and the degrees of freedom locked by the feature will be 
indictated in green.

4. Select Tertiary Feature from the dropdown list (if required) and the degrees of freedom locked by the feature 
will be indictated in green. 

NOTE:  Once all 6 DoF icons are green the alignment can be created.

5. Click the Material drop-down to apply material and temperature compensation, if needed.

6. Click Create

Align Point Cloud
Select Align Point Cloud to access point cloud alignment mode. To further improve the point cloud alignment, use 
aligning points to define a set of references to lock the alignment to the correct surfaces based on point pairs.

• The Main window will split into two halves to facilitate point cloud alignment.

• Select representative pairs of points from the point cloud and the CAD model by clicking corresponding areas 
in each half of the Main window. Point pairs share a common color and number.

The Align Point Cloud commands are located in the Point Cloud Alignment Mode tab across the top of the 
screen, and the commands are organized into Alignment, Aligning Points, View, and Close groups.

NOTE:  If you are using the Probing Version of CAM2, this command is not available. See “Probing 
Version” on page 9.

Alignment
The Alignment group contains the Solve Alignment, Preview Alignment, Advanced, Include All, Exclude All, and 
Create commands.

Solve Alignment
Solve Alignment updates the current alignment. The Main window shows an animation of the point cloud and 
features as the alignment calculates.
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Preview Alignment
Preview Alignment enables an alignment preview which appears when you’ve selected six aligning point pairs, 
and updates as you continue to select aligning points. Click Preview Alignment to exit preview mode.

Advanced
Advanced opens the Alignments window. Use the Alignments window to manage the point cloud alignment. See 
“Manage Alignments” on page 266.

Include All
Include All specifies whether to use point cloud data in the alignment calculation.

Exclude All
Exclude All specifies whether to exclude all point cloud data from the alignment calculation.

Create
Create creates a new alignment.

Aligning Points
The Aligning Points group contains the Show All, Add, and Clear Points commands. 

Show All
Show All shows all aligning points in the Main window and in an Aligning Points folder in the Features section of 
the Navigation window.

NOTE:  This option is useful when you have multiple point cloud alignments, as you can reuse aligning points 
from other alignments.

Add
Add creates aligning points.

Clear Points
Clear Points removes all point pairs from the scans in the Main windows. 

View
The View group contains the Vertical, Horizontal, and Lock Viewers commands. 
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Vertical
Vertical splits the Main window into left and right panels.

Horizontal
Horizontal splits the Main window into top and bottom panels.

Lock Viewers
Lock Viewers protect the contents of the Main window panels from user input.

Close
The Close group contains the Close command, which exits Point Cloud Alignment mode. 

Iterative
Use this type of alignment when you want to best fit (shared error) three or more point-reducible features.

In the Alignments window, click Iterative, or select Iterative from the New drop-down.

Requires: three or more point-reducible features with associated nominals, or four inspect surface/vector points and 
one feature point (RPS alignment). 

Figure 13-1 Alignments window - Iterative
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NOTE:  If a measured feature does not have a nominal, you must add one to continue. For more information, 
see “Nominals and Tolerances” on page 194. 

You can align point clouds to CAD data using an Iterative alignment. Point cloud data aligned to CAD is 
colored according to tolerance information. When you have loaded CAD and you have measured one or more 
point clouds, create an Iterative alignment by selecting one or more point clouds to best-fit align to the entire 
CAD assembly. Should the Iterative alignment not be optimal, you can define a set of Aligning Points (user-
defined point pairs) to lock the alignment to the correct surfaces.

Home-in points with nominal surface points cannot be used in an iterative alignment; you can only home in to 
a nominal point.

Details box: 
•  Select a Feature.1 

To create an Iterative 
alignment:

1. Edit the name (if required).

2. Select the required features in the Features list. See “Features” on page 34.

3. Click the ⊕ to add the selection to the UI, or select each feature from the drop-down lists.

You can also apply additional feature options:

4. Use Custom Weights: Specify feature specific weights, and is accessed from the ••• Feature Options icon.

You can expand the Advanced Options bar for additional options:

5. Max Iterations: Specify a maximum number of iterations. A smaller value may reduce alignment time, and 
result in a less accurate alignment; a larger value may increase alignment time, but result in a more accurate 
alignment.

NOTE:  The Alignment Results will show the number of iterations needed, and this value will typically be 
less than the max iterations value. If the value is equal, increase the max iteration value and reapply the 
alignment.

6. Sample Size: Applies to any Inspect Surface feature included in the alignment. This value is ignored for Point 
Cloud.

7. Use Custom Weight: Toggles Weight table, as with ••• icon.

8. Fit Scale: Toggles Fit Scale.

NOTE:  When Fit Scale is active, Constraints and Material are not supported.

9. Constraints: Enable constraints to be added to the alignment:

1When in a dialog box, click the drop-down arrow and scroll down to select a feature. You can also click the name of the feature with the Left 
Mouse button in the Features panel. To select a feature from the Main Window, move the pointer over the drop-down list box and click the 
From Screen icon that appears. This selects the drop-down list and you can then click a feature with the Left Mouse button in the Main Win-
dow. If the drop-down list is already selected, then just click the feature with the Left Mouse button in the Main Window. 
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• Planar: select a Plane reducible feature from the dropdown list.

• Linear and Point

• Select a point reducible feature from the dropdown list. 

• Line Reducible: select a line reducible feature from the dropdown.

OR

• From Two Points: select 2 point reducible features from the drop down list to establish a line.

10. Select the Material from the drop-down.

11. Click Create to solve the alignment.

NOTE:  View the alignment results and errors in Manage Alignments by selecting the alignment from the list. 
See “Manage Alignments” on page 266.

 

Advanced Options
Options box: 
• Enter a Maximum Iterations number for the calculations, or use the default value. Use this number if your 

alignment calculation seems to “loop” between two or more solutions. Change the default value using the 
Maximum Iterations preference. See “Maximum Iterations ” on page 87. 

• Enter a Tolerance for the Iterative best fit error of the Measured to Nominal features, or use the default value. 
Change the default value using the Iterative Alignment Tolerance preference. See “Iterative Alignment 
Tolerance ” on page 87.

• Click Apply/Solve.

Results box: 
• Alignment accuracy.

Fit Scale
You can select to scale the measured features during the best fit calculations. The scale is the ratio between the 
measured features and their nominal features.

• Select the Fit Scale check box to scale measured features during best fit calculations. 

Set Weights
Each feature can have an X, Y, and Z coordinate value used with a higher priority in the calculation. 

• Select the Set Weights check box to add the Weights columns to the feature list.

• Enter a value for the X, Y, and Z coordinate value for each feature. The default value is 1; input a number 
greater than 1 to emphasize a weight. 
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NOTE:  When you check the Set Weights check box, CAM2 will automatically calculate weight values for 
measured vector points. For more information, see “Measuring a Vector Point” on page 174. For all other 
feature types, weights of 1,1,1 are set by default. You can then change the values.

Constraints
To add a constraint to an iterative alignment, click the Type drop down and select the constraint type: Linear or 
Planar.

Linear Constraint 

Select a line constraint by which a measured line must lie on a common axis. The part will translate and rotate on 
that line to minimize the errors of features added to the list of alignment features.

In order to define the line constraint, you must select a line, two features to make a line, or select a point.

Planar Constraint 

Select a plane constraint by which the measured plane must be perfectly matched to the nominal plane. The part 
will translate and rotate on that plane to minimize the errors of features added to the list of alignment features.

In order to define the plane constraint, you must pick a Nominal plane and measure it, then add two or more point 
features that will constrain the translation and rotation of the part within that constraint plane. 

NOTE:  Surface Points may only be used when the normal component of the nominal surface is not parallel to 
the nominal constrained plane.

Polyline Groups and Planar Constraints 

Using the plane constraint, you can measure one or more parallel lock plane polyline features and add them to the 
list of features to perform the iterative alignment. These polylines will be best fit to the corresponding surfaces 
while holding the plane constraint and are ideal for determining the pitch angle of propellers or wings and different 
offsets from the base.

Material Temperature
CAM2 adjusts measurements to the current part temperature entered. A nominal temperature of 20°C (68°F) is 
used. The ability to scale for temperature allows you to measure parts in areas that are either warmer or cooler. The 
measurement results are adjusted for thermal expansion or contraction.

To scale for material temperature changes: 

• In the Details box, click the drop-down arrow and select a material from the library of materials. You will see 
the coefficient of linear expansion next to the material name. You cannot change this value.

• Enter the temperature of the part, and select Celsius (°C) or Fahrenheit (°F) from the drop-down arrow.
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NOTE:  If the material you are using is not available in the library and you know the coefficient of linear 
expansion of the material you are using, click Plus (+) next to the Materials drop-down arrow. In the Create 
New Material dialog box, enter a name and coefficient of linear expansion value for the new material. Click 
OK to add this material to the library. 

Feature Based
Use this type of alignment when it is important to prioritize the fit (primary, secondary, tertiary) to three features.

Requires: three features with associated nominals. The type of features is determined by the Alignment method. 

• Method:  Select1 an Alignment method. 

• Features:  Select2 
a
 Primary, Secondary, and Tertiary feature. 

NOTE:  Associated nominals are required for this command. If a measured feature does not have a nominal, 
you must add one to continue. For more information, see “Nominals and Tolerances” on page 194.’

The alignment solves as:

• The primary feature moves exactly to its nominal. There will be no alignment error between this actual and 
nominal feature.

• The secondary feature moves as close to its nominal without moving the primary feature. There may be some 
alignment error between this actual and nominal feature. 

• The tertiary feature moves as close to its nominal without moving the primary of secondary features. Most of 
the alignment error is between this actual and nominal feature. 

NOTE:  You can also create a Three Feature Alignment from CAD using Align My Part. For more 
information, see “Align My Part” on page 268.

Datum
Use this type of alignment when it is important to prioritize the fit (primary, secondary, tertiary) to three previously 
assigned planar or linear datum features. Datum alignments support the same Datum Reference Frame alignments 

1When in a dialog box, click the drop-down arrow and scroll down to select a feature. You can also click the name of the feature with the Left 
Mouse button in the Features panel. To select a feature from the Main Window, move the pointer over the drop-down list box and click the 
From Screen icon that appears. This selects the drop-down list and you can then click a feature with the Left Mouse button in the Main Win-
dow. If the drop-down list is already selected, then just click the feature with the Left Mouse button in the Main Window.
2When in a dialog box, click the drop-down arrow and scroll down to select a feature. You can also click the name of the feature with the Left 
Mouse button in the Features panel. To select a feature from the Main Window, move the pointer over the drop-down list box and click the 
From Screen icon that appears. This selects the drop-down list and you can then click a feature with the Left Mouse button in the Main Win-
dow. If the drop-down list is already selected, then just click the feature with the Left Mouse button in the Main Window.
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as those created in GD&T mode, some of which are not possible using a Feature Based alignment. For more 
information, see “GD&T” on page 287.

Requires: three planar or linear datum features.

• Features:  Select1 a Primary, Secondary, and Tertiary datum feature. 

The alignment solves 
as:

• The primary feature moves exactly to its nominal. There will be no alignment error between this actual and 
nominal feature.

• The secondary feature moves as close to its nominal without moving the primary feature. There may be some 
alignment error between this actual and nominal feature. 

• The tertiary feature moves as close to its nominal without moving the primary of secondary features. Most of 
the alignment error is between this actual and nominal feature. 

To create a Datum alignment:

1. Edit the name (if required).

2. Select a Primary Datum from the drop-down list.

3. Select a Secondary Datum from the drop-down list.

4. Select a Tertiary Datum from the drop-down list.

5. Click Create.

NOTE:  View the alignment results in Manage Alignments by selecting the alignment from the list. See 
“Manage Alignments” on page 266.

Coordinate System
Select Coordinate System to create a coordinate system alignment. 

For simplicity, there are two coordinate systems for use in a coordinate system alignment:

1. World Coordinate System (WCS) - a coordinate system containing the associated nominal features. This is the 
default coordinate system of a new file.

2. Measured Coordinate System (MCS) - a coordinate system containing the Measured and Constructed features. 
See “Alignment Using Coordinate Systems” on page 278.

NOTE:  You can also construct a Nominal Coordinate System (NCS) using Coordinate System. See 
“Coordinate System” on page 278.

1When in a dialog box, click the drop-down arrow and scroll down to select a feature. You can also click the name of the feature with the Left 
Mouse button in the Features panel. To select a feature from the Main Window, move the pointer over the drop-down list box and click the 
From Screen icon that appears. This selects the drop-down list and you can then click a feature with the Left Mouse button in the Main Win-
dow. If the drop-down list is already selected, then just click the feature with the Left Mouse button in the Main Window.
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Requires: a Constructed and a Nominal coordinate system. 

• Measured Coordinate System:  Select a Coordinate System.1

• Nominal Coordinate System:  Select a Coordinate System.2

The Measured Coordinate System (MCS) moves to the Nominal 
Coordinate System (NCS) or the World Coordinate System (WCS). See “Coordinate Systems” on the next page.

NOTE:  In most cases, the MCS to NCS alignment removes the need for rotating and translating a 
Constructed Coordinate System to match the World Coordinate System.

To create a Coordinate System alignment:

1. Edit the name (if required).

2. Select a Measured Coordinate System from the drop-down list.

3. Select a Nominal Coordinate System from the drop-down list.

4. Click the Material bar to expand the material and temperature options.

5. Select the material from the drop-down.

6. Select the ⊕ icon to enter a new material and CTE.

7. Enter the material Temperature.

8. Select the temperature Unit (ºF or ºC).

9. Click Create.

Import
Select Import to create the current alignment from a file.

1. From the Alignments window, click the New drop-down and selectFeature BasedImport

2. Edit the name (if required).

3. Click the Imported File Name field to browse and select the alignment file to be imported (.fal, .xal or .txt 
format).

4. Click the Material drop-down to apply material and temperature compensation, if needed.

5. Click Create to import and set the alignment active.

1When in a dialog box, click the drop-down arrow and scroll down to select a coordinate system. You can also click the name of the coordinate 
system with the Left Mouse button in the Coordinate Systems panel. To select a coordinate system from the Main Window, move the pointer 
over the drop-down list box and click the From Screen icon that appears. This selects the drop-down list and you can then click a coordinate sys-
tem with the Left Mouse button in the Main Window. If the drop-down list is already selected, then just click the coordinate system with the 
Left Mouse button in the Main Window. 
2When in a dialog box, click the drop-down arrow and scroll down to select a coordinate system. You can also click the name of the coordinate 
system with the Left Mouse button in the Coordinate Systems panel. To select a coordinate system from the Main Window, move the pointer 
over the drop-down list box and click the From Screen icon that appears. This selects the drop-down list and you can then click a coordinate sys-
tem with the Left Mouse button in the Main Window. If the drop-down list is already selected, then just click the coordinate system with the 
Left Mouse button in the Main Window. 
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Select Alignment
Use the Select Alignment drop-down window to select the active alignment for all features. See “Alignments” on 
page 266.

Coordinate Systems
The Coordinate Systems group on the Alignments tab consists of Coordinate System commands. 

CAUTION:  Although, at times it may be necessary to mix nominal, measured, and constructed features when 
creating constructions, do it with caution. Mixing types of features to create a construction might cause 
inaccuracies in your measurement data.

Coordinate System
Using the existing features in a file, you can click Coordinate System to construct a coordinate system. You can 
also press the C keyboard shortcut on the keyboard to create a coordinate system. There are two tabs in the 
Construct Coordinate System using the Wizard dialog box:

• Basic Tab
• Advanced Tab

NOTE:  The default coordinate system is World, which is the same coordinate system as your measurement 
device.

• Nominal Coordinate Systems, NCS, are generated from nominal and/or constructed features.

• Measured/Constructed Coordinate Systems, MCS, are generated from measured and/or constructed features.

If you are using multiple coordinate systems in your measurement file, quickly switch between each coordinate 
system by choosing it from the Coordinate System drop-down. For more information, see “Select Coordinate 
System” on page 286.

Alignment Using Coordinate Systems
One way to align Measured data with Nominal CAD data:

1. Create a Coordinate System from the Nominal CAD data. This is known as the Nominal Coordinate System 
(NCS).

2. Create a Measured Coordinate System from the measured/constructed data. This is known as the Measured 
Coordinate System (MCS).

3. Create a new Coordinate System alignment and select these two coordinate systems in the command. See 
“Coordinate System” on page 276.

NOTE:  CAM2 only supports  coordinate systems. 

Basic Tab
Use the Basic tab when you have a plane, a line, and a point that define the coordinate system.
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Requires: three features that define a coordinate system. 

• Name: Type in a name for the coordinate system.

• Plane Feature:  Select a Plane.1 You can also select the coordinate axis that this feature defines. The default 
A
xis value is +Z. 

• Line Feature:  Select a Line. 2 You can also select the coordinate axis that this feature defines. The default 
A
xis value is +X. 

• Point Feature:  Select a Point.3

Other Functions: 

• Align With:  Select a Coordinate System.4 The coordinate system automatically aligns with another existing 
c
oordinate system. The default value is World. For more information, see “Coordinate System” on page 276. 

NOTE:  After you create a coordinate system alignment by checking the Align With checkbox and clicking 
OK, clearing the checkbox will not remove the alignment.

• Offset: Select the check box and type the XYZ location for the origin of the new coordinate system.  Typing 
values in different units and coordinate systems.5

•
 Rotation: Select the check box and type the amount of rotation around any of the three axes. (Negative values 

are allowed.)

NOTE:  If you select both Offset and Rotate About check boxes, you can select to offset or rotate first.

1When in a dialog box, click the drop-down arrow and scroll down to select a plane, or plane reducible, feature. You can also click the name of 
the plane with the Left Mouse button in the Features panel. To select a plane from the Main Window, move the pointer over the drop-down list 
box and click the From Screen icon that appears. This selects the drop-down list and you can then click a plane with the Left Mouse button in 
the Main Window. If the drop-down list is already selected, then just click the plane with the Left Mouse button in the Main Window.
2When in a dialog box, click the drop-down arrow and scroll down to select a line, or line reducible, feature. You can also click the name of the 
line with the Left Mouse button in the Lines panel. To select a line from the Main Window, move the pointer over the drop-down list box and 
click the From Screen icon that appears. This selects the drop-down list and you can then click a line with the Left Mouse button in the Main 
Window. If the drop-down list is already selected, then just click the line with the Left Mouse button in the Main Window. Note: Two points 
can also be used to define a line. You can construct a line using two points using Construct Line: By Best Fit. 
3When in a dialog box, click the drop-down arrow and scroll down to select a point, or point reducible, feature. You can also click the name of 
the point with the Left Mouse button in the Points panel. To select a point from the Main Window, move the pointer over the drop-down list 
box and click the From Screen icon that appears. This selects the drop-down list and you can then click a point with the Left Mouse button in 
the Main Window. If the drop-down list is already selected, then just click the point with the Left Mouse button in the Main Window.
4When in a dialog box, click the drop-down arrow and scroll down to select a coordinate system. You can also click the name of the coordinate 
system with the Left Mouse button in the Coordinate Systems panel. To select a coordinate system from the Main Window, move the pointer 
over the drop-down list box and click the From Screen icon that appears. This selects the drop-down list and you can then click a coordinate sys-
tem with the Left Mouse button in the Main Window. If the drop-down list is already selected, then just click the coordinate system with the 
Left Mouse button in the Main Window.
5You can type a value in any unit, and CAM2 2020 converts the value to the default unit value. For example, the default value is 0,0,0 mm but 
your feature is 5,5,10 inches. Type 5in, 5in, 10in and CAM2 2020 automatically converts the value to 127, 127, 254 millimeters. To change the 
coordinate system, click the arrow on the right side of the dialog box and select from the menu. CAM2 2020 automatically converts the values 
to the current coordinate system during the feature construction.
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Click OK to create the coordinate system. The features construct a coordinate system. Any coordinate system 
offset and rotation follows the . 

NOTE:  If you select a hybrid of measured and nominal features as Primary, Secondary, and Origin features, 
you have the option of creating the coordinate system as Actual or Nominal. Click the drop-down arrow on 
OK to create the coordinate system as Actual or Nominal.

Basic Coordinate System Examples
The coordinate system constructs in the plane. All features temporarily project to the plane in the construction of 
the coordinate system.

Plane/Line/Point 
This is commonly referred to as the 3-2-1 coordinate system: 3 points (plane) - 2 points (line) - 1 point (point).

• Plane Feature: a plane. 

• Line Feature: a line. 

• Point Feature: a point. This defines the origin (0,0,0) of the coordinate system. 

Figure 13-1 Plane/Line/Point 

Advanced Tab
Use the Advanced tab when you have features for, or features that construct a plane, a line, or a point that define 
the coordinate system. 

Requires: features that define a coordinate system.

• Name: Type in a name for the coordinate system.
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• Primary: Click the Plane or Line icon.  Select a Feature.

1

  You can select the coordinate axis 
t
hat this feature defines. The default Axis value is +Z. You can type in an offset value for the feature. 

• Plane icon: Select features that define a plane. Three point- 
reducible, two line-reducible, two point and one line-reducible, or a plane. The Right-Hand Rule 
determines the axis direction of the plane when you use multiple features. See “Right-Hand Rule” on 
page 330.

• Line icon: Select features that define a line. Two point-reducible or a line. The order of the two 
points determines the axis direction of the line. 

• Secondary: Click the Plane or Line icon.  Select a Feature.

2

 You can select the coordinate axis 
t
hat this feature defines. The default Axis value is +X. You can type in an offset value for the feature. 

• Plane icon: Select features that define a plane. Three point- 
reducible, two line-reducible, two point and one line-reducible, or a plane. The  Right-Hand Rule 
determines the axis direction of the plane when you use multiple features. See “Right-Hand Rule” on 
page 330.

• Line icon: Select features that define a line. Two point-reducible or a line. The order of the two 
points determines the axis direction of the line. 

• Origin:  Select a Feature.3 

• Hold Position: the 
coordinate system is at the center of the feature. 

1When in a dialog box, click the drop-down arrow and scroll down to select a feature. You can also click the name of the feature with the Left 
Mouse button in the Features panel. To select a feature from the Main Window, move the pointer over the drop-down list box and click the 
From Screen icon that appears. This selects the drop-down list and you can then click a feature with the Left Mouse button in the Main Win-
dow. If the drop-down list is already selected, then just click the feature with the Left Mouse button in the Main Window. 
2When in a dialog box, click the drop-down arrow and scroll down to select a feature. You can also click the name of the feature with the Left 
Mouse button in the Features panel. To select a feature from the Main Window, move the pointer over the drop-down list box and click the 
From Screen icon that appears. This selects the drop-down list and you can then click a feature with the Left Mouse button in the Main Win-
dow. If the drop-down list is already selected, then just click the feature with the Left Mouse button in the Main Window.
3When in a dialog box, click the drop-down arrow and scroll down to select a feature. You can also click the name of the feature with the Left 
Mouse button in the Features panel. To select a feature from the Main Window, move the pointer over the drop-down list box and click the 
From Screen icon that appears. This selects the drop-down list and you can then click a feature with the Left Mouse button in the Main Win-
dow. If the drop-down list is already selected, then just click the feature with the Left Mouse button in the Main Window.
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• Hold to Primary: the coordinate system is at the closest point on the primary feature from the origin 
feature. 

• Hold to Secondary: the coordinate system is at the closest point on the secondary feature from the origin 
feature. 

• Hold to Key-In: the coordinate system corresponds to the location (primary, secondary and origin) keyed-
in by the user.

Other Functions: 

• Align With:  Select a Coordinate System.1 The coordinate system automatically aligns with another existing 
c
oordinate system. The default value is World. For more information, see “Coordinate System” on page 276. 

• Offset: Select the check box and type the XYZ location for the origin of the new coordinate system.  Typing 
values in different units and coordinate systems.2

•
 Rotation: Select the check box and type the amount of rotation around any of the three axes. (Negative values 

are allowed.)

NOTE:  If you select both Offset and Rotation check boxes, you can select to offset or rotate first.

Click OK to create the coordinate system. The features construct a coordinate system. Any coordinate system 
offset and rotation follows the Right-Hand Rule. See “Right-Hand Rule” on page 330.

Advanced Coordinate System Examples
Plane/Line (two points)/Point 
This is commonly referred to as the 3-2-1 coordinate system: 3 points (plane) - 2 points (line) - 1 point (point).

• Primary: a plane. The plane vector defines the axis.

• Secondary: two points. Point 1 to Point 2 defines the axis.

• Origin: a point. This defines the origin (0,0,0) of the coordinate system. 

1When in a dialog box, click the drop-down arrow and scroll down to select a coordinate system. You can also click the name of the coordinate 
system with the Left Mouse button in the Coordinate Systems panel. To select a coordinate system from the Main Window, move the pointer 
over the drop-down list box and click the From Screen icon that appears. This selects the drop-down list and you can then click a coordinate sys-
tem with the Left Mouse button in the Main Window. If the drop-down list is already selected, then just click the coordinate system with the 
Left Mouse button in the Main Window.
2You can type a value in any unit, and CAM2 2020 converts the value to the default unit value. For example, the default value is 0,0,0 mm but 
your feature is 5,5,10 inches. Type 5in, 5in, 10in and CAM2 2020 automatically converts the value to 127, 127, 254 millimeters. To change the 
coordinate system, click the arrow on the right side of the dialog box and select from the menu. CAM2 2020 automatically converts the values 
to the current coordinate system during the feature construction.
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Figure 13-1 Plane/Line (two points)/Point 

Plane/Plane/Plane 
This is commonly referred to as the 3 Plane coordinate system.

• Primary: a plane. The plane vector defines the axis.

• Secondary: a second plane. The plane vector defines the axis.

• Origin: a third plane. This defines the origin (0,0,0) of the coordinate system. The origin is the intersection of 
the three planes, and the plane vector defines the axis. 

Figure 13-2 Plane/Plane/Plane 

Plane/Plane/Point 
• Primary: a plane. The plane vector defines the axis.

• Secondary: a second plane. The plane vector defines the axis.

• Origin: a point. This defines the origin (0,0,0) of the coordinate system.

Figure 13-3 Plane/Plane/Point 
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Point/Point/Point 
This is commonly referred to as the 3 Point coordinate system.

• Primary: three points.Point 1, to Point 2, to Point 3 define the plane.

• Secondary: two points. Point 1 to Point 2 defines the axis.

• Origin: a point. This defines origin (0,0,0) of the coordinate system. 

Figure 13-4 Point/Point/Point 

Plane/Line/Point Hold Secondary 
This is commonly referred to as the Perpendicular Intersection coordinate system.

• Primary: a plane. The plane vector defines the axis.

• Secondary: a line. The line vector defines the axis.

• Origin: a point. Select the Hold Secondary radio button. This defines the origin (0,0,0) of the coordinate 
system and moves it to the nearest point on the line. 

Figure 13-5 Plane/Line/Point Hold Secondary 

Plane/Line/Line 
This is commonly referred to as the Line/Line Intersect coordinate system.

• Primary Feature: a plane. The plane vector defines the axis.

• Secondary Feature: a line. The line vector defines the axis.

• Origin Feature: a second line. This defines the origin (0,0,0) of the coordinate system. The origin is the point 
at which the second line intersects the first line. The line vector defines the axis.
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Figure 13-6 Plane/Line/Line 

By Key-In
Type the coordinates of the new origin, a point on the X axis and a point on the XY plane to define the coordinate 
system.

• Name: Type in a name for the coordinate system.

• Origin: Type in the XYZ values.  Typing values in different units and coordinate systems.1

• Point on X Axis: Type in the XYZ values.  Typing values in different units and coordinate 
systems.2

•
 Point on XY Plane: Type in the XYZ values.  Typing values in different units and coordinate systems.3

• Align With:  Select a Coordinate System.4 The coordinate system automatically aligns with another 
e
xisting coordinate system. The default value is World. For more information, see “Coordinate System” on 
page 276. 

• Click Create to create the coordinate system.

1You can type a value in any unit, and CAM2 2020 converts the value to the default unit value. For example, the default value is 0,0,0 mm but 
your feature is 5,5,10 inches. Type 5in, 5in, 10in and CAM2 2020 automatically converts the value to 127, 127, 254 millimeters. To change the 
coordinate system, click the arrow on the right side of the dialog box and select from the menu. CAM2 2020 automatically converts the values 
to the current coordinate system during the feature construction.
2You can type a value in any unit, and CAM2 2020 converts the value to the default unit value. For example, the default value is 0,0,0 mm but 
your feature is 5,5,10 inches. Type 5in, 5in, 10in and CAM2 2020 automatically converts the value to 127, 127, 254 millimeters. To change the 
coordinate system, click the arrow on the right side of the dialog box and select from the menu. CAM2 2020 automatically converts the values 
to the current coordinate system during the feature construction.
3You can type a value in any unit, and CAM2 2020 converts the value to the default unit value. For example, the default value is 0,0,0 mm but 
your feature is 5,5,10 inches. Type 5in, 5in, 10in and CAM2 2020 automatically converts the value to 127, 127, 254 millimeters. To change the 
coordinate system, click the arrow on the right side of the dialog box and select from the menu. CAM2 2020 automatically converts the values 
to the current coordinate system during the feature construction.
4When in a dialog box, click the drop-down arrow and scroll down to select a coordinate system. You can also click the name of the coordinate 
system with the Left Mouse button in the Coordinate Systems panel. To select a coordinate system from the Main Window, move the pointer 
over the drop-down list box and click the From Screen icon that appears. This selects the drop-down list and you can then click a coordinate sys-
tem with the Left Mouse button in the Main Window. If the drop-down list is already selected, then just click the coordinate system with the 
Left Mouse button in the Main Window.
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By Offset
Create a new coordinate system by rotating and/or offsetting (moving) an existing coordinate system.

• Name: Type in a name for the coordinate system.

•  Select a Coordinate System.1 

• Offset: Select the check box 
and type the XYZ location for the origin of the new coordinate system.  Typing values in different units and 
coordinate systems.2

•
 Rotation: Select the check box and type the amount of rotation around any of the three axes. (Negative values 

are allowed.)

NOTE:  If you select both Offset and Rotate About check boxes, you can select to offset or rotate first.

• Align With:  Select a Coordinate System.3 The coordinate system automatically aligns with another existing 
c
oordinate system. The default value is World. For more information, see “Coordinate System” on page 276. 

• Click Create to create the coordinate system.

Offset and Rotation are applied according to the Right-Hand Rule. See “Right-Hand Rule” on page 330.

Select Coordinate System
Use the Select Coordinate System drop-down window to select the active coordinate system for all features. See 
“Coordinate Systems” on page 278.

 

1When in a dialog box, click the drop-down arrow and scroll down to select a coordinate system. You can also click the name of the coordinate 
system with the Left Mouse button in the Coordinate Systems panel. To select a coordinate system from the Main Window, move the pointer 
over the drop-down list box and click the From Screen icon that appears. This selects the drop-down list and you can then click a coordinate sys-
tem with the Left Mouse button in the Main Window. If the drop-down list is already selected, then just click the coordinate system with the 
Left Mouse button in the Main Window.
2You can type a value in any unit, and CAM2 2020 converts the value to the default unit value. For example, the default value is 0,0,0 mm but 
your feature is 5,5,10 inches. Type 5in, 5in, 10in and CAM2 2020 automatically converts the value to 127, 127, 254 millimeters. To change the 
coordinate system, click the arrow on the right side of the dialog box and select from the menu. CAM2 2020 automatically converts the values 
to the current coordinate system during the feature construction.
3When in a dialog box, click the drop-down arrow and scroll down to select a coordinate system. You can also click the name of the coordinate 
system with the Left Mouse button in the Coordinate Systems panel. To select a coordinate system from the Main Window, move the pointer 
over the drop-down list box and click the From Screen icon that appears. This selects the drop-down list and you can then click a coordinate sys-
tem with the Left Mouse button in the Main Window. If the drop-down list is already selected, then just click the coordinate system with the 
Left Mouse button in the Main Window.
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Chapter 14: GD&T

The Geometric Dimensioning and Tolerancing (GD&T) commands are located in the GD&T tab across the top of 
the screen. 

 
GD&T in Labels 289

Applying GD&T Tolerances to Multiple Features 289

Exact Feature Length 290

Datum 291

Form 292

Orientation 293

Location 294

Profile 296

Run Out 298

The GD&T (Geometric Dimensioning and Tolerancing) tab contains commands for a part that is toleranced using 
the GD&T system. The GD&T system accurately displays dimensions and tolerances in a specific graphical format 
on a drawing. 

• GD&T is represented by a series of symbols that have specific meanings.

• GD&T tolerances allow you to measure parts and compare them to a datum to ensure that specific design and 
tolerance requirements are met. See “Datum” on page 291.

• GD&T tolerances and results add to each feature in the report.

• GD&T form tolerances appear with the appropriate name and image in the Feature Information panel, 
reports, and labels.

• GD&T labels are automatically added to the Main window. 

The commands on the GD&T tab are organized into Datum, Orientation, Location, Profile, and Run Out groups. 
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Figure 14-1 GD&T
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CAM2 includes the following GD&T tolerances: 

GD&T Tolerance  GD&T Command 

Form

Circularity

Cylindricity

Flatness

Straightness

Orientation

Perpendicularity

Angularity

Parallelism

Location

Concentricity

Position

Regardless of Feature Size (RFS)

Maximum Material Condition 
(MMC)

Least Material Condition (LMC)

Profile
Profile of a Surface

Profile of a Line

Runout Total Runout

 

GD&T in Labels
When you add a GD&T tolerance to a feature, a label adds to the Main window. You can drag this label around 
the view, adjust the text size, align it to the screen view, and add more details to the label using the Labels 
commands on the View tab. For more information, see “Labels” on page 118.

The position and detail level of the label stores in every captured view. For more information, see “View” on page 
104.

Applying GD&T Tolerances to Multiple Features
When you add a GD&T tolerances to a feature, you can quickly apply those tolerances to multiple features:
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1. Select the feature with GD&T tolerances from the Features panel. 

2. Right-click and select Copy Tolerances.

3. Select the feature(s) from the Features panel to receive the copied GD&T tolerances.

4. Right-click and select Paste Tolerances.

5. Click Yes to apply the copied tolerances to the selected feature(s).

Exact Feature Length
The Orientation GD&T tolerances use the location of the readings to calculate the length of the feature. Sometimes 
this is not very accurate because it is difficult to digitize to the edge of your part.   

For example, you are reporting the parallelism of a line to a datum. The edge of your part is 300 mm, however the 
furthest readings are less than 300 mm apart. To enter an exact length for a feature:

1. Create an Orientation GD&T tolerance.

2. Right-Click the feature in the GD&T panel and select Override Length from the shortcut menu.

3. Select the Override Length check box and type in the length value.  Typing values in different units.1 

The GD&T tolerance calculates the readings and extends the feature length from the center of the 
measured feature in both directions. 

1You can type a value in any unit, and CAM2 2020 converts the value to the default unit value. For example, the default value is 0mm but the 
diameter is 10inches. Type 10in and CAM2 2020 automatically converts the value to 254 millimeters. 
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Datum
The Datum group includes the commands for creating and defining planar and linear datums.

The datum is the theoretically exact plane or line (axis) from which a dimensional measurement is made, and is 
used for comparison in the Orientation, Runout, and Location GD&T tolerances. The Form and Profile GD&T 
tolerances do not require a datum because they use simple geometry for comparison. 

To define a datum: 

1. Select an existing feature from the Features panel. 

2. On the GD&T tab, click Planar or Linear.

3. In the Letter drop-down list, choose the letter to identify the Datum; only unassigned Datum letters are available. 

NOTE:  You can also right-click a feature from the Features panel and select Assign a Datum. 

To delete a datum: 

1. Select an existing feature from the Features panel. 

2. On the GD&T tab, select Planar or Linear to remove the datum from the feature. 

Datum Scheme Status Indication
The GD&T control frame indicates datum scheme status with a color-coded control frame border behind the datum 
callouts:

• Black - the selected datum scheme may be used.

• Red - the selected datum scheme is invalid/incomplete and cannot be used.

NOTE:  The black control frame border color signifies that the datum scheme may be used, and does not 
guarantee that the datum scheme will be able to solve when the position tolerance solves. Red indicates the 
datum scheme cannot be used whatsoever.

Datum scheme status is determined according to type, number, and geometry of datums selected, whether all 
degrees of freedom are constrained, the geometry of the nominals (e.g., three planes that are all parallel are 
invalid), and whether all datums have both an actual and nominal feature. 

Composite Datums
Create a Composite Datum for your part with the Manage Datums command. A Composite Datum consists of two 
or more datum features that work in tandem to constrain certain degrees of freedom during an assembly process.

To create a composite datum: 

1. In the Manage Composite Datums dialog box, select each datum in Available Datums panel. 

2. Click Create. 
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NOTE:  The create button is available only if the selected datums will create a composite datum. 

To delete a datum: 

1. In the Manage Composite Datums dialog box, select an existing in Available Composite Datums panel. 

2. Click Delete. 

Click Close to exit. 

Form
CAM2 automatically adds Form tolerances to each feature.

Circularity
To tolerance the measured form of a circle:

1. Select an existing feature from the Features panel. 

2. In the Feature Information panel, type a tolerance from your drawing for Circularity, or use the default.

To remove any GD&T from tolerance:

1. Select an existing feature from the Features panel.

2. In the Feature Information panel, clear the Circularity check box. 

See “Circularity” on page 314.

Cylindricity
To tolerance the measured form of a cylinder:

1. Select an existing feature from the Features panel. 

2. In the Feature Information panel, type a tolerance from your drawing for Cylindricity, or use the default.

To remove any GD&T from tolerance:

1. Select an existing feature from the Features panel.

2. In the Feature Information panel, clear the Cylindricity check box. 

See “Cylindricity” on page 318.

Flatness
To tolerance the measured form of a plane:

1. Select an existing feature from the Features panel. 

2. In the Feature Information panel, type a tolerance from your drawing for Flatness, or use the default.
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To remove any GD&T from tolerance:

1. Select an existing feature from the Features panel.

2. In the Feature Information panel, clear the Flatness check box. 

See “Flatness” on page 315.

Straightness
To tolerance the measured form of a line:

1. Select an existing feature from the Features panel. 

2. In the Feature Information panel, type a tolerance from your drawing for Straightness, or use the default. 

To remove any GD&T from tolerance:

1. Select an existing feature from the Features panel.

2. In the Feature Information panel, clear the Straightness check box. 

See “Straightness” on page 316.

Orientation
The Orientation group includes the commands for Perpendicularity, Angularity, and Parallelism tolerances.

Perpendicularity
Perpendicularity measures the condition of a surface, center plane, or axis at a right angle (90 degrees) to a datum 
plane or axis. To tolerance a plane or line to a datum:

1. Select an existing feature from the Features panel. 

2. On the GD&T tab, click Perpendicularity. 

3. In the GD&T panel, type a tolerance from your drawing, or use the default. See “GD&T” on page 27.

4. Click in the right control frame and select a datum. See “Datum” on page 291. 

5. The GD&T label displays the results. See “Labels” on page 118.

You can also enter the Exact Feature Length. See “Exact Feature Length” on page 290.

To remove any GD&T tolerance:

1. Select an existing feature from the Features panel.

2. Right-click the tolerance frame in the GD&T panel and select Delete. 

See “Perpendicularity” on page 318.
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Angularity
Angularity measures how much a surface, axis, or plane can deviate from an angle described in the design. This 
tolerance requires a datum reference, and no bonus tolerance is permissible. To tolerance a plane or line to a datum: 

1. Select an existing feature from the Features panel. 

2. On the GD&T tab, click Angularity. 

3. In the GD&T panel, type a tolerance from your drawing, or use the default. See “GD&T” on page 27.

4. Click in the right control frame and select a datum. See “Datum” on page 291.

5. The GD&T label displays the results. See “Labels” on page 118.

You can also enter the Exact Feature Length. See “Exact Feature Length” on page 290.

To remove any GD&T tolerance:

1. Select an existing feature from the Features panel.

2. Right-click the tolerance frame in the GD&T panel and select Delete. 

NOTE:  The feature being toleranced must have a nominal associated or you must specify an angle value.

See “Angularity” on page 314.

Parallelism
Parallelism measures the condition of a surface or center plane that is equal in distance at all points from the datum 
plane. To tolerance a plane or line to a datum: 

1. Select an existing feature from the Features panel. 

2. On the GD&T tab, click Parallelism. 

3. In the GD&T panel, type a tolerance from your drawing, or use the default. See “GD&T” on page 27.

4. Click in the right control frame and select a datum. See “Datum” on page 291.

5. The GD&T label displays the results. See “Labels” on page 118.

You can also enter the Exact Feature Length. See “Exact Feature Length” on page 290. 

To remove any GD&T tolerance:

1. Select an existing feature from the Features panel.

2. Right-click the tolerance frame in the GD&T panel and select Delete. 

See “Parallelism” on page 317.

Location
The Location group includes the commands for Concentricity and Position tolerances.
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Concentricity
Concentricity measures how well a cylinder fits inside of another cylinder. To tolerance a cylinder to a datum: 

1. Select an existing feature from the Features panel. 

2. On the GD&T tab, click Concentricity. 

3. In the GD&T panel, type a tolerance from your drawing, or use the default. See “GD&T” on page 27.

4. Click in the right control frame and select a datum. See “Datum” on page 291.

5. The GD&T label displays the results. See “Labels” on page 118.

You can also enter the Exact Feature Length. See “Exact Feature Length” on page 290.

NOTE:  The resulting cylinder used for calculation will hold the midpoint of the original cylinder and be 
resized so that the new length is equally divided on either side.

To remove any GD&T tolerance:

1. Select an existing feature from the Features panel.

2. Right-click the tolerance frame in the GD&T panel and select Delete. 

See “Concentricity” on page 317.

Concentric Circles
You can apply concentricity to circle features. To do so, define a datum circle as a linear datum and assign 
concentricity to the circle. The concentricity calculation for the circle will treat the circle as a cylinder of 0 length, 
thus comparing the position of the center of the circle relative to the Datum axis.

Position
True Position is defined as a cylindrical tolerance zone about the nominal center line, through the thickness of the 
material into which the hole was drilled (or the height of the stud). This tolerance requires three datum references 
that can make an orthogonal coordinate system. To tolerance the position of a feature: 

1. Select an existing feature from the Features panel. 

2. On the GD&T tab, click Position. 

3. In the GD&T panel, type a tolerance from your drawing, or use the default. See “GD&T” on page 27.

4. Click the Material Condition drop-down list, to the right of the tolerance, and select:
• RFS - Regardless of Feature Size
• MMC - Maximum Material Condition
• LMC - Least Material Condition

NOTE:  Any position bonus is automatically calculated and appears in the tolerance frame. 
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5. Click the Datum Reference drop-down list and select a datum. Repeat this step to select two more datums. 

NOTE:  You can specify a datum scheme for each Position tolerance. If the actuals are not solved before 
CAM2 calculates the statistic, the Active Alignment is used. See “Active Alignment” below. Click the GD&T 
button in the lower right corner of the Main window to exit. 

6. The GD&T label displays the results. See “Labels” on page 118.

To remove any GD&T tolerance:

1. Select an existing feature from the Features panel.

2. Right-click the tolerance frame in the GD&T panel and select Delete. 

See RFS and MMC for a Measured Circle on page 321, RFS and MMC for a Measured Shaft on page 322, and 
True Position on page 323. 

Active Alignment
You can compute statistics using the active alignment instead of a specified datum alignment. To do so, select 
Active Alignment in the primary datum field for Position tolerances.

NOTE:  By default, CAM2 computes statistics using the active alignment until you select datums; however, 
selecting Active Alignment in the primary datum field clears any selected datum scheme. Datum features must 
be valid in order to perform the alignment. The GD&T Tolerances reference frame indicates datum scheme 
validity, a red border indicates an invalid datum scheme. 

Profile
The Profile group includes the commands for Profile of a Line, Profile of a Polyline Group, and Profile of a 
Surface tolerances. 

Profile of a Line
Profile of a Line is a two-dimensional geometric tolerance that controls how much a polyline, or curve, can deviate 
from the true profile. It represents the smallest tolerance zone conforming to the nominal curve contour that will 
hold the entire measured surface. To tolerance the profile of a line: 

1. Select an existing polyline or cross-section feature from the Features panel. 

2. On the GD&T tab, click Profile of a Line. 

3. In the GD&T panel, type a tolerance from your drawing, or use the default. See “GD&T” on page 27.

4. If necessary, click in the right control frame and select a datum. See “Datum” on page 291.

5. The GD&T label displays the results. See “Labels” on page 118.

To remove any GD&T tolerance:

1. Select an existing feature from the Features panel.
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2. Right-click the tolerance frame in the GD&T panel and select Delete. 

See “Profile of a Line” on page 320.

Profile of a Polyline Group
Profile of a Polyline Group is a two-dimensional geometric tolerance that controls how much a group of polylines, 
or curves, can deviate from the true profile. It represents the smallest tolerance zone conforming to the nominal 
curve contour that will hold the entire measured surface. To tolerance the profile of a polyline group: 

1. Select an existing polyline group from the Features panel. 

2. On the GD&T tab, click Profile of a Polyline Group. 

3. In the GD&T panel, type a tolerance from your drawing, or use the default. See “GD&T” on page 27.

4. If necessary, click in the right control frame and select a datum. See “Datum” on page 291.

5. The GD&T label displays the results. See “Labels” on page 118.

To remove any GD&T tolerance:

1. Select an existing feature from the Features panel.

2. Right-click the tolerance frame in the GD&T panel and select Delete. 

Profile of a Surface
Profile of a Surface is a three-dimensional geometric tolerance that controls how much a surface can deviate from 
the true profile. It represents the smallest tolerance zone conforming to the nominal surface contour that will hold 
the entire measured surface. 

NOTE:  CAM2 calculates Surface Profiles using the Active Alignment or an established 3 Datum reference 
frame. For more information, see Alignments on page 266 and Datum on page 291.

To tolerance the profile of a surface: 

1. Select an existing inspect surface point or point cloud feature from the Features panel. 

2. On the GD&T tab, click Profile of a Surface. 

3. In the GD&T panel, type a tolerance from your drawing, or use the default. See “GD&T” on page 27.

4. If necessary, click in the right control frame and select a datum. See “Datum” on page 291.

5. The GD&T label displays the results. See “Labels” on page 118.

To remove any GD&T tolerance:

1. Select an existing feature from the Features panel and.

2. Right-click the tolerance frame in the GD&T panel and select Delete. 

See “Profile of a Surface” on page 319.
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Run Out
The Run Out group includes the command for Total Runout tolerancing. 

Total Runout
Total Runout controls the composite surface variations of circularity, cylindricity, parallelism, straightness, taper 
and profile of a surface where applied to features constructed around a datum axis. Total Runout applied to 
surfaces constructed perpendicular to a datum axis controls composite variations of perpendicularity and flatness. 
The tolerance is applied simultaneously at all circular and profile measuring positions as the part is rotated through 
360°. 

You will need to measure a cylinder (feature), and a plane (datum) perpendicular to the cylinder. Make sure to 
rotate the cylinder the full 360° as you are adding readings. It is recommended that you measure down the length of 
the shaft, rotate the shaft a little, and continue measuring until you rotate the shaft all the way around. To tolerance 
the total runout of a cylinder:

1. Select an existing feature from the Features panel. 

2. On the GD&T tab, click Total Runout. 

3. In the GD&T panel, type a tolerance from your drawing, or use the default. See “GD&T” on page 27.

4. Click in the right control frame and select a datum. See “Datum” on page 291.

5. The GD&T label displays the results. See “Labels” on page 118.

You can also enter the Exact Feature Length. See “Exact Feature Length” on page 290.

NOTE:  The resulting cylinder used for calculation will hold the midpoint of the original cylinder and be 
resized so that the new length is equally divided on either side.

To remove any GD&T tolerance:

1. Select an existing feature from the Features panel.

2. Right-click the tolerance frame in the GD&T panel and select Delete. 

See “Total Runout” on page 321.
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Chapter 15: CAM2® 2021 Remote

CAM2® 2021 Remote offers an interface to control CAM2, in combination with the iPhone®, iPod® Touch, or 
iPad®. The ability to invoke commands without needing to go back to the computer is essential when you are 
working at a distance. 

To enable remote control of CAM2 and your FARO Laser Tracker or FaroArm:
• Connect your computer to an existing wireless network, or set up an ad hoc network on your computer. 

• Connect your iPhone, iPod Touch, or iPad to that wireless network. 

• Start the CAM2 Remote application, and connect to your FARO Laser Tracker or FaroArm. 

 
Using a Wireless Network 300

Using an Ad Hoc Network 300

Setting up the Remote Device 301

CAM2 Remote Screens 304

Operating and Troubleshooting 305
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Using a Wireless Network
If your computer is already connected to a network that has a wireless router, get the current Internet Protocol, or 
IP, address (nnn.nnn.nnn.nnn) for the wireless network, and use CAM2 Remote to connect to that network. 
Continue to Setting up the Remote Device. In that section, use your current wireless network name and security 
key. 

Using an Ad Hoc Network
This section details how to setup a computer-to-computer, or ad hoc, network on your computer running Windows 
XP, Windows Vista, or Windows 7. Create an ad hoc network only if you do not have an existing wireless 
network. 

NOTE:Windows 10 does not support this method.

Windows XP
NOTE:  Make sure your iPhone, iPod Touch, or iPad has been registered and working properly prior to 
CAM2 installation. 

1. Open the Start menu and click Control Panel.

2. Under Pick a category, click Network and Internet Connections.

3. Under or pick a Control Panel icon, click Network Connections.

4. Right-click your wireless network connection, and then click Properties.

5. In the Wireless Network Connection Properties dialog box, click the Wireless Networks tab.

6. On the Wireless Networks tab, under Preferred networks, click Add.

7. In the Wireless network properties dialog box, on the Association tab, type the name of your ad hoc wireless 
network in Network name (SSID) box. For example, you could type FARO Remote. 

• Clear the The key is provided for me automatically check box and select the This is a computer-to-
computer (ad hoc) network check box.

• Create a 13-digit password and type it in both the Network key and Confirm network key boxes. For the 
best security, include letters, numbers, and punctuation. Then click OK.You will also need to enter this 
key into your iPhone, iPod Touch, or iPad later. 

8. Click OK again to save your changes.

Windows Vista
NOTE:  Make sure your iPhone, iPod Touch, or iPad has been registered and working properly prior to 
CAM2 installation. 

1. Open the Start menu.

2. Click Connect To.
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3. Click Setup a Connection or Network.

4. Click Setup a Wireless Ad Hoc Network and click Next.

5. Enter the new network name such as FARO Remote. 

6. Enter a Security Key. You will also need to enter this key into your iPhone, iPod Touch, or iPad later. 

7. Check Save This Network.

Windows 7
NOTE:  Make sure your iPhone, iPod Touch, or iPad has been registered and working properly prior to 
CAM2 installation. 

1. Open the Start menu and click Control Panel.

2. Click Network and Internet, then click Network and Sharing Center.

3. Under Change your networking settings, click Setup a New Connection or Network.

4. Click Setup a Wireless Ad Hoc (computer-to-computer) Network.

5. Click Next twice.

6. Enter the Network name such as FARO Remote.

7. Select the Security WAP (or WEP) and enter the Security key or password. You will also need to enter this key 
into your iPhone, iPod Touch, or iPad later.

8. Select the Save This Network checkbox.

9. Click Turn on Internet Connection Sharing.

Setting up the Remote Device
This section details the installation of operating system software for the iPhone, iPod Touch, or iPad and the CAM2 
Remote application. Before continuing, you should have already registered your iPhone, iPod Touch, or iPad and 
created an iTunes account. 

Apple iOS Software
Before you begin, make sure that the iPhone, iPod Touch, or iPad has the latest operating system software installed. 
To check this:

1. Connect the iPhone, iPod Touch, or iPad to your PC or Notebook and start iTunes. 

2. In iTunes select the iPhone, iPod Touch, or iPad device on the left side of the screen. iTunes shows the version 
of the installed operating system software.

3. Click Check for update. 

If there is a new update, iTunes will ask you to install it. Install the update.
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Figure 15-1 Apple iTunes

NOTE:  CAM2 Remote requires iOS 3.1.1 or later and has been fully tested on iOS 4. 

CAM2 Remote Application
The CAM2 Remote application is a free download from the iTunes store. 

1. In iTunes, select the iTunes Store. 

2. Search for CAM2 Remote and download the application.

3. After the download is complete, select the iPhone, iPod Touch, or iPad device and click Sync. This copies the 
CAM2 Remote application to your iPhone, iPod Touch, or iPad. 

Setting up the Wi-Fi Connection
This section details how to setup your iPhone, iPod Touch, or iPad in order to control CAM2 via a Wi-Fi network 
connection. Make sure your computer’s Wi-Fi connection is active and switch on the iPhone, iPod Touch, or iPad. 

1. On the Start screen, touch the Settings application. 
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Figure 15-1 Start Screen

2. On the Settings screen touch WiFi. 

Figure 15-2 Settings

3. Active the WiFi by touching the On/Off switch. 

4. On the Wi-Fi Networks screen you should see a list of all available Wi-Fi networks including the network that 
you just setup on your computer (FARO Remote). Touch this network. 
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5. Enter the Security Key, or Password, from the network that your setup on your computer (FARO Remote). 
Please notice that this key is case-sensitive (you have to touch Shift on the onscreen keyboard EACH TIME 
before entering a capital letter).

6. Touch Join. 

7. Press the Home key to return to the Start screen. 

Manually Connecting to the Network
If the network does not appear on Wi-Fi Networks screen:

1. Touch Other.

2. On the Other Network screen, type your network name (FARO Remote). 

3. Touch Security and choose WEP. Touch Other network to return to the Other Network screen. 

4. On the Other Network screen, type the Security Key, or Password, from the network that your setup on your 
computer (FARO Remote). Please notice that this key is case-sensitive (you have to touch Shift on the onscreen 
keyboard EACH TIME before entering a capital letter).

5. Touch Join. 

Starting CAM2 Remote
Since CAM2 Remote will control the CAM2 software, make sure that you have started the CAM2 software on 
your computer and check that at least one measuring device is connected. 

Before starting the CAM2 Remote application, you must get the Internet Protocol, or IP, address for your wireless 
network connection. You will enter this twelve digit address (nnn.nnn.nnn.nnn) just after starting the CAM2 
Remote application. 

1. On your computer, open the Start menu and click Run. 

2. Type cmd and press OK. 

3. Type ipconfig and press Enter. 

4. Look for the Wireless Network Connection section and write down the twelve digit IP address 
(nnn.nnn.nnn.nnn). Close the command window. 

5. On your remote device, Touch CAM2 Remote.

6. Enter the twelve digit IP address and touch Connect. 

7. On the Devices screen, touch a measuring device to control remotely.

CAM2 Remote Screens
This section describes the CAM2 Remote screens. The Commands screen and the QuickTools screen are the two 
main screens. After selecting a command or QuickTools program, the three sections of the Measurement panel 
screen shows you the measurement data. 
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Commands Screen
The Commands screen contains all of the CAM2 measurement commands. Touch a command to measure. 

Starting a command with CAM2 Remote:
• Automatically adds a measurement feature to the CAM2 measurement file 

• Switches CAM2 to Measurement mode 

• Switches CAM2 Remote to the Measurement screen 

QuickTools Screen
Touch QuickTools at the bottom of the screen to see a list of any QuickTools in the current measurement file. 
Touch a QuickTool to measure. 

NOTE:  This list automatically refreshes if you change to another CAM2 measurement file on your computer. 

Measurement Screen
The CAM2 Measurement panel is your control panel during measurement, providing the current measurement 
mode, the position of the probe, the position and form of the feature being measured, and an image of the part 
when running a QuickTools program. For more information, see “Measurement Panel” on page 188. 

This same information is also now available in the Measurement screen of CAM2 Remote. Use the buttons on this 
screen to measure:

• Return to Commands - Touch the button in the upper right corner of the screen to return to the Commands 
screen. 

• Probe Settings - Touch the button in the upper right corner of the screen to change the probe/tooling, and the 
measurement mode.

• Record Measurement - Touch the button in the lower left of the screen to add a reading to the feature. 

• Record End Click - Touch the button in the lower center of the screen to add an end click to the feature. 

• Remove Last Point - Touch the button in the lower right of the screen to remove the last reading from the 
feature. 

The Measurement screen has three screen sections. Notice the three dots just above the three buttons that indicate 
the current section. Slide the screen to the left or right to change: 

Feature Information (left dot) - This section shows the results for the feature. 

QuickTools Picture (center dot) - This section shows any QuickTool images for the feature. 

Live Digital Readout (right dot) - This section shows a live X,Y,Z location of the probe. 

Operating and Troubleshooting
As you are using the CAM2 Remote application to control your CAM2 measurement file, you should be aware of 
potential issues with the wireless connection. 
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Preventing Disconnection
The ad hoc network connection will be disconnected if the iPhone, iPod Touch, or iPad Auto-Locks. Consider 
setting the Auto-Lock time to 5 Minutes or Never to prevent frequent disconnects (Settings > General > Auto-
Lock). 

If the device loses the ad hoc connection, it will default to the next available wireless network that is available and 
configured on the iPhone, iPod Touch, or iPad. 

iPhone, iPod Touch, or iPad Troubleshooting
If you are encountering problems with the Wi-Fi connection this could have several reasons:

• Is your iPhone, iPod Touch, or iPad already connected to another wireless network? 

• Microsoft Windows does not support a wireless network connection with a simultaneous ad hoc wireless 
connection. If you are connected through a Wi-Fi network use that network to connect to the device and 
do not create an ad hoc wireless connection. 

or 

• On the WiFi Network screen, touch the arrow next to the network name and then touch Forget Network. 

• Do you have the latest iPhone, iPod Touch, or iPad software installed? Older versions might have problems 
with setting up a stable connection to the computer.

• Have you entered the Security key correctly? Try to enter the Security key again. Please notice that the 
Security key is case-sensitive and that you have to click Shift on the onscreen keyboard each time before you 
enter a capital letter.

• In rare circumstances the iPhone, iPod Touch, or iPad accepts the ad hoc network but the network cannot be 
used.

1. On the Start screen, touch Settings.

2. Touch WiFi. 

3. Make sure a check mark is visible before your ad hoc network name.

4. Touch the arrow next to your ad hoc network name.

5. The IP address should begin with169.254.xxx.xxx on Windows XP and 192.168.xxx.xxx on Windows Vista 
and Windows 7.

If there is no IP (blank field), this is why CAM2 can't connect. Wait about 60 seconds on that screen and a 
new IP address will be assigned automatically.
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Chapter 16: Keyboard Shortcuts and Shortcut 
Menus

There are many Keyboard Shortcuts and Shortcut menus to quickly launch some commands in CAM2. 

NOTE:  Keyboard Shortcuts function for the active device only. See “Device Center” on page 128. 

 
Keyboard Shortcuts 308

Shortcut Menus 310
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Keyboard Shortcuts
The following is a list of Keyboard Shortcuts, or keyboard shortcuts, that you can use to quickly start some CAM2 
commands. 

Keyboard Shortcut  Function 
Arrow keys

2,4,6,8 on numeric keypad
Pans the view in the specified direction.

F1 Help

F2 Measuring a Point

F3 Measuring a Plane

F4 Measuring a 2D Line

F5 Measuring an Inspect Surface Point

F10 Measuring a Circle

F11 Measuring a Cylinder

F12 Measuring a Sphere

Insert Add Readings 

G Record Measurement

H Record End Click

Backspace Remove Last Point

SHIFT + A Measure All

SHIFT + R Measure

ALT + ENTER Feature Properties

Plus Sign (+) on keyboard Increase Whisker Scale

Minus Sign (-) on keyboard Decrease Whisker Scale

4 +X/-X View 

5 +Y/-Y View 

6 +Z/-Z View 

7 Isometric SE

8 Isometric SW
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Keyboard Shortcut  Function 
9 Isometric NE

0 Isometric NW

I

Plus Sign (+) on numeric keypad
Zoom In

O

Minus Sign (-) on numeric keypad
Zoom Out

E Reset Zoom

W Zoom To Area

7 on numeric keypad Rotate Around X Counterclockwise

9 on numeric keypad Rotate Around X Clockwise

1 on numeric keypad Rotate Around Y Counterclockwise

3 on numeric keypad Rotate Around Y Clockwise

0 on numeric keypad Rotate Around Z Counterclockwise

Period (.) on numeric keypad Rotate Around Z Clockwise

S Switch between the three shaded and wireframe views

Shift + Alt + Enter Full Screen

Number Sign (#) Grid

R Reset View

L Labels

ESC Cancels the Current Measurement

P Device Center

D Show Feature Window

A Manage Alignments Alignment

C Coordinate System Coordinate System Alignment

M Move Device

Delete Delete any selected item

Enter Repeat Last Command

Home Reset
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Keyboard Shortcut  Function 
T Motor On Off

B Set Backsight

V Drive Beam

X Change Measurement Mode

CRTL + N New file

CRTL + O Open file

CRTL + S Save file

CRTL + B Generate Barcode

CRTL + P Preferences

Spacebar Change Selection Mode

CRTL + Shift + L Open Log Directory

ALT + F4 Exit CAM2

Shortcut Menus
Right-click in areas of the CAM2 window or control panels to quickly access commands. 

Any Panel’s Title Bar 
• Floating - Undock a panel from the edge of the screen. 
• Dock - Move and attach a floating panel to the edge of the screen. 
• Auto Hide - Set the panel to Auto Hide mode. 
• Hide - Temporarily hide a panel. Use View Panels to show any hidden panel. For more information, see 

“Panels” on page 122.

Any Selected Feature or Feature Label 
NOTE:  Some menu items are not available for all feature types, or if multiple features are selected. 

• Rename - Edit the feature name. Press the Enter key to continue. 
• Delete - Permanently delete the feature from the file. 
• Assign A Layer - Move the feature to an existing layer. See “Layers” on page 112. 
• Label - Show or Hide the feature’s label. See “Labels” on page 191. 
• Label Style - Specify the style of the feature’s label. See “Labels” on page 118. 
• Features Readings - View the feature’s readings in the Main window. See “Measurement Data” on page 27. 
• Whiskers - View the feature’s whiskers in the Main window. See “Whisker Scale” on page 114. 
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• Nominal Whiskers - View the feature’s nominal whiskers in the Main Window. See “Whisker Scale” on 
page 114. 

• Add Measurement - Create a measured feature and associate the selected feature as a nominal. 
• Add Readings - Add readings to the feature with the current device.  
• Add Readings From - Add readings to the feature with any device.  
• Measure - Add readings to the feature with any device, and replace all existing readings. 
• Clear Readings - Permanently delete all readings from the feature. See “Measurement Data” on page 192. 
• Aim - Laser Tracker Only, Aim at the feature with the current device. See “Aim” on page 137. 
• Aim With - Laser Tracker Only, Aim at the feature with any device. See “Aim” on page 137. 
• Construct - Choose any available construction. See “Construct From Selected Features” on page 263. 
• Import CAD Part(s) - Add a CAD part to the measurement file. See “CAD” on page 61. 
• GD&T Mode - Opens the GD&T mode. See “GD&T” on page 287.
• Copy Tolerances - Copy all tolerances for the feature. See “Copy Tolerances” on page 108.
• Paste Tolerances - Paste a set of tolerances copied from another feature. See “Paste Tolerances” on 

page 108.
• Generate Shortcut - Create a shortcut. See “Shortcuts ” on page 151.
• Make Nominal - Designate the feature as nominal. See “Features” on page 34.
• Capture View - Capture the current view and store it with the feature. See “Capture View” on page 106.
• Clear View - Clear the captured view of the feature. 
• Recall View - Recall the captured view of the feature. 
• Zoom To Features - Zoom in to the feature. 
• Flip Vector - Reverses the direction of the feature’s normal vector. See “Flip Vector” on page 109.
• Properties - Edit the feature. See “Properties” on page 108.

Any Selected Reading in the Measurement Data Panel 
• Aim - FARO Laser Tracker only - Automatically point the laser beam to the X,Y,Z coordinate of the reading. 
• Delete - Permanently delete the reading from the file. 

For more information, see “Measurement Data” on page 192.

Any Tab in the Ribbon
• Show Quick Access Toolbar Below The Ribbon - Places the Quick Access Toolbar below the ribbon. For 

more information, see “Quick Access Toolbar” on page 23. 
• Minimize - Minimize the appearance of a ribbon. For more information, see “Minimize the Ribbon” on page 

22. 

• Customize Ribbon - Customize the appearance of a ribbon. For more information, see “Customize the 
Ribbon” on page 22. 

Any Selected QuickTools Program
• Play - Start playing the contents of a QuickTools program. 
• Stop - Stop playing the contents of a QuickTools program. 
• Record - Start recording, or adding to, a QuickTools program.
• Delete - Permanently delete the QuickTools program from the file. 
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Chapter 17: Operational Concepts

This chapter describes some glossary terms, definitions, and specifics on tolerances in CAM2 2021.
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GD&T Tolerances
The following are examples of the Geometric Dimensioning and Tolerancing for measured circles, which show the 
Maximum Material Condition (MMC) and the Regardless of Feature Size (RFS) options. For more information on 
GD&T Tolerancing, refer to GEO METRICS III - The Application of Geometric Dimensioning and Tolerancing 
Techniques, by Lowell W. Foster, and published by Addison-Wesley Publishing Company Inc.

Angularity

Angularity measures how much a surface, axis, or plane can deviate from an angle described in the design. This 
tolerance requires a datum reference, and no bonus tolerance is permissible.  

! Possible Axis Orientation

In the figure above, the angularity tolerance is used to control the center axis of an angled hole. The tolerance zone 
of 0.5 is indicated by the parallel lines.  

This form of angularity tolerance applies only in the drawing view in which the tolerance is specified, and requires 
the permissible variation to be defined for other views. 

NOTE:  In GD&T, the degree of permissible variation is not specified as a tolerance on the angle. Instead, an 
indirect method is used where one specifies a tolerance zone at a specified angle from a datum, within which a 
part feature, axis, or center plane must lie. 

Circularity

Circularity measures the form deviation of a circle.
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! Maximum Error

" Minimum Error

In this example, the circle is measured with seven points. The Circularity calculation is the Maximum distance plus 
the Minimum distance.

NOTE:  The result and report values for the circle show the maximum error as a positive number, and the 
minimum error as a negative number. These positive and negative signs indicate the direction of the maximum 
and minimum error readings from the circle. The Circularity result value is the absolute distance between the 
maximum and minimum error.

Flatness

Flatness measures the form deviation of a plane.
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! Maximum Error

" Minimum Error

In this example, the plane is measured with seven points. The Flatness calculation is the Maximum distance plus 
the Minimum distance.

NOTE:  The result and report values for the plane show the maximum error as a positive number, and the 
minimum error as a negative number. These positive and negative signs indicate the direction of the maximum 
and minimum error readings from the plane. The Flatness result value is the absolute distance between the 
maximum and minimum error.

Straightness

Straightness measures the form deviation of a line.

! Maximum Error

" Minimum Error
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In this example, the line is measured with seven points. The Straightness calculation is the Maximum distance plus 
the Minimum distance.

NOTE:  The result and report values for the line show the maximum error as a positive number, and the 
minimum error as a negative number. These positive and negative signs indicate the direction of the maximum 
and minimum error readings from the line. This calculation does not add a positive and a negative number 
together for a smaller value. The Straightness result value is the absolute distance between the maximum and 
minimum error.

Concentricity

Concentricity measures how well a cylinder (line) fits inside of another cylinder (line).

! 0.2 Tolerance Zone

The center line of the measured cylinder is compared to the center line of the datum cylinder. The center line of the 
measured cylinder must be inside the tolerance zone. Concentricity is always RFS (Regardless of Feature Size) for 
the diameter of the cylinder. However, the measured length of the cylinder is critical in the calculation.

Parallelism

Parallelism measures the condition of a plane that is equal in distance at all points from the datum plane.
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! 0.2 Tolerance Zone

The measured plane, line, or cylinder, is compared to the datum plane, line, or cylinder. The measured feature must 
be inside the tolerance zone. The measured length of the feature is critical in the calculation.

Perpendicularity

Perpendicularity measures the condition of a plane at a right angle (90 degrees) to a datum plane.

! 0.2 Tolerance Zone

The measured plane, line, or cylinder, is compared to the datum plane, line, or cylinder. The measured feature must 
be inside the tolerance zone. The measured length of the feature is critical in the calculation.

Cylindricity

Cylindricity measures the form deviation of a cylinder.  
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! Maximum Error

" Minimum Error

In this example, the cylinder is measured with 13 points. The Cylindricity calculation is the Maximum distance 
plus the Minimum distance. 

NOTE:  The result and report values for the cylinder show the maximum error as a positive number, and the 
minimum error as a negative number. These positive and negative signs indicate the direction of the maximum 
and minimum error readings from the cylinder. This calculation does not add a positive and a negative number 
together for a smaller value. The Cylindricity result value is the absolute distance between the maximum and 
minimum error.

Profile of a Surface

Profile of a Surface is a three-dimensional geometric tolerance that controls how much a surface can deviate from 
the true profile. It represents the smallest tolerance zone conforming to the nominal surface contour that will hold 
the entire measured surface.  
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! Actual Profile

" 0.8 tolerance zone equally spaced about the true profile, or 0.4 each side

# Datum Plane A

In the figure above, the surface profile tolerance of 0.8 is equally spaced on either side of the true profile. The true 
profile must be situated between the uniform boundary of 0.4 (upper and lower) with respect to Datum Plane A. 

NOTE:  The profile will be out of tolerance if one point has a deviation larger than half the tolerance value.

Profile of a Line

Profile of a Line is a two-dimensional geometric tolerance that controls how much a polyline, or curve, can deviate 
from the true profile. It represents the smallest tolerance zone conforming to the nominal curve contour that will 
hold the entire measured surface.  

! Actual Profile

" 0.8 tolerance zone equally spaced about the true profile, or 0.4 each side

# Datum Plane A
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In the figure above, the line profile tolerance of 0.8 is equally spaced on either side of the true profile. The true 
profile must be situated between the uniform boundary of 0.4 (upper and lower) with respect to Datum Plane A. 

NOTE:  Profile of a Line is computed as the most positive error value minus the most negative error value (or 
zero if no negative errors).

Total Runout

Total Runout controls the composite surface variations of circularity, cylindricity, parallelism, straightness, taper 
and profile of a surface where applied to features constructed around a datum axis. Total Runout applies to an 
entire surface simultaneously, not just individual circular elements.  

! Datum A

In the figure above, the Total Runout tolerance of 0.2 indicates that the entire surface must have cylindrical surface 
variation of less than 0.2 relative to Datum A as the part is rotated. The tolerance is applied simultaneously at all 
circular and profile measuring positions as the part is rotated through 360°. 

RFS and MMC for a Measured Circle
Measured Nominal +Tol. -Tol. Deviation Out of Tol.

X: 0.100 0.000 +0.010 -0.010 0.100 0.090

Y: 0.000 0.000 +0.010 -0.010 0.000 *****

Z: 0.000 0.000 +0.010 -0.010 0.000 *****

Diam: 1.050 1.000 +0.010 -0.010 0.050 0.040

RFS: 0.2001  +0.0203  0.200 0.1805

MMC: 0.2002  +0.0404  0.200 0.1606

Bonus is at its maximum: 0.020
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1. Measured RFS = twice the 2D distance between the Nominal and Measured points.

2. Measured MMC = twice the 2D distance between the Nominal and Measured points.

• CIRCLE: The MMC bonus is the difference between the measured diameter and the minimum limit, 
not to exceed total size of the tolerance band. There is no bonus if the part is smaller than the 
maximum limit.

• SHAFT: The MMC bonus is the difference between the measured diameter and the maximum limit, 
not to exceed total size of the tolerance band. There is no bonus if the part is larger than the maximum 
limit.

3. “+Tol” of RFS = Entered by operator.

4. “+Tol” of MMC = “+Tol” of RFS + Bonus.

5. “Out of tolerance” of RFS = Measured RFS minus the RFS tolerance.

6. “Out of tolerance” of MMC = Measured MMC minus the MMC tolerance.

RFS and MMC for a Measured Shaft
Measured Nominal +Tol. -Tol. Deviation Out of Tol.

X: 0.016 0.000 +0.010 -0.010 0.016 0.006

Y: 0.000 0.000 +0.010 -0.010 0.000 *****

Z: 0.000 0.000 +0.010 -0.010 0.000 *****

Diam: 1.002 1.000 +0.010 -0.010 0.002 *****

RFS: 0.0321  +0.0203  0.032 0.0125

MMC: 0.0322  +0.0204  0.032 0.0046

Bonus = 0.008

1. Measured RFS = twice the 2D distance between the Nominal and Measured points.

2. Measured MMC = twice the 2D distance between the Nominal and Measured points.

• CIRCLE: The MMC bonus is the difference between the measured diameter and the minimum limit, 
not to exceed total size of the tolerance band. There is no bonus if the part is smaller than the 
maximum limit.

• SHAFT: The MMC bonus is the difference between the measured diameter and the maximum limit, 
not to exceed total size of the tolerance band. There is no bonus if the part is larger than the maximum 
limit.

3. “+Tol” of RFS = Entered by operator.

4. “+Tol” of MMC = “+Tol” of RFS + Bonus.

5. “Out of tolerance” of RFS = Measured RFS minus the RFS tolerance.

6. “Out of tolerance” of MMC = Measured MMC minus the MMC tolerance.
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True Position
ANSI Y 14.5M is very specific in its description of the meaning and usage of true position tolerance. FARO has 
incorporated True Position into CAM2 2021 with the intent of matching this specification as close as possible, 
based upon the amount and type of data that is made available during a normal measurement session.

True Position is defined as a cylindrical tolerance zone about the nominal center line, through the thickness of the 
material into which the hole was drilled (or the height of the stud). This tolerance requires three datum references 
that can make an orthogonal coordinate system. A point-reducible datum is not supported; however, bonus 
tolerance is permissible for MMC and LMC. To apply the concept of True Position to CAM2 2021 measurements, 
one must make some simplifying assumptions.

1. The datum features specified on the engineering drawing were used in the coordinate system. 

2. There are small deviations between the nominal primary datum and the measured primary datum.

3. Material thickness is much less than the diameter of the feature.

4. Feature centerlines are perpendicular to the primary datum.

Regarding MMC and RFS, CAM2 2021 can apply these conditions to datums and features. CAM2 2021 calculates 
the True Position of features as follows:

• For measured 2D features, the true position is calculated as twice the distance between the measured and the 
nominal as projected to the plane of the measured feature.

 

! Nominal

" Measured Circle

X = Distance between measured and nominal in plane of measured circle.
True Position = 2 * X

Figure 17-1 True Position of a Circle
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A more exact definition would be twice the distance between the measured and the nominal, as projected to the 
plane of the nominal feature. But, since the plane of the nominal feature is not generally provided, it is practical to 
use the plane of the measured if the aforementioned simplifying assumptions are valid.

! Measured 

"  Nominal

# XY Plane

X = Distance between measured and nominal in the XY plane.
True Position = 2 * X

Figure 17-2 True Position of a Point

MMC cannot be applied if there is no measured diameter from which to calculate a bonus tolerance. If the features 
cannot be measured as circles and do not lie in the XY plane, then manual calculations will need to be performed 
to determine the true position. 
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Glossary and Definitions
This section describes the glossary terms and definitions used in this manual.

Best Fit Arc

! Maximum Error

" Minimum Error

Best Fit Circle

! Maximum Error

" Minimum Error

FARO CAM2
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Best Fit Cone

! Maximum Error

" Minimum Error

Best Fit Cylinder

! Maximum Error

" Minimum Error
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Best Fit Ellipse

! Maximum Error

" Minimum Error

Best Fit Line

! Maximum Error

" Minimum Error

Best Fit Paraboloid

! Maximum Error

" Minimum Error
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Best Fit Plane

! Maximum Error

" Minimum Error

Best Fit Point

.

! Maximum Error
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Best Fit Rectangular Slot

! Maximum Error

" Minimum Error

Best Fit Round Slot

! Maximum Error

" Minimum Error

Best Fit Sphere

! Maximum Error

FARO CAM2
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" Minimum Error

Best Fit Torus

! Maximum Error

" Minimum Error

Right-Hand Rule
Cartesian coordinates describe the position of points in space relative to three mutually perpendicular axes X, Y, & 
Z. The intersection of these axes form the origin, or zero of the system.

Each axis emanates from the origin according to the right-hand rule. The right-hand rule defines the positive 
direction of each axis, such that when the hand is positioned according to the figure below, the + Z points along the 
thumb, the + X axis points along the index finger, and the + Y axis points along the middle finger. 

NOTE:  CAM2 2021 does not support left hand rule coordinate systems.

Unsolved Features
A feature that does not have the minimum readings to complete the calculation of the feature, or a feature that has 
enough readings and fails the best-fit calculation. 
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Digitize the Required Number of Points
Measuring a small percentage of a feature does not provide the most accurate representation of the feature. Since 
CAM2 2021 constructs a best-fit feature from the points you collect, the number of points collected and the spacing 
of those points directly impact the accuracy of the measurement result.

A common principle applies regardless of the feature you measure. The more points you collect, and the more 
evenly you distribute them over the part, the more repeatable your measurement result will be. For optimal results, 
we recommend collecting two times the minimum points plus one. 
(Minimum number of points x 2 + 1). 

When considering the distribution of the points over the part, remember that even distribution is best. If there are 
times when only a portion of the feature is accessible, then take as many points as you can on that portion. While 
this is not the ideal situation, taking as many points as you can will help ensure a better representation of the 
feature.

Measurement 
Command 

(Not requiring a 
projection plane)

Minimum number of points 
needed to solve the feature

Optimal number of 
points to solve the 

feature

Plane 3 7

Cone 6 13

Cylinder 6 13

Line 3D 2 5

Point 1 1

Sphere 4 9

Ring 6 13

 

Measurement 
Command 
(Requiring a 
projection 
plane)

Minimum number of points 
needed to solve the feature

Optimal number of 
points to solve the 

feature

Arc 3 7

Circle 3 7

Ellipse 6 13

Line 2D 2 5
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Measurement 
Command 
(Requiring a 
projection 
plane)

Minimum number of points 
needed to solve the feature

Optimal number of 
points to solve the 

feature

Rectangular Slot 6 13

Round Slot 6 13

FARO CAM2

FARO CAM2 2021 (v2021.0)Page 332 of 336



Technical Support

FARO Technologies, Inc. is committed to providing the best technical support to our customers. If you have any 
problem using one of our products, please follow these steps before contacting our Technical Support Team:

• Be sure to read the relevant sections of the documentation to find the help you need.

• Visit the FARO Customer Care area on the Web at www.faro.com to search our Knowledge Base. This is 
available 24 hours a day 7 days a week. 

• Document the problem you are experiencing. Be as specific as you can. The more information you have, the 
easier the problem will be to solve. 

• If you still cannot resolve your problem, have your device’s Serial Number available before calling.

Support Hours (Monday through Friday) 
North America:

8:00 a.m. to 7:00 p.m. Eastern Standard Time (EST). 

Europe:

8:00 a.m. to 5:00 p.m. Central European Standard Time (CET). 

Asia:

8:30 a.m. to 5:30 p.m. Singapore Standard Time (SST). 

Japan:

9:00 a.m. to 5:00 p.m. Japan Standard Time (JST). 

China:

8:30 a.m. to 5:30 p.m. China Standard Time (CST). 

India:

9:30 a.m. to 5:30 p.m. India Standard Time (IST). 

You can also e-mail or fax any problems or questions 24 hours a day.

Phone
North America:

800 736 2771, +1 407 333 3182 (Worldwide)

Mexico:

001-866-874-1154

Brazil:

0800-047-4271, +55 11 3500-4600

FARO CAM2
Technical Support

FARO CAM2 2021 (v2021.0) Page 333 of 336

http://www.faro.com/


Europe:

+800 3276 7378, +49 7150 9797-400 (Worldwide)

Asia:

1800 511 1360, +65 6511 1350 (Worldwide)

Japan:

0120.922.927, +81 561 63 1411 (Worldwide)

China:

+86 400.677.6826, +86 21 6191 7600 (Worldwide)

India:

1800.1028456, +91-1146465656 (Worldwide)

Thailand:

+662.7441273-6 (Worldwide)

Korea:

+82.51.662.3413 (Worldwide)

Fax
North America:

+1 407 562 5294

Europe:

+800 3276 1737, +49 7150 9797-9400 (Worldwide)

Asia:

65 65430111

Japan:

+81 561 63 1412

China:

+86 21 64948670 

India:

+91-11-46465660

Thailand:

+662.7443178

Korea:

+82.51.941.8170
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E-Mail
North America:

support@faro.com

Brazil:

supporte@faro.com

Europe:

support.emea@faro.com

Asia:

support.asiapacific@faro.com

Japan:

support.japan@faro.com

China:

support.china@faro.com

India:

support.india@faro.com

Thailand:

support.thailand@faro.com

Korea:

support.korea@faro.com

E-Mails or Faxes sent outside regular working hours usually are answered before 12:00 p.m. the next working day. 
Should our staff be on other calls, please leave a voice mail message; calls are always returned within 4 hours. 
Please remember to leave a description of your question and your device’s Serial Number. Do not forget to include 
your name, fax number, telephone number and extension so we can reach you promptly.

End User Documents
All documents related to the Software End User License Agreement, Purchase Conditions, and FARO Products 
Service Policy can be found on the FARO Knowledge Base at the following URL: 
https://knowledge.faro.com/Essentials/General/FARO_End_User_License_Agreement_Location. 
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Glossary

3
3D
Three dimensional

3D Distance
The distance between a nominal feature's 
center and a measured/constructed feature's 
center.

3D Dynamic
Refers to the rotation of a computer model 
of a part in virtual space.

3D Image
The three dimensional representation of an 
object.

3D Modeling
The creation of a three dimensional 
mathematical model of an object; typically 
performed using digitizing devices.

3D Surface
The three dimensional representation of 
the boundary of a region in space.

A
Actual Feature
A feature or measurement that exists and is 
not merely potential or theoretical.

Alignment
The establishing of a coordinate system on 
a part, typically in reference to a 
coordinate measurement machine. See also 
"CMM."

Angle
The figure defined by two lines extending 
from the same point.

Angularity
Angularity measures how much a surface, 
axis, or plane can deviate from an angle 
described in the design.

Apex
In reference to an angle, the point from 
which the two lines of the angle emanate. 
See also "Vector."

Arc
A segment of a circle.

Axis
Any line used as a fixed reference in 
conjunction with one or more other 
references for determining the position of a 
point or a series of points.

B
Basic Measurement Strategy, 
CAM2 2021
Look at what you need to measure and 
consider the following questions: What 
should you include in the formal Report? 
Which features (geometric elements) do 
you need to capture? Which features can 
you Measure directly (i.e., planes, circles, 
cylinders, lines, etc)? Which features do 
you need to Construct (e.g., bolt hole 
circle)  Which Dimensions do you need? 
(e.g., circle center to circle center) What 
logical sequence should you use to move 
around the part and capture the features? 
For example, left to right, top to bottom, or 
measure all planes first, then circles, etc.
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Best Fit
Creating a feature that fits a set of points 
so each point is the shortest distance to the 
feature.

Bisect
To divide into two equal parts.

Bisector
A feature (line or plane) which is created 
and equidistant at all points from two 
existing features.

Bolt Hole Pattern
A group of holes which is intended to 
accept bolts from a mating part in an 
assembly.

C
CAD
Computer-Aided Design

CAD/CAM
CAD refers to computer-aided design. 
CAM refers to computer aided modeling. 
Some software packages perform both 
functions and are referred to as 
CAD/CAM.

CAE
Computer-Aided Engineering

CAMM (CAM2)
Computer-Aided Manufacturing 
Measurement

Circle
A closed planar curve in which every point 
on the curve is equidistant from the center.

Circularity
Circularity measures the form deviation of 
a circle.

Coincident Points
Points that have the same XYZ value.

Collinear
Data points which lie on the same line.

Computer Aided Design (CAD)
Software which replaces or augments 
manual drafting and design. Allows parts 
to be designed using computer software, 
and stored in an electronic database.

Concentricity
Concentricity measures how well a 
cylinder (line) fits inside of another 
cylinder (line).

Cone
A basic or prismatic feature defined as a 
region generated by revolving a right 
triangle about one of its legs.

Conicity
The deviation of measured data points 
from the resultant cone.

Construction
A feature created from measured features.

Coordinate System
A system of representing points in a space 
of given dimensions by coordinates, such 
as the Cartesian coordinate system or the 
system of celestial longitude and latitude. 
A coordinate system is a system by which 
uses one or more features, or coordinates, 
to uniquely determine the position of a 
point or other geometric element as a 
frame of reference.
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Coplanar
Points or features which lie in the same 
geometric plane.

Corner
The point resulting from the intersection of 
three planes.

Cross Section
A section made by a plane cutting 
anything transversely, especially at right 
angles to the longest axis.

Curvature
The deviation of a feature from a straight 
line.

Curvature change
The change in the slope of a curved 
feature.

Cylinder
A geometric feature formed by extruding a 
circle along its centerline in a direction 
normal to its plane.

Cylindrical
A part which is similar to a cylinder in 
shape.

Cylindricity
Cylindricity measures the form deviation 
of a cylinder.

D
Datum
A datum (plural datums or data) is a 
reference from which measurements are 
made. In engineering and drafting, a datum 
is a reference point, surface, or axis on an 
object against which measurements are 
made.

Datum Coordinate
The XYZ values of a feature used to 
establish an alignment.

Device Position
The location of the measurement device 
relative to the measurements of your part.

Diameter
The width of a circular of cylindrical 
feature.

Digitizing
Storing data points in the computer system. 
See also "Scanning."

Dimensioning
The function of determining the 
relationship between geometric features.

Distance
The degree of separation between 
geometric features.

Drawing
The engineering documentation that 
indicates how a part is to be manufactured, 
assembled, or installed.

DRO
Digital ReadOut. The display of XYZ 
coordinates on the screen.

E
Edge points
Data points which lie on the edge or 
border of a part.

Electrostatic Discharge (ESD)
Electronic pulses generated by the 
discharge of loaded objects and/or people.
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Ellipse
A geometric feature resulting from the 
intersection of a plane with a cylinder at an 
angle other than 90 degrees.

Entity
A feature or object in a CAD database.

ESD
Electronic pulses generated by the 
discharge of loaded objects and/or people.

Ethernet
Ethernet is a family of computer 
networking technologies commonly used 
in local area networks (LAN), metropolitan 
area networks (MAN) and wide area 
networks (WAN).

Evaluation / to evaluate
The review of a product or process for 
suitability for its intended purpose.

External shape
The boundary which encloses a geometric 
form.

F
Fabrication drawing
An engineering drawing that specifies how 
a part is to be manufactured.

Feature
Refers to an attribute of a part or a 
geometric object.  See also "Solved 
Feature" and "Unsolved Feature"

Feature Reducibility
Part of a feature that can be used for 
constructions and dimensioning.

Field of View (FOV)
The horizontal and vertical angle that the 
FARO 3D Imager cameras view.

Filtering
Filtering allows you to reduce the number 
of points in point clouds while still 
maintaining the characteristics of the 
scanned object.

Fine Registration
Fine Registration solves all of the 
registered point clouds simultaneously in 
order to distribute the error and improve 
the overall fit of the registration group. See 
also "Registration."

Fit
How easily two mating parts can be 
assembled.

Flatness
Flatness measures the form deviation of a 
plane.

Form
The maximum bandwidth (Max. Error 
added to the Min. Error) of error that a set 
of measured points deviates from the true 
form of the resultant feature calculated 
from that set of points.

G
GD&T
Geometric Dimensioning and Tolerancing. 
A system of specifying engineering design 
and drawing requirements with respect to 
actual function and relationship of part 
features.
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Geometric features
A shape that can be expressed using 
standard shapes i.e. circle, line, and arc.

H
Hardware
Refers to the mechanical portion of a 
computer-based system. Opposite of 
Software.

Hardware lock
Dongle or port lock. Provides software 
security using a computer chip that 
attaches to the parallel (printer) port on a 
computer.

Hot Keys
See also "Keyboard Shortcuts."

I
Inputting
Refers to the keying in of data.

Intersection
A meeting or crossing at a point.

ISO
International Organization for 
Standardization

Isometric
A “3D” view of a part from a direction 
which is equiangular from each coordinate 
axis.

Iterative Alignment
A means of aligning measured data to 
CAD data by best fitting through many 
repetitions or iterations.

J
Jump drive
See also "USB Drive."

K
Key-in
To manually enter data using a keyboard.

Key-in alignment
The software function that creates a new 
coordinate system based upon translation 
and rotation relative to an existing 
coordinate system.

Keyboard Shortcuts
One keystroke commands which invoke a 
software function.

L
Layer
A software tool used to group features and 
entities.

Least Material Condition (LMC)

Line-to-plane
A type of angular dimension.

Line intersect
A type of alignment based upon a plane 
and two lines.

M
Max. (Maximum) Error
The largest distance from a reading above 
or outside a best-fit feature.
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Maximum Material Condition 
(MMC)
Maximum material condition is that 
condition of a part feature wherein it 
contains the maximum amount of material 
within the stated limits of size. For a hole, 
the MMC is defined as the condition when 
the diameter is at the lowest end of its 
tolerance band. For a stud, the MMC is 
defined as the condition where the 
diameter is at the highest end of its 
tolerance band.

Measure
To capture data points to determine the 
size, position, and form of feature. See also 
"Digitizing" and "Scaning."

Mid-Point
A point which is equidistant from two 
other points.

Min. (minimum) Error
The largest distance from a reading below 
or inside a best-fit feature.

MT
Material Thickness

N
NIST
National Institute of Standards and 
Technology

Nominal
The theoretical value for a feature.

Nominal Feature
A feature with nominal values created 
from a CAD entity of keyed in values.

Normal
The vector which defines a direction 
perpendicular to a curve or surface at a 
specific point.

O
Off-line
Any function which does not require a 
specific device to be connected.

Offset
To create a feature that is equidistant by a 
specified distance at all points.

On-line
A function which indicates that a specific 
device must be connected to perform a 
specific function.

Orientation
In reference to Geometric Dimensioning 
and Tolerancing, it is the type of 
dimension that pertains to the orientation 
of one feature relative to a datum feature. 
Such as Parallelism, Perpendicularity and 
Concentricity.

Origin
The point from which the axes of a 
coordinate system emanate.

Orthogonal coordinates
Coordinates which are perpendicular.

Out Of Tolerance (OOT)
The condition where the measure value 
exceed the nominal value combined with 
the tolerance value.
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P
Pan
In CAD, to change the position of the 
viewing window relative to the model.

Parallel
Two lines or planes which are equidistant 
at all points.

Parallelism
Parallelism measures the condition of a 
plane that is equal in distance at all points 
from the datum plane.

Perpendicular intersect
A type of alignment which requires a 
plane, line and point, where the origin is 
defined at the projection of the point on to 
the line.

Perpendicularity
Perpendicularity measures the condition of 
a plane at a right angle (90 degrees) to a 
datum plane.

Plane
A geometric feature defined by a point and 
a vector. A flat surface.

Plane-to-Plane
A type of distance dimension which yields 
the perpendicular distance between the 
centroid of the second plane and the first 
plane.

Point-to-Line
A dimension type which yields the 
perpendicular distance between the point 
and the line.

Point-to-Point
A dimension type which yields the 3D 
distance between two points.

Point Cloud
A set of points in a three-dimensional 
coordinate system that are typically 
intended to be representative of the 
external surface of an object.

Point reducible feature
A feature that has a repeatable center point 
such as a circle or sphere.

Polyline
A multi-segmented line.

Position
The location of a feature in a coordinate 
system.

Prismatic
Taking the shape of a prism or 3 
dimensional object whose faces are 
represented by regular geometric features.

Prismatic features
A feature that can be represented by 
regular geometric shapes. The opposite of 
curves and surfaces.

Profile of a Line
A Line is a two-dimensional geometric 
tolerance that controls how much a 
polyline, or curve, can deviate from the 
true profile. It represents the smallest 
tolerance zone conforming to the nominal 
curve contour that will hold the entire 
measured surface.

Profile of a Surface
A three-dimensional geometric tolerance 
that controls how much a surface can 
deviate from the true profile. It represents 
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the smallest tolerance zone conforming to 
the nominal surface contour that will hold 
the entire measured surface.

Project to
To reproduce or move in a prescribed 
direction.

Projection Plane
For all 2D features, the plane that all 
readings are projected to before best fit 
calculations are started.

Q
QuickTools
A set of RPM commands in a list to play 
anytime the drawing file is open, 
facilitating repeatable part measurement.

R
Re-capturing
In reference to digitizing, the re-
measurement of erroneous data points.

Reading
The individual point of a feature measured 
with the device.

Readout
The visual display of data on a computer 
screen. See also "Digital ReadOut."

Rectangular
A polygonal shape whose corners intersect 
at right angles.

Regargless of Feature Size 
(RFS)

Registration
Registration is the joining of two or more 
spatially disjointed point clouds using 
common references, effectively stitching 
multiple point clouds into one. See also 
"Fine Registration."

Resolution
The number of decimal places that a 
measurement device can reliably display.

Reverse Engineering
The creation of design or CAD data from 
an existing or prototype part.

Right Hand Rule
A coordinate system where the positive 
direction of each axis is described by three 
fingers of the right hand.

Rotation
Angular motion about a specified point or 
axis.

Roundness
The deviation of the measured data points 
from the true form of the resultant circle.

S
Slot
An elongated hole with round or squared 
ends.

Smoothing
Smoothing allows you to refine “noisy” 
point cloud data to achieve a smoother 
surface.

Software
Refers to the application of a computer-
based system. Opposite of Hardware.
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Solve
To calculate the results of a measurement 
or feature.

Solved Feature
A feature with enough readings to 
calculate.  See also "Unsolved Feature."

Spherical
A shape which is similar to that of a 
sphere.

Sphericity
The amount by which the measured data 
points deviate from the resultant sphere.

Spline
A smooth curve which cannot be 
represented by a simple mathematical 
function.

Straightness
The amount by which the measured points 
deviate from the resultant line.

Surface
The outer boundary of an object.

Surface off-set
An output surface that is equidistant from 
an input surface at all points.

Surfacing
The technique of creating 3D models by 
defining the outer boundary of objects in 
virtual space.

T
Tolerance
A zone of accuracy in both size and 
placement of a feature. For example, a 
hole of a diameter of 1.00 ± 0.01 located at 

the x, y, z of 1.000, 1.000, 0.000 ± 0.005 
means a 1 unit diameter hole can be 
between 1.01 and 0.99 in size and the 
location can be plus or minus 0.005 units 
from the specified nominal location. You 
determine the quality of a part by 
comparing your actual values to the 
nominal values within a tolerance range.

Total Runout
Total Runout controls the composite 
surface variations of circularity, 
cylindricity, parallelism, straightness, taper 
and profile of a surface where applied to 
features constructed around a datum axis.

True Position
Refers to a GD&T callout that specifies 
how a feature such as a hole is to be 
positioned on a part as well as toleranced. 
A true position callout may also specify 
additional tolerance or “bonus” if the hole 
is over-sized or if a shaft is under-sized 
(maximum or least material condition; 
MMC or LMC).

U
Unit Vector
A directional line with a non-dimensional 
magnitude of one. The line may be 
associated with the normal vector of a 
surface at a specific location. The vector is 
described in relation to the current 
alignment using the letters I, J, and K that 
are associated to X, Y, and Z.

Universal Serial Bus (USB)
Universal Serial Bus (USB) is an industry 
standard that establishes specifications for 
cables and connectors and protocols for 
connection, communication and power 
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supply (interfacing) between computers, 
peripherals and other computers.

Unsolved Feature
A feature without enough readings to 
calculate.  See also "Solved Feature."

USB
Universal Serial Bus (USB) is an industry 
standard that establishes specifications for 
cables and connectors and protocols for 
connection, communication and power 
supply (interfacing) between computers, 
peripherals and other computers.

USB Drive
A storage device integrated with the USB 
interface.

V
Vector
A term used to describe the direction of a 
line or object that may or may not have a 
magnitude. The line may be associated 
with the normal vector of a surface at a 
specific location. The vector is described 
in relation to the current alignment using 
the letters I, J, and K that are associated to 
X, Y, and Z.

Vertex
The point of intersection of two sides of an 
angle.

Volume
The amount of space occupied in three 
dimensions.

W
Whisker
A single line that visually represent 
distance data of a feature.

X
X, Y, Z
Refers to the Cartesian Coordinate System 
for three-dimensional space.

Z
Zoom
A command used to change the view of 
the design on the screen, specifically to 
show a closer view.
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Index

+
+X/-X view  116
+Y/-Y view  116
+Z/-Z view  116

2
2D line

measure  154

3
3-2-1 coordinate system  280, 282
3 plane coordinate system  283
3 point coordinate system  284
3D Imager

preferences  83, 87
See devices  127

3D line
measure  169

A
abbreviations

tolerance type abbreviations  92
Acrobat Reader

help  30
active survey  53
actual and nominal features in constructions  226
adding

CAD part  61, 96
features to a layer  113
GD&T  287
nominals

multiple nominals  195
single nominal  194
typing  195

pictures
image creator  52

adding nominals
automatic  195

dynamic nominals  195
adding pictures  50
adding to QuickTools  50
aim

at a feature  137
at a reading  193

align my part  98, 268
alignment

align my part  98, 268
clear  267
constrain  274
coordinate system  98, 276
datum  275
delete  268
edit  98, 266
export  268
file location  68
import  63, 277
iterative  271

maximum iterations preference  87
manage  98, 266
point cloud  99, 269
preferences  87
recalculation  267-268
set active  267
tab  265
three feature  275
tube automatically  83
tube measurement  164
wizard  98, 268

analysis
cross-section scan  100

angle  257
by key-in  215
by selecting features  257

angle unit  74
angularity  294
arm as mouse

user preference  78
arrange labels  119
auto repeat measurement  77
automatic

construction  226
dimension  257
feature recognition  100, 188
nominals  195
pick from CAD  96, 218
probe compensation  184, 191
surface point compensation  78

automation  141
shortcuts  151
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B
barcode  59
breakpoints  251

tube
breakpoints  164

C
CAD

creating nominals  217
edit properties  108
export to XGL  65
highlighting preference  69
insert  61, 96
measurement preference  84
measuring on CAD side  184
preferences

rendering quality  70
show construction lines  70

properties  96
properties control panel  122
selecting  37
selecting side for measurement  182
shading  114
show and hide  37
translator  58

CAD part
file location  68

CAD to Part alignment  266
import  277
iterative  271
three feature  275

CAM2 2018
control panels  25
customer experience improvement program  14
help  29
installing  4
introduction  1
ribbon  16
screen layout  15
starting  12

camera  116
probe  29

capture view
cross-section scan  105

center of rotation  28
change

adapter in QuickTools  147

the order of features  36
to measure mode  85
to measurement mode  85

circle
construct  243
key in  206
measure  158
pick from CAD  221

circularity  292
clear

alignment  267
readings  109
saved CAD view  150

closed control panels
view  112

comments  184
QuickTools  147

comparison to CAD  185
compensate axis point  175
compensation for the probe  184
composite datum  291
concentricity  295
cone

construct  251
key-in  209
measure  165
pick from CAD  222

configuration
hardware  96, 128

constrain alignment  274
construct

automatic  226
circle  243

by best fit  243
by coaxial intersection  246
by offset  245
from cone  246
plane intersect  244, 253

cone  251
by best fit  251

coordinate system  278
cross-section scan  254
cylinder  248

by best fit  248-249
ellipse  253

by best fit  253
expand geometry  256
line  231

by axis best fit  232
by best fit  231
by bisection  232
by intersection of 2 planes  233
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by offset  234
by projection  235
parallel  236
perpendicular  237

plane  226
bisector  228
by 3 points and 3 offsets  227
by best fit  227
by offset  229
parallel

See by offset  229
perpendicular  230

point  238
best fit  238
by intersection  239
by midpoint  238
by offset  241
by projection  242
midpoint

See by midpoint  238
move IJK

See by offset  241
point cloud  256

by CAD  256
by layers  256

polyline from points  255
preference  75
rectangular slot  252

best fit
rectangular slot

construct  252

round slot
by best fit  252

sphere  247
by best fit  247
by offset  247

tab  225
torus  249

by best fit  250
tube  250

from features  250
using actual and nominal features  226

constructed planes
use as projection planes  80

construction
expand geometry  226

construction lines preference  70
context menus

See shortcut menus  310
control panels  25

CAD part properties  122

feature information  27, 122, 194
GD&T  27
layers  112-113, 123
measurement  123, 188
measurement data  27, 123, 192
messages  26, 123
moving and docking  25
reordering  25
view closed  112
views  27

coordinate format  23
coordinate system  278

advanced tab  280
alignment  98, 276
basic tab  278
by key-in  285
by offset  286
plane/line/line  284, 286
plane/line/point  280, 282
plane/line/point hold secondary  284
plane/plane/plane  283
plane/plane/point  283
point/point/point  284
types

cartesian  23
cylindrical  24
spherical  24

copy tolerances  108
creating a layer  112
cross-section scan

analysis  100
capture view  105
construct  254
even distribution  185
measure  168
recall view  105
rotate view  104
view  104
view data  105

cross-sections
See also polyline group  178

custom tolerances  115
custom zoom  117
customer experience improvement program  14
customize ribbon  22
cylinder

construct  248
key in  207
measure  160
pick from CAD  221

cylindricity  292
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D
data

view  121
datum  291

alignment  275
datum alignment  275
default

compensation method  79
measure mode  79
plane preference  80

delete
a layer  113
alignment  267
deviation markers  121

deviation markers  120
delete  121
export  64
file location  68
generate  121
import  62
key-in  121
pick  106, 120
zone size  121

device
import reference points  132
measurement mode setting  129
move  96, 133
multiple devices  129
TrackArm  135

device-controlled
See arm as a mouse  29

device-controlled mouse  29, 78
device center  96, 128

startup preference  77
device manager

panel
preferences  77
startup preference  77

device position  131
export and import device position  135
file location  68
import reference points  132
moving device with survey  56
new  96, 133
save and load setup  135
set in QuickTools  148
solve in QuickTools  148

devices
device center  96, 128

manage  130
tab  127

digital readout (DRO)  189
dimension  257

angle  257
by key-in  215
by selecting features  257

automatic  257
length  259

by key-in  215
from features  100, 259

distance intervals  129
docking panels  25
document

file location  68
header information  106-107

DRO
background tolerance color  76
preferences  76
refresh rate  85
search radius  77

dynamic
nominals  195
zoom  117

dynamic device camera  29

E
e-mail

report  50
edit

a layer  113
CAD part properties  96
clear readings  109
features and CAD part  108
measured features  183
report template  46

electronic manual  30
ellipse

construct  253
key-in  214
measure  167
pick from CAD  223

erasing readings  109
even distribution  185
exact length

in GD&T  290
exclude

features in report  48
exit program  94
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expand geometry  226
expand geometry construction  256
export  63

CAD to XGL  65
deviation markers  64
device position  135
measurement data

CAD  65
text file  64

point cloud  64
point cloud to mesh  65
points  63
tolerances  65
transformation matrix  65
tube  65
view  122

extract
feature in QuickTools  147
tab  199

F
FARO 3D Imager

See devices  127
FARO Laser Tracker

See devices  127
FaroArm

See devices  127
feature

actual and nominal in constructions  226
alignment  275
automatic recognition  100, 188
CAD highlighting preference  69
comments  184
display preference  77
DRO background tolerance color  76
DRO search radius preference  77
editing  108, 183
grouping  36
labels  191
layers

adding features  113
creating  112
deleting  113
editing  113
removing features  113

length in GD&T  290
naming  34

multiple  34

override length
in GD&T  290

properties  183
readings  123
reordering  36
selecting  34
show/hide  35, 114

show only selected  114
status indicator  35
tracker-related cylindrical coordinate system  76
types defined  28
unsolved  330
whiskers

scale  114
window  106, 124
window preference  76

feature information
control panel  27, 122, 194

features
default tolerances  91

file
CAD translator  58
export  63
import  60
locations  10
new  58
open  58
preferences  67

alignment  87
device manager panel  77
Laser Tracker  86
temperature sensors  87
TrackArm  86
unit & decimal place  74

save  58
save as  58
tab  57

file location
alignment  68
CAD part  68
deviation markers  68
device position  68
documents  68
measurement  68
points  68
reference targets  68
tube  68

fine registration
in QuickTools  147

fit scale  273
fix normals  38
flatness  292
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flip vector  109
freeze recalculation  148
front view  116
full screen view

main window  112
measurement panel  189

G
GD&T

adding to a feature  287
angularity  294
circularity  292
concentricity  295
control panel  27
copy tolerances  90, 108
cylindricity  292
datum  291

composite  291
default tolerances  91
flatness  292
location  294
orientation  293
parallelism  294
paste tolerances  108
perpendicularity  293
position  295
profile  296

line  296-297
surface  297

runout  298
straightness  293
tolerances  287
total runout  298
using exact feature length  290

generate
barcode  59
deviation markers  121

geometric data  189
getting started  10
grid  116
group

feature  36
properties  36

H
hardware

configuration  96, 128

header
document  106-107

help  66
Acrobat Reader  30
CAM2 2018  29

hide
all labels  120
CAD  37
feature  35, 114
point cloud targets  116

high point  173
home in point  170

home in zone  171, 174
measuring points  172
zone size  85, 91

home tab  95
hot keys

See keyboard shortcuts  308

I
image

measurement  189
image creator  50

adding pictures  52
commands  50
creating pictures  52

imager
preferences  83, 87
See devices  127

import  60
alignment  63, 277
CAD  96
CATIA  58
deviation markers  62
device position  135
IGES  58
overwrite nominals preference  68
point cloud  61
points  61
ProE  58
QuickTools  63
reference points  132
reference targets  62
STEP  58
tolerances  63
tube  62
VDA  58

in report list  48
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include
features in report  48-49

include previously measured features  85
insert

CAD part  61, 96
inside compensation  185
inspect surface  156
inspect surface point  156

pick from CAD  219
installing

CAM2 2018  4
introduction

CAM2 2018  1
isometric view

NE  117
NW  117
SE  117
SW  117

iterative alignment  271
constraints  274
fit scale  273
material temperature  274
set weights  273
tolerance  87

K
key-in

circle  206
cone  209
cylinder  207
deviation markers  121
ellipse  214
line  204
paraboloid  214
plane  204
point  205
rectangular slot  213
round slot  212
sphere  207
tab  203
torus  208
tube  209
vector point  205

keyboard shortcuts  308

L
label orientation  120

label readings  120
label scale  120
labels  118

arrange  119
for features  191
hide all  120
readings  120
show all  119
smart naming preferences  76

laser probe measurement  187
Laser Tracker

preferences  86
See devices  127

layers  112
adding features  113
control panel  123
creating  112
deleting  113
editing  113
removing features  113

learn files
importing  143

length  259
by key-in  215
from features  100, 259
override in GD&T  290
unit  75
using exact in GD&T  290

licensing  4
network  5
updating  8
wizard  5

licensing wizard  5
line

construct  231
key in  204
measure  154, 169
pick from CAD  220
profile  296-297

line/line intersect coordinate system  284
load device setup  135
locate

TrackArm  135
location  294
locking QuickTools programs  145
logo

file location  93
in report template  47
preference  93

low point  173
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M
manage alignments  98, 266
manage custom tolerances  115-116
manage devices  130
material temperature  274
maximum iterations  87
measure

2D line  154
3D line  169
circle  158
compensate axis point  175
compensation preference  79, 84
cone  165
cross-section scan  168
cylinder  160
ellipse  167
features

editing  183
high point  173
high/low point  173
home in point  170
inspect surface  156
inspect surface point  156
low point  173
mode  99

QuickTools  151
mode preference  79
on CAD side  182
paraboloid  181
planar point  170
plane  154
point  155
point cloud  157
polyline  176
polyline group  178
properties

measure on CAD side  184
rectangular slot  166
round slot  165
scan mode  190
single point circle  180
sphere  159
surface edge  158
surface point  174, 176
tab  153
torus  161
tube  162
vector point  174
with a laser probe  187

measure all
include previously measured features  85

measurement
automatic feature recognition  100, 188
comments  184
completion mode  79
control panel  123, 188
data

export
to CAD  65
to text file  64

file location  68
geometric data  189
image  189
measure mode preference  85
measurement mode preference  85
mode settings  129
prompt  189
properties

comments  184
select a plane  181

sound preference  78
measurement data

control panel  27, 123, 192
menus

See ribbon  16
See shortcut menus  310

mesh
nominal  98

messages
control panel  26, 123

mirror nominal  97
mode

GD&T  287
moving

control panels  25
device  96, 133
device position with a survey  56

multiple
devices  129
nominals  195

N
naming

feature  34
features automatically  76
multiple features  34

navigation window  33
network licensing  5
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new
file  58
in this version  31

nominal and actual features in constructions  226
nominals

adding to a feature  194
clearing  194-195
from CAD

See pick from CAD  217
from keyboard

See key-in  203
importing

a CAD file  61
a text file  60

mesh  98
mirroring  97

not in report list  48
not used values

See set weights  273
notification center  24

O
offset

a circle  245
a coordinate system  286
a line  234
a plane  229
a point  241
a sphere  247

on-screen labels  191
open file  58
orientation  293
outside compensation  185
override length in GD&T  290
overwrite nominals preference  68

P
pan view  28
panels  122
paraboloid

key-in  214
measure  181
pick from CAD  220

parallelism  294
paste tolerances  108
perpendicular intersection coordinate system  284
perpendicularity  293

pick deviation markers  106, 120
pick features  96, 218
pick from CAD

circle  221
cone  222
cylinder  221
ellipse  223
inspect surface point  219
line  220
paraboloid  220
pick features  96, 218
plane  220
point  218
rectangular slot  223
round slot  222
sphere  221
tab  217
torus  222
vector point  218

pictures  50
creating for QuickTools  52
image creator  52

planar points
measure  170

plane
construct  226
key in  204
measure  154
pick from CAD  220
select in measuring  181

plane-lock scanning  185
player

QuickTools  151
point cloud  186

alignment  99, 269
comparison to CAD  185
construct  256

by CAD  256
by layers  256

edit
copy  40
cut  40
delete  41
merge  40
paste new  40
split  40

export  64
export to mesh  65
import  61
measure  157
point distance filter  185
preferences  81
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targets show/hide  116
point distance filter  185
points

construct  238
export  63
file location  68
high  173
home in  170
import  61
inspect surface  156
key in  205
low  173
measure  155
pick from CAD  218
surface point  174, 176
vector point  174

polyline
construct from points  255
measure  176

polyline group
measure  178

pop-up menus
See shortcut menus  310

position  295
export and import device position  135
moving device with survey  56
save and load device setup  135

post alignment format  93
pre alignment format  93
preferences  67

3D Imager  83, 87
alignment  87

iterative alignment tolerance  87
maximum iterations  87

angle unit  74
CAD

rendering quality  70
show construction lines  70

construction  75
decimal place

vector  75
device center  77
device manager

use arm as mouse  78
device manager panel  77
display controls

CAD surface highlighting  69
DRO options  76
feature window  76

background tolerance color  76
DRO search radius  77

tracker-related cylindrical coordinate 
system  76

features  77
FARO TrackArm  86
file  67

alignment file location  68
CAD part file location  68
deviation markers location  68
device position file location  68
documents file location  68
measurement file location  68
overwrite nominals  68
reference targets location  68
tube file location  68

Laser Tracker  86
length unit  75
measurement

auto-switch to measure mode  85
auto repeat measurement  77
change to measurement mode  85
constructed actual planes  80
copy GD&T tolerances  90
default compensation method  79
default plane  80
DRO refresh rate  85
home in zone size  85, 91
include previously measured features  85
material compensation mode  84
measure/template mode  79
measurement completion mode  79
measurement sound  78
point cloud  81
profile calculation method  85
show control window  78
use last plane  80

points file location  68
remote server  87
report  92

default format with alignment  93
default format without alignment  93
logo  93

smart naming  76
temperature sensors  87
tolerance  90
tolerances

features  91
GD&T defaults  91

Tracker adapters
units  75

unit
angle  74
length  75
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unit & decimal place  74
preset views  116

+X/-X  116
+Y/-Y  116
+Z/-Z  116
isometric NE  117
isometric NW  117
isometric SE  117
isometric SW  117
recenter  117
reset  117
reset rotation  117

preview saved CAD view  150
printing

a report  50
features  194

probe compensation  184
automatic  184, 191
inside  185
none  185
outside  185
sampled end click  184

probing version  9
profile  296

line  296-297
surface  297

profile calculation method  85
projection plane  181
prompt

measurement  189
properties  108

feature  183
group  36

Q
quick access toolbar  23
quick launch toolbar  201, 278
QuickTools  141-142

add comments  147
CAD view commands  150
CAM2 Control Station  151
change adapter  147
clear saved CAD view  150
command properties  149
creating from features  143
creating pictures  52
deleting programs  146
editing programs  144
extract feature  147

fine registration  147
freeze recalculation  148
import  63
importing learn files  143
locking programs  145
measure mode  151
playing programs  144
preview saved CAD view  150
program commands  148
programs  142
recenter to saved CAD view  150
recording programs  142
save CAD view  150
set active device position  148
solve device position  148
starting from command line  145
template mode  151
tools  146
unfreeze recalculation  148
unlocking programs  146
view report  147

R
readings

aim  193
change probe  193
clearing  109
delete  193
edit probe settings  194
removing  193
report  193
See measurement data  192
viewing  123

recalculation
an alignment  267-268
freeze in QuickTools  148
unfreeze in QuickTools  148

recall view
cross-section scan  105

recenter
saved CAD view  150
view  117

rectangular slot
construct  252
key-in  213
measure  166
pick from CAD  223

reference points
import  132
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reference targets
file location  68
import  62

registration
in QuickTools  147

remove server
preference  87

removing features from a layer  113
renaming features  34
rendering quality  70
reordering

control panels  25
feature  36

repeat
last command  108
measurement  77

report
default format  93
document information  106-107
email  50
exclude features  48
include features  48-49
interface  47
logo  47

file location preference  93
preferences  92
printing  50
QuickTools  147
readings  193
report list  48
saving  50
selecting a template  50
survey results  56
template  46

reset
rotation  117
view  117
zoom  118

ribbon  16
customize  22

right-click menus
See shortcut menus  310

rotate
a coordinate system  286
set center of rotation  28
view  28

cross-section scan  104
round slot

construct  252
key-in  212
measure  165
pick from CAD  222

runout  298

S
sampled end click compensation  184
save as  58
saving

CAD view for QuickTools step  150
device setup  135
files  58
report  50

scanning  190
filter  186
mode  190

screen layout  15
selecting

a plane  181
CAD  37
feature  34
features  29

selection
brush  39
clear  39-40
front facing  40
invert  39
lasso  39
polygon  39
rectangular  39

set
weights  273

settings  67
setup device  130
shading mode  114
sheet metal

See CAD part properties  97
See measuring on the CAD side  184

shortcut menus  310
shortcuts  66, 141, 151
show

all labels  119
CAD  37
control window preference  78
feature  35, 114
only selected  114
point cloud targets  116

simultaneous measurement  129
single nominal  194
single point circle

measure  180
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slots
construct  252
measure  165-166

smart labeling  76
sphere

construct  247
key in  207
measure  159
pick from CAD  221

starting
CAM2 2018  12

status indicator  35
straightness  293
surface edge

measure  158
surface edge point

measure  176
surface point

automatic compensation  78
measure  174

surface profile  297
survey

active survey  53
moving device position  56
performing a survey  55
reporting survey results  56
setup  54
types of survey  54

system requirements  3
hardware  3
software  3

T
tabs

alignment  265
construct  225
default  16
devices  127
extract  199
file  57
home  95
key-in  203
measure  153
pick from CAD  217
view  111

targets show/hide  116
temperature

material  274

temperature sensors
preferences  87

template mode  99
preference  79
QuickTools  151

three feature alignment  275
time intervals  129
tolerances

abbreviations  92
adding and editing  194
copy  108
copy preference  90
custom  115

manage  115-116
editing for a feature  196
export  65
feature defaults  91
GD&T  287
GD&T defaults  91
import  63
iterative alignment  87
paste  108
preference  90

tools
QuickTools  146

torus  161
construct  249
key in  208
pick from CAD  222

total runout  298
TrackArm

locate  135
preferences  86

Tracker
units preference  75

tracker-related cylindrical coordinate system  76
transformation matrix  65
translate CAD files  58
tube

alignment  164
automatic alignment  83
construct  250
export  65
file location  68
import  62
key-in  209
measure  162
turn representation  84

types of survey  54
typing nominals  195
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U
unfreeze recalculation  148
unit of measure

changing  24
preference  74

unlocking QuickTools programs  146
unsolved feature  330
updating your license  8
use last plane preference  80
user

preferences  67
profiles  66

V
vector

decimal place preferences  75
flip  109

vector point  174
key in  205
measuring points  175
pick from CAD  218

versions  9
view

arrange labels  119
closed control panels  112
controlling with mouse  28
cross-section analysis  100
cross-section scan  104
custom tolerances  115
deviation markers  120

delete  121
generate  121
key-in  121
pick  106, 120
zone size  121

export as image  122
feature readings  123
full screen  112
grid  116
hide all labels  120
label readings  120
labels  118
layers  112
panels  122
preset views  116

+X/-X  116
+Y/-Y  116

+Z/-Z  116
isometric NE  117
isometric NW  117
isometric SE  117
isometric SW  117
recenter  117
reset  117

reset
zoom  118

reset rotation  117
sale labels front facing  120
sale labels to screen  120
show

all labels  119
feature window  106, 124

tab  111
targets show/hide  116
whisker scale  114

view data  121
views

control panel  27
visibility of a feature  114

W
what is new  31
whiskers

scale  114

Z
zone size

deviation markers  121
zoom

reset  118
to area  117
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Email: support@faro.com 

FARO Brazil 
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TEL: +65 6511.1350 
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Shanghai 200231, China 
Tel.: 400.677.6826 

Email: supportchina@faro.com 

FARO Business Technologies India Pvt. Ltd.
E-12, B-1 Extension, 

Mohan Cooperative Industria Estate, 
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Tel.: 1800.1028456 

Email: supportindia@faro.com 

FARO Technologies, Inc. 
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